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The Application Desktop

3 October, 2022

The Application Desktop

The Enterprise Architect application workspace (or user
interface) provides a multi-featured and flexible analysis,
modeling, design and construction environment. The
workspace is built from familiar components, such as
toolbars, docking windows, dialogs and menus. Together
these elements provide a rich set of tools for working with
models, UML, diagrams, source code, executing
applications (debugging and visualization), rich text
documents, collaborative tools, extension technologies and
much more.
The Enterprise Architect user interface is highly
customizable both in functionality and in appearance. Visual
styles are available based on the popular Microsoft Office
and Visual Studio, from the classic look and feel of the
Windows XP era right up to the latest Office and Visual
Studio incarnations. Dark and light styles are further
enhanced with the ability to automatically display source
code and diagrams in dark or normal styles.
Customization of toolbars, menus, workspace layouts,
Perspectives and shortcuts helps you get the most out of
Enterprise Architect for your particular needs. Taking the
(c) Sparx Systems 2022
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time to become familiar with the customizations available is
well worth while, as it can help you build the precise
modeling and design environment you need to focus on your
work.
If you want to explore the basic process and tools for
creating a model in Enterprise Architect, you can watch the
demonstration on the Sparx Systems website, and/or work
through the simple Tutorial provided in this section. Use the
links under the 'Learn more' heading.

User Interface Tools
Tools

Description

Enterprise
Architect
Workspace

The Workspace is the interface through
which you create, open and display your
models. The main workspace component
is the central Diagram View, which is
where you create model diagrams, view
reports, scroll through lists of model
elements and edit and debug source code.

Ribbons

The ribbons provide access both to
high-level functions related to the project
life cycle, and to project and system
administration functions; at all levels of
the system you can also access functions
and operations using context menus.

(c) Sparx Systems 2022
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Windows

The windows help you to enter and
display information on your project and
models; you can re-arrange windows to
adapt the screen space to your work
habits.

Toolbars

Toolbars are small sets of buttons that
provide quick access to common
operations, both on your project as a
whole and on the individual modeling
units.

Diagram
Toolbox

The Diagram Toolbox provides all the
components and connectors that you use
to create models using the medium of
diagrams; the Toolbox automatically
matches the kind of diagram you have
open, from any technology that is
currently active in your model.

Keyboard
Keys

You can use keyboard key combinations
to quickly initiate a wide range of actions
throughout the system, and Diagram
Quick Key (single-key) shortcuts to
perform actions on the elements and
connectors in an open diagram.

Customizatio

Enterprise Architect provides various

(c) Sparx Systems 2022
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n

customization tools that you can use to:
· Tailor the ribbons, menus, toolbars and
function keys you use in your work
· Set the visual style of the application,
and
· Customize the workspace layout

Navigation

You can use several navigation and
search tools to search for, track and locate
information in your project, and filter the
information so that you can explore
particular views of your project rather
than the entire contents.

(c) Sparx Systems 2022
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The Summary Window
The Summary window shows a brief, read-only summary of
the general properties of the currently selected:
· Element (including Packages)
· Attribute
· Operation
· Test
· Maintenance item
· Resource
It does not display details for Views, Model Packages,
diagrams, instances or connectors.
The Summary window immediately displays general
information on the item in context, so you can quickly scan
a number of items to locate and check those of interest to
you. You can highlight a section of text or the complete
content, and copy it to be pasted into an external document.

(c) Sparx Systems 2022
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The window is mirrored by the 'Summary' tab of the
Inspector window; the 'Summary' tab and Summary window
always remain in synchrony.

Access
Ribbon

Start > All Windows > Design >
Summary
Start > All Windows > Design >
Inspector > Summary

Context
menu

In the Browser window, right-click on the
object | Properties | Summary

Keyboard
Shortcuts

Ctrl+6
Alt+1 > Summary

(c) Sparx Systems 2022
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Alt+1 > Inspector > Summary

(c) Sparx Systems 2022
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The Journal Window
Enterprise Architect provides a great facility for maintaining
a daily log of ideas, comments, notes, suggestions, events,
to-do lists and other reminders of what the developers
concerned with a selected element or diagram have done or
intend to do for the selected object. Like the model-level
personal Diary, this is a good way to keep the momentum
flowing day to day. The facility is simple to use, allowing
you to quickly jot down your thoughts as they occur to you.
The 'Journal' tab is part of the Discuss & Review window,
and allows you to record points as you work on, review and
discuss the element or diagram with other team members.

Access
Ribbon

Start > All Windows > Collaborate >
Discuss & Review Elements | Journal,
then click on element or diagram
Start > Collaborate > Journal | Journal,
then click on element or diagram

Context
Menu

Right-click on element in diagram or
Browser window | Collaborate | Journal
Right-click on open diagram or diagram
in Browser window | Collaborate |

(c) Sparx Systems 2022
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Journal
Keyboard
Shortcuts

Ctrl+9 > Journal

Creating a 'Journal' entry
If you are the first to access the 'Journal' for an element or
diagram, it has the single entry 'Today' in the 'Date' column.
You can type freely in the 'Journal' column against 'Today',
including carriage returns and text formatting. Editing a
Journal entry is in most cases the same as entering formatted
text into the Notes window, with many options to mark up
text, create hyperlinks, use the glossary and similar. Some
features, such as the Translation features for Notes are not
currently supported in the Journal window.
When you have finished typing your comments, click away
from the Journal window and your text will be automatically
saved as the editing window loses focus.
You can return to the Journal at any time (as long as another
user is not actively updating it) and:
· (Right-clicking on the 'Date' column) Refresh the Journal
with any text that another user might have just added
· Add further notes; you and other team members use the
same Journal entry to record notes and comments on the
element or diagram throughout the day
(c) Sparx Systems 2022
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Edit the existing text, including reformatting
Delete text or complete notes; select the text and click on
the Delete key or use the 'Delete' context menu option

Journal Entries Each Day
Every day, when you open Enterprise Architect and review
the 'Journal' for an element or diagram, it has a 'Today' item
at the top, against which you record the day's Journal entries
on the selected object. Beneath the 'Today' item are the
entries for previous days, identified by the date on which
they were made. These only include dates on which an entry
was made; there are no blank lines for days on which no
entries were made.
As you build up a number of Journal items on an element,
you can set the number of items to display (effectively the
number of days on which items were posted) in
chronological order, starting with today. To do this:
1. Click on the Hamburger icon at the top of the tab and
select the 'Show This Many Entries' option.
2. On the submenu, click on the number of days for which to
show comments - 1 (Today), 3, 7, 15, 30 or All (every
item posted on this object).
You can also pin the currently listed comments for an
element or diagram to the tab. Those comments show in the
tab regardless of which other object you are working on,
(c) Sparx Systems 2022
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which is a useful way of showing instructions written to
guide your work on other objects. To pin the comments:
1. Click on the Hamburger icon at the top of the tab and
select the 'Pin this comment' option.
2. When you want to display comments for other elements
or diagrams, click on the Hamburger icon again and select
the 'Unpin Comment' option.
Additionally, you can set the 'Journal' tab and the Discuss
and Review window as defaults so that they are displayed
each time you log back in for a new work session. To do
this, click on the 'Hamburger' icon and select the 'Set this
Tab as Default' option.
As well as formatting and editing today's entry, you can edit
the entries for previous days. This means you can remove
information that is no longer relevant (such as old
reminders) or things that were listed to be achieved that are
now complete. On the other hand, you can also highlight
entries that are still significant, and refer back to them from
the 'Today' entry.

(c) Sparx Systems 2022
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The Inspector Window
The Inspector window provides the facility of examining the
details of an individual element, whether held in the current
model or in an external data source.
Generally the window has a 'Details' tab listing all the
features and characteristics of the element, appropriate to
the element type. The categories of features and
characteristics are listed even if they do not contain items.

(c) Sparx Systems 2022
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The window also has a 'Trace' tab, which is an instance of
the Traceability window for viewing and navigating the
(c) Sparx Systems 2022
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dependencies and connections of the currently selected
element. The 'Trace' tab has the appearance, facilities and
content of the Traceability window, and updates in
synchrony with the window.
Similarly, the window has a Summary tab that has the
appearance, facilities and content of the Summary window,
and updates in synchrony with that window.
If you are working with an external data source in a
Cloud-connected model, the Inspector window has another
tab - 'External' - that shows the characteristics and features
of the selected external data item. In this case, if a category
does not contain any items it is not shown in the list.

Inspector Window Toolbar
The Inspector window toolbar provides three icons that
enable you to display the full details of a selected item.
Icon

Description
Select an item and click on this icon to
open the appropriate dialog or window
and - where appropriate - tab to display
the properties of that item. For example,
if you had selected an Operation,
Attribute or Reception, this icon would
display the Features window at the
appropriate tab for that item.

(c) Sparx Systems 2022
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Class

Select an item and click on this icon to
make the item the focus of the docked
Properties window.

Class

Click on this icon to display this
Inspector window Help topic.

(c) Sparx Systems 2022
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Inspector - Details
As you develop an element in your model, you can define a
range of added-on properties of that element through the
appropriate dialogs, pages and tabs. It is possible to neatly
summarize all of these properties for a selected element,
using the 'Details' tab of the Inspector window. The
properties listed - where they exist in the element - are
grouped by type and include:
· Relationships
· Operations
· Attributes
· Receptions
· Linked Features (Linked attributes and operations)
· Requirements (both external and internal)
· Constraints
· Scenarios
· Related Files
· Testing items (sub-grouped as Unit, Integration, System,
Acceptance, Scenario and Inspection tests)
· Resources allocated to the element
· Project management items (sub-grouped as Decisions,
Events, Efforts, Risks and Metrics)
· Maintenance items (sub-grouped as Features, Changes,
Documents, Issues, Defects and Tasks)
· Discussions
(c) Sparx Systems 2022
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Integration
These property types are all listed by default. You can filter
out types that you don't require, making it easier to find
specific items by defining your own filter:
3. Right-click on the 'Details' tab.
4. Select 'Navigation options' from the context menu, to
display the 'Select Visible' dialog.
5. Clear the check box against each property type to hide.
6. Click on the Save button; a prompt displays for a name
for the selection. You can later select the name and
re-apply the filter by clicking on the drop-down arrow to
the left of the Save button, or by clicking on the name in
the list of sets at the bottom of the 'Details' tab context
menu.
7. Click on the OK button.
Having listed the appropriate properties, you can perform a
number of operations on them, including dragging and
dropping many of them onto other elements.
·

Access
Click on an element, and then apply one of these access
methods:
Ribbon

(c) Sparx Systems 2022
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Start > All Windows > Design > Explore
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> Inspect > Details
Explore > Portals > Windows > Explore
> Element Browser
Keyboard
Shortcuts

Alt+5 | Element Browser
Alt+1 | Inspector > Element
Ctrl+1 > Element

Options
Option

Action

List items

If you want to open the list of items of a
particular type in the appropriate window,
dialog or view (to, for example, review
the details of the items) right-click on the
list name and select the '<object> List'
option, or select any item then use the
keyboard shortcut Shift+Enter.
Where a list has categories, such as
Maintenance, Project or Testing, the
option also operates on the selected
category. For example, you might list all
Maintenance Items in the 'Maintenance
Overview' tab of the Maintenance
window, or just the Change items in the

(c) Sparx Systems 2022
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'Changes' tab of the Maintenance
window.
Alternatively, click on the list heading
(such as Requirements) and press the /
(forward slash) key. There are various
other 'hot-key' combinations for different
object types that each open a list in the
appropriate dialog, but / opens the dialog
or window for every object type.
Expand or
collapse
every list of
objects

Right-click on the element name and
select the 'Expand All' option to expand
the list of every object type in the
'Details' tab. Select the 'Collapse All'
option to collapse all the lists and just
show the headings. There are keyboard
alternatives for these commands - press
the Ctrl and + keys, and the Ctrl and keys, respectively

Copy Item
Name to
Clipboard

Copy the name of the selected list item to
the clipboard by right clicking on it and
selecting the 'Copy Item Name to
Clipboard' option, then paste it into a text
field. If the name has a status prefix in
brackets, the copy operation changes the
status to the item type. For example:
Testing
Unit

(c) Sparx Systems 2022
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[ Pass ] Verify update
If you copy the unit test name and paste
it, the name will be:
[ Unit ] Verify update
Add items of
a specific
type

Right-click on the property type name
and select the 'New <object>' option.
(This option is not applicable to all items,
some of which cannot be created without
using information external to the selected
element.) Or select any item and use the
keyboard shortcut Ctrl+N for new items.
The appropriate window or dialog
displays. Add new or edit existing items
as necessary.
For example, if you right-click on the
Attributes list name and select the 'New
Attribute' option (or Ctrl+N), the Features
window displays at the 'Attributes' tab,
and you can add to or edit the attributes
in the element.
You can also press the F2 key to open the
appropriate window for adding new items
or reviewing the existing items of a type.

Edit specific
items

Expand the appropriate folder and
double-click on the required item.
Alternatively, right-click on the item
name and select the 'Edit' or 'Edit > <item

(c) Sparx Systems 2022
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name>' option, or press the F2 key.
The appropriate dialog, docked window
or view displays, on which you update
the item.
Delete a
specific item

A number of types of item have no
independent existence from the parent
element, and can therefore be deleted
from the element without impact
elsewhere. Such items include Change
items, Tasks, Resources and Constraints.
To delete an item, right-click on it and
select the 'Delete' option.

Drag a
relationship
onto a
diagram

Click on the relationship in the
'Relationships' list and drag it onto the
diagram.
If the element at one or both ends of the
relationship is not already on the
diagram, those elements are also added to
the diagram.
If the relationship is already on the
diagram, but hidden, it becomes visible
again.
Alternatively:
· Right-click on the Relationships list
name and select the 'Place All Related
Elements in Diagram' option, or

(c) Sparx Systems 2022
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Right-click on the relationship and
select the 'Place Related Elements in
Diagram' option

Hide/Show a
Relationship
in the current
diagram

Right-click on the relationship in the
Relationships list and select the 'Hide
Relationship' or 'Show Relationship'
option, as appropriate.

Display the
'Properties'
dialog of the
other element
in the
relationship

Right-click on the relationship in the
Relationships list and select the 'View
Related Element Properties' option.

Locate the
related
element in
the Project
tab of the
Browser

Right-click on the relationship in the
Relationships list and select the 'Locate
Related Element' option. The element is
highlighted in the 'Project' tab of the
Browser window.

Locate the
related
element in
other
diagrams

Right-click on the relationship in the
Relationships list and select the 'Find in
all Diagrams' option.

(c) Sparx Systems 2022
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Open an
associated
file

Double-click on the required file path
within the Files list.
If the file can:
· Be opened within Enterprise Architect,
the file opens on a separate tab in the
Diagram View workspace
· Not be opened within Enterprise
Architect, the file opens in the default
Windows viewer/editor for the file type

Display the
source code
for a feature

Right-click on an attribute or operation in
the Attributes or Operations list or in the
Linked Features list, then click on the
'View Source Code' option.
Alternatively:
· Click on the attribute or operation and
press Ctrl+E, or
· In the Linked Features list,
double-click on the attribute or
operation
If no code has been generated for the
selected feature, nothing happens.
If code has been generated for the feature,
the code is displayed. The source code
viewer in which the source code displays
depends on which editor you select as the
default, either for the project as a whole
or for a specific programming language;

(c) Sparx Systems 2022
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if you select the Enterprise Architect
internal editor, the code displays in the
Source Code Viewer with the cursor
positioned on the selected feature.
Move a
property to
another
element

Click on the property in the 'Details' tab
and drag it onto the other element in a
diagram. The properties you can do this
for are:
· Constraints
· Requirements
· Maintenance Items
· Tests
Alternatively, for Maintenance items,
right-click on the property and select the
'Move to' option. A list of the elements in
the currently-active diagram is displayed;
click on the element to move the property
into.
If you use the 'Move to' option on Testing
items, the submenu lists other categories
of test on the same element, into which
you can move the test details.

Copy a
property to
another
element

As for the Move operation, with the same
property/item types, but press the Ctrl
key while dragging the item onto its
target.

(c) Sparx Systems 2022
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There is no equivalent menu option to
copy the item.
Additional properties you can copy (by
simply dragging the property onto the
target without pressing the Ctrl key)
include:
· Attributes
· Operations
· Receptions
There is a 'Copy to' option for Test items,
which copies the test from one test
category to another for the same element.
Attach a
Recording
Marker to an
Operation or
Signal

(c) Sparx Systems 2022

Right-click on the object and select the
'Visual Analyzer | Set Breakpoint' option,
and the option to set the required type of
recording marker.
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Inspector - Status
The 'Status' tab on the Inspector window provides a quick
outline for reviewing the status and priority of all elements
of type Requirement in a diagram. This triage tool helps you
to focus on what is most important right now, as well as
provides a clear view of what can be postponed.
With a diagram selected in the Browser, and the 'Status' tab
selected, you can see:
· A list of all elements in a diagram
· An indicator of the element Status
· An indicator of the element Priority
For each element in a diagram there is a line in the 'Status'
tab with:
· Element name
· Status icon
· Priority icon

(c) Sparx Systems 2022
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Note:The listing indent respects the Browser nesting of an
element.

Configuring the Status color
The color of the status indicator can be user-defined in the
'Status Types' dialog. The shape for the 'Status' indicator is
fixed as a circle. For more details see the Status Type Help
topic.

Configuring the Priority shape and color
To give each Priority Type a clear visual reference you can
assign a particular shape and a color. The shapes available
are:
(c) Sparx Systems 2022
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Square
· Circle
· Triangle
· Diamond
For more details see the Priority Types Help topic.
·

(c) Sparx Systems 2022
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The Focus Window
The Focus window is a valuable tool for locating and
examining items of importance from anywhere in the overall
model. For example, you might want to identify and locate
items having a particular group of characteristics, which are
defined in a Model View. Or you might need to locate
particular types of item that are currently active, or diagrams
and windows that you personally have been working on
recently. The Focus window provides several means of
locating such items.

Access
Ribbon

Start > Application > Design > Focus

Keyboard
Shortcuts

Alt+1 | Focus

Focus Window Facilities
The Focus window has four tabs, each providing a means of
defining, locating and accessing the particular items you
want to review in the model.
(c) Sparx Systems 2022
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Tab

Description

Model Views

Provides access to the Model Views
facilities.

Working Sets

Provides a list of the currently-defined
Working Sets, each of which can be
expanded to show the diagrams and
facilities opened by the set.

Quick Find

A simple search for either elements or
diagrams that have a specific text string
in their names or Aliases.

Revisit

Provides lists of the Enterprise Architect
diagrams, documents, windows and files
that you have opened in the last seven
days.

(c) Sparx Systems 2022
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Model Views
The 'Model Views' tab helps you to capture information on
the objects in your model from different aspects that you
define yourself, helping you to encapsulate your model
under the areas you are interested in. You can define a
number of types of view based on searches or objects that
you have placed into a collection, or you can collate
diagrams into a slide show. You can also import views from,
or export views to, other models. The Model Views window
contains a 'Recent' folder, which keeps track of the
elements, diagrams, documents, discussions reviews and
maintenance (Construct) items you have recently been
working on.
Model Views are not filtered by Perspective, so you will see
all Views defined for your model at any time.

Access
Ribbon

Start > All Windows > Design > Explore
> Focus > Model Views

Keyboard
Shortcuts

Alt+1 | Focus > Model Views
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Features

Feature

Detail

View Root
Nodes

There are two types of View root-node
available:
· Model Views - stored in the model and
visible to all users; you can have many
of these
· Technology-defined Views - read only;
each View is added by, stored with and
populated by the corresponding MDG
Technology
Additionally, there is a Library folder that
contains current correspondence from the
Library concerning items that are held in
any of the Views; this folder has a
separate repository of postings for each
Library server connection you access
through the model. You can control how
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recent these postings must be, and how
many are to be listed.
When you open the Model Views for the
first time on a project, a Model Views
root section is added for you. This can
not be deleted or renamed; however, you
can create further Model View root nodes
that you can modify and delete.
Subordinate
Folders
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Under a Model View root node you can
create Views folders, Search folders,
Slideshow folders and Favorites folders.
The Search, Slideshow and Favorites
folders are functional and cannot contain
subordinate folders, so whilst you can
create several Search, Slideshow or
Favorites folders immediately under the
Model View node you can group and
better organize multiples of these folders
under appropriately-named View folders.
· A Search View is a folder of elements
or structures that you assemble by
assigning a Model Search to the folder
- when you double-click on or expand
the folder, the search runs and refreshes
the folder contents; you can also set a
search to refresh at a defined interval,
and to notify you if new results are
found
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A Slideshow folder contains links to
diagrams, which you can display as a
slide show with the diagrams being
displayed in the sequence in which they
are listed in the folder
One folder represents one slide show you can run the slide show
automatically or manually; in either
case the diagrams are closed after they
have been displayed
· A Favorites folder gives you easy
access to commonly-used items in the
Browser window; to create hyperlinks
in a Favorites folder to the required
items in the Browser window; drag
items from the Browser window into
the Favorites folder
You can also export all of the View
folders containing Views from any root
section as an XML file, and import a
Views XML file as an additional, editable
Model View root node.
These are single-level items; if you drag a
Package into the Favorites folder, you
cannot expand that Package there.
However, you can double-click on the
Package in the Favorites folder to select
and highlight it in the Browser window.
To select specific items inside a Package,
·
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expand it in the Browser window and
then drag the items into the Favorites
folder.
Key to Model Items on the Model View can be
View
identified by their accompanying icons:
Contents
·
- A Model Views root node
·
- A View Folder
·
- A Favorites Folder
·
- A Search Folder
·
- A Slideshow Folder
MDG Technologies can define their own
Model Views, in which case they will
display their own technology-specific
icon.
The Recent
Folder
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The 'Recent' folder provides links to
searches that extract information on the
current status of objects and items in the
model. The searches are grouped to
identify:
· Recently changed elements, diagrams
and documents
· Recent posts in discussions and formal
reviews
· Results of recently-run tests
· Recently requested and implemented
Change items
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Recently reported and investigated
Defects and Issues
· Recently started, finished or active
Tasks
See the Help topic The Recent Folder.
·

Accessing
Operations
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To perform operations on the Model
View contents, you can use the item
context menus.
Each level of the Model Views hierarchy
has a slightly different context menu.
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The Recent Folder
The 'Recent' folder provides links to searches that extract
information on the current status of objects and items in the
model. The searches are grouped to identify:
· Recently changed elements, diagrams and documents
· Recent posts in discussions and formal reviews
· Results of recently-run tests
· Recently requested and implemented Change items
· Recently reported and investigated Defects and Issues
· Recently started, finished or active Tasks
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Access
Ribbon

Start > Application > Design > Focus >
Model Views > Recent

Keyboard
Shortcuts

Alt+1 > Focus > Model Views > Recent

Facilities
Object

Options

Elements

These options execute searches across the
model for elements that have been
changed in the last:
· Day
· Three days
· Week
· Thirty days

Diagrams

These options execute searches across the
model for diagrams that have been
changed in the last:
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·
·
·
·

Day
Three days
Week
Thirty days

Documents

These options execute searches across the
model for documents that have been
changed in the last:
· Day
· Three days
· Week
· Thirty days

Discussions

These options execute searches for
elements with Discussions that have been
opened or had posts within the last:
· Day
· Three days

Reviews

These options execute searches for
Reviews that are:
· Currently open
· Currently active

Construct

This category is divided up into sets of
options to search for elements with
Change Management items - Issues,
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Defects, Changes and Tasks - having a
specific status:
· New
· Verified
· Recently Reported
· Recently Resolved
· Unresolved Issues
Or, for Tasks:
· Recently Finished
· Starting Today
· Overdue
· Ending Today
· Active
· 30 Day Task Summary
The Construct category also has a set of
options to search for elements with Test
item results:
· Recent Results
· Recent Failures
· Recent Passes
· Recent Deferrals
· Recent Modified Elements
· Not Run
· Not Checked
(c) Sparx Systems 2022
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Model Views Context Menus
This section details the options available from the Model
Views context menu, explaining the options provided at
every level of the Model Views hierarchy.

Access
Ribbon

Start > All Windows > Design > Explore
> Focus > Model Views : Right-click on
object

Options
The Model Views context menus display different options,
depending on which level of the Model Views hierarchy you
right-click on.
Menu Option Action
Properties
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(Not for the initial Model Views or
Technology-defined root nodes.)
Display the appropriate 'Properties' dialog
for the selected object.
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You can edit any of the properties, if
required; changes to objects populated
from the model are reflected in all other
views (Properties window, diagrams,
reports) of that object.
The 'Properties' option for a Slideshow
folder displays the 'Slideshow Properties'
dialog, which enables you to automate
the slide show and set the number of
seconds for which each diagram is
displayed. If you deselect the 'Enable'
checkbox, you must press Spacebar to
display each diagram.
New Views
Folder

(Root node only)
Display a prompt for the Views folder
name and create the folder in the selected
root node.

New Model
View

(Root Nodes only)
Add a new Model View root node;
displays a prompt for the View name.

Import Views (Root node only)
From XML
Prompt for the XML file location and
create a new Model Views node to hold
the imported Views.
Export to
(c) Sparx Systems 2022
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XML (Views
Only)

(Root node only)
Prompt for a file path and name, and copy
all Views under the selected root node to
an XML file at that location.

Remove
Model View

(Not for the initial Model Views or
Technology-defined root nodes)
Display a prompt to delete the selected
user-defined Model View and, if
confirmed, delete the root node and all
contents.

New Search
Folder

(View folder only)
Display the 'Create New View' dialog
(similar to the 'View Properties' dialog)
for you to define the search that populates
the View.

New
Favorites
Folder

(View folder only)
Display the 'Create a new favorites based
folder' dialog, which prompts for the
folder name.

New
Slideshow

(Model View, View folder only)
Display the 'Create a new slideshow'
dialog, in which you type the name of the
slide show.
You must use the 'Properties' dialog to
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define the properties of the slide show.
Open Search

(Search View only)
Display the Model Search screen in the
main work area, listing the full results of
the search and giving access to all the
facilities of the Model Search.
Shortcut: Shift+Space

Refresh

(Search View only)
Refresh the search and open the View to
show the elements or documents
retrieved by the search.
Shortcut: Space

Double Click (Search View only)
Opens Search Enable you to perform the 'Open Search'
function by double-clicking on the View.
If you deselect this option, double-click
refreshes the search and opens the View
to show the elements retrieved by the
search.
Remove
Folder
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(View folder only)
Display a prompt to delete the selected
Views folder and, if confirmed, delete the
folder and all contents.
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Remove
View

Display a prompt to delete the selected
Search View and, if confirmed, delete the
View and all contents.

Remove
Favorites

Display a prompt to delete the selected
Favorites folder and, if confirmed, delete
the folder and all contents.

Remove
Slideshow

Display a prompt to confirm deletion of
the selected slide show and, if confirmed,
delete the slide show and all its diagrams.

Run
Slideshow

Run the slide show in the Diagram View.

Run
Slideshow
Full Screen

Run the slide show in full screen mode,
so that the slide show fills the whole
screen.

Stop
Slideshow

Cancel execution of the slide show
running in the Diagram View.
Shortcut: Esc

In Project
Browser

(An element, diagram or Package object
only)
Highlight the selected item in the
Browser window.

Find in all

(An element or child Package object
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Diagrams

only)
Locate the selected object in any
diagrams in which it has been used in the
model, and either:
· Display the single diagram with the
object highlighted or
· List the several diagrams in which the
object has been located

Remove
Linked Item

(An element, diagram or Package object
only)
Display a prompt to delete the selected
object and, if confirmed, remove the
object from the folder.
This has no effect on the object in the
Browser window or any diagrams.
You would not delete an object in a
View, as it is replaced the next time the
View is refreshed.

Edit
Connections

(On the Model Library folder) Displays
the 'Team Documents Server
Connections' dialog, on which you set up
and manage the connections to Model
Libraries in the current model and other
models. Once a connection is defined, it
is automatically established when you
click on the model name.
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Open Model
Library

Opens the connection to the
currently-selected Model Library and lists
the folders containing the content.

Find
Document

Locates the selected Model Library
document in the Library window, and
opens the document in the 'Team
Document' tab of the main Enterprise
Architect work area.

Help

(Root nodes only)
Display Help on Model Views.
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Model Views Operations
From the Model Views window you can perform a number
of operations to define the information you extract from the
model and to further process that information, as described
here.

Access
Ribbon

Start > All Windows > Design > Explore
> Focus > Model Views

Operations
Operation

Detail

Define
Search View

When you:
· Create a Search View, the 'Create New
View' dialog displays
· Display the Search View properties, the
'View Properties' dialog displays
These dialogs are identical.
In the 'Name' field, type a name for the
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View.
In the 'Search' field, either:
· Click on the drop-down arrow and
select an existing search from the lists,
or
· Click on the
button and select to:
- Create a SQL search on the
'Custom SQL Search' dialog or
- Edit an existing search or define a
new one using the 'Manage Searches'
dialog,
then close the dialog and select
that search name in the second 'Search'
field
A custom SQL search statement should
return the GUID and type of the object
found so that the system can search for
the selected item in the Browser window.
The SELECT statement is case-sensitive
and should be typed as shown:
SELECT ea_guid AS CLASSGUID,
Object_Type AS CLASSTYPE, Name
FROM t_object
If required, in the' Search Term' field type
a specific value to search for.
If you are working with the Corporate or
extended versions of Enterprise
Architect, and you want the search to run
automatically and refresh the results,
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select the 'Refresh this search' checkbox.
The 'Frequency' field has three sections,
for hours, minutes and seconds; click on
the appropriate section and use the up and
down arrows at the end of the field to set
the interval for refreshing the search
results.
You can also set the refresh to display a
pop-up notification if the search results
change. To do this, select the 'Notify me
when new results found' checkbox.
Click on the OK button; the Search View
is created (or updated) in a collapsed
state.
When you expand the View, the search
executes and populates the View.
Move
Objects Into
Favorites

Drag any required Package, diagram or
element from the Browser window into
the required Favorites folder.

Move
Objects
Between
Views

Views and Favorites folders are fixed in
the Views folder in which you create
them, and you cannot move them.
However, you can:
· Copy (by dragging) objects from any
View into any Favorites folder, and
· Move (by dragging) objects between
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any two Favorites folders
Use Objects
From Model
Views

To make use of an element, diagram or
Package held in any View or Favorites
folder, click on the item and drag it into a
diagram.
The item behaves in the same way as if
you dragged it from the Browser window.
Also, when a Package has been identified
as a Favorite in a Model View, you can
double-click on it to select and highlight
it in the Browser window.

Create
Documents
containing
Objects

A very useful feature of the Model Views
facility is the ability to drag separate
items from the Views into an existing
Linked Document.
To do this you create your Linked
Document, generate your Model View,
and open the document and Model View
as docked windows. You then drag the
items - individually or as a multiple
selection - from the View into the
document, selecting one of two options:
· 'Insert as Hyperlink(s)' and
· 'Render as RTF'
If you select 'Insert as Hyperlink(s)', a
hyperlink is embedded in the document
for each dragged object, linking to the
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object in the Browser window.
If you select 'Render as RTF', a prompt
displays for you to select the RTF
template (if any) from which to generate
a small report on the dragged objects.
You can select different templates for
different objects. However, there must be
compatibility between the selected object
type (such as Diagram) and the RTF
template used (such as Diagram report).
You can have hyperlinked objects and
RTF-rendered objects in the same
document.
Export/Impor
t Views
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You export Views to create an XML file
that you can:
· Import into another model as a
user-created Model View or
· Call from an MDG Technology
Selection (MTS) file to access the
Technology-defined View provided by
the active MDG Technology
The export and import functions are
available from the Model Views
root-node context menus.
When you use the export function, it acts
on the complete set of View folders in the
selected 'My Views' root node, Model
Views root node, or user-generated root
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node; you cannot export individual
Views, nor can you export Favorites
folders.
The function displays the 'Save As'
dialog, on which you browse for the
directory location for the exported XML
file, and specify the file name.
When you use the import function, it
displays the 'Select Import Filename'
dialog on which you browse for the
directory and XML file you want to
import; the import creates a new Model
View folder with the same name as the
copied root node.
Set Up a
TechnologyDefined
View
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To set up the Technology-defined View
for an MDG Technology, you:
1. Create a user-generated Model View in
Enterprise Architect while using the
technology.
2. Populate it with the required View
folders and Views.
3. Export the Views from that Model
View as an XML file to an appropriate
location.
4. Create a call to the file from the
technology's MTS file.
Thereafter, any model for which the
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MDG Technology is active automatically
displays those Views in a
Technology-defined View.
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Diagram Slide Show
The slide show facility of the Model Views enables you to
create and run screen-based presentations of sets of
diagrams. When you run a slide show, it displays the
diagrams in the folder in the sequence in which they are
listed in the folder. After each diagram has been displayed,
it is closed. You can use this facility to:
· Create a slide show as a folder within a Views folder
under a Model Views node
· Run a slide show manually
· Run a slide show automatically with each diagram
displaying for a period that you define
· Display a slide show within the Enterprise Architect work
area
· Display a slide show in full screen mode
· Delete a slide show

Access
Ribbon

Start > All Windows > Design > Explore
> Focus > Model Views

Keyboard
Shortcuts

Alt+1 | Focus > Model Views
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Create a slide show
Ste Action
p
1

Under a Model Views node, click on the Views
folder to contain the slide show.

2

Right-click on the Views folder and select the 'New
Slideshow' option.
The 'New Slideshow' dialog displays.

3

In the 'Name' field, type the name of the slide show.

4

Click on the OK button.
The new slide show folder is added to the selected
View folder.

5

Dock the Browser window separately from the
'Model Views' tab of the Focus window.

6

Drag the diagrams to be displayed as part of the slide
show from the Browser window into the new slide
show folder.
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To remove a diagram that is not required, right-click
on it in the slide show folder and select the 'Remove
Linked Item' option.
The diagram items in the slide show folder are links
to the diagrams in the Browser window, not copies
of the diagrams or the diagrams themselves; any
actions you take in the slide show have no impact on
the original diagrams.
7

Close the folder.

Define how the slide show is to operate automated or manual
Ste Action
p
1

Right-click on the slide show folder and select the
'Properties' option.
The 'Slideshow Properties' dialog displays.

2

To automate the slide show, select the 'Enable'
checkbox.
To run the slide show manually, deselect the
checkbox.
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3

If you are automating the slide show, in the 'Time'
field type the number of seconds that each diagram
is to remain on display.

4

Click on the OK button.

Run a slide show of diagrams, in either
Diagram View or full screen
Ste Action
p
1

Right-click on the slide show folder and select either
the:
· 'Run Slideshow' option, to run the slide show in
the Diagram View
· 'Run Slideshow Fullscreen' option to run the slide
show using the full screen
The first diagram in the slide show displays.

2

If you have set up the slide show to run
automatically, you can leave it to display the
diagrams as defined.
You can also moderate the slide show using manual
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commands.
3

If you are controlling the slide show manually, click
on the slide show name.
This toolbar displays:

4

Control the slide show using the toolbar icons or the
equivalent aids:
· Display the next slide , (Spacebar) or (→)
· Display the previous slide , (←)
· Display the first slide , (↑)
· Display the final slide , (↓)
· Pause the slide show · Resume the slide show · Stop the slide show or right-click on the slide
show folder name and select the 'Stop Slideshow'
option

Delete a slide show
Ste Action
p
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1

Right-click on the slide show folder and select the
'Remove Slideshow' option.
Enterprise Architect prompts you to confirm the
deletion.

2

Click on the Yes button.
The folder and its list of links to diagrams in the
model is removed.
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Working Sets
As you perform work on your model, you open various
windows, diagrams and views, and you will probably need
to return to these same views in a later work session. At the
end of your work session, you can capture your current
work environment as a working set, which you use to return
to that exact environment later, either when you choose to or
by having the system automatically recreate it when you
next log on to Enterprise Architect. You can also create a
working set as an empty definition to which you add
specific windows, diagrams and views, from either the
'Working Sets' tab or from a Working Set Artifact element.
You can use the working set to pick up your work from
where you left off, or as a set of 'home pages' to start from
each day. You can also open multiple working sets, which
combines the views from each set. This can be useful to
check the progression between different stages in a piece of
work.
A working set is initially a personal list, not visible to or
active for any other user. You can convert it into a global set
to share with other users of your model; for example, if a
working set shows a cross-section of an aspect of the model
you want to demonstrate or have reviewed.
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Access
Ribbon

Start > Personal > Working Sets

Manage Working Sets
Option

Action

Create a
working set
from open

Either:
· Click on the first icon in the toolbar, or

(c) Sparx Systems 2022

Page 75 of 1150

The Application Desktop

diagrams or
files

(c) Sparx Systems 2022

3 October, 2022

Right-click on the body of the tab and
select the 'Create Working Set' option,
or
· Right-click on the body of the tab and
select the 'Create Working Set From'
option, and either the 'Open Diagrams'
or 'Open Files' sub-option as
appropriate
The 'Create Working Set' dialog displays,
listing the diagrams and views that are
currently open, in the order in which they
were opened. If necessary, you can
change the order using the 'hand' buttons
at the bottom of the dialog.
Select the checkbox against each item
that you want to retain in the working set,
or click on the Include All button. If you
selected the 'Create Working Set From'
option, the checkboxes against the open
diagrams or the open files are already
selected.
In the 'Name' field, type a name for the
working set.
You can either:
· Immediately click on the OK button to
create the working set from the selected
items, or
· Add other selections as described for
·
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Create a new working set
Create a new
working set
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Either:
· Click on the first icon in the toolbar, or
· Right-click on the body of the tab and
select the 'Create Working Set' option,
or
· Switch to an open diagram, drag a
'Working Set' icon from the 'Dynamic
Viewpoints' page of the Diagram
Toolbox onto the diagram, right-click
on the new Working Set Artifact
element and select the 'Edit Working
Set' option
The 'Create Working Set' dialog displays.
In the 'Name' field, type a name for the
working set.
To add a diagram or view, click on the
Add Other button and select an option
from the list:
· Add Diagram
· Add Matrix Profile
· Add Search
· Add Library
· Add Document Template
· Add Resource Document
You are prompted to select the required
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diagram, profile, search, Library topic,
document report template or Resource
document name(s); each view is then
added to the list with its checkbox
selected.
Click on the Add Other button again, to
select the next item.
When you have all the diagrams and
views you need, click on the OK button
to create the working set.
Open an
existing
working set
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A Working Set created on the 'Working
Sets' tab is indicated by this icon .
A Working Set created as an Artifact
element is indicated in the list by this
icon .
Click on a working set name and either:
· Select the third icon in the toolbar or
· Right-click and select the 'Open
Working Set' context menu option
Enterprise Architect opens all the
diagrams and views listed in that set.
If you already have a working set open,
the 'new' set of views is added to the
original set, with the last-listed diagram
or view on top and in focus.
You open one Model Search, Matrix
profile or Library at a time; therefore, the
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last-opened Search, profile or Library
replaces the previous instances.
Automaticall
y apply a
working set
when the
model is
opened

Right-click on the working set name and
select the 'Apply when model opens'
option.
This option is a toggle that turns the same
option off for the previous working set on
which it was selected.
The folder turns green, indicating that the
option is 'on' for this working set.
When you close the model and
subsequently open it, the diagrams and
views in the working set are
automatically opened.

Share a
working set

Right-click on the working set name and
select the 'Share Working Set' option.
The folder icon on the left of the working
set name in the list now contains an icon
depicting the globe, and the working set
is available in the 'Working Sets' tab of
every other user of the model.
This setting is not reversible; to make the
global list into a personal list, make a
copy of it.

Add an open
view or

If, in your work, you open a diagram or
view that you decide to add to a working
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diagram to a
working set

set:
· Click on the 'Working Sets' tab,
right-click on the required set name and
select the 'Add Active View' option
The open view is added to the working
set.

Duplicate a
working set

If you want to use a variation of a
working set without losing the original,
you can create a copy and amend that
copy as required.
Right-click on the source working set and
select the 'Copy as New' option.
The 'Create Working Set' dialog displays.
In the 'Name' field, type a name for the
working set.
Each of the listed diagrams and views is
already selected; make any changes you
require, and click on the OK button to
save the list as a new working set.

Edit a
working set

To change the diagrams and views in a
working set, or change the set name, click
on the set name and either:
· Click on the second icon in the toolbar
or
· Right-click and select the 'Edit' option
The 'Create Working Set' dialog displays.
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Make any changes you require, and click
on the OK button to save the changes.
Refresh a
Working Set

For shared or Global Working Sets,
another user might make a change - such
as to the items included - while you have
that set applied. If there is a possibility of
the Working Set being updated,
right-click on it and select the 'Refresh
Working Set Items' option to bring your
view of the Working Set up to date.

Delete a
working set,
or a view in
working set

Expand the working set and select a
specific item (to remove that item) or the
set name (to move the whole set)
Either:
· Click on the fifth icon in the toolbar or
· Right-click on the set and select the
'Delete Working Set Item' option
A prompt displays to confirm the
deletion; click on the Yes button.
The item or set is removed.
If you delete a working set that you have
opened, the diagrams and views from that
set remain open until you specifically
close each one or close Enterprise
Architect.
Note:
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When you create a Working Set on a
diagram, using the icon from the
'Common' page of the Diagram
Toolbox, the Working Set persists in
the Personal Tasks view if you delete
the element from the diagram, but not
if you delete the element from the
model via the Browser window

Save floating
window
layout in
working set

If any of the selected diagrams or views
in your working set are floating windows,
the 'Create Working Set' or 'Edit Working
Set' dialog includes the item 'Save
Workspace Layout'.
Select this checkbox; the working set
captures the complete current workspace
layout, including the locations of the
floating or docked views.
Next time you load the working set, the
captured workspace layout is reapplied.

Track
working
set/views last
opened

You might use several working sets in a
work session, and close some views and
open others.
To capture the diagrams and views you
actually have open when you close down
Enterprise Architect, right-click on the
body of the tab and select the 'Store Main
Tab View History' option. A new, empty
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working set folder displays at the top of
the list - 'Windows open when Model was
last closed'.
When you reopen the model in a new
work session, this new folder is
automatically populated with a list of the
diagrams and views that were open when
you last closed the model; this is a
read-only set that cannot be edited.
You can expand the set and double-click
on specific windows to re-open them, or
right-click on the set and use the 'Open
Working Set' option to reopen all the
diagrams and views you had open before.
However, it is recommended that you use
the 'Apply when model opens' context
menu option on the set; thereafter,
whenever you open the model, all the
diagrams and views you had open when
you closed the model are automatically
re-opened.
Locate a
diagram from
the working
set in the
Browser
window
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· Right-click on the diagram name and
select the 'Find in Project Browser'
option, or
· Click on the diagram name and click
on the 'Locate in Project Browser'
toolbar icon ( )
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The section of the Browser window
containing the diagram is expanded, and
the diagram name is highlighted.
Locate a
Working Set
Artifact
element in
the model
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Either:
· Right-click on the element name and
select the 'Find in Project Browser'
option, or
· Click on the element name and click on
the 'Locate in Project Browser' toolbar
icon ( )
The section of the Browser window
containing the element is expanded, and
the element name is highlighted.
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Focus - Quick Find
The 'Quick Find' tab of the Focus window helps you to
locate elements and/or diagrams anywhere in the model, by
searching for a specified text string in the object name or
alias. Objects that match the text string are listed in the
'Elements' tab or 'Diagrams' tab within the 'Quick Find' tab.

Access
Start > All Windows > Design > Explore
(c) Sparx Systems 2022
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Ribbon

> Focus > Quick Find

Keyboard
Shortcuts

Alt+1 | Focus > Quick Find

Search for Objects
Select the appropriate tab - 'Elements' or 'Diagrams' - and
type the text to be searched for into the field above the tab
names.
Click on the Search icon - . The results of the search are
listed in the selected tab.
If you want to check both elements and diagrams, perform
the searches separately. However, the results of the searches
remain on display until you execute a new search, so you
can compare or match up elements and diagrams that have
the same text string.

Act on Search Results
Each list of results has a context menu. Right-click on an
item in the list to display the options:
· Properties - displays the 'Properties' dialog for the element
or diagram; note that selecting the object also
(c) Sparx Systems 2022

Page 86 of 1150

The Application Desktop

·
·

·

3 October, 2022

automatically updates the Properties window to show
details of the object
Open - displays the selected diagram in the Diagram View
Find in Project Browser - locates and highlights the
element or diagram in the 'Project' tab of the Browser
window
Find in all Diagrams - if the selected element is used in
one diagram, this option opens the diagram and highlights
the element
If the element is not used in a diagram, or is used in
several diagrams, the options displays the 'Element Usage'
dialog - empty if the element is not used, listing the
diagrams if it is used; click on the required diagram to
open it
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Focus - Revisit
The 'Revisit' tab provides links to the diagrams and system
windows that you currently have open, and the documents,
windows, diagrams and source files that you have recently
opened and then closed again.

Access
Ribbon

Start > Application > Design > Focus >
Revisit

Keyboard
Shortcuts

Alt+1 | Focus > Revisit

Facilities
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Category

Options

Diagrams

This category lists the diagrams that you
currently have open - at the top of the list
- and the diagrams you have opened and
closed recently, in time/date order with
the most recently-opened diagram first.
You can click on a diagram name to
re-access that diagram and resume work
on it.

Documents

This category lists the Linked Documents
that you have opened recently. If you
click on a document name, the document
re-opens.

Windows

This category lists the windows that you
have opened and closed during the
current work session. If you click on a
window name, the window re-opens.

Files

This category lists the source files that
you have opened and closed recently.
You can click on a file name to re-open
that file and resume work on it.
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The Window Selectors
There are many useful windows in Enterprise Architect,
through which you can create, review and process data in
your model. Each window can be accessed though one of
several paths, such as ribbon options, menu options and
shortcut keys. However, the fastest way to open either any
single window or a succession of windows is through the
Window Selectors. You simply press the appropriate Alt
key combination and click on the name of the window you
require in a grouped list.
Another Alt key combination provides access to lists of
workspaces, each of which opens a complete suite of related
windows simultaneously.
Each window that you open remains displayed until you
specifically close it again.
As you gain experience in working in Enterprise Architect,
you will find these Window Selectors invaluable for
opening the windows you immediately require, to display or
update information on the object currently in focus.

The Window Selectors
Window

Description

Alt+1 Design

The Design Window Selector provides
access to the windows for locating,
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Window
Selector

creating and working on objects on the
model, including within diagrams. Click
on the name of the required window to
immediately open it.

Alt+2 Properties
Window
Selector

The Properties Window Selector lists the
windows for editing the properties,
features, structural elements and internal
structures of an element. Click on the
name of the required window or tab to
immediately open it. This window
selector can be displayed from both the
'Start > All Windows' panel and the
'Design > Element' panel.

Alt+3 Collaborate
Window
Selector

The Collaborate Window Selector
provides access to the Collaboration
facilities such as Discussions, Reviews,
Journal entries, personal conversations
and information concerning the overall
model.

Alt+4 Execute
Window
Selector

The Execute Window Selector provides
access to the Simulation, Source Code,
Visual Analysis and Process Execution
windows and tabs.

Alt+5 Construct

The Construct Window Selector gives
access to tools for managing resources,
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Window
Selector

changes, testing and project metrics.

Alt+6 Publish
Window
Selector

The Publish Window Selector provides
access to facilities for generating static
and dynamic reports, exchanging models
in part or entire, and keeping the model
data accurate and up to date.

Alt+7 Workspace
Window
Selector

The Workspace Window Selector is
slightly different from the other Window
Selectors, in that it lists workspaces for a
number of areas of work or tasks. Each
workspace opens a suite of related
windows together, so that you have all
the necessary tools to work on the task.
The panel provides workspaces for model
design and construction, software
analysis and simulation, and whatever
you have customized to support your own
working requirements
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The Design Window Selector
The Design Window Selector provides immediate access to
a range of windows for locating, creating and working on
objects on the model, including within diagrams. Each
window name is a command that, when you click on it,
opens that window.

The windows are organized into four sets, as described in
the tables of this topic.

Explore
The 'Explore' group of windows help you to locate and
display information on the structures of your model.
Option

Description

Browse

Opens or returns focus to the Browser
window at the 'Project' tab. The Browser
window displays your model objects and
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features in a number of arrangements,
reflecting the content and structure of
your model. The Browser window is the
primary mechanism for browsing and
exploring your model and is the jumping
off point for many of the most important
features in Enterprise Architect. The
'Project' tab displays the full structure and
content of your model
Inspect

Displays the Inspector window at the
'Details' tab. The Inspector window
provides the facility of examining the
details of an individual element, whether
held in the current model or in an external
data source. The 'Details' tab lists all the
features and characteristics of the
element, appropriate to the element type.

Focus

Displays the Focus window, a valuable
tool for locating and examining items of
importance from anywhere in the overall
model. This window provides access to
Model Views, Working Sets, and recently
opened diagrams and screens.

Trace

Displays the Traceability window, in
which you can quickly see what elements
are immediately linked to the selected
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element and in what relationships, and
what elements are indirectly linked via a
chain of relationships. You can also
select a diagram and explore the
relationships of all elements in that
diagram. The window is mirrored in the
'Trace' tab of the Inspector window.
Search

Opens the Find in Project window,
through which you can run a wide range
of system and user-defined searches to
extract and collate information on aspects
of your model.

Navigate

Toggles the display of the Navigator
toolbar, which identifies the location of
the Package or diagram you are currently
working in, and provides options to
change the focus to another level of the
Package's branch, perform relevant
operations on the Package, and locate
other Packages in the model.

Summary

Displays the Summary window, a brief,
read-only summary of the general
properties of the currently selected:
· Element (including Packages)
· Attribute
· Operation
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System

Test
Maintenance item or
Resource

Displays the System Output window,
which shows the data that Enterprise
Architect generates during each of a
range of processes. The data from each
type of operation generally has its own
tab of this window.

Create
The 'Create' group of windows help you to develop new
structures and supporting documents in your model.
Option

Description

New Package

Displays the 'New Package' dialog,
through which you can create a new
Package as a child of the current node.

New Model
from Pattern

Displays the Start Page at the 'Create
from Pattern' tab (the Model Wizard) ,
through which you can generate a
Package with a subordinate structure
from a range of model templates.
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New
Diagram

Displays the 'New Diagram' dialog,
through which you can create a new
diagram under the current Package, from
a range of diagram templates.

New Element

Displays the 'New Element' dialog,
through which you can create new
elements within specific tool-sets.

Properties

Displays the Properties window, which
provides all the properties and
characteristics of the selected object such
as an element, diagram, connector or
operation.

Notes

Displays the Notes window, on which
you can add brief notes or longer
descriptions and supporting information
on the model object.

Document

Displays the Document window, in which
you can read, create or edit a more formal
or lengthy document on the current
element - a Linked Document. You can
also run searches to locate other elements
that have Linked Documents, and work
on those documents as necessary.
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Tools
The 'Tools' group of windows help you to create and
develop design and analysis structures in your model, such
as specifications, databases and schemas.
Option

Description

Specification
Manager

Displays the Specification Manager
window, a simple document-based
interface to a selected Package or
diagram in the model, providing the
means of creating and reviewing
elements as text representations of
objects in the model.

Database
Builder

Displays the Database Builder window, a
tailored interface for the data modeler,
allowing all database-related modeling
tasks to be performed in a single location.

Schema
Composer

Displays the Schema Composer window,
a versatile tool for quickly and easily
defining a variety of formal schema from
a model, without needing to use a profile
or stereotyped elements when building
the definition of an XSD (or other)
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document.
DMN Editor

Displays the Decision Table Editor,
through which you use the Decision
Tables facility as a simple method of
applying the Decision Model and
Notation (DMN) standard to model how a
decision is made, and generate code for
the decisions.

External
Systems

Displays the External Data window,
which you can use to integrate the data
from external providers such as Jira and
Polarion into an Enterprise Architect
model.

Package
Matrix

Displays the Relationship Matrix, a
spreadsheet display of relationships
between model elements within a
Package, or between elements in two
different Packages. You can filter the
selection of relationships shown.

Gap Analysis

Displays the Gap Analysis Matrix, which
you use to analyze model artifacts to
identify potential gaps between solutions.
It helps you highlight shortfalls between
the original or current solution and the
proposed improvement - items that have
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been deliberately omitted, accidentally
left out, or not yet defined.

Diagram
The 'Diagram' group of windows help you to add objects to
the diagrams in your model, and format the diagrams.
Option

Description

Toolbox

Opens the Diagram Toolbox, a panel of
icons that you can use to create elements
and connectors on a diagram. There are
numerous pages available in the Toolbox,
each page providing the icons for
elements, connectors or patterns for a
specific type of diagram under a specific
Toolset or Perspective. You can also use
the Toolbox icons to add elements to:
· A Package through the Specification
Manager and
· A Package or an element in the
Browser window

Layout Tools

Displays the Layout Tools window,
which helps you to set the elements on a
diagram in one of a number of regular
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arrangements such as a circle, a box or a
fan.
Diagram
Layers

Displays the Filters & Layers window at
the 'Layers' tab, which helps you to hide
or expose parts of any diagram in
segments that represent any concept that
is the basis for separating or grouping the
elements on that diagram. The layers can
be compared to transparencies laid on top
of one another in a stack, each
transparency showing one grouping of
elements on the diagram.

Diagram
Filters

Displays the Filters & Layers window at
the 'Filters' tab, which helps you to
modify the display of diagram
components so that the required items are
immediately identified, without damaging
the structure and integrity of the model.

Insert
Related
Elements

When a diagram is open this option
displays the 'Insert Related Elements'
dialog, which helps you to add a group of
elements to a diagram based on a defined
relationship type and element types.

(c) Sparx Systems 2022

Page 101 of 1150

The Application Desktop

3 October, 2022

The Properties Window Selector
The Properties Window Selector provides immediate access
to a range of windows for creating, examining and working
on the properties of objects in the model, both from the
Browser window and in diagrams. Each window name is a
command that, when you click on it, opens that window.
You can display this Window Selector from both the 'Start >
All Windows' ribbon panel and the 'Design > Element'
ribbon panel.

The windows are organized into four sets, as described in
the tables of this topic.

General
The options listed in this group provide access to the
windows through which you define the nature and purpose
of a selected element.
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Option

Description

Properties

Displays or returns focus to the Properties
window. This window provides a
convenient and immediate way to view
and edit the properties of a range of
modeling objects, including elements.

Notes

Displays or returns focus to the Notes
window for the element, in which you
can record useful information on the
purpose, design and development of the
element.

Document

Displays the Document window, in which
you can read or edit the contents of a
Linked Document on the current element.

Tagged
Values

Displays the 'Tags' tab of the Properties
window, on which you can:
· Assign a Tagged Value to an Item
· Modify Tagged Values
· Assign Notes to a Tagged Value
· Perform advanced tag management
Note that Tagged Values from
stereotypes are not displayed on the
'Tags' tab, but in a segment of the
'Element' tab of the window.
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Properties
Dialog

Displays the 'Properties' dialog for the
currently selected element, which helps
you to define and review a wide range of
properties of that element. The tabs and
properties shown on the dialog depend on
the type of element selected.

Element
Browser

Displays the 'Details' tab of the Inspector
window, showing all the added-on
features and characteristics of the
selected element.

Parents &
Interfaces

Displays the 'Set Parents and Interfaces'
dialog, on which you define the parent
element(s) for a generalizable element, or
an interface it realizes (implements).

Template
Parameters

Displays the 'Templates' dialog, on which
you can define:
· Parameterized Class template
parameters and
· Binding expressions on a Binding
Class

Element Features
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The options listed in this group display specific tabs of the
Features window, to enable you to manage those features of
a selected element.
Option

Description

Features

Displays the Features window, a versatile
and seamless tool for creating and editing
the features of the selected element. The
window has a number of tabs that help
you to view, create, delete and manage:
· Attributes
· Operations and, for State elements,
operation behaviors
· Reception elements
· On a State element, Internal Triggers
· Structural elements, such as the Parts
and Properties added to elements
· Edge-mounted elements (Interaction
Points) such as ActionPins and Ports
that form the primary interaction points
of complex, composite elements
· Entry Points and Exit Points
(Connection Points) on a State element

Attributes

Displays the Features window at the
'Attributes' tab, which enables you to
create and manage attributes of a selected
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element. Attributes define the properties
or internal data elements of an element.
Operations

Displays the Features window at the
'Operations' tab, which enables you to
create Operations and manage their basic
properties. Operations are features of an
element that represent the behavior or
services an element supports.

Receptions

Displays the Features window at the
'Receptions' tab, which enables you to
manage any Receptions on the element.
A Reception is a feature of a Classifier,
and is derived from a Signal element.

Parts/Properti
es

Displays the Features window at the
'Parts/Properties' tab, which helps you to
define certain constructs and events as
structural elements, specifically Part and
Property elements in this case.

Interaction
Points

Displays the Features window at the
'Interaction Points' tab, which helps you
to define certain constructs and events
with structural elements, specifically
Interaction Points or Ports, in this case.
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Responsibilities
The options listed in this group help you to identify, create
and delete the entities that define the operating or processing
rules applied to an element.
Option

Description

Relations

Displays the Relationships window for
the current element, listing the connectors
issuing from and linking to the selected
element.

Responsibiliti Displays the Responsibility window,
es
which provides a convenient method of
quickly identifying, creating and deleting
rules applied to an element. The window
shows the name and main properties of
the entities that impose such rules or
restrictions on the element, namely
Requirements, Constraints, Scenarios and
files.
Requirements Displays the 'Requirements' tab of the
Responsibility window, helping you to
sketch out an element's internal
requirements (you can switch from this
tab to the 'Properties' dialog to add detail
(c) Sparx Systems 2022

Page 107 of 1150

The Application Desktop

3 October, 2022

to the requirement).
Constraints

Displays the 'Constraints' tab of the
Responsibility window, which helps you
to sketch out the element's constraints
(you can switch from this tab to the
'Properties' dialog to add detail to the
constraint). Typical constraints are preand post-conditions, which indicate
things that must be true before the
element is created or accessed and things
that must be true after the element is
destroyed or its action is complete.

Structured
Scenarios

Displays the Scenarios View, offering a
wide range of facilities for generating and
modifying scenarios, which you can use
to quickly and easily define the structure,
actions and interactions of the scenarios
defined for an element such as a Use
Case. These scenarios can be the main
(basic) path, alternate paths or exception
paths.

Simple
Scenarios

Displays the 'Scenarios' tab of the
Responsibility window; this is the
simplest of the three screens on which
you can create and manage scenarios for
an element. You use this tab to create a
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Basic Path scenario or, if a Basic Path
already exists, an Alternate Path scenario.
A scenario is a real-world sequence of
operations that describes how the
functional behavior, business workflows
and end-to-end business processes
represented by an element work in
real-time.
Find
Scenarios

Executes a search across the model to
locate all elements that have defined
scenarios.

More
Option

Description

Compartment
Visibility

If you have selected an element on an
open diagram, this option displays the
Compartment Visibility window in which
you can set a collection of options to
display or hide the features of that
element on that diagram.

Feature
Matrix

Displays the Feature Matrix, on which
you create display and manage
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relationships between two elements
where the source and/or target is an
element attribute, operation or reception.
Default
Appearance

Displays the 'Default Appearance' dialog,
on which you can change the global
default appearance settings for an
element type to a default appearance for a
specific selected element wherever it is
used in any diagram. The default
appearance is the:
· Fill, border and font colors
· Font styles, including font face and size
· Border thickness

Lock

If you have selected an element, diagram
or Package, this option displays the 'Lock
Element' dialog on which you set or
release a lock against other users being
able to update the object.
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The Collaborate Window Selector
The Collaborate Window Selector provides immediate
access to a range of windows for collaborating with other
members of your modeling team. Each window name is a
command that, when you click on it, opens that window.

The windows are organized into four sets, as described in
the tables of this topic.

Discuss & Review Elements
The 'Discuss & Review Elements' group of windows help
you to discuss and review model elements.
Option

Description

Journal

Opens or returns focus to the Discuss &
Review window at the 'Journal' tab. The
Journal allows you to, for a selected
object or diagram, maintain a daily log of
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ideas, comments, notes, suggestions,
to-do lists and other reminders.
Discuss

Opens or returns focus to the Discuss &
Review window at the 'Discuss' tab. You
can select an individual element or
diagram and develop a discussion that is
directly associated with that object.

Review

Opens or returns focus to the Discuss &
Review window at the 'Review' tab,
through which you can set up and
conduct a formal review of one or more
elements and/or diagrams as defined by a
Review element.

Histories
The 'Histories' group of windows help you to look back at
the history of discussions and reviews of elements and
diagrams in your model over a period of time that you can
set.
Option

Description

Journals

Opens or returns focus to the Discuss &
Review History window at the 'Journals'
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tab. The 'Journals' tab lists the elements
across the model against which journal
comments have been posted.
Discussions

Opens or returns focus to the Discuss &
Review History window at the
'Discussions' tab. The 'Discussions' tab
shows the Discussions that have been
recorded on elements across the model.

Reviews

Opens or returns focus to the Discuss &
Review History window at the 'Reviews'
tab. The 'Reviews' tab shows the activity
in formal reviews across the model,
listing the items in which activity has
occurred.

Manage
Reviews

Opens the Reviews view, which lists all
the Review elements in your model. It
shows, for a selected Review element, the
details of the elements and diagrams
under review, allowing you to quickly see
what reviews are taking place and what is
happening within them.

Personal
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The 'Personal' group of windows help you to communicate
with other members of your team.
Options

Description

Chat

Opens or returns focus to the Chat &
Mail window at the 'Chat' tab. The 'Chat'
tab provides a facility for following and
participating in quick conversations with
individuals or members of a user group
on any topic.

Mail

Opens or returns focus to the Chat &
Mail window at the 'Model Mail' tab.
This provides you with the ability to
send, receive and respond to emails
within the project team.

My Diary

Opens or returns focus to the Chat &
Mail window at the 'My Diary' tab. In
your personal diary you can type all kinds
of ideas, notes, suggestions, to-do lists
and other reminders of what you have
done or intend to do in the model.

Conversation
s

Opens or returns focus to the Discuss and
Review - History window at the 'Chat'
tab. This lists the recent Chat
conversations that you have been a part
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of or within groups that you are a
member of.

Model
The 'Model' group of windows help you to organize your
project.
Options

Description

Home
Diagram

The Home Diagram command opens
your home diagram, if you have one
defined.

Model
Library

Opens or returns focus to the Library
window. The Library window is a place
where documents such as specifications,
requirements and project guidelines can
be stored in the model.

Calendar of
Events

Opens the Calendar view. This provides a
project management overview, in
calendar format, of the deployment of
resources, timeframes for tasks, and
upcoming project events such as
milestones and meetings.
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Opens the Glossary View for the project,
showing definitions of terms and, if you
are in a project that has been translated
into another language, the translations of
the terms.
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The Execute Window Selector
The Execute Window Selector provides immediate access to
a range of windows for running simulations, working with
source code, and analyzing and executing code. Each
window name is a command that, when you click on it,
opens that window.

The windows are organized into four sets, as described in
the tables of this topic.

Simulation
The 'Simulation' group of windows help you to perform,
check and manage model simulations of the processing
defined in sections of your model.
Options

Description

Simulator

Displays the Simulation window, which
provides the main interface for starting,
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stopping and stepping through your
Simulation.
Sim Events

Displays the Simulation Events window,
which is where you manage triggers and
sets of events in a simulation.

Sim Break
Points

Displays the 'Simulation Breakpoints' tab
of the Breakpoints & Events window,
which enables you to interrupt and
inspect the Simulation process.

Sim
Variables

Displays the Simulator Locals window,
which shows all current simulation
variables when the simulation is single
stepping or paused at a breakpoint.

Sim Call
Stack

Displays the Call Stack window which,
during a Simulation, displays information
about the threads and current execution
context of the Simulation.

Decision
Management
(DMN)

Displays the DMN Simulation window.
Using Decision Model and Notation
(DMN) features you can not only model
the decisions that your organization
makes but also run simulations from
these models to predict outcomes based
on example data sets.
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BPSim

Displays the Configure BPSim window,
through which you define a Business
Process Simulation (BPSim)
configuration to be represented and
contained in a BPSim Artifact element.
The configuration is created specifically
for and from an existing Business
Process, defined in BPMN.

Modelica

Displays the Configure SysML
Simulation window, the interface through
which you can provide run-time
parameters for executing the simulation
of a SysML model.

Executable
State
Machines

Opens the Find in Project view and
performs an Executable StateMachines
search, listing all Executable
StateMachines in the model.

Source Code
The 'Source Code' group of windows help you to generate,
import and synchronize code from sources both internal to
the model and external.
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Options

Description

Script
Library

Displays the Scripting window, which
lists all available scripts in the model
according to group.

Open Source
File

Launches a 'File Open' dialog, through
which you open a source file in a text
editor within Enterprise Architect.

Import VS
Project

When you have selected a parent Package
in the Browser window, displays the
Visual Studio Solution Import window
through which you can import software
projects authored in Visual Studio.

Import
Eclipse

When you have selected a parent Package
in the Browser window, displays the
Eclipse Project Import window through
which you can import software projects
authored in Eclipse.

Import Mono

When you have selected a parent Package
in the Browser window, displays the
Visual Studio Solution Import window
through which you can import software
projects authored in Mono.

Import

When you have selected a parent Package
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NetBeans

in the Browser window, displays the
NetBeans Project Import window through
which you can import software projects
authored in NetBeans.

Generate
Code

Displays the 'Generate Code' dialog,
through which you can generate
programming code from a UML element
structure.

Synchronize
Code

Displays the 'Synchronize Package
Contents' dialog, through which you can
synchronize the model and source code,
creating a model that represents the latest
changes in the source code and vice
versa.

Analyze
The 'Analyze' group of windows help you to analyze the
performance of the applications you are developing, in
whole or in part, in a number of ways.
Options

Description

Analyzer
Scripts

Displays the Execution Analyzer
window, which enables you to manage all
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Analyzer scripts in the model.
Analyzer
Services

Displays the Analyzer Services window,
which lists the status of each Enterprise
Architect service named in the config
file, and its state.

Profiler

Displays the Profiler window, which
allows you investigate application tasks
that are determined to be performing
slower than expected; you can see the
actions that are consuming the
application and the functions involved.

Recorder

Displays the Record & Analyze window,
which helps you to record the live
execution of an application and to
generate a Sequence diagram from those
recordings.

Tester

Displays the Testpoints window, through
which you can develop a scheme by
which constraints and rules governing the
behavior of objects can be taken from the
model and applied to one or more
applications.

XSLT
Debugger

Displays the XSLT Debugger window
and the System Output window at the
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'XSLT Transformation' tab, to run a
transformation, control the process and
inspect the state of the transformation
using Enterprise Architect's debugger in
combination with breakpoints.
File Search

Displays the Find in Files window,
through which you can execute File Text
Searches.

Execute
The 'Execute' group of windows help you to view the
execution of code and manage various parameters such as
the breakpoints, variables, DDLs and memory used in the
execution.
Options

Description

Debugger

Displays the Debug window from which
a debugging session can be controlled
and output from the debugging session
can be examined.

Breakpoints

Opens the Breakpoints and Markers
window, which allows you to enable,
disable, delete and otherwise manage
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breakpoints and markers in your source
code.
Call Stack

Opens the Call Stack window, which is
used to display all currently running
threads in a process.

Local
Variables

Opens the Locals window, which
displays variables of the executing
system.

Watches

Opens the Watches window, which can
be used to evaluate data items that are not
available as Local Variables. This
window is most useful for native code (C,
C++, VB).

Modules

Displays the Modules window, which for
.NET and native Windows applications
lists the DLLs loaded by the debugged
process.

Memory
Viewer

Displays the Memory Viewer, which can
display the raw values of memory in hex
and ASCII.

Job Queue

Opens the Job Queue window, which
streamlines the process of working with
Analyzer Scripts.
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Opens the Console window, a command
line interpreter through which you can
quickly enable a script engine and enter
commands to act on the script.
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The Construct Window Selector
The Construct Window Selector provides immediate access
to a range of features including resource management,
testing, change management and project management. Each
window name is a command that, when you click on it,
opens the window covering that feature.

The features are organized into four sets, as described in the
tables of this topic.

Resources
The 'Resources' group of windows provides access to
features for general project management including
managing task and resource allocation.
Option

Description

Resource

Opens the Resource Allocation window
which displays a Gantt chart where you
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Allocation

can assign resources working on tasks.
The Gantt chart displays all
resources/tasks assigned to the currently
selected Element.

Resource
History

Displays the Construct History window
which provides a summary of all project
management transactions over a given
period, with separate tabs for Tests,
Resource Allocations and Maintenance
objects.

Project
Kanban

Opens the repository's default Kanban
diagram which can be used for visually
defining and tracking a range of work
items and their current stage of
development.

Personal
Kanban

In a shared security-enabled model
environment, this opens a personalized
Kanban diagram which can be used to
visually track of a range of elements of
particular relevance to that user.

Gantt View

Opens the Project Gantt View which
illustrates a project schedule by showing
a visual timeline of the start and finish
dates of assigned resources.
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Active Tasks

Opens the Active Tasks search in the
Find in Project facility. This will return
the set of tasks that are currently set as
active (percentage complete < 100).

30 Day
Summary

Opens the 30 Day Task Summary search
in the Find in Project facility. This
provides a brief summary of the work
allocated to each resource over the last 30
days.

Testing
The 'Testing' group of windows provides access to features
used in testing and test management.
Option

Description

Test
Overview

Displays the Tests Cases window where
you can create and manage test scripts for
model elements. This supports unit,
integration, scenario, system, acceptance
and inspection tests.

Test History

Opens the 'Test' tab on the Construct
History window, which provides a project
management summary, over a given
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period, of the Tests being run across the
model.
Unit

Opens the 'Unit' tab in the Tests Cases
window where you can create and
manage unit tests for the currently
selected element.

Integration

Opens the 'Integration' tab in the Tests
Cases window, where you can create and
manage integration tests for the currently
selected element.

System

Opens the 'System' tab in the Tests Cases
window where you can create and
manage system tests defined for the
currently selected element.

Acceptance

Opens the 'Acceptance' tab in the Tests
Cases window where you can create and
manage acceptance tests for the currently
selected element.

Scenario

Opens the 'Scenario' tab in the Tests
Cases window where you can create and
manage scenario tests for the currently
selected element.

Inspection

Opens the 'Inspection' tab in the Tests
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Cases window where you can create and
manage inspection tests for the currently
selected element.
Recent
Passes

Opens the Passed Tests search in the Find
in Project facility. Searches the project
for elements having test records where
the 'Status' value is 'Pass'. In the <Search
Term> you can specify the number of
days in the period to search for.

Recent
Failures

Opens the Failed Tests search in the Find
in Project facility. Searches the project
for elements having test records where
the 'Status' value is 'Fail'. In the <Search
Term> you can specify the number of
days in the period to search for.

Change
The 'Change' group of windows provides a quick reference
to the change management features including defects,
maintenance, issues, changes and features.
Option

Description

Maintenance

Opens the 'Maintenance Overview' tab on
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Overview

the Maintenance window, which provides
a summary of the features, changes,
issues and other maintenance details for
the currently selected element.

Maintenance
History

Opens the 'Maintenance' tab on the
Construct History window, which
provides a summary of the features,
changes, issues and other maintenance
details for a selected timeframe. This is
regularly updated on model changes.

Features

Opens the 'Features' tab on the
Maintenance window, which provides a
list of the features and options to add new
features to the currently selected element.

Changes

Opens the 'Changes' tab on the
Maintenance window. This provides a list
of the changes and options to add new
changes to the currently selected element.

Documents

Opens the 'Documents' tab on the
Maintenance window, which provides a
list of the Documents logged for the
currently selected element.

Issues

Opens the 'Issues' tab on the Maintenance
window. This provides a list of the issues
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logged for the currently selected element
and options to add new issues.
Defects

Opens the 'Defects' tab on the
Maintenance window. This provides a list
of the defects logged for the currently
selected element, as well as options to
add new defects.

Tasks

Opens the 'Tasks' tab on the Maintenance
window. This provides a list of the tasks
logged for the currently selected element,
as well as options to add new tasks.

Project
The 'Project Tools' window provides access to features for
recording against an element details such as decisions,
events, effort, risks, and metrics. The Issues and QA are at
the project level.
Option

Description

Decisions

A record of decisions or choices made on
an element.

Events

A record of events or actions taken on an
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element.
Issues

The Project Issues are a record of issues
on the repository or project level as
distinct from the element Issues in the
Change area. These are for recording
events, occurrences and situations that
impact on project development and
delivery.

QA

The Quality Assurance reporting or
System Documents provide pre-defined
reporting, across the repository, on
testing, dependencies, maintenance and
resources.

Risks

A record of any risks associated with the
element.

Metrics

A record of metrics measured for the
element.

Effort

A list of effort expended in work on the
element.
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The Publish Window Selector
The Publish Window Selector provides access to commands
that facilitate publishing and exchanging model data.

The Publish commands are organized into four sets, as
described in the tables of this topic.

Report Generator
The 'Report Generator' commands focus on the specification
and generation of reports of model data, including the
printing or saving of model diagrams as images.
Option

Description

Generate
Package
Report

Use this command to generate a report on
the currently selected Package.
The 'Generate Documentation' window
will be displayed, using the current
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Package name as the default output
filename. This window is used to select
the report template, style-sheet and cover
page. It also allows you to specify a range
of filters and other options that will affect
the generated report.
Generate
Element
Report

Use this command to generate a report on
the currently selected element or
elements.
The 'Generate Documentation' window
will be displayed. This window is used to
select the report template, style-sheet and
cover page. It also allows you to specify
a range of filters and other options that
will affect the generated report.

Generate
Diagram
Report

Use this command to generate a report of
the diagrams within the currently selected
Package hierarchy.
The 'Generate Documentation' window
will be displayed, with the system
template 'Diagram Report' selected as the
default. The 'Diagram Report' template
generates only images of the model
diagrams.
You can use the 'Generate
Documentation' window to select a
different report template, style-sheet or
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cover page. It also allows you to specify
a range of filters and other options that
will affect the generated report. The
current Package name is used as the
default output filename.
Edit Report
Templates

This command opens the Document
Template Design window.
The Document Template Designer is
used to create and edit report templates
that define:
· The model components to report on
· The information to extract on each
component and
· The styles and layout of the report
It can also be used to design Stylesheets,
Cover Pages and Tables of Contents.

Print
Diagram

Displays the 'Print' window, for the
currently open diagram.
Use the window to select the printer
device, set printer properties and specify
the number of copies to print.
Click on 'OK' to print the diagram.

Save
Diagram as
Image

Creates an image of the currently open
diagram and saves that image to a file of
your choosing.
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Custom and Dynamic Reports
The 'Custom and Dynamic Reports' group of commands
allows you to create and view documents in Enterprise
Architect's Document Editor window.
Option

Description

Create a
Custom
Document

Displays the 'Create Custom Document'
window, to create a 'Custom Document'
artifact in the currently selected Package.
Custom Documents provide a way to
include dynamic content that is dragged
into the document from the Browser
window, including Packages, diagrams,
elements and features. Every time you
open the document the content is
dynamically refreshed from the model
objects you have included and from the
template instructions.

Show
Dynamic
Preview

Opens the 'Dynamic Document View'
window.
The 'Dynamic Document' view in the
main work area helps you to instantly
generate a document on a selected
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element, using one of a range of
templates to immediately display the
information you require in the most
appropriate structure and format. The
document can be printed, but is not stored
electronically - it is dynamically
generated for the current element
whenever you select the view and when
you change the template. You cannot edit
the document contents in the view.
Open a
Document
File

Opens a document, selected from the file
system, in Enterprise Architect's code or
document editor window.

New
Document
File

Opens a new, empty document that can
be saved to your file system. (This
document is not saved within your
Enterprise Architect model.)
The Document Editor window and
'Document Edit' ribbon are displayed, and
the new document in opened for editing
in the editor window.
When saving the document, a 'File
Chooser' dialog is displayed, allowing
you to specify a filename and folder for
creating the new file on your file system.
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Model Interchange
The 'Model Interchange' list of commands provides facilities
for exporting and importing model data to and from XML
files, to support sharing models with other Enterprise
Architect projects and with other modeling tools.
Option

Description

RAS
(Reusable
Asset
Service)

The Reusable Asset Service (RAS)
provides a convenient mechanism for
modelers to distribute or download
reusable model structures, as well as
project baselines. The shared repository is
accessible via a Pro Cloud Server
connection, making it accessible by
distributed teams.

Project
Transfer

The Project Data Transfer feature
supports transferring the full set of data
from one repository into another
repository, as an overwrite process. It
supports these types of transfer:
· A file repository to a DBMS repository
· A DBMS repository to an existing
project file
· A DBMS repository to another DBMS
repository
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A file repository to a file repository

Full Model
Export
(native)

The Full Model Export (native) option
provides a Project Transfer by exporting
the current project to Native XML. The
export process will generate multiple
Native XML files, representing the data
of the project. This can then be imported
to another repository using the Full
Model Import (Native) option.

Full Model
Import
(native)

The Full Model Import (native) option
imports a set of Native XML files
generated by the Full Model Export
(native) option.

Export
Package to
XMI

This option is used to export a
Package-tree from your model to a file in
one of several XMI (XML-based) or
Native formats. The exported file
contains all the information required for
performing Enterprise
Architect-to-Enterprise Architect
transfers, as well for options for exporting
to other modeling tools.

Import
This command is for importing a
Package from Package, or Package hierarchy, from an
XMI
XML file containing model information
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in XMI format. The file will have been
created by export from Enterprise
Architect or from some other compatible
modeling tool.
The new Package will be imported as a
child of the currently selected Package.
Publish as
Other Format

Displays the Publish Model Package
window, which allows you to export the
selected Package to a file in one of
several XML formats. The available
formats allow users to import the file into
other modeling tools.

CSV
Import/Expor
t

This command displays the CSV
Import/Export window.
Within Enterprise Architect, you can
import and export information on
elements to and from comma-separated
value (CSV) text files. The CSV
Import/Export window is used to select
the CSV specification that defines what
will be exported (which element
properties) and the file that it will be
exported to, or imported from.

CSV
Specification

This command displays the CSV
Import/Export Specification window,
with which you can define a CSV
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import/export specification.
The specification defines the:
· Fields from the spreadsheet in the order
they are imported or exported
· Source or target filename (optional)
and
· Delimiter between columns
Glossary

Opens the Project Glossary View.
The Model, or Project, Glossary consists
of a list of defined terms for your project.
The Project Glossary View provides
options to review the terms of different
types already defined for a model.

Model Control
The 'Model Control' commands are related to the change
management of your model data and include Version
Control configuration as well as Auditing.
Option

Description

Simple
Package
Control

Displays the 'Package Control Options'
dialog.
In order to configure a Package to save
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and load in Native/XMI format to a
named file, you use the 'Package Control
Options' dialog to flag the Package as
being controlled and to set a number of
options. These options include setting the
filename to save to/load from, the type of
Native/XMI to import and export, and
whether to export and/or import the
Native/XMI in a batch process.
Model
Version
Control

Displays the 'Version Control Settings'
dialog.
To set up a Version Control configuration
on your model, you define a number of
settings that control how the status of
your model is communicated to your
Version Control system. You define these
settings using the 'Version Control
Settings' dialog.

Package
Version
Control

Displays the 'Package Control Options'
dialog.
Once your Version Control application is
set up and you have Version Control
configurations in place, you can use the
'Package Control Options' dialog to place
the individual Packages in your model
under Version Control. To put a Package
under Version Control, you:
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·

·

Flag the Package as a controlled
Package
Specify the Version Control
configuration to control it and
Associate an XMI file with the Package

Model
Opens the 'Manage Model Options'
Options/Prefe dialog for configuring a number of model
rences
or project based options covering
Enterprise Architect features. These
include:
· General options
· Baseline configuration for RAS storage
· Cloud administration
· Translation configuration
· Collaboration across projects
· Review of Status locks
· Source Code Engineering settings
Auditing
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Opens the Auditing view, which covers
the audit configuration and view of the
audit history. Auditing records model
changes, including when the change
occurred and who made it. It records
changes to Packages, elements, features,
connectors and diagrams, detailing the
creation, modification and deletion of
these items.
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Export
Reference
Data

Opens the 'Export Reference Data' dialog.
Reference data includes meta-information
for properties and base values, as well as
option configurations, document
templates, tool features and more. You
can conveniently export all or specific
parts of your model reference data to an
.XML file for exchanging with other
repositories.

Import
Reference
Data

Opens the 'Import Reference Data' dialog
for importing meta-information into your
model from an .XML file that was
exported out of another model or from an
iteration of the current model.
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The Workspace Window Selector
The Workspace Window selector provides access to
commands for applying a wide range of predefined
workspace layouts. Each layout name is a command that,
when you click on it, opens and arranges various windows,
positioned, grouped and sized in a manner that facilitates the
workflow of the task at hand.

The workspace commands are organized into four sets, as
described in the tables of this topic.

Design and Construct
This set of commands provides access to workspace layouts
tailored for use in general modeling tasks as well as some
specific tasks, such as database modeling or designing XML
Schemas.
Options
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Default

Applies the 'Default' workspace layout,
which is a good starting point for a range
of general modeling tasks.
These windows are displayed:
· Main work area (for diagrams)
· Browser and Inspector windows
grouped together
· Properties and Notes windows

Clear

Applies the 'Clear' workspace layout.
This clears the desktop by closing all
'docked' windows. You can then open the
specific windows that you want.
In this layout, only the menu ribbon and
the main work area are visible.

Browse

Applies the 'Browse' workspace layout,
designed for browsing the model and its
element properties.
These windows are displayed:
· Main work area
· Browser, Inspector and Focus windows
grouped together

Wide View

Applies the 'Wide View' workspace
layout.
This layout has the main work area
occupying the full width of the
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application desktop. Other open
windows are 'auto-hidden'.
These windows are displayed:
· Main work area
· Browser and Inspector windows
grouped together ('auto-hidden' to the
left)
· Properties and Notes windows
('auto-hidden' to the right)
Explore

Applies the 'Explore' workspace layout,
for use in 'exploring' the features of your
model.
These windows are displayed:
· Main work area
· Browser, Inspector and Focus windows
grouped together
· Responsibility and Maintenance
windows grouped together
· Summary window
· Discuss & Review and Chat & Mail
windows grouped together

Core
Modeling

Applies the 'Core Modeling' workspace
layout, for use when performing core
modeling tasks.
These windows are displayed:
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·

·

·

Main work area
Browser and Inspector windows
grouped together
Properties and Notes windows grouped
together
Pan & Zoom, Layout Tools and Filters
& Layers windows grouped together

Database
Modeling

Applies the 'Database Modeling'
workspace layout, for use when
performing Database Modeling tasks.
These windows are displayed:
· The Database Builder window,
occupying the main work area
· Browser and Inspector windows
grouped together
· Properties and Notes windows

Gap Analysis

Applies the 'Gap Analysis' workspace
layout, for use when performing Gap
Analysis.
These windows are displayed:
· The Gap Analysis Matrix, occupying
the main work area
· Browser and Inspector windows
grouped together (on the left)
· Properties window (also on the left)
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Schema
Design

Applies the 'Schema Design' workspace
layout, for use when modeling Schema
Designs.
These windows are displayed:
· The Schema Composer, occupying the
main work area
· Browser and Inspector windows
grouped together
· Properties and Notes windows

Trace by
Matrix

Applies the 'Trace by Matrix' workspace
layout, which uses the Relationship
Matrix for tracing relationships between
model elements.
These windows are displayed:
· The Relationship Matrix, occupying
the main work area
· Browser and Inspector windows
grouped together
· Properties and Notes windows

Software & Simulation
This set of commands provides access to workspace layouts
tailored for use in performing specific tasks in software
(c) Sparx Systems 2022
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engineering and model simulation.
Options

Description

Software
Engineering

Applies the 'Software Engineering'
workspace layout, for use when
performing general Software Engineering
tasks.
These windows are displayed:
· Main work area
· Browser, Inspector and Execution
Analyzer windows grouped together as
tabs
· Features window (contains pages for
features such as attributes, operations
and receptions)
· Properties and Notes windows

Debug

Applies the 'Debug' workspace layout, for
use when debugging software.
These windows are displayed:
· Main work area
· Browser, Inspector and Execution
Analyzer windows grouped together
· Breakpoints & Markers, Watches,
Modules and Memory Viewer windows
grouped together
· Debug, Local and Call Stack windows
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grouped together
Profile

Applies the 'Profile' workspace layout, for
use when profiling software.
These windows are displayed:
· Main work area
· Browser and Execution Analyzer
windows grouped together
· Profile window

Record

Applies the 'Record' workspace layout,
for use when recording program
execution.
These windows are displayed:
· Main work area
· Browser and Execution Analyzer
windows grouped together
· Record & Analyze window

Testpoints

Applies the 'Testpoints' workspace
layout.
These windows are displayed:
· Main work area
· Browser and Execution Analyzer
windows grouped together
· Testpoints window
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XSLT Debug

Applies the 'XSLT' workspace layout, for
use when debugging XSLT.
These windows are displayed:
· XSLT Debugger window open in main
work area
· Browser and Execution Analyzer
windows grouped together
· System Output window at the bottom
of the screen

Simulation

Applies the 'Simulation' workspace
layout, for use when running simulations.
These windows are displayed:
· Main work area
· Browser, Inspector and Execution
Analyzer windows grouped together
· Simulation and Simulation Events
windows
· Locals and Call Stack windows

DMN-Sim

Applies the 'DMN-Sim' workspace
layout, for use when creating or running
DMN simulations.
These windows are displayed:
· Main work area
· Browser, Inspector and Execution
Analyzer windows grouped together
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DMN Simulation and DMN Expression
windows

BPSim

Applies the 'BPSim' workspace layout,
for use when working with Business
Process Simulations.
These windows are displayed:
· Main work area
· Browser and Inspector windows
grouped together
· Diagram Toolbox
· Properties window
· Configure BPSim window

SysML-Sim

Applies the 'SysML-Sim' workspace
layout, for use when working with
SysML Simulations.
These windows are displayed:
· Configure SysML Simulation window
in main work area
· Browser and Inspector windows
grouped together
· Diagram Toolbox
· Properties window
· System Output window
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Workspace Tools
The commands in this list provide access to facilities for
customizing and managing workspaces, menu ribbons and
working sets.
Options

Description

Workspaces

Displays the 'Workspaces' tab of the
'Workspaces Layout' window.
This window allows you to select from a
range of predefined workspace layouts
and apply one of them, such that the
application desktop displays a particular
set of windows and toolbars, arranged in
a way to facilitate certain modeling
activities.

My
Workspaces

Opens the 'My Workspaces' tab on the
'Workspace Layout' window, enabling
you to select, create and maintain the
workspaces that you use, as a means of
organizing all the tools appropriate to
your areas of work.

My Ribbon
Sets

Opens the 'My Ribbon Sets' tab of the
'Workspaces Layout' window.
This tab allows you to set a filter on the
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ribbons and the panels in the ribbons, so
as to provide a clearer focus on only the
core features that you use and eliminate
any distracting features outside your
domain of work.
Save
Workspace

Saves the current Workspace layout as a
new customized Workspace.

Working Sets

Opens the 'Working Sets' tab of the
'Focus' window. These Working Sets are
saved outlays of what you want opened in
Enterprise Architect. Working Sets can
be manually created or a capture of your
current work environment.

User Layouts
The User Layouts list presents a list of the workspace
layouts you have created yourself.
Option

Description

<empty>

This list remains empty until you have
defined and saved some workspace
layouts of your own.
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The Start Page
The Start Page is the default landing page that displays
when you first open Enterprise Architect. It provides a range
of useful tools to:
· Create and/or access project files, connect to a server
repository, or access a project via the Cloud, through the
'Open' options, the 'Recent' and 'Pinned' lists and the
'Manage Projects' option; these are documented in this
Help topic
· Generate basic models in your project using Patterns from
a wide range of technologies, both when you first create
the project and over time; you can develop these models
further as complete components of your project - see the
Model Wizard Help topic
· Add diagrams to your model based on diagram patterns
tailored to specific technologies, displaying the
appropriate Toolbox pages for the generated diagram; see
the Add New Diagrams Help topic
· Quickly set up the organization of any number of complex
processes that require common, structured methods and
carefully organized checkpoints at important stages based
on a range of Process Guidance templates; see the
Applying Process Guidance Help topic
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Access
Opened by default on start up of Enterprise Architect, at the
'Open Project' tab.
Ribbon

Start > Appearance > View > Show Start
Page > Open Project

Other

(If the Start Page is not shown) Click on
the drop-down arrow at the right of the
'current view' bar (above the view name
tabs) and select the 'Show Start Page'
option > Open Project

Open
(c) Sparx Systems 2022

Page 159 of 1150

The Application Desktop

3 October, 2022

Option

Action

Open File

Click on this option to display the
Windows 'Select Enterprise Architect
Project to Open' dialog, to browse for and
open an existing .eap, .eapx, .qea, .qeax
or .feap project file.

Create New

Click on this option to display the
Windows 'New Project' dialog , to create
a new local .eap, .eapx, .qea, .qeap or
.feap project file, that you can add model
structures to using the Model Wizard
(Start Page 'Create from Pattern' tab).

Cloud
Connection

Click on this option to open the 'Cloud
Connection' dialog, which you use to
specify a project held at a remote
location, and to access it through the
internet or web. You work on the project
using the Enterprise Architect installation
on your machine.
An advantage of working in this way is
that you do not need to have the database
drivers installed on your machine, as you
would to work on projects held on a
DBMS server.
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Server
Connection

Click on this option to display the 'Open
Server Connection' dialog, on which you
specify an existing data source to connect
to, on one of a number of supported
repositories.
This feature is available in the Corporate,
Unified and Ultimate Editions.

Custom Data
Source

Click on this option to display the
Microsoft 'Data Link Properties' dialog,
from which you begin to define a data
source to connect to, on one of a number
of supported repositories.
This feature is available in the Corporate,
Unified and Ultimate Editions.

URL

If you click on this option, the
'Connection String' dialog displays. Type
or paste in the server connection string to
the project you want to open, and click on
the OK button.
This is the same dialog that you use in the
'Manage Projects' dialog (see the 'Manage
Projects' option in the next section.)

Manage Projects
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Click on this option to open the 'Manage Projects' dialog,
which you use to manage connections to the Enterprise
Architect projects (.eap files, .eapx files, .qea files, .qeax
files, .feap files, DBMS server connections and Cloud
connections) to which you have access. See the Managing
Connections to Projects Help topic.

Recent
This is a list of up to ten Enterprise Architect projects (.qea
files, .qeax files, .feap files, DBMS server connections and
Cloud connections) that you have opened most recently. The
drop-down arrow in the list heading displays options to:
· Switch the list between recently-accessed models and
currently 'watched' models
· Change the sequence of models in the list between an
alphabetical listing and a chronological listing (most
recently opened at the top)
· Set up a 'Watched Model' configuration to define what
projects to monitor and what actions to capture within the
models (see the Model Watches Help topic)
Option

Action

<Model
names>

Either:
· Click on a project name in the list to
open that project in the current
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instance of Enterprise Architect (and
close any project you already have
open), or
· Ctrl+click on a project name in the list
to launch that project in a separate
instance of Enterprise Architect, in
addition to the current project
You can also right-click on a project
name in the list and display a short
context menu with options to:
· Open the selected project in the current
instance of Enterprise Architect (and
close any project you already have
open)
· Launch the selected project in a new
instance of Enterprise Architect
(keeping the current project open in the
current instance)
· Add the project to the list of watched
projects that you are monitoring for
various kinds of activity
· Pin the connection, thereby moving it
to the 'Pinned' model list; the project
name is deleted from the 'Recent' list
· Edit the name of the selected project,
by overtyping the name in a brief
dialog
· Remove the selected project from the
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list (which removes the link to the
project, not the project file itself)

Pinned
The 'Pinned' repository list allows modelers who frequently
work on particular repositories to add them to a list where
they can always be easily and reliably accessed. Some users
might only work on a single corporate repository or a small
set of project repositories, so the 'Recent' list will always
provide access to these projects. However, other users such
as consultants and multi-disciplinary team members often
work on a large number of repositories and, in this scenario,
the repositories they need to visit regularly might 'drop-off'
the 'Recent' list as new repositories are visited. If these
repositories are added to the 'Pinned' list they will always be
available for selection.
The 'Pinned' list shows up to ten Enterprise Architect
projects (.qea files, .qeax files, .feap files, DBMS server
connections and Cloud connections) that you have opened at
some point in the 'Recent' list and you have 'pinned' so that
they remain available for selection across all registry hives
that you might use.
You can also right-click on a project name in the list and
display a short context menu with options to:
· Open the selected project in the current instance of
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Enterprise Architect (and close any project you already
have open)
Launch the selected project in a new instance of
Enterprise Architect (keeping the current project open in
the current instance)
If the project is accessed via a connection string to a
DBMS or Cloud repository, change the connection string
Edit the name of the selected project, by overtyping the
name in a brief dialog
Remove the selected project from the list (which removes
the link to the project, not the project file itself; the link is
not returned to the 'Recent' list)

Notes
·

·

When you initially open Enterprise Architect, the Browser
window contains the option '<click to open project>'; this
has the same effect as the Manage Projects button
You can hide the Start Page, or show it again, by toggling
the 'Start > Appearance > View > Show Start Page' ribbon
option; this setting persists after shut down and restart of
Enterprise Architect until you explicitly toggle the option
again
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How to Remove Links to Recent
Projects
In the 'Manage Projects' dialog and on the Start Page
'Recent' section, the projects that you have opened most
recently are listed either in alphabetical order or in the order
of opening date/time (most recent first), up to a maximum of
ten projects. If the list identifies projects that you do not
want to be so immediately accessible, you can remove them
specifically from the list.
Removing a project from the 'Recent' list only removes the
hyperlink to the project and does not remove the project
from the file system or repository.

Access
Ribbon

> Open Project or
Start > Appearance > View > Show Start
Page > Recent

Keyboard
Shortcuts

Ctrl+O
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Remove a Project Hyperlink from the
'Manage Projects' List
Ste Action
p
1

On the 'Manage Projects' dialog, in the 'Recent
Projects' panel, click on the name of the project to be
removed.

2

Click on the Remove Selection from List button.
The project link is immediately removed from the
list.

Remove a Project Hyperlink from the Start
Page, Recent List
Step

Action

1

On the Start Page, right-click on the name
of the project to remove and select the
'Remove Selection from List' option.

2

The name of the project disappears from

(c) Sparx Systems 2022

Page 167 of 1150

The Application Desktop

3 October, 2022

the list.

Notes
·

·

You can only remove one project link from the list at a
time
To remove a link there must be at least two projects
between the 'Recent' and 'Pinned' lists
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The Ribbon Menu
Enterprise Architect displays a set of ribbons at the top of
the screen, as a modern, contemporary way of accessing the
tool's features. Ribbons bring many features immediately to
the surface, making them easily accessible to a modeler;
both new users and those who have been using Enterprise
Architect for many years will be delighted to find their
preferred tools right at their fingertips. Each ribbon provides
actions with a particular focus, and the commands on the
ribbons are grouped by function into panels.

Searching for an Item
The ribbons expose a wide range of Enterprise Architect
features, and the system provides two facilities to help you
locate and access the feature you need:
· In the 'Microsoft Office 2016' Visual Style theme, click
on the 'Find Command' field at the end of the sequence of
tabs and type in some text relating to the feature you want
to locate, then press the Enter key; this displays a
hierarchical menu of options that match your search text,
and when you click on an option the appropriate dialog
opens
· Click on the
button (for File Management options)
to the left of the ribbon tabs and type your search text in
the 'Search' field at the bottom of the resulting dialog; a
list of options relating to the search text is immediately
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displayed down the left hand side of the dialog and, when
you click on an option, the appropriate dialog opens
Also, when you 'mouse over' any option on any of the
ribbons, a tool-tip displays, summarizing the function of the
option. The tool-tip can be configured to display either in
the left end of the status bar at the bottom of the screen or
floating beside the option it describes.
You therefore have help in identifying both what option
provides a function, and what function an option provides.

Contextual Ribbons
Some ribbons are contextual and are only needed when you
are performing a particular task. For example, the
'Document-Edit' ribbon is only needed when you are
viewing or editing a document inside Enterprise Architect.
This ribbon will remain visible while a document is open;
when all documents are closed the ribbon will be hidden
from view.

Moving Between Ribbons
To change the selection of a ribbon, you can either left-click
on the tab of the ribbon you require, or hover the cursor on
the ribbon band and roll the mouse scroll-wheel forward to
scroll right to left through the ribbon tabs or backwards to
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scroll left to right.

Using the Keyboard with Ribbons
The actions that are presented on the ribbons can also be
accessed using the keyboard. If you tap and release the Alt
key, each ribbon will be annotated with a letter code.
Pressing this letter on the keyboard will activate the ribbon
and display a further set of annotations for the actions in the
ribbon.

Customizing the Ribbons
If a ribbon presents more options than you require, you can
customize it to hide the panel containing those options, or
hide the whole ribbon. To do this, you select the 'My Ribbon
Sets' tab on the 'Workspace Layout' dialog (Start > All
Windows > Workspace > Workspace Tools > My Ribbon
Sets), create a Ribbon Set to customize the ribbon display,
and define the ribbons and panels to show or hide in that
Ribbon Set. You can re-activate hidden ribbons and panels
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by editing this Ribbon Set.
The 'My Ribbon Sets' tab also provides the option of
defining one of the ribbons as the default to automatically
display when Enterprise Architect is opened in a work
session. Normally the 'Start' ribbon is fully open when the
system is accessed. For more information, see the
Customizing Ribbon Sets Help topic.

Minimizing the Ribbon Bar
On occasion you might need more screen space to view
diagrams and other model representations. To help with this,
you can conveniently minimize the ribbons and completely
hide them from view. The ribbon tabs will still be visible,
so you can click on the required tab and redisplay the
corresponding ribbon until the focus is returned to another
part of the user interface. Many modelers will find that
leaving the ribbons maximized will provide a convenient
visual reminder of the actions that are available while
working on models.
To minimize or restore the ribbons, right-click on the ribbon
bar and select or deselect the 'Minimize the Ribbon' option.
Alternatively, double-click on the name tab of the
currently-displayed ribbon.

Hiding Ribbon Text
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At times you might find that the ribbon text adds more
visual distraction than you would like. You can select
another option on the ribbon context menu to hide the text
underneath the larger ribbon icons so that it only displays
when you mouse-over the icon. You can then remind
yourself of the icon's purpose or select the drop-down
options from the icon menu without the text being displayed
there permanently.
Right-click on the ribbon background and select the
'Minimal Text Mode' option. Click on the option again to
deselect it and redisplay the icon text.
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Customizing Ribbon Sets
The Enterprise Architect ribbons provide access to the
functions and facilities of the system, grouped according to
work area. If you only work with the facilities of a certain
area, such as Coding or Simulation, you can create a Ribbon
Set to present just those facilities and hide other facilities
that you do not use. You might hide certain panels of a
ribbon, or the whole ribbon.
When you open Enterprise Architect, the Start ribbon is
expanded in the ribbon bar by default. You can also set a
different ribbon to be the default expanded on opening the
system.
If you have user security enabled on a model or project, as
an administrator you can also define sets of ribbons to be
shown or hidden for other users in each of the security user
groups. See the Perspectives for Security Groups Help topic.

Access
Ribbon

Start > All Windows > Workspace >
Workspace Tools > My Ribbon Sets

Create a Ribbon Set
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Ste Action
p
1

On the 'My Ribbon Sets' tab of the Workspace
Layout window, the 'Create Ribbon Set' and
'Configure Ribbons' panels display.

2

Click on the New button, and in the 'Create New
Ribbon Set' dialog type a name for the Ribbon Set.
Click on the OK button to add the new name to the
'Create Ribbon Set' panel and to make it the focus of
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the 'Configure Ribbons' panel.
3

To hide a complete ribbon, clear the 'Enable'
checkbox against the ribbon name.
To hide selected panels within a ribbon, click on the
white arrowhead to the left of the ribbon name, to
display a list of panels that the ribbon contains. For
each panel to hide, clear the 'Enable' checkbox
against the panel name.
Clearing all the panel checkboxes for a ribbon also
hides the complete ribbon (you cannot display an
empty ribbon).

4

If you want to redisplay a panel or ribbon, select the
corresponding 'Enable' checkbox. Selecting a panel
within a hidden ribbon shows the ribbon again.
Selecting to show a hidden ribbon selects the
checkboxes against all its panels; you can then clear
individual panels as required.
If you have cleared a number of ribbons and/or
panels, you can restore the complete set of ribbons
and panels by clicking on the Reset All button.

5

If you want to change the default ribbon expanded
on opening Enterprise Architect, click on the
drop-down arrow in the 'Default Ribbon' field at the
foot of the page and select the appropriate ribbon
name.
If you have hidden a complete ribbon in the
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'Configure Ribbons' panel, that ribbon is not
available for selection in the 'Default Ribbon' field.
The Reset All button also sets the field back to the
'Start' ribbon.
6

Click on the Save button to save your settings, and
on the Close button to close the Workspace Layout
window.

Notes
·

·

You cannot hide the 'Start' ribbon, 'Specification Specify' ribbon or 'Document - Edit' ribbon, or any panels
that they contain
If you no longer want to keep a Ribbon Set, click on the
name in the 'Create Ribbon Set' panel and click on the
Delete button and on the OK button in the confirmation
prompt; if there are no Ribbon Sets left, the system reverts
to the default of a full set of ribbons with all panels
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Specification - Specify Ribbon
The 'Specification - Specify' ribbon provides a selection of
facilities that you might use when creating and editing
model elements as a text-based specification, using the
Specification Manager. The ribbon becomes available when
the Specification Manager is open.

Panels
Panel

Description

Element

The 'Element' panel offers a range of
facilities for working with the elements
that are displayed in the Specification
Manager view. There are facilities for
adding new elements and viewing and
editing element properties.

Display

The 'Display' panel provides a range of
options that make it possible to tailor the
appearance of the Specification Manager
view, to better display the information
you want to examine. There are options
providing visual cues, such as
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highlighting the selected element and
using bold fonts to emphasize element
names, as well as options to filter the list
of elements that are displayed.
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Display Panel
The 'Display' panel provides a range of options that make it
possible to tailor the appearance of the Specification
Manager view, to better display the information you want to
examine. There are options providing visual cues, such as
highlighting the selected element and using bold fonts to
emphasize element names, as well as options to filter the list
of elements that is displayed.

Available Facilities
Facility

Description

Notes Format

Click on the drop-down arrow, to a
display a brief menu of commands for
customizing the visibility and style of
displayed element notes:
· Preview - show the Notes in Preview
mode; this limits the Notes displayed to
a maximum size and uses the Notes
window for editing
· Full Notes Inlined - show the complete
Notes text for each element underneath
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·

·

·

Level
Numbering
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the element name; in this mode you can
create, edit and delete Notes text in the
Specification Manager and perform the
same operations as are available in the
Notes window context menu
Full Notes in Column - show the
complete Notes text for each element in
a new column next to the element
names; you have the same freedom to
edit the text as for 'Full Notes Inline'
Document View - columns are hidden
and Notes are displayed inline; use the
Enter key as a keyboard shortcut to
begin editing.
Hide - show no Notes at all; to edit or
view the Notes, open the Properties
window or docked Notes window

Clicking the drop-down arrow displays
options for applying level numbering and
indenting notes for elements contained
within the current Package.
· Enable - toggle the display of
automatically applied level numbering
within the Specification Manager and
the Browser window, for elements
within the currently displayed Package
· Indent Description - if you have
enabled level numbering, this option is
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available to indent the element
description under each element name,
to align with the element name
Show
Columns

The Specification Manager can display a
wide range of properties for the elements
in the selected Specification Package,
with each property being shown in a
separate column. This command opens
the 'Field Chooser' dialog, allowing you
to customize the display of the columns
so that you show as many or as few as
you need, in an appropriate sequence.

Tagged
Value
Column

Display the 'Add Tag Value Column'
dialog. This dialog allows you to add a
specific Tagged Value to the list of
columns displayed by the Specification
Manager. If the current element already
has the named Tagged Value, the value
can be edited, otherwise the Tagged
Value must first be added to that element.

Bold Names

Use this option to turn on or off, the use
of Bold element names in the
Specification Manager view.
When on, all element names, including
the names of child elements, are
displayed using bold font.
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Collapsible
Regions

Use this option to enable the use of
Expansion boxes on parent elements.
If an element has child elements, you can
configure the Specification Manager to
either:
· Hide the child elements but provide an
expansion box that you can click on to
open and collapse the element
hierarchy (select the 'Collapsible
Regions' option), or
· Automatically display the child
elements indented underneath the
parent element (deselect the
'Collapsible Regions' option)

Highlight
Selection

Use this option to actively highlight the
currently selected row. When you click
on an element name or property, the
Specification Manager defaults to
indicating the selection with side bars
and/or underlines. You can, if you prefer,
also highlight the entire row of data for
the element, by selecting the 'Highlight
Selected Row' option. This is only
relevant when columns are visible.

Filter Bar

Use this option to show or hide the Filter
Bar, which allows filtering of the visible
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items in the Specification Manager view.
The Filter Bar displays underneath the
column headings and consists of a row of
fields, one field per column. As you type
a value into one of these filter fields,
element rows in the Specification
Manager list are hidden unless the value
in the corresponding column contains the
value in the filter field.
Element Icon

This option defaults to selected, to
display an element icon in front of each
element name in the Specification
Manager. The icon is a pictorial
representation of the element type, and
matches the element type icon shown
against the element in the Browser
window. Deselect the checkbox to hide
the element icons.

Add New
Button

This option defaults to selected, to
display the Add New button and its
associated drop-down menu at the bottom
of the Specification Manager display.
Deselect the option to hide the button.

Auto
Synchronize

Select this checkbox to automatically
synchronize the Specification Manager
display to the Package selected in the
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Browser Window. As you click on
different Packages in the Browser
window, the Specification Manager
changes to display the content of the
currently-selected Package.
If you do not select the checkbox and you
move around the model structure the
Package displayed remains as the one
originally selected by clicking on the
'Design > Package > Specification View'
option.
Font Size
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Across the Specification Manager view,
the various display components such as
parent element names, child element
names, Notes/property values and column
headings each have their own font size.
You can select to increase or decrease the
font sizes as a set across the display,
relative to the current sizes.
Specify the default font size based on
preference:
· Small
· Medium
· Large
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Element Panel
The 'Element' panel brings together a range of facilities for
working with the elements that are displayed in the
Specification Manager view. There are facilities for adding
new elements, and for viewing and editing the Properties of
elements, as well as for generating documentation in a
number of formats.

Available Facilities
Facility

Description

Element
Type

Click on the drop-down arrow to display
a range of options for filtering the type of
element created when you select to add a
new element using the Specification
Manager Add New button (not the
drop-down arrow):
· <Any> - when selected, and when you
click on the Add New button, the 'New
Element' dialog displays from which
you select the type of element to create
· Other - displays the full list of work
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·

·

·

·

Insert
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sets from which you select a specific
element to add to the list in the
<element types> section of the
drop-down
<element types> - a list of element
types that you have selected to create,
using the 'Other' option; click on one of
these, and every time you click on the
Add New button an element of that
type is created, until you specifically
select a different type
Clear Recent Items - clears the
<element types> list; a prompt displays
to confirm the operation, as it can be a
lengthy job to reconstruct the list of
selected element types
Note that if you have a specific element
type selected, that type is not cleared
from the list; selecting the <Any>
option allows you to clear the final
element type from the list
Use Last Created Type - sets the type
of element created to the type of the
last-created element
Limit Display to Selected Type - filters
the Specification Manager display to
only show elements of the selected type

Click on the drop-down arrow to display
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a short menu of options for adding
elements:
· Add Default - add a new element of the
default element type, which is the
currently-selected type of those set
using the 'Element Type > Other'
option
Alternatively, if no element type is
selected, the 'New Element' dialog
displays; use this to create an element,
the type of which becomes the default
type
· Add Child - add a new element as a
child of the currently selected element;
if a default element type has been
specified, an element of that type is
created, otherwise the 'New Element'
dialog is displayed, prompting you to
choose a type
· Repeat Previous - repeat the previous
element insertion action, creating a new
element of the same type, as a sibling
to the previously inserted element
· Show Toolbox - open and display the
Diagram Toolbox showing the
Common, Artifact and other 'pinned'
pages, or switch focus to the currently
opened Toolbox; you can drag element
icons from the Toobox to create
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·

·

Documentati
on
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elements in the Specification Manager,
switching to other Toolbox pages if
necessary
Add Other - display the 'New Element'
dialog, prompting you to choose an
element type and create an element of
that type
Add Multiple Elements - display the
'Create Multiple Elements' dialog,
through which you can add several
elements to the Specification Manager
in one operation

Clicking on the drop-down arrow
displays a list of commands for
generating documentation and reports
based on the current Package, in a range
of different formats. Also available is a
facility for spell-checking the notes of
elements belonging to the current
Package.
· Generate Documentation
(RTF/PDF/DOCX) - displays the
'Generate Document' dialog, where you
can specify a range of parameters and
options that control generation of a
report document; you can select
document templates that control which
elements are included in the report,
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choose from a range of cover pages and
style sheets, and specify the file output
path and file format
Publish as HTML - displays the
'Publish as HTML' dialog, from which
you can create a report on the current
Package for display as a web page; the
dialog allows you to specify a range of
parameters and options to control the
report generation, such as style
templates, diagram themes, image
formats and the output file path name
Publish as Joomla! Article - opens the
'Publish as Joomla! Article' dialog; use
this dialog to specify connection details
for the Joomla! database, the content
template and diagram theme to use, as
well as which element information to
include, then initiate the generation
CSV Import/Export - opens the 'CSV
Import/Export' dialog from which you
can import and export element data
from Enterprise Architect, using CSV
files for exchange with spreadsheet
tools; the 'CSV Import/Export' dialog
allows you to define file specifications
that control which element properties
are exported and imported, as well as
specifying the actual file to use for the
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export or import
QA Reports and Metrics - open the QA
Reports window, which provides a
number of pages, each of which
provides facilities for reporting on a
particular aspect of the elements in the
current Package, namely Testing,
Maintenance, Dependency Details,
Implementation Details and Use Case
Metrics; each page provides a
particular set of parameters and options
to control that type of report generation
Spell Check Current Package - display
the 'Spell Check' dialog, which is used
to run the spell checker to review the
notes of all elements within the current
Package

Edit Notes

Click on this button to begin editing the
element's Notes. If the Notes are hidden,
or displayed in Preview mode, the Notes
window will be used for editing,
otherwise the Notes field or column
within the Specification Manager will be
used. With the element selected, the
Space bar can be used as a keyboard
shortcut to begin editing.

Edit

Click on this button to begin editing the
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Selection

current element's name. With the element
selected, the Enter key can be used as a
keyboard shortcut to begin editing.

Apply Auto
Naming

Display the dialog 'Apply Auto Naming
to Elements'. If you have set up
auto-naming conventions for the names
and/or Aliases of specific types of
elements, you can apply those naming
conventions to all of the elements of
those types in the currently selected
Package, in one operation. The dialog
groups by type those elements that have
defined auto-naming conventions, and
shows the effects of applying the
conventions to the element names and/or
Aliases. You can update the names of all
the elements in the Package, or select
only certain elements to update. The
facility for configuring auto-naming
conventions can be accessed via this
dialog.

Move Up

Click on this button to move the selected
element up in the Specification Manager
list. The element's position is also
reflected in the Browser window.

Move Down

Click on this button to move the selected
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element down one place in the
Specification Manager list. The element's
position is also reflected in the Browser
window.
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Explore Panel
The 'Explore' panel is to the left of each of the other ribbons.
It contains icons to invoke the Portals feature and a range of
search facilities.

The Search Facilities
Click on the drop-down arrow under the icon to display a
selection of search facilities that you can use to locate
objects in the model, or code in source files:
· Model - display the Find in Project view, which provides
access to the full range of standard and customized
searches in your project (Ctrl+Alt+A)
· Files - locate and open source files having specific
characteristics, using the 'Find in Files' dialog
(Ctrl+Shift+Alt+F)
· Recent Diagrams - display the 'Find in Project' view
defaulted to an executed specific search for recently
modified (that is, Active) diagrams. The default time
period is the three days prior to today's date
· Recent Elements - display the 'Find in Project' view
defaulted to an executed specific search for recently
modified (that is, Active) elements. The default time
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period is the three days prior to today's date
Recent Tasks - display the 'Find in Project' view defaulted
to an executed specific search for Active Tasks (those that
are in progress)
Diagram - display the Find in Project view, pre-loaded
with the Diagram Details search to locate diagrams of a
specific name or type
Package - display the Find in Project view, pre-loaded
with the Find Package search to locate Packages of a
specific name or type
Browse for Diagram - locate and select a specific diagram
using the 'Select Classifier' dialog, which shows the full
hierarchy of Packages in the model (Ctrl+Shift+Alt+D)
Browse for Package - locate and select a specific Package
using the 'Find Package' dialog, which shows the full
hierarchy of Packages in the model (Ctrl+Shift+Alt+P)

The Portals
Clicking on the Portals icon displays a list of the Portals that
you might use to set up the user interface to support a
particular area of work. When you click on a Portal name
the corresponding Portal displays on the left or right of the
work area (according to your personal settings). The icon
next to the name of the selected Portal is highlighted, so the
list indicates which Portal is active.
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Portal/Option Description
Workspaces

Provides links to the system-provided
workspaces that you might use to lay out
the Enterprise Architect work area, and to
any workspaces that you have created
yourself. The categories provided are:
· My Workspaces
· Core
· Design
· Software
· Simulation
· Construction
· BABOK Guide

Recent
Places

Provides links to recently viewed
diagrams, documents and files. Links are
grouped into these categories:
· Current Diagrams
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Perspectives
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Recent Diagrams
Documents
Recent Files

Provides a range of model Patterns from
which you can generate model structures
for particular areas of work. The Patterns
are organized into groups within
Perspectives, and presented for selection
through the Start Page 'Create from
Pattern' tab (Model Wizard). The
system-provided Perspectives are:
· UML
· Strategy
· Analysis
· Requirements
· UX Design
· Business Modeling
· Software Engineering
· Systems Engineering
· Database Engineering
· Enterprise Architecture
· Information Exchange
· Publishing
· Construction
· Management

Page 197 of 1150

The Application Desktop

3 October, 2022

Windows

Provides links to the Enterprise Architect
windows and displays that you use to
develop a model and create and manage
the objects within it. These facilities are
grouped under the activity areas of:
· Exploring the model
· Displaying object properties
· Managing the display of diagrams
· Working with specialized tools
· Tracing relationships between objects
· Enabling collaboration between team
members
· Managing tests
· Managing resource tasks
· Project management and maintenance
· Developing code and document
templates

Extend

Lists the MDG Technologies currently
active in your model - such as ArcGIS
and NIEM (4.0) - and for each one
provides links to the facilities for working
with those technologies within Enterprise
Architect.

Execute

Provides a wide range of options that
help you to:
· Perform Execution Analysis on your
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model - building and running the
Analyzer scripts
Open the Record & Analyze, Profiler,
Debugger and/or Testpoints dialogs for
monitoring the execution of your
modeled application
Set up and perform simulations of the
execution of your application
Control the progress of a simulation
Access various windows that display
specific aspects of debugging an
application
Control the progress of a debug
Set up and run recording of the
execution of an application
Display the dialogs to prepare to profile
the execution of an application
Create and edit code from the model

Guidebook

Provides links to the library of Enterprise
Architect User Guides in PDF format.
The Portal initially displays with ten
categories of document, each of which
can be expanded to a list of the PDF
documents in that category.

Learning

Provides links to either the web version
of the Enterprise Architect User Guide,
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or the locally-installed Help if you have
downloaded that. The Portal also
provides links to a number of useful web
pages on the Sparx Systems website, such
as the Resources, Tutorials, Webinars and
Video Demos pages.
Show
Toolbar
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Not actually a Portal but a list of the
'floating' Toolbars that you can also
anchor to the Toolbar ribbon above the
work area. Toolbars that are currently
active are marked with a tick. Click on
the unmarked name of a hidden Toolbar
to expose it either floating or anchored,
and click on a ticked Toolbar name to
hide that Toolbar.
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Document - Edit Ribbon
The 'Document - Edit' ribbon provides a set of tools and
facilities for working with documents such as imported
document files and Linked Documents. It becomes available
when you open an editable document within Enterprise
Architect.

Panels
Panel

Description

File

The 'File' panel helps you to manage
internal document files, the way the
content displays, file security and objects
you can add to the content (such as
hyperlinks).

Edit

The 'Edit' panel provides a wide range of
facilities for manipulating and checking
the text within a document, and searching
the content for specific text strings. It also
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provides facilities for tracking and
managing document changes.
Font

The 'Font' panel helps you to completely
control the Fonts in a document,
including setting Bold, Italics and font
types and size. The color of text and
background can be altered to create
visually attractive documents.

Paragraph

The 'Paragraph' panel helps you to format
all aspects of paragraphs in a document
including left, right and center alignment
and justification. Text indentation, bullets
and numbered lists can be added to create
well formatted documents. Line spacing,
document styles and table borders can be
set to facilitate reading.
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File Panel
The 'File' panel helps you to manage internal document
files, the way the content displays, file security and objects
you can add to the content (such as hyperlinks).

Available Facilities
Facility

Description

Save

Click on this icon to save any changes
you have made to the document file. (The
icon is not available if no changes are
pending).

File

Click on the drop-down arrow and select
from a number of options for
manipulating the file contents as a whole.
· Import File - import the contents of an
existing document into the current file
· Save As (Export to File) - save your
document to a different document file
· New (Clear Document) - clear the
current contents of the document for
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·

View
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redesign
Reload from Repository - reload the
file contents from the previously-saved
version
Page Layout - display the 'Page Setup'
dialog and set the page margins for the
file
Printer Setup - display the 'Print Setup'
dialog and confirm or reselect the core
parameters such as page size, or click
on the Properties button to define more
advanced settings
Print - display the 'Print' dialog to
define the print job for the document
Print Preview - display the document as
it would appear when printed

Click on the drop-down arrow to display
options for displaying the document
content on the screen.
· Page Mode - display a full-screen view
of the content as pages with borders
· Page Mode - Borderless - display a
full-screen view of the content with no
borders
· Fitted Mode - fit the document to the
display area
· Horizontal Ruler - display or hide the
Page 204 of 1150

The Application Desktop

3 October, 2022

·

·

·

·

·

·

Manage
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ruler at the top of the page, showing tab
stops and paragraph indentation marks
Vertical Ruler - display or hide the
ruler against the left edge of the page,
indicating the depth of the top and
bottom margins of the page
Status Ribbon - display or hide the
status ribbon at the bottom of the
editing panel, showing the current page
number, line number and column
number
Hidden Text - show text marked as
'Hidden' using the 'Font | Hidden Text'
option
Field Names - toggle between
displaying field names in the text and
displaying the field values
Hyperlink Cursor - toggle the cursor
icon when you 'mouse over' a
hyperlink, between the default image (a
line or arrow) and a pointing hand
Page Header/Footer - display or hide
the text of page headers and footers

Click on this icon to select from a set of
options for protecting the document from
being edited or deleted, so that it is safe
from accidental change. The Document
Editor defaults to locking against
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protection, so you first turn off the lock
and then protect either the whole
document or a selected block of text.
· Protect Document - toggle between
setting a lock to prevent any editing or
deletion of the entire document, and
removing protection so that changes
can be made
· Text Selection Lock - remove the lock
against setting protection on the text of
the document
· Snap to Grid - (defaults to on) applies a
grid to the tab markers and paragraph
indents, so that they snap to the nearest
sixteenth of an inch
· Watermark Picture - display an image
file browser and select an image to use
as a watermark in the document
· Remove Unused Lists - clear unused
list formats from the file when you
save it, to reduce file size
Model Link
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Click on this icon to select from options
to create a link between a text string that
you highlight in the document and a new
or existing object in the model.
· Glossary Definition - display the
'Glossary Detail' dialog, to create a
Project Glossary entry for the
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Fixed Zoom
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highlighted text string
New Model Element - display a short
list of types of object to create (or
select the 'Other' option to access a
wider range of object types) to generate
an object of that type from the
highlighted text string, in the current
Package; the object is linked to the
highlighted text in the document
Link to Existing Element - display the
'Select Classifier' dialog, through which
you browse for and select an element to
link to a highlighted text string
Hyperlink - create a hyperlink from the
highlighted text to an existing object in
the model; the 'Hyperlink Details'
dialog displays, through which you
specify the type of object to link to, and
its location

Click on this icon to display a list of page
magnification options between 75% and
400%, and an option to set a custom
magnification of the page anywhere
between 10% and 500%.
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Edit Panel
The 'Edit' panel provides a wide range of facilities for
manipulating and checking the text within a document, and
searching the content for specific text strings.

Available Facilities
Edit
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Click on this icon to display and select
from a list of editing operations you can
perform within your document. This list
includes facilities for tracking changes,
setting the direction of text flow, and
setting up list overrides.
· Cut - remove a highlighted text string
and hold it in the clipboard
· Copy - copy a highlighted text string
and hold it in the clipboard
· Paste - paste a text string from the
clipboard into the document at the
cursor position
· Paste Special - paste a
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specially-formatted object from the
clipboard into the document, such as
formatted text or an OLE object
Edit Picture - open the appropriate
graphics editor for the selected image,
to edit the image
Undo - roll back the last unsaved
change made; you can undo a
succession of unsaved changes
Redo - re-establish the last unsaved
change that has been undone; you can
redo a succession of undone changes
Select All - highlight the text of the
whole document for performing an
operation on it
Repaginate - repaginate the document,
and update the 'Page Number' and
'Page Count' fields and the Table of
Contents
Edit Section - display the 'Section
Parameters' dialog, on which you set up
the document properties to apply to the
text between two section breaks
Edit Style - display the 'Edit Stylesheet'
dialog, through which you create and
edit styles to apply to either paragraphs
of text or characters
Edit Input Field - display the 'Input
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Field Parameters' dialog, through
which you create or edit a field at the
cursor position in the document, for the
document users to enter data in
Edit Frame/Drawing Object - display a
short list of options for editing or
re-positioning a frame or drawing
object, including setting the direction
of text flow within the object
List and Overrides - display a list of
options for setting up paragraph
numbering list items, overrides and
levels
Page Header/Footer - display a
hierarchy of menus for creating, editing
and deleting the page headers and
footers of the document
Edit Footnote/Endnote - select to add
or edit either an end-note or the
footnotes of the current page
Edit OLE Object - open the appropriate
editor to edit the embedded OLE object
Inline IME - set the document to accept
both single-byte characters and
double-byte characters, without having
to switch to an external Input Method
Editor (IME) application (double-byte
characters are complex characters used
in languages such as Japanese and
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·

Insert
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Cyrillic)
Document Text Flow - display the
'Document Text Flow' dialog, on which
you set the text flow for the whole
document to left-to-right, right-to-left,
or the default for the system

Click on this icon to display and select
from a list of text breaks, objects, special
text structures and special characters to
insert in the document at the cursor
position.
· Insert Break - display a short menu
from which you select to insert a page
break, section break or column break
· Embed Picture - insert an image file as
a picture in the document
· Link Picture - insert a link to an image
file in the document
· OLE Object - display the 'Insert Object'
dialog, from which you can select the
appropriate application to create the
OLE object in the document
· Insert RTF File - insert the complete
contents of another document file
· Frame - inserts a small frame at the
cursor position, which you can then
drag to the appropriate size
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Drawing Object - display the 'Select
Drawing Object' dialog and select to
insert a text box, rectangle or line,
which you can then drag to the
appropriate size
Page Number - insert a page number
field at the cursor position
Page Count - insert a page count field
at the cursor position
Date and Time - display the 'Insert
Current Date and Time' dialog, which
you use to create data and/or time
fields in the page layout, in one of a
selection of formats
Footnote/Endnote - select to insert a
footnote or an endnote linked to a
marker in the text; a dialog displays in
which you enter the marker character
and the note text
Bookmark - display the 'Bookmark'
dialog, which you can use to create,
locate and delete bookmarks in your
document
Table of Contents - display a short
dialog in which you define the highest
and lowest heading levels to reflect in
the Table of Contents (you must define
the appropriate Table of Contents level
styles before doing this); when you
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click on the OK button, the Table of
Contents generates
Data Field - display the 'Data Field
Parameters' dialog, in which you enter
the field name and the data value of
your own data field to insert in the
document
Text Input Field - display the 'Input
Field Parameters' dialog, in which you
enter the field name and characteristics
of a field in which the document users
can enter their own information
Checkbox Field -display the 'Checkbox
Field Parameters' dialog, in which you
define a checkbox that the document
users can select or clear
Selection Field - display the 'Selection
Field Parameters' dialog in which you
define a drop-down list field for which
the document users can select one of a
set of values to display
Hyperlink - display the 'Insert
Hyperlink' dialog, on which you enter
the hyperlink text and the identifier for
the object being linked to, either within
the model or external to it
Non-breaking Space - insert a
non-breaking space at the cursor
position, so that if the document text
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Cut

Copy
Paste

Search
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flows to a new page at that point, the
words linked by the space are kept
together
Non-breaking Dash - insert a
non-breaking dash at the cursor
position, so that if the document text
flows to a new page at that point, the
words linked by the dash are kept
together
Optional Hyphen - insert a hyphen at
the cursor position

Click on this option to remove a
highlighted text string and hold it in the
clipboard.
Click on this option to copy a highlighted
text string and hold it in the clipboard.
Click on this option to paste a text string
from the clipboard into the document at
the cursor position.
Click on this icon to display a short menu
of options for locating a text string in the
document.
· Search - open the 'Search Text' dialog,
to specify the text string to locate and
the initial search parameters
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Spell Check
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Search Forward - continue the search
forwards towards the end of the
document, to the next occurrence of the
defined text string
Search Backward - continue the search
back towards the start of the document,
to the next occurrence of the defined
text string
Replace - open the 'Replace Text'
dialog to search for a text string and
replace it with another, in selected text
or throughout the document
Go to Line - display a short dialog in
which you specify the number of a line
in the document to 'jump' the cursor to

Click on this icon to display a set of
simple options for checking the spelling
in the document.
· Spell Check - start a spell check on the
document, and respond to all apparent
spelling errors
· Auto Spell Checking - set the system to
automatically check all existing text
and new text as it is typed or imported
into the document, underlining
apparent errors in red
· Thesaurus - display the 'Thesaurus'
dialog in which you can check for
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Tracking
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alternative or opposite terms for the
selected text string
Spelling Options - display the 'Spelling
Options' dialog, on which you identify
the text features to include or ignore in
the check, the language dictionary to
apply, what speed and accuracy of
check to accept

Click on this icon to display a menu of
options for enabling and using Change
Tracking in the document. These options
include:
· Enable Tracking - turn Change
Tracking on and off
· Find Next Change - locate and
highlight the next tracked change,
moving towards the end of the
document
· Find Previous Change - locate and
highlight the previous tracked change,
moving towards the start of the
document
· Accept Change - update the document
with the currently-selected change
· Accept All Changes - update the
document with all changes
· Reject Change - remove the change
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from the document
Reject All Changes - remove all
changes from the document
Hide Changes - hides or reveals deleted
text and the highlighting on added text
in the document
Apply Comment - helps you create a
comment on the selected text, which
displays in the outside page margin
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Font Panel
The 'Font' panel helps you to completely control the Fonts in
a document, including setting Bold, Italics and font types
and size. You can alter the color of the text and highlighting
to create visually compelling documents.

Available Facilities
For many of these facilities, you can either select an icon
from the panel or an equivalent option from the 'Font'
drop-down menu.
Font
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Click on this icon to display a list of
options for changing the appearance of a
selected string of characters. These
options include:
· Normal - return changed text to the
Normal, unformatted style
· Bold - display and print the selected
text in bold
· Underline - underline the selected text
with a single line
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Double Underline - underline the
selected text with a double line
Italic - italicize the selected text
Subscript - make the selected text a
subscript on the immediately preceding
text
Superscript - make the selected text a
superscript on the immediately
preceding text
Strike - run a single line through the
selected text
Double Strike - run a double line
through the selected text
All Caps - change all selected
characters to upper case
Small Caps - change all selected
characters to small capitals
Fonts - display the 'Font Selection'
dialog, from which you select the
typeface and point size to apply to the
selected characters
Style - display the 'Select a Style'
dialog, from which you select a defined
style to apply to the selected characters
Text Highlight - display the 'Color'
dialog from which you select and apply
a background highlight color for the
selected text string
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<style> field

<typeface>
field
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Spacing - display the 'Character
Spacing' dialog, on which you select to
expand or compress the spacing
between characters to a number of
Twips that you define, or return the
spacing to Normal
Horizontal Scaling - display the
'Horizontal Character Scaling' dialog,
on which you set the width of the
selected characters to less than or
greater than 100%
Hidden - hide the selected text and
close up the remaining text; you can
reveal the hidden text using the 'View >
Hidden Text' option on the 'File' panel
Boxed - place a simple rectangular
frame around the selected text
Protect - prevent any changes to the
selected text; available if the 'Manage >
Protection Lock' option is deselected
on the 'File' panel
Hyperlink - make the selected text into
a hyperlink

Click on the drop-down arrow and click
on the text style to apply to the selected
text.
Click on the drop-down arrow and click
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on the name of the typeface to apply to
the selected text.
<point size>
field

Clear
Formatting

Bold
Italic
Underline
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Click on the drop-down arrow and click
on the point size to apply to the selected
text. You can also type a point size into
the field.
Click on this icon to clear any formatting
you have applied to the selected text
using the other facilities of the 'Font'
panel.
Toggle the selected text between bold and
normal type.
Toggle the selected text between italics
and normal type.
Click on the icon to underline the
selected text with a single line, or to
remove the underline. Click on the
drop-down arrow and select:
· Double Underline - underline the
selected text with two lines, or to
remove the double underline
· Underline Color - display a color
palette from which you can select a
color for the existing underlines, or
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define a color not presented in the
palette
Strikethrough

Subscript

Superscript

Character
Case

Highlight
Text
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Click on the icon to put a single
strike-through line across the selected
text, or to remove the line. Click on the
drop-down arrow and select the 'Double
Strikethrough' option to do the same with
a double line through the text.
Click on this icon to toggle the selected
text between a subscript (below the level
of the adjacent text) and normal.
Click on this icon to toggle the selected
text between a superscript (above the
level of the adjacent text) and normal
text.
Click on the drop-down arrow and select
an option for changing the case of the
selected text:
· lowercase - convert all characters of the
selected text to lower case
· UPPER CASE - convert all characters
of the selected text to upper case
Click on the drop-down arrow to display
the 'Color Palette', and select or define a
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color to show behind the selected text as
a highlight.
Text Color
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Click on the drop-down arrow to display
the 'Color Palette', and select or define a
color in which to display the selected
text.
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Paragraph Panel
The 'Paragraph' panel helps you to format all aspects of
paragraphs in a document to help make the text look
attractive and comfortable to read. Formatting options
include left, right and center alignment and justification, text
indentation, bullets and numbered lists, line spacing,
document styles and defining table borders.

Available Facilities
For many of these facilities, you can either select an icon
from the panel or an equivalent option from the 'Paragraph'
drop-down menu.
Table

(c) Sparx Systems 2022

Click on this icon to display a list of
facilities for setting up and formatting a
table in your document. For options that
apply to cells, you can apply the settings
to the whole table, just the selected cells,
just the column(s) containing the selected
cells, or just the rows(s) containing the
selected cells.
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Insert Table - display the 'New Table'
dialog and specify how many rows and
columns to create; the table defaults to
showing the gridlines
Insert Row - add a row above the
current row, with the same row
properties
Insert Column - add a column to the
left of the current column, with the
same column properties
Merge Cells - merge the selected cells
into one cell, across or down the table,
or both
Split Cell Horizontally - split the
selected cell into two columns within
the row
Split Cell Vertically - split the selected
cell into two rows within the column
Delete Cells - display the 'Delete Table
Cells' dialog, in which you specify
whether to delete just the selected cells,
the rows containing the selected cells,
or the columns containing the selected
cells
Row Position - display the 'Table Row
Alignment' dialog, in which you align
the row borders with the left margin,
the page center or the right margin,
either just for the selected row or for
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the whole table
Row Height - display the 'Row Height'
dialog, in which you set the row height
to automatically adjust to the row
contents, or to only adjust above a
minimum height or to always be an
exact height (which you specify, in
Twips), for just the selected row or for
all rows in the table; content that
exceeds a fixed row height is not
visible in the table
Header Row - set the first row of the
table as a header row, which will be
duplicated at the top of each section of
the table flowing onto a new page
Keep Row Together - set the selected
rows to stay together if the table would
be split by an automatic page break at
those rows
Row Text Flow - display the 'Table
Text Flow' dialog, on which you
specify whether the text should flow
left-to-right or right-to-left, or the
direction of the system default; you can
apply the setting to selected rows or to
the whole table, and the rows are
aligned with the left or right margins of
the page to match the text flow
Cell Width - display the 'Set Cell
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Width' dialog, on which you specify
the width of the selected cells and the
indent of text within the cells, in Twips
Cell Border Width - display the 'Set
Cell Border' dialog on which you set
the width of the lines at any or all of
the top, bottom, left and right of the
selected cells, with the border around
either the selected cells as a block or
around each individual cell
Cell Border Color - display the 'Set
Cell Border Color' dialog, on which
you select one color for all the lines of
the cell borders or a color for each or
any of the border lines, clicking on the
border-name button to select the color
to apply
Cell Shading - display the 'Cell
Shading' dialog, on which you select a
shading of the background of the
selected cells, from 0% (no shading)
darkening to 100% (black)
Cell Color - display the 'Cell Color
Selection' dialog, on which you click
on the Set Color button and on a
background color for the selected cells
Cell Vertical Align - display the 'Cell
Vertical Alignment' dialog, on which
you align the text in the cells to the top,
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center or bottom of the cell, or the
baseline of the lowest top line of text
(if you have applied special formatting
to a cell within the selection)
Cell Rotate Text - display the 'Cell
Text Rotation' dialog, in which you set
the text to display horizontally (as
normal), rotated by 90 degrees
anticlockwise to flow from the bottom
of the cell to the top and left to right, or
rotated by 90 degrees clockwise to flow
from the top of the cell to the bottom
and right to left; this is especially
useful when the cells are in the outside
columns and act as labels for the
content of the body of the table
Select Current Column - select the
whole column containing the
currently-active cell
Show Gridlines - display or hide the
pale blue table and cell borders on the
screen, so that you can visualize the
layout of the table; the grid is not
printable - if you intend to print the
table, you must define the borders as
having at least minimum width

Click on this icon to display a list of
facilities for formatting the selected
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paragraphs of text in your document.
· Normal - align the text so that new
lines begin parallel with the left margin
of the page and flow to the right
· Center - align the text so that new lines
begin at the center of the page and flow
equally towards the left and right
margins of the page
· Right Justify - align the text so that
new lines begin parallel with the right
margin of the page and flow to the left
· Justify Both - align the text so that lines
begin and end parallel with the left and
right margins respectively
· Double Space - separate the lines
within the selected paragraph with
double line spacing
· Indent Left - indent the selected
paragraph one tab space in from the left
margin; each selection indents the text
one more tab space
· Indent Right - indent the selected
paragraph one tab space in from the
right margin; each selection indents the
text one more tab space
· Hanging Indent - indent the paragraph
except for the first line one tab space
· Keep Together - if there is a possibility
(c) Sparx Systems 2022
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that the selected text will be split by a
page break, set the text to be moved to
the top of the next page as a single unit
Keep With Next - if there is a
possibility that the selected paragraph
will be separated from the next by a
page break, set the paragraph to move
onto the same page as the next
paragraph
Widow/Orphan Control - prevent the
first and last lines of the selected
paragraph from being separated from
the rest of the text by a page break; at
least one other line will stay with or
move with the separated text
Page Break Before - set the selected
paragraph to print at the top of a new
page
Border and Shading - display the
'Paragraph Box' dialog, on which you
select to add borders above, below, to
the sides and - for multiple-column text
- between the columns of the selected
text, to format the borders as a single or
double thin line or thick line, to set the
color of the borders, and to add a
shaded background to the selected text;
as you increase the percentage shading,
the text color changes to contrast with
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the background
Paragraph Spacing - display the
'Paragraph Spacing' dialog, on which
you set the line spacing within the
paragraph to one of three standard
spacings, or to a point-spacing that you
define, or to a multiple line spacing that
you define; you can also set extra
spacing to apply before and/or after the
paragraph
Background Color - displays the 'Color'
dialog, on which you select a color as
the background of the selected text;
note that the text color does not
automatically change to contrast with
the background, and if this option is
used with the 'Border and Shading'
option it blocks that text change
Bullet - convert the selected lines of
text to a bullet list, or to convert a
bulleted list to unbulleted paragraphs
Numbering - convert the selected lines
of text to a numbered list, or to convert
a numbered list to un-numbered
paragraphs
Increase Level - increase the indent of
the selected text and move it further in
from the left margin
Decrease Level - if the selected text is
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Bullets
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indented from the left margin, reduce
the indent and draw the text closer to
the margin
List Numbering - display the 'Apply
paragraph numbering using Lists'
dialog, which you use to apply a
hierarchical numbering system to the
paragraphs in the document
Set Tab - display the 'Set a Tab
Position' dialog, on which you set the
interval for tab points, the type of tab
point, and what kind of lead-in line the
tab has, if any
Clear Tab - display the 'Clear a Tab
Position' dialog and select a single tab
from the list to clear
Clear All Tabs - clear all tab settings
from the document
Style - display the 'Select a Style'
dialog, on which you select a pre-set
style to apply to the selected text
Text Flow - display the 'Paragraph Text
Flow' dialog, on which you select the
direction in which text flows from the
opening words - Left-To-Right,
Right-To-Left, or the system default
direction

Click on this icon to convert the selected
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lines of text to a bullet list, or to convert a
bulleted list to unbulleted paragraphs.
Numbers

Decrease
Indent

Increase
Indent
Show
Paragraph
Markers
Fill
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Click on this icon to convert the selected
lines of text to a numbered list, or to
convert a numbered list to un-numbered
paragraphs.
If the selected text is indented from the
left margin, click on this icon to reduce
the indent and draw the text closer to the
margin.
Click on this icon to increase the indent
of the selected text and move it further in
from the left margin.
Click on this icon to toggle the display of
paragraph markers ( ) throughout the
document.
Click on this icon to display a selection of
colors, and select one to use as the
background color for the selected block
of text. If you want to clear the
background color, select the 'Default
Color' option. If you want to use a color
that is not offered in the selection, click
on the 'More Colors' option and select or
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define the color you require.
Left
Alignment
Center
Alignment
Right
Alignment
Left and
Right
Alignment
Line Spacing
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Click on this icon to align the left ends of
the selected lines of text with the left
margin of the page.
Click on this icon to align the centers of
the selected lines of text with the vertical
center of the page.
Click on this icon to align the right ends
of the selected lines of text with the right
margin of the page.
Click on this icon to align the ends of the
selected lines of text with the left and
right margins of the page.
Click on this icon to display a list of
conventional line spacings, and options to
customize line spacing and paragraph
spacing.
· 1.0
)
· 1.5
)
set the line spacing in
the highlighted text to the selected
value
· 2.0
)
· 3.0
)
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Line Spacing Options - display the
'Paragraph Spacing' dialog, on which
you set the line spacing within the
paragraph to one of three standard
spacings, or to a point-spacing that you
define, or to a multiple line spacing that
you define; you can also set extra
spacing to apply before and/or after the
paragraph

Click on this icon to display a list of
options for adding borders to the table
cells you have selected - individual cells,
groups of cells, rows, columns or the
whole table. Other table-formatting
options are available from the 'Table'
option.
· Bottom Border - convert the gridline to
a black border along the bottom of the
selected cell(s)
· Top Border - convert the gridline to a
black border along the top of the
selected cell(s)
· Left Border - convert the gridline to a
black border along the left edge of the
selected cell(s)
· Right Border - convert the gridline to a
black border along the right edge of the
selected cell(s)
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No Border - remove any borders
around and between the selected cells
All Borders - convert the gridline to a
black border around the selected cell(s)
and - for multiple cells - between the
selected cells
Outside Borders - convert the gridline
to a black border around but not
between the selected cells
Inside Borders - convert the gridline to
a black border between but not around
the selected cells
Insert Table - display the 'New Table'
dialog and specify how many rows and
columns to create in a new table
starting at the cursor position; the table
defaults to showing the gridlines
View Gridlines - toggle between
showing and hiding the pale blue table
outlines on the screen display; the
gridlines are not printable, so if you
want to show borders on the table in
the printed document, add cell borders
Borders and Shading - display the 'Cell
Shading' dialog, through which you
identify which grouping of table cells
to shade and the depth of shading to
apply
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Specialize Ribbon
The 'Specialize' ribbon provides facilities to enable and
access Add-Ins (extensions written in COM) and MDG
Technologies that interact with the Enterprise Architect user
interface to extend and specialize the product's capabilities.
When an Add-In is added to Enterprise Architect, either by
inclusion with the installer or by subsequently importing
into Enterprise Architect, it can be assigned to the particular
area of functionality that it supports (using the
EA_GetRibbonCategory function), and is represented by an
icon in an 'Add-In' panel in the appropriate ribbon. Icons for
unassigned Add-Ins are shown on this 'Specialize' ribbon, in
the 'Add-Ins' panel.
The contents of this ribbon therefore depend on what
Add-Ins and Technologies you have installed and enabled,
and whether they have been assigned to a particular
functional area of Enterprise Architect.

Panels
Panel

Description

Tools

The 'Tools' panel provides a collection of
facilities to create and run automation

(c) Sparx Systems 2022

Page 238 of 1150

The Application Desktop

3 October, 2022

scripts, and to access external data
sources through the Cloud Server.
Technologies

This panel provides the icons for
managing and publishing MDG
Technologies in Enterprise Architect, and
also an icon for each enabled MDG
Technology available in your installation
of Enterprise Architect.
Click on the 'Manage Technology' icon to
open the 'MDG Technologies' dialog.
This dialog helps you to add and
configure paths to additional technology
files and to activate or deactivate the
built-in technologies.
Click on the 'Publish Technology' icon to
access options for working with MDG
Technologies in general.
Each Technology icon displays a
drop-down list of options for working
with the Technology.

Add-Ins

This panel provides two icons for
enabling and configuring Add-Ins:
· Manage Addin - display the 'Manage
Add-Ins' dialog, which you use to
enable or disable Add-Ins for use; an
Add-In that is disabled is not loaded
when you start up Enterprise Architect,
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and no icon appears for it in the ribbons
· Addin Windows - display the Add-In
window containing any window that
has been defined to display in this
space, for the currently active Add-In
If your system includes unassigned
Add-Ins, an icon for each one is also
included in this panel.
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Tools Panel
The 'Tools' panel provides facilities for importing data from
external data sources through the Cloud Server. Also
accessed from this panel is the model Scripting window,
which provides the means to manage, create and edit
automation scripts to work with your model.

Available Facilities
Facility

Description

System
Integration

This icon opens the External Data facility
for defining how the data from external
sources is represented in Enterprise
Architect.
When developing a model in Enterprise
Architect you could connect to an
external application such as TFS or JIRA
as the data source. You would then
indicate how data items in one
application are reflected in the other.
Subsequently, you can check the pairings
of data items from separate external tools,
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using the 'Show All Linked Items' menu
option.
Script
Library

Click on this icon to display the Scripting
window, through which you can add, edit
and manage model-based scripts in
JavaScript, JScript and VB.Net.

JavaScript

Click on this icon to display the
JavaScript console, a command line
interpreter that accepts single line
JavaScript commands that will be
executed one at a time.

VBScript

Click on this icon to display the VBScript
console, a command line interpreter that
accepts single line VBScript commands
that will be executed one at a time.

JScript

Click on this icon to display the JScript
console, a command line interpreter that
accepts single line JScript commands that
will be executed one at a time.
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Technologies Panel
The 'Technologies' panel provides the icons for managing
and publishing MDG Technologies in Enterprise Architect,
and also an icon for each enabled MDG Technology
available in your installation of Enterprise Architect. This
topic identifies some of the Technologies that might be
represented here. Each Technology icon displays a
drop-down list of options for working with the Technology.
These options might include:
· Help - open the Help file for the Technology
· About - display a short panel of information on your
installation of the Add-In
· Connect to External Model - connect to a project created
in another application, to which the Technology provides
a bridge
· Import <data> - import data defined in the Technology
into Enterprise Architect
· Export <data> - export data from Enterprise Architect to
data structures specific to the Technology

Available Facilities
Not all of these Technologies will be shown, and others
(c) Sparx Systems 2022
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might be available in the panel.
Facility

Description

Manage
Technology

Click on the 'Manage Technology' icon to
open the 'MDG Technologies' dialog.
This dialog helps you to add and
configure paths to additional technology
files and to activate or deactivate the
built-in technologies.

Publish
Technology

Click on the 'Publish Technology' icon to
access these options for working with
MDG Technologies in general:
· Publish Diagram as Pattern - create a
Pattern file from the currently-open
diagram, using the 'Save Diagram as
Pattern' dialog
· Publish Diagram as UML Profile create and export a Profile file based on
the currently-open diagram, using the
'Save UML Profile' dialog
· Publish Package as UML Profile create and export a Profile file based on
the current Package, using the 'Save
UML Profile' dialog
· Generate MDG Technology - open the
MDG Technology Creation Wizard to
guide you through the process of
creating and integrating the structures
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·

·

and resources appropriate to an MDG
Technology of your own design
Import MDG Technology - import an
MDG Technology into the model either
for your own use or for all users of the
model; the 'Import MDG Technology'
dialog displays
Import Package as UML Profile import a UML Profile file

ArcGIS

Provides access to facilities that help you
create ArcGIS models; the ArcGIS
system supports the development and
management of geodatabases.

ArchiMate

Provides access to the facilities of
ArchiMate 3, one of the business
modeling tools integrated with Enterprise
Architect. It offers a common language
for describing the construction and
operation of business processes, which
you can use to describe, analyze and
visualize clearly the relationships
between business domains.

ODM

Provides access to the facilities of the
Object Management Group's Ontology
Definition Metamodel (ODM) for
Enterprise Architect, with ontology
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modeling capabilities that enable you to
develop large-scale ontologies within the
fully-integrated modeling environment,
for your project domain.
GML

Provides access to the facilities of
Enterprise Architect's integration with the
Open Geospatial Consortium's
Geography Markup Language (GML) 3.3
application schemas, providing an XML
grammar for geographical feature
modeling capabilities.

NIEM 2.1

Provides access to the facilities of the
National Information Exchange Model
(NIEM) release 2.1 in Enterprise
Architect, which provides a common
framework that is used to define how
information can be shared between
systems, government agencies and
organizations.

NIEM

Provides access to the facilities of
National Information Exchange Model
(NIEM), releases greater than 2.1, in
Enterprise Architect.

Eclipse

The MDG Link™ for Eclipse is designed
to support simultaneous UML
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development in both Enterprise Architect
and Eclipse, adding extra functionality to
the code generation abilities of Enterprise
Architect and merging the changes with
minimal effort. Click on the icon to
display a short menu of options for using
the Add-In.
· View Project Connections - display the
'Eclipse Connections' dialog, to review
the connections between Enterprise
Architect Packages and Eclipse
Projects
· Options - display the 'Options' dialog
on which you set up the Eclipse
installation path for Enterprise
Architect to use to access Eclipse
· Help - open the integrated Help for the
MDG Link for Eclipse
· About - display a panel of information
on your installation of the MDG Link
for Eclipse
Visual Studio
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The MDG Link™ for Visual Studio.NET
is designed to support simultaneous UML
development in both Enterprise Architect
and Visual Studio, adding extra
functionality to the code generation
abilities of Enterprise Architect and
merging the changes with minimal effort.
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Click on the icon to display a short menu
of options for using the Add-In.
· View Project Connections - display the
'Visual Studio Connections' dialog, to
review the connections between
Enterprise Architect Packages and
Visual Studio Projects
· MDG Options - display the 'MDG Link
Options' dialog to set or cancel
Enterprise Architect as the tool for
editing source code, and to
automatically check for changes on
merge (or not)
· Import Build Scripts - import build
scripts into Enterprise Architect from
Visual Studio
· Export Linked Package List - export a
linked-Package list from Enterprise
Architect into Visual Studio
· Import Linked Package List - import a
linked-Package list into Enterprise
Architect from Visual Studio
· Help - open the integrated Help for the
MDG Link for Visual Studio
· About - display a panel of information
on your installation of the MDG Link
for Visual Studio
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Add-Ins Panel
This panel provides the facilities for enabling Add-Ins and
displaying any windows that they define. The panel also
provides icons to access unassigned Add-Ins.

Available Facilities
Facility

Description

Manage
Addin

Displays the 'Manage Add-Ins' dialog,
which you use to enable or disable
Add-Ins for use; an Add-In that is
disabled is not loaded when you start up
Enterprise Architect, and no icon appears
for it in the ribbons.

Addin
Windows

Displays the Add-In window, which
contains any window that has been
defined to display in this space, for the
currently active Add-In.

<unassigned
Add-Ins>

An Add-In that is not assigned to an
'Add-Ins' panel in a specific ribbon will
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have an icon in this 'Specialize > Add-Ins'
ribbon panel.
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Execute Ribbon
The 'Execute' ribbon provides a comprehensive set of
facilities for running units of code and analyzing how the
code executes, checking system use and data use and
whether there are errors. If there are errors in the code, you
can isolate them and correct them, testing those corrections
as well.

Panels
Panel

Description

Tools

The 'Tools' panel brings together a
collection of tools for analyzing the
execution of an application. The tools
available are a fully featured Debugger,
an execution Profiler and a stack trace
Recorder. There are also facilities for
running the application and recording
Test Point output, for subsequent
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analysis. The 'Services' icon provides
options to start, stop and test Satellite and
Agent services, and to make use of the
Code Miner.
Windows

The 'Windows' panel provides access to a
suite of windows associated with the
debugging process, each of which
provides information on an aspect of the
application being debugged, particularly
at a breakpoint.

Source

The 'Source' panel provides a set of
buttons for building an application that is
being analyzed. The active Analyzer
Script defines the behavior of the
Analyze tools, by specifying the
commands that are executed and the
settings and parameters for those
commands. After making modifications
to the code base, you can simply click on
'Build'.

Run

The 'Run' panel provides the commands
for running an application that is being
analyzed. You simply click on buttons to
begin execution of the updated
application, pausing or stepping through
code as required.
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Tools Panel
The 'Tools' panel brings together a collection of tools for
analyzing the execution of an application. The tools
available are a fully featured Debugger, an execution
Profiler and a stack trace Recorder. There are also facilities
for running the application and recording Test Point output,
for subsequent analysis.

Available Facilities
Facility

Description

Analyzer

Displays the Execution Analyzer
window, which lists - by Package - all
Analyzer Scripts defined in the model.
From this window, you can create, edit
and manage scripts that specify the
commands and parameters required to
build, test, run, debug, deploy and
simulate your applications. The window's
toolbar buttons provide for control of
script tasks such as build, run, test and
deploy, and also provide access to a range
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of debugging facilities.
The icon also provides access to the Job
Queue window. This window streamlines
the process of working with Analyzer
Scripts; when an Analyzer Script context
menu option is executed (for example,
'Build') it is placed in a job queue;
multiple jobs can be queued, and other
work performed while the jobs are
processed.
Services
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These options enable you to start, stop
and test local supporting VEA services.
Those services might run a native Linux
program, for example, or build a project.
· View Status of all Services - displays a
window that lists the status of each
Enterprise Architect service named in
the config file, and its state
· Satellite Service
- Start
- Stop
- Test (Satellite service status)
· Agent Service
- Start
- Stop
- Test (Agent service status)
· Code Miner Service
- Start - reads the current service
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configuration and starts services that
are configured to run
and stops services that are not
configured
- Stop All - stops any services that
are currently running
- Edit Configuration File - prompts
for the service config file to use, then
opens it in an
Enterprise Architect text editor
- Auto Start with EA automatically starts services having the
'status:ON' attribute when
the model opens
- Auto Stop on Close automatically stops running services
when Enterprise Architect is closed
Debugger
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Click on the drop-down arrow to display
a list of options for starting and using the
Debugger.
· Open Debugger - open the Debug
window; this window provides a
toolbar for controlling Debugger
operations such as run, step-into,
step-over, pause and also displays
debug output messages
· Start Debugging - start the application,
according to the debug options of the
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active analyzer script
Attach to Process - display a list of
executing processes - select and attach
to a process for debugging purposes
Create Stack Diagram - create an
Interaction diagram based on the
current execution stack; available only
when execution is halted at a
breakpoint
Create marker set for class - creates a
set of breakpoint markers for methods
of the selected Class
Switch to Profiler - switch dynamically
from the Debugger to the Profiler,
allowing performance monitoring and
execution tracing
Set as JIT Debugger - set Enterprise
Architect as the default Just In Time
debugger; for Windows systems only
Set as JIT Model - set the current
model as the default on which to
perform Just In Time debugging; for
Windows systems only
Process First Chance Exceptions enable processing of First Chance
Exceptions
Apply Debug Layout - apply a
workspace layout containing windows
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useful for debugging, set out in a
convenient arrangement
Profiler
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The Profiler is used to record stack trace
information for an application that is
being analyzed, at pre-determined
sampling intervals.
Click on the drop-down arrow to display
a list of commands for starting and
working with the application Profiler.
· Open Profiler - open the Profiler
window; this window provides a
toolbar for controlling Profiler
operations and displays a summary of
the collected sample data
· Attach to Process - display a list of
executing processes - select and attach
to a process to enable execution
profiling and activity monitoring of
that process
· Start - reattach the Profiler to the last
profiled application process (where
available), otherwise start the
application specified in the debug
options of the active analyzer script and
attach the Profiler to that application
process
· Resume - begin or resume collection of
profiling data
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Stop - detach the Profiler from the
application process; the application
process will continue to run - click on
the Start button to re-attach to that
process
Switch to Debugger - dynamically
switch from Profiling to Debugging to
allow finer grained inspection of
application behavior
Create Report from Current Data create a detailed execution call graph
and overall summary, showing
functions called and number of times a
function was active when the Profiler
inspected execution
Load Report from File - load a profiler
report from a saved file
Save Report to File - save the collected
profile data to a file
Stop Process on Exit - an option to stop
the application process when the
Profiler is detached from that process
Show Debug Output - optionally show
debug output as the Profiler executes
Discard Fragments - discard partial
stacktraces from samples
Discard Current Data - discard all
collected sample data in preparation for
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·

Recorder
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a new run
Apply Profiler Layout - apply a
workspace layout containing windows
useful for application profiling, set out
in a convenient arrangement

The Recorder is used to record
information about function calls made by
an application that is being analyzed.
Click on the drop-down arrow to display
a list of commands for starting and
working with the Recorder.
· Open Recorder - open the Record &
Analyze window; this window provides
a toolbar for controlling Recorder
operations such as run (the
application), manual record, auto
record, stop recording and also displays
the recorded function call information
· Attach to Process - attach the Recorder
to an executing process
· Start Recorder - start the application
specified the debug options of the
active analyzer script and attach the
Recorder to that application process;
recording will begin when execution
hits a recording marker that has been
set in the source code
· Stop Recording - stop recording the
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execution trace of the application
process; the application process will
continue to run
Auto Record - automatically begin
recording an execution trace, without
manual intervention, once execution
hits a recording marker that has been
set in the source code
Manual Record - use the manual record
functions to start and stop recording
while stepping through source code in
the Debugger
Step Thru - step through executing
code while recording an execution
trace
Save Recording to Model (Artifact) save the recorded execution trace to a
model artifact
Save Recording to File - save the
recorded execution trace to a file in the
local file system
Load Recording - load a recorded
execution trace from a previously
saved file
Clear Recording Data - discard any
recorded execution trace in preparation
for recording a new trace
Create Sequence Diagram - create a
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Sequence (Interaction) diagram from
the current execution trace; requires
that model and code are synchronized
Create Call Graph - create a Call Graph
from the current execution trace;
requires that model and code are
synchronized
Create Class Diagram - create a Class
diagram using the elements that are
instantiated and accessed in the current
recording
Create Test Point Diagram - create a
Test Point diagram and Test Sets based
on the elements and their active
members that were hit during the
recorded session
Synchronize Model to Source Code synchronize the source code of the
current application with the model, to
ensure correct recording and creation
of diagrams
Show/Hide Execution Point - show or
hide the current execution point during
the recording process; hiding this
results in a faster recording time
Apply Recording Layout - apply a
workspace layout optimized for use of
the Recorder
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Tester

Test Points are a scheme by which rules
and constraints governing the behavior of
objects can be taken from the model to
create Test Cases to verify the
application.
Click on the drop-down arrow to display
a list of options for working with Test
Points and Test Cases.
· Show Testpoint Window - open the
Test Points window to manage,
configure and run Test Points and
associated Test Cases, Sets and Suites
· Find Test Suites and Test Sets - search
the current model for Test Suites, Test
Sets and related elements used in
managing Test Point based verification
· Open Object Workbench - open a
simple Object testing environment for
Java and .Net; instantiate objects and
dynamically call their methods

XSLT

Opens the XSLT Debugger, to debug an
XSL Transformation.

(c) Sparx Systems 2022

Page 264 of 1150

The Application Desktop

3 October, 2022

Windows Panel
The 'Windows' panel provides access to a suite of windows
associated with the debugging process, each of which
provides information on an aspect of the application being
debugged, particularly at a breakpoint.

Available Facilities
Facility

Description

Breakpoints

Click on this icon to open the
Breakpoints & Markers window, which
you use to manage and configure source
code breakpoints and other markers.

Call Stack

Click on this icon to open the Call Stack
window, which displays all the
currently-running threads in a process, at
a breakpoint.

Local
Variables

Click on this icon to open the Locals
window, which displays the local
application variables at a breakpoint.
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Watches

Click on this icon to open the Watches
window, which lists the customer
variables by name when the application is
at a breakpoint.

Modules

Click on this icon to open the Modules
window, which lists the modules an
application has loaded and is using at run
time.

Memory
Viewer

Click on this icon to open the Memory
Viewer window to view a piece of
memory when the application is paused at
a breakpoint.
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Source Panel
The 'Source' panel provides a set of buttons for building an
application that is being analyzed. The active Analyzer
Script defines the behavior of the Analyze tools, by
specifying the commands that are executed and the settings
and parameters for those commands. After making
modifications to the code base, you can simply click on
'Build'.

Available Facilities
Facility

Description

Find

Open the Find in Files window to search
the local file system for source files that
contain particular text.

Edit

This icon provides a collection of tools
for viewing and editing source code files
associated with elements in the current
model. Also provided are tools that
generate source code for a particular
element or synchronize an element to
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reflect changes in its associated source
code file.
· Open Source File - display a 'File
Chooser' dialog to browse for a source
code file to open in the code editor
window
· Search in Files - display the 'Find in
Files window, to locate files of a
selected type containing a specified
code string
· Edit Element Source - open the code
editor window and load the source code
file associated with the currently
selected element
· Edit New Source File - create and
populate a new source code file
· Open in External Editor - launch the
configured External Editor and load the
source code file associated with the
currently selected element
Merge
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Click on this option to display a short
menu of user-defined commands defined
in the currently active Analyzer script, to
integrate with your source Version
Control provider. Click on the command
type to execute the command and
perform the defined operation:
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Merge
· Changes
· History
· Commit
· Working Copy
· Repository
If a command has not been defined, the
option is grayed out.
·

Build
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Click on the drop-down arrow to display
a short menu of commands for building
application source code:
· Build - build the current application,
according to the currently active
Analyzer script
· Deploy - execute the 'Deploy'
command of the selected script.
· Clean - run the Analyzer Clean
command to delete intermediate files
from the current application
· Rebuild - run the Analyzer Clean and
Build commands as defined in the
currently active Analyzer script
· Cancel Build - cancel the currently
executing build
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Run Panel
The 'Run' panel provides a set of buttons for building and
running an application that is being analyzed. After making
modifications to the code base, you can simply click on
'Build', then click on buttons to begin execution of the
updated application, pausing or stepping through code as
required. The active Analyzer Script will determine the
behavior of the debugger tools, by specifying the commands
that are executed as well as the settings and parameters for
those commands.

Available Facilities
Facility

Description

Start

Click on the drop-down arrow to display
a short menu of commands:
· Debug - start the application, according
to the debug options of the active
Analyzer Script
· Run - resume execution of the
application process that is currently
being debugged - if no process is
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·

·

·

currently being debugged, then start the
application specified in the debug
options of the active Analyzer Script
and attach the Debugger to that
application process
Attach to Process - display a list of
executing processes, select and attach
to a process for the purpose of
debugging
Test - execute the Test command
configured in the current Analyzer
Script
Show Execution Point - display and
highlight the line of source code that
corresponds to the current execution
point

Pause

Pause execution of the application being
debugged.

Step Over

Execute the next line of source code,
without pausing inside any methods
called by that line. The execution point
will move to the next source line in the
current context.

Step In

Execute the next line of source code,
stepping into any method that is called.
Execution is paused before executing the
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first executable line in the called method.
If source code for the called method is
not available, the debugger will return
immediately to the calling code.
Step Out

Automatically run to the end of the
current context/method and return to the
calling context. Execution will pause
again, upon return to the calling context.

Stop

Clicking on the drop-down arrow
displays a short menu providing options
to terminate debugging the application.

·

·

·
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Stop - stops the Debugger and stops the
process that is being debugged (the
default when you just click on the
ribbon icon)
Detach - stops the Debugger but leaves
the process running
Quit Application - stops the Debugger
and posts a WM_QUIT message to the
main window of the process, if it has
one
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Simulate Ribbon
The 'Simulate' ribbon presents a range of tools for
configuring, building and running simulations of models, in
particular models of executable states, decision analysis,
business process analysis and system behavior. The
definition of a simulation is further supported by the facility
to create JavaScript to control a simulation, including the
use of mathematical solvers such as MATLAB and Octave.
Enterprise Architect also provides the ability to start, pause
and resume execution of a simulation, as well as set break
points and view Call Stacks or local variables. A number of
pre-defined model searches are also provided to assist with
locating model artifacts related to your simulations.

Panels
Panel

Description

Dynamic
Simulation

The 'Dynamic Simulation' panel brings
together a range of tools for working with
Behavioral Model simulations. It
provides access to a number of windows
that allow you to control a simulation, set
up simulation triggers and signals, set
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breakpoints, inspect local variables or
view the Call Stack. It also offers a
number of pre-defined model searches for
retrieving recently modified
StateMachines and Activity Graphs, and
enables you to apply the appropriate
Perspective and Work Space for the
simulation you are performing.
Executable
States
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Executable StateMachines provide a
means of rapidly generating, executing
and simulating complex state models. In
contrast to dynamic simulation of State
Charts using Enterprise Architect's
Simulation engine, Executable
StateMachines provide a complete
language-specific implementation that
can form the behavioral 'engine' for
multiple software products on multiple
platforms.
The 'Executable States' panel provides a
number of facilities for working with
Executable StateMachines. You can
access facilities to configure Analyzer
Scripts that determine how code is
generated, compiled and executed for the
Executable StateMachine. There are
commands for you to generate, build and
execute the code that runs the simulation,
as well as a facility to view the generated
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code in the built-in code editor.
Decision
Analysis

The 'Decision Analysis' panel helps you
to perform simulations of models created
under Enterprise Architect's
implementation of the Decision Modeling
and Notation (DMN) facility, developed
by the Object Modeling Group (OMG).
This facility enables you to open a DMN
Simulation and set up DMN Expressions,
and to locate and work from DMN
Configuration Artifacts.

Process
Analysis

The 'Process Analysis' panel provides
facilities to manage and run BPMN
simulation models, based on the BPSim
standard.

System
Behavior

The 'System Behavior' panel provides
access to the 'SysML Simulation
Configuration Manager' view, where you
can configure and manage SysML-based
simulations as well as access a
pre-defined search to retrieve SysML
Configuration Artifacts.

Console

The 'Console' panel provides options for
working on JavaScript code, and
specifically on the code for MATLAB
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and Octave Solvers.
Run
Simulation

(c) Sparx Systems 2022

The 'Run Simulation' panel provides a
number of buttons to control execution of
an active simulation, namely Start, Pause,
Step Over, Step In, Step Out and Stop.
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Dynamic Simulation Panel
The 'Dynamic Simulation' panel brings together a number of
tools for working with Behavioral Model simulations. It
provides access to a range of windows that allow you to
control a simulation, set up simulation triggers and signals,
set breakpoints, inspect local variables or view the Call
Stack. It also offers a number of pre-defined model searches
for retrieving recently modified StateMachines and Activity
Graphs, and enables you to apply the appropriate
Perspective and Work Space for the simulation you are
performing.

Available Facilities
Facility

Description

Simulator

Click on this icon to display a short menu
providing these options:
· Open Simulation Window - display the
Simulator control window, from which
you can manage, activate and control
simulations
· Find Simulations - opens the Start Page
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'Search in Project' tab with the
'Simulation > StateMachine Diagrams'
search loaded for execution (click on
the 'Run' arrow); you can change the
search to locate Activities, Executable
StateMachines, Interactions, BPSim
configurations and other objects related
to running simulations
Recent StateMachines - opens the Start
Page 'Search in Project' tab with the
'Simulation > Recent StateMachine
Diagrams' search executed
Recent Activity Graphs - opens the
Start Page 'Search in Project' tab with
the 'Simulation > Recent Activity
Diagrams' search executed
Apply Perspective - Displays the Start
Page 'Create from Pattern' tab (Model
Wizard), in which you select the
Perspective to apply model structures
appropriate to the simulations you
intend to perform
Apply Workspace - apply the
Simulation Workspace, which opens all
of the relevant windows (Simulation,
Simulation Events, Local Variables,
Call Stack and Execution Analyzer
windows) for Dynamic Simulation, and
arranges them around the screen for
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ease of use
· Help - display the Dynamic
Simulations Help topic.
In the searches you can specify the time
period (number of days prior to today)
from which to draw the results.
Events

Click on this icon to open the Simulation
Events window, to work with signals and
triggers that are used as input to the
currently active simulation.

Local
Variables

Click on this icon to display a list of
Local Variables and their values from the
current simulation. The simulation must
be halted at a break point in order to
display variables.

Call Stack

Click on this icon to display the Call
Stack for the current simulation.
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Executable States Panel
Executable StateMachines provide a valuable means of
rapidly generating, executing and simulating complex State
models. In contrast to dynamic simulation of State Charts
using Enterprise Architect's Simulation engine, Executable
StateMachines provide a complete language-specific
implementation that can form the behavioral 'engine' for
multiple software products on multiple platforms.
The 'Executable States' panel provides a number of facilities
for working with Executable StateMachines. You can access
facilities to configure Analyzer Scripts that determine how
code is generated, compiled and executed for the Executable
StateMachine. There are commands for you to generate,
build and execute the code that runs the simulation, as well
as a facility to view the generated code in the built-in code
editor.

Available Facilities
Facility

Description

Statemachine

Click on the drop-down arrow to display
a list of options for working with
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Executable StateMachine Artifacts to
configure, generate and run code-based
simulations.
· Generate, Build and Run - generate,
build and run the current Executable
StateMachine Artifact, according to the
Analyzer Script configuration
· Generate - generate the current
Executable StateMachine Artifact,
according to the Analyzer Script
configuration
· Build - build the current Executable
StateMachine Artifact, according to the
Analyzer Script configuration
· Run - start a simulation of the current
Executable StateMachine Artifact,
according to the Analyzer Script
configuration
· Find Executable Statemachines - run a
pre-defined search to locate all
Executable StateMachine Artifacts in
the model
· View Source - view the source code
generated for the current Executable
StateMachine Artifact
· Analyzer Scripts - display the
'Execution Analyzer' dialog, where you
can configure Analyzer Script options
for the current Executable
(c) Sparx Systems 2022
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StateMachine Artifact
Apply Perspective - apply the
Perspective for Executable
StateMachines to your modeling
environment; the Start Page 'Create
from Pattern' tab (Model Wizard)
displays, presenting the Executable
StateMachine Patterns
Apply Workspace - apply the
Simulation Workspace, which opens all
of the relevant windows (Execution
Analyzer, Simulation, Simulation
Events, Locals and Call Stack
windows) for Executable State
simulation, and arranges them around
the screen for ease of use
Help - display Help information about
Executable StateMachines
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Decision Analysis Panel
The 'Decision Analysis' panel helps you to perform
simulations of models created under Enterprise Architect's
implementation of the Decision Modeling and Notation
(DMN) facility, developed by the Object Modeling Group
(OMG). This facility enables you to open a DMN
Simulation, set up DMN Expressions and locate and work
from DMN Configuration Artifacts.

Available Facilities
Facility

Description

Open DMN
Simulation

Select this option to open the DMN
Simulation window, through which you
can create and edit
DMNSimConfiguration Artifacts, run a
DMN simulation and generate and test a
DMN Server.

DMN
Expression

Select this option to display the DMN
Expression window. The content of this
window depends on the DMN component
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you select in a diagram or the Browser
window. If you have not selected any
component, the window is blank.
Find DMN
Configuratio
n Artifacts

Select this option to immediately execute
a search for DMNSimConfiguration
Artifacts in the model. The results of the
search are listed on the Find in Project
window.

Apply
Perspective

Select this option to apply the Perspective
for DMN to your modeling environment.
The Model Wizard (Start Page 'Create
from Pattern' tab) displays, presenting the
DMN Patterns.

Apply
Workspace

Select this option to apply the DMN
Simulation Workspace, which opens the
relevant windows (DMN Simulation,
DMN Expression) for Decision Analysis
simulation, and arranges them around the
screen for ease of use

Help

Select this option to display the DMN
Decision Models Help topic.
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Process Analysis Panel
The 'Process Analysis' panel provides access to the
Configure BPSim window, and also a pre-defined search to
retrieve BPSim configuration Artifacts.

Available Facilities
Facility

Description

BPSIM

Click on the drop-down arrow to display
a short menu providing these options:
· Open BPSim Manager - display the
Configure BPSim window, through
which you can configure, execute and
analyze simulations of BPSim models
· Find BPSim Configuration Artifacts open the Start Page 'Search in Project'
tab and load a pre-defined set of search
parameters to find Business Process
Simulation configuration Artifacts
containing simulation parameters for
executing BPMN 2.0 simulations
· Apply Perspective - apply the
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Perspective for BPSim to your
modeling environment; the Start Page
'Create from Pattern' tab (Model
Wizard) displays, presenting the
BPSim Patterns
Apply Workspace - apply the Process
Analysis Simulation Workspace, which
opens all of the relevant windows
(Toolbox, Properties, Notes and
Configure BPSim windows) for
Process Analysis Simulation, and
arranges them around the screen for
ease of use
Help - display the BPSim Business
Simulations Help topic
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System Behavior Panel
The 'System Behavior' panel provides access to the
Configure SysML Simulation view, where you can
configure and manage SysML-based simulations as well as
access a pre-defined search to retrieve SysML Configuration
Artifacts.

Available Facilities
Facility

Description

Modelica/Si
mulink

Click on the drop-down arrow to access
the SysML Simulation configuration and
management view, or to access a
pre-defined model search that retrieves
SysML Configuration Artifacts.
· SysMLSim Configuration Manager display the Configure SysML
Simulation view to build and run
simulations using SysML and
OpenModelica or Simulink
· Find SysMLSim Configuration
Artifacts - open the Start Page 'Search
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in Project' tab and load a pre-defined
set of search parameters to find
SysMLSim Configuration Artifacts
Apply Perspective - apply the SysML
Perspective to your modeling
environment; the Model Wizard (Start
Page 'Create from Pattern' tab)
displays, presenting the SysML 1.5
Patterns, OpenModelica Case Studies
and SysPhS elements
Apply Workspace - apply the System
Behavior Simulation Workspace,
which opens all of the relevant
windows (Toolbox, Properties, Notes
and Configure SysML Simulation
windows) for System Behavior
Simulation, and arranges them around
the screen for ease of use
Help - display the (SysPhS Simulation)
Simulation Help topic
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Console Panel
The 'Console' panel provides options for working on
JavaScript code for Dynamic Simulation, and specifically on
the code for MATLAB and Octave Solvers in Mathematical
Simulation.

See the Model Simulation topics Dynamic Simulation with
JavaScript and Solvers.
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Run Simulation Panel
The 'Run Simulation' panel provides a number of buttons to
control execution of the active simulation.

Available Facilities
Facility

Description

Start

Begin or continue execution of the
currently active simulation.

Pause

Pause execution of the current simulation

Step Over

Step over a transition or a control path
that enters a different process or
StateMachine space

Step In

Step into a sub-process in the current
simulation

Step Out

Step out of a sub-process or sub-machine
state and return to the parent process or
StateMachine
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Halt execution of the current simulation
at the current execution point.
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Develop Ribbon
The 'Develop' ribbon collects together all the tools for
working with programming and database languages,
including tools to reverse engineer, forward engineer and
synchronize code and models. A system can be designed
from requirements through to visual models of the
components and code elements, and then generated to
programming or database code.

Panels
Panel

Description

Data
Modeling

The 'Data Modeling' panel provides
facilities for importing existing projects
from other tools, to create or add to an
Enterprise Architect project, and for
importing code files in a range of
programming languages into your model,
creating new model elements that
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represent the classes in those files.
Schema
Modeling

From the 'Schema Modeling' panel, you
can access facilities for importing XSD
files, WSDL files and DB Schema, and
for generating XSD and WSDL files from
your model. You can also edit XSL
Transformations, and edit and debug
language grammars.

Source Code

The 'Source Code' panel brings together a
number of facilities for working with
source code. Here, you can generate
source code from the model and
synchronize the model with updated
source code. You can also locate, open,
edit and merge source code files. Also
available are the:
· Execution Analyzer, in which you can
specify how the model is used to
generate a built product, including how
an application will be compiled,
debugged and simulated
· Grammar Editor window, an advanced
facility that allows you to view, add,
edit and manage language grammars,
used for importing source code, and
· Code Analyzer that allows code
metrics to be queried much faster than
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conventional methods
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Data Modeling Panel
The 'Data Modeling' panel provides facilities for importing
existing database projects from other tools, to create or add
to an Enterprise Architect project, and for importing
database schema and DDL files.

Available Facilities
Facility

Description

Database
Builder

Click on this icon to add, edit and
manage database models for a wide range
of DBMS products, using the Database
Builder.

Import

Click on this icon to display the 'Import
DB schema' dialog, through which you
can specify a database schema to import
from a target DBMS.

Generate

Click on this icon to display the 'Generate
DDL' dialog, from which you can export
the current model selection as DDL
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script, targeting a particular DBMS.
Templates

Click on this icon to display the 'DDL
Template Editor', in which you can edit
the templates used to create DDL scripts
for each DBMS.

Datatypes

Click on this icon to display the 'Database
Datatypes' dialog to add, modify and
delete database datatypes.
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Schema Modeling Panel
From the 'Schema Modeling' panel, you can access facilities
generating and importing DB Schema and for importing and
exporting XSD files and WSDL files from your model.

Available Facilities
Facility

Description

Schema
Composer

Click on the drop-down arrow to display
options for creating and managing
custom profiles for the generation of
industry-specific XSD files.
· Open Schema Composer - display the
Schema Composer view, which you
use to create Schema profiles and
generate XSD files from them
· Import for Schema Composer - import
a Schema Composer profile from an
external file, using the 'Schema
Importer' dialog
· Find Schema Composer Profiles execute a standard search to locate all
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·

Schema Composer profiles in the
project
Help - display the Schema Composer
Help topic

Edit

Displays an 'Open File' browser through
which you locate and select an
XSD/XML file to open in the Code
Editor window.

Import XSD

Click on this icon to display the 'Import
XML Schema' dialog for importing an
XSD file to a model Package; choose a
file to import and specify a range of
options to apply when importing the file

Import
WSDL

Click on this icon to display the 'Import
WSDL' dialog, where you can choose a
file to import into the selected Package

Export XSD

Click on this icon to display the 'Generate
XML Schema' dialog for generating the
current Package to an XSD file; specify a
path for the export file and specify a
range of options to apply when exporting
the Package

Export
WSDL

Click on this icon to generate either a
«WSDLnamespace» stereotyped Package
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or a «WSDL» stereotyped Component
(Document) to WSDL files
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Source Code Panel
The 'Source Code' panel brings together a number of
facilities for working with source code. Here you can import
existing source code files into your model, creating new
model elements that represent the classes in those files. You
can select a Class in your model, then click a button to open
the code editor window and automatically load the source
code file associated with that Class. Facilities are also
provided for:
· Issuing commands to generate source code from the
model
· Synchronizing the model from the source code
· Performing code analysis
· Accessing tools such as the Debugger, Profiler, Execution
Recorder and the Testpoints Window
· Working with language grammars
· Managing code templates and defining the way source
code is imported into and generated from your model

Available Facilities
Facility
(c) Sparx Systems 2022
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Create From
Pattern

Click on this icon to display the Patterns
window, through which you can generate:
· Starter projects including model
information, code and build scripts for
one of several basic application types
(on the 'Application Patterns' page)
· Examples of key sections of code to
generate Sequence diagrams, including
a Class model, build scripts and related
source code (from the 'VEA Examples'
page)

Edit

Click on this icon to open a file browser
through which you locate and open the
required code file to edit.

Behavior

Click on this icon to display the Source
Code editor, to create or edit Behavior
code for the operations in the selected
element, or in the parent of the selected
operation. You have three options:
· Edit Behavior
· Edit Internal Code
· Edit (or View) Source Code
All three options display the Code Editor
window, but show the appropriate
features, code and editing options for the
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type of code identified by the option.
Solutions

Click on the drop-down arrow to display
a list of options for importing project
code from certain popular development
products into the current project. For
example:
· Import a Visual Studio Solution
· Import a Mono Solution
· Import an Eclipse Project
· Import a Netbeans Project
Having imported the material, you can
perform a comparison between the
external project source code and the
Enterprise Architect model to check for
Class differences, using the 'Compare
with Model' option, and you can refresh
the Enterprise Architect model to update
it with any changes to the source.

Files

Click on the drop-down arrow to display
a list of options for importing code files
into the current model from a variety of
sources, selecting from a range of popular
coding languages.
· Edit New Source File - display the
Code Editor window as a 'New File'
document, enabling you to create and
populate a new code file of whatever
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type and format you require
· Import Directory - display the 'Import
Source Directory' dialog, through
which you import a complete directory
tree in one pass; language and other
options can be specified within the
dialog
· View Dry Run Log - If you have
performed a source directory import
with the 'Perform a Dry Run' option
selected, a log file of that dry run is
generated; this option displays that log
file
You can also import:
· ActionScript Files
· C Files
· C# Files
· C++ Files
· Delphi Files
· Java Files
· PHP Files
· Python Files
· Visual Basic Files
· VB .Net Files
· Binary File - supported file types are:
Java JAR files and .NET PE or IL
format (exe, dll)
(c) Sparx Systems 2022
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Windows .RC File (a Windows C/C++
.RC file), as a series of screen
definitions
If you have developed model structures
for any customized programming
language, those languages are also
included in the list.
·

Generate

Click on this icon to display options to
generate source code for:
· The currently selected model
element(s), or
· A single element, with options, or
· All elements in the current context
Source code is generated into the file that
is associated with each individual
element. Code is generated only for
elements that are of type Class or
Interface.

Synchronize

Click on this icon to display options to
synchronize the currently selected model
elements with their associated source
code files, or to synchronize the whole
Package containing the selected elements.

Options

Click on the drop-down arrow to display
a list of options for managing templates,
which determine the way source code is
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imported into and generated from your
model.
· Edit Code Templates - display the
Code Template Editor window, where
you can review and edit the templates
used for generating source code from
your model
· Set Package as Namespace Root - set
the selected Package as the Namespace
root, for code generation
· Suppress Namespace - ignore the
current subordinate Package when
generating Namespaces and showing
Package paths
· Configure Local Paths - display the
'Local Paths' dialog, where you can set
up and manage a list of Local Path
definitions, used for path substitutions
in collaborative environments
· Configure Code Engineering Datatypes
- manage the list of Datatypes that are
used in Code Engineering
· Define Preprocessor Macros - manage
a list of preprocessor macros that will
be used when C and C++ code is
imported into the model
· Reset Source Language - display the
'Manage Code Generation' dialog to
change the source language and other
(c) Sparx Systems 2022
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·

Execution
Analyzer
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generation options for all Classes in the
selected Package
Set Live Code Generation - update
your source code instantly as you make
changes to your model

Click the drop-down arrow to access a
menu of Analyzer tools.
· Edit Analyzer Scripts - display the
Execution Analyzer window, where
you can create and manage scripts that
define the build, run, test, deploy and
simulate functions for the current
Package
· Edit Active Script - display the
Analyzer script editor to edit the
currently-active Analyzer script
· Show Testpoints Window - display the
Analyzer Test Points window, to
configure, execute and work with
dynamic test suits and test cases
· Find Test Suites and Test Sets - search
the model for Test Suites and Test Sets
· Open Debugger - display the Analyzer
Debug window to facilitate debugging
and testing of the current application
· Open Profiler - display the Analyzer
Profiler window, from which you can
Page 308 of 1150

The Application Desktop

3 October, 2022

·

·

perform application performance
profiling and execution inspection of
the current application
Open Recorder - display the Analyzer
Recording window, from which you
can set recording points, record
program execution and create diagrams
based on recordings
Open Object Workbench - open a
simple Object Testing window, from
which you can make ad hoc calls on
Object methods; available for Java and
.NET objects

Grammar
Editor

Display the Grammar Editor window, an
advanced facility that allows you to view,
add, edit and manage language
grammars, used for importing source
code.

Code
Analyzer

The Code Analyzer can perform very
complex queries on source code
repositories at lightning speed either
locally or on a Sparx Intel Cloud service,
allowing code metrics to be queried much
faster than conventional methods.
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Settings Ribbon
The 'Settings' ribbon is used for managing the way a
repository is used, from setting up reference data, security
and Version Control to audits and integrity checks.
Enterprise Architect is a flexible platform and can be
configured to suit any enterprise, business or technical team.

Panels
Panel

Description

Security

The 'Security' panel collects together a set
of facilities for using and managing
security in the model. Security helps
teams collaborate by allowing individuals
to intentionally signal that they are
working on a part of the model.

Model

The 'Model' panel provides facilities to
configure options for the current model,
to check and repair the integrity of the
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model database, to transfer project data
from one database to another and to
configure auditing settings for recording
changes to the model database.
Reference
Data

The 'Reference Data' panel is used to set
up and manage the metadata for a model.
Reference Data is typically created when
the model is initiated, but some of this
data such as Resources and Images will
be added to as the model evolves. There
is a wide range of options, from setting
up auto naming counters for elements,
creating Stereotypes, Tagged Value
Types and Cardinalities, to setting up
people, Status, Priority and much more.
Resources store a wide range of
additional model content such as
Templates, Profiles, Patterns and
Relationship Matrices. Images can be
saved in the model and used to replace
the conventional geometric
representations with descriptive and
compelling images that resonate with
non-technical audiences.

Version
Control

The 'Version Control' panel is used for
working with the Version Control facility
in the tool, allowing you to manage
changes and versions of model content
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for individual Packages or the entire
model. Version Control Configurations
can be defined using the 'Project-VC' or
'Package-VC' options, and checked for all
versioned Packages using the 'Check
Configuration' option. There is a range of
options to view the history of changes
and to revert the model to a previous
version if desired. There are also options
to work offline and to compare the status
reported by the model and the Version
Control provider.
User Tools

(c) Sparx Systems 2022

The 'User Tools' panel provides access to
a series of external tools useful to you
while working on the model. Windows
Explorer can be useful when working
with importing and exporting content
from the model, including CSV files for
exchange with a spreadsheet tool, XML
Schema files, Database and Source code
files and the generation of
Documentation. Open Database
Connectivity (ODBC) settings can be
accessed to assist when working with live
databases, and system information can be
viewed.
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Security Panel
When Security is enabled on a project, users are required to
provide a User ID and password to login to that project.
Project Security helps teams to collaborate by allowing
individuals or groups to intentionally signal that they are
working on specific parts of the model.

Available Facilities
The 'Security' panel collects together a set of facilities for
managing security in the model, such as enabling Project
Security, specifying which security mode to use, defining
the lists of authorized users and user groups, and assigning
permissions to users and groups to grant access to various
aspects of Enterprise Architect's functionality.
Facility

Description

Administer

Click on the drop-down arrow to display
a selection of commands for configuring
security in the model.
· Apply Locks to Connectors - extends
all locks on source elements to the
connectors owned by those elements,
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·

·

My Account
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so that those connectors cannot be
deleted and their properties cannot be
edited; new connectors cannot be
created on those elements
Require User Lock to Edit - enables
'pessimistic' locking on the current
project; in this mode, users must apply
a personal lock to model elements and
diagrams before any modifications can
be made
Group Workflow - select to set up the
workflow from one status to another,
for each security group
Enable Security - toggles (either enable
or disable) the state of Project Security
for the current project; you are
prompted to supply an Authorization
Key before the security state is changed
Show User Avatars - displays (or, if
unselected, hides) all user avatars in
Chat and Discussion entries, in your
work sessions

Click on the drop-down arrow to display
a selection of commands for configuring
security on your user ID.
· Manage My Locks - displays a dialog
that lists all locks you have applied
under your user ID; you can review and
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release locks using this dialog
· Remember Me - when set, this stores
your credentials and applies them
automatically each time you log in
· Change Password - displays the
'Change Password' dialog in which you
can change the password for your own,
currently logged in, user ID
· Set Avatar - assigns an avatar image
(from a selected Image Asset Artifact)
to your user ID
· Hide OpenID login window - displays
(unselected) or hides (selected) the
'OpenID Authentication' dialog; also
resets the 'Don't show this window
again' checkbox on the 'OpenID
Authentication' dialog
· Login as Another User - displays the
login dialog to enable you to log in to
the Enterprise Architect project as
another user
(Some of these options are also available
from the <user name> drop-down in the
top right corner of the Enterprise
Architect screen.)
Users
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This command displays the 'Security
Users' dialog, where new users can be
defined and permissions can be granted to
Page 316 of 1150

The Application Desktop

3 October, 2022

those users. Users can be added to
existing User Groups. The dialog also
provides for import of user definitions
from Windows Active Directory lists.
Groups

This command displays the 'Security
Groups' dialog, where new User Groups
can be created and users can be added to
those groups. Permissions can be granted
to User Groups using this dialog.

Locks

This command displays the 'Manage
Locks' dialog. The dialog shows a list of
all elements and diagrams within the
model that have active locks. You can
also filter to show only items with User
Locks or Group Locks. The list of items
can be sorted by lock type, item name,
locking user, locking group, or the time
of lock application. The dialog can be
used to select some or all of the locked
items, and then to unlock the selected
items.
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Model Panel
The 'Model' panel provides facilities to configure options for
the current model, to check and repair the integrity of the
model database, to transfer project data from one database to
another and to configure auditing settings for recording
changes to the model database.

Available Facilities
Facility

Description

Options

Displays the 'Manage Model Options'
dialog, through which you configure
options for the current model, including
required and restricted MDG
Technologies, code generation and
general options.

Auditing

Opens the Audit View to configure and
view audit management information for
the current model.

Integrity

Occurrences such as network crashes or
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failed XMI imports can sometimes
compromise the integrity of information
in the model database. Clicking on the
'Integrity' drop-down arrow displays a list
of commands for addressing these kinds
of issue and for general database
maintenance.
· Project Integrity - displays the 'Project
Integrity Check' dialog; used for
examining database records to check
for 'orphaned' records or inaccurate or
unset identifiers
· Project Compare - displays the 'Project
Compare' dialog, with which you can
compare one model database against
another, at a table record level
· Manage .EAPX/.EAP File - clicking on
this item displays a pop-up menu with
these options:
- Repair .EAPX/.EAP File - use this
option to repair a .EAPX or .EAP file
that has become damaged due to
system or network outages
- Compact .EAPX/.EAP File removes deleted records from the
database tables
- Update .EAPX/.EAP File Indexes
- updates the selected .EAPX or .EAP
file to the latest set of indexes (schema
(c) Sparx Systems 2022
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Transfer
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1558)
Manage Firebird
- Update Index Statistics - optimize
indexes on Firebird databases
Run Patch - displays the 'Run Patch'
dialog, which provides a means to run
patches that could be provided by
Sparx Systems, to update the database
structure of the current model

Clicking on the drop-down arrow
displays a menu of facilities for copying
or sharing project data between one
project and another.
· Full Project Transfer via Connection display the 'Project Transfer' dialog;
use this dialog to copy the tables and
records of one project database to
another
· Full Project Transfer via Native XML export or import a complete project in
the native XML format
· Migrate EAP/EAPX Project to QEA migrate a complete project from an
EAP or EAPX file to another
repository
· Copy QEA Project to Firebird (FEAP)
- copy the project data from a .qea file
(in Enterprise Architect release 16.0
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upwards) to a legacy .FEAP file (for
use in Release 15.2 or earlier)
Perform project file replication work
on either a .eap project file or a .qea
project file:
- Make Design Master - prepare a
.EAPX/.EAP file or a .QEA file for the
creation of database replicas
- Create New Replica - create
database replicas from the Design
Master file
- Synchronize Replicas - merge the
changes made to each replica with the
Design Master
- Remove Replication - remove
from the database the additional
information that is required for
managing database replication
- Resolve Replication Conflicts where two users have made conflicting
changes to the model database,
manually decide which change will
override the other (not for QEA
Replication)
Shared Repository - set up a shared
repository for basic reference data to be
shared between multiple
implementation models
Export Reference Data - display the
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'Export Reference Data' dialog; used to
select specific types of Reference Data
for export to an XML file
Import Reference Data - display the
'Import Reference Data' dialog; used to
import Reference Data from an XML
file into the current model
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Reference Data Panel
The 'Reference Data' panel is used to set up and manage the
metadata for a model. Reference data such as Resources and
Images is generally added as the model evolves. A wide
range of additional model content such as Templates,
Profiles, Patterns and Relationship Matrices can be stored as
Resources. Images can be saved in the model and used as
alternatives to the conventional geometric representations of
elements, to appeal to non-technical audiences.

Available Facilities
Facility

Description

Settings

Click on the drop down arrow to display
a menu of options for setting a wide
range of project-level parameters.
· Auto Names and Counters - set up and
manage the use of automatic name
generation
· Project Template Package - specify a
Package that holds diagrams and
elements that will be used as templates
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for all new elements
Database Datatypes - manage the list of
Datatypes that are used in Database
Engineering
Namespace Roots - manage a list of
Namespace roots for the current model;
used mainly for code generation
Coding Datatypes - manage the list of
Datatypes that are used in Code
Engineering
Preprocessor Macros - manage a list of
preprocessor macros that will be used
when C and C++ code is imported into
the model
Colors - provides options to define and
manage a set of standard colors for use
in the current project
- Get Project Custom Colors
- Set Project Custom Colors

UML Types

Displays the 'UML Types' dialog, from
which you can manage basic model
information, such as Stereotypes, Tagged
Value types and Cardinality settings.

Model Types

Provides a range of facilities for
managing various Types of reference data
used in a project.
· People - manage the list of people
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associated with the model, including
authors, resources, roles and clients
General Types - manage project
factors, such as Status types,
Constraints, Difficulty and Priority
Project Indicators - configure indicators
such as Metric, Risk and Effort types
Maintenance - define and manage Test
types
Estimation Factors - set up and manage
a list of estimation factors used for Use
Case Estimation

Resources

Click on this icon to display the
'Resources' tab of the Browser window,
from which you can manage a variety of
custom resources, model Patterns,
templates and technologies.

Images

Click on this icon to display the 'Image
Manager' dialog. The Image Manager
provides facilities for storing images in
the current model, that can then be used
as alternatives to the standard geometric
shapes normally used to represent
elements on your model diagrams. Stored
images can be previewed, renamed and
updated using this facility.
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Version Control Panel
The 'Version Control' panel provides facilities for
configuring and managing the Version Control facility in the
tool. Version Control Configurations can be defined using
the 'Project-VC' option and validated for all versioned
Packages using the 'Check Configuration' option. There are
options to work offline and also to compare the status
recorded in the model against that reported by the Version
Control provider.

Available Facilities
Facility

Description

Project-VC

Displays the 'Version Control Settings'
dialog, in which you can define new
Version Control Configurations, or
re-specify the Working Copy Folder of an
existing Version Control Configuration.

Package-VC

Configure a single Package for Version
Control. Display the 'Package Control
Options' dialog to specify the Version
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Control Configuration and the name of
the file to use in controlling the selected
Package.
Work Offline

Toggles Version Control in and out of
'Offline' mode. The 'Offline' mode allows
modelers to work with Version
Controlled Packages, even when there is
no connection to the Version Control
server. Packages can be 'checked-out'
offline and modified, but can only be
'checked-in' once a connection to the
Version Control server has been
re-established.

Re-Synch
Status

Query the Version Control server to
retrieve the check-out status of the file
associated with each of the Version
Controlled Packages in the current
project. Where it is necessary and
appropriate to do so, the status of the
Package is updated in the project
database to match the status reported by
the Version Control system. For example,
if a Package is marked in the project
database as checked-out to the current
user, but the Version Control server
reports the associated file as not
checked-out, then the Package flags will
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be updated to show 'not checked-out'.
Check
Configuratio
n
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This command scans all Version
Controlled Packages within a project,
checking the validity of the Version
Control settings for each Package. The
validation process scans the model
database and verifies that the Version
Control Configuration associated with
each Version Controlled Package is fully
specified in the current model. It also
queries the corresponding Version
Control provider to find the status of the
Package file associated with each Version
Controlled Package. The results of the
validation process are sent to the System
Output window.
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User Tools Panel
The 'User Tools' panel provides access to external tools. A
pre-defined selection of tools includes Windows Explorer,
ODBC Data Sources and System Information. You can
extend this list with any other tools of your choice.

Available Facilities
Which user tools appear in the list depends on what has
been configured on your workstation. For example, you
might add 'WINE Console' for the purpose of setting up
Subversion clients for Enterprise Architect under WINE.
Facility

Description

Windows
Explorer

Launches 'Windows Explorer'.

ODBC Data
Sources

Launches the 'ODBC Data Source
Administrator' dialog, from which you
can set up ODBC drivers for various
DBMSs, thereby enabling Enterprise
Architect to connect to repositories
hosted in the selected DBMS.
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Displays System Information pertaining
to your personal workstation.
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Construct Ribbon
The 'Construct' ribbon presents the tools and facilities for
visualizing and managing the tasks and the resources needed
to construct a system, from the allocation of human
resources to tasks, to the Kanban boards and Gantt chart for
visualizing the progress of work done. Teams can
collaborate directly in the tool and manage a wide range of
variations to model elements - including Issues and Defects
- and tests can be defined and results recorded.

Panels
Panel
Resource
Management
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Description
The 'Resource Management' panel is a
collection of tools for managing human
resources and their allocation to elements
that represent tasks to be completed.
Kanban diagrams can be used to visualize
boards of elements and Gantt charts show
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the duration of assigned tasks and other
important views. The Resource
Allocation window is used to assign
resources to elements representing work
to be done. There are several searches
that list a variety of useful views, such as
Overdue Tasks, Tasks Starting Today,
and more.
Test
Management

The 'Test Management' panel is used for
creating and managing all aspects of
testing. The Test Cases window
conveniently collects all the tests for an
element, and allows new tests to be
created and existing ones to be managed.
The tests can be fully described and
Inputs, Acceptance Criteria, Results,
Status and more can be defined for each
test. There are several predefined
searches that can be run to find recent test
results, such as recent tests that have
passed. A configurable Test Report can
also be generated, creating a single
document that describes all tests or any
combination of tests.

Change
Management

The 'Change Management' panel is used
for define and record important items that
apply to an element. Enterprise Architect
is a platform for managing any initiative
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and can keep track of variations in the life
time of any element. Regardless of the
methods or processes that are being used,
elements such as Requirements, User
Stories, Business Rules, Components and
others will change, have issues, require
tasks and have defects. All of these
variations can be created and managed
and a series of useful searches are
conveniently made available to find items
such as recently requested changes,
incomplete tasks and many more.
Project
Management
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The 'Project Management' panel provides
facilities for managing project-level items
such as issues, events, tasks and
decisions, for defining project risks, effort
and metrics, and for obtaining an
overview of the project status, including
Quality Assurance reports and project
statistics.
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Resource Management Panel
The 'Resource Management' panel is a collection of tools for
managing human resources and their allocation to elements
that represent tasks to be completed. Kanban diagrams can
be used to visualize boards of elements, and a Gantt chart
shows the duration of assigned tasks and other important
views. The Allocation window is used to assign resources to
elements representing work to be done. There are several
searches that list a variety of useful views, such as Overdue
Tasks, Tasks Starting Today, and more.

Available Facilities
Facility

Description

Kanban

Click on the drop-down arrow to display
a list of options for using Kanban
diagrams to effectively manage tasks and
work assignments necessary to construct
the model and its deployable artifacts.
· Find Kanban Diagrams - open the 'Find
in Project' tab containing an executed
search for finding Kanban diagrams in
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the model; double-click on an entry to
open that Kanban diagram
Open My Kanban - if a Kanban
diagram has been set up with your
work assignments and tasks, open that
diagram
Manage - (for user settings) provides
these options:
- Set Current as Default - set the
currently-open Kanban diagram as your
user default
- Choose Default - display a
browser through which you locate and
select a Kanban
diagram to be your user default
(you can also select <none> to clear the
setting)
- Clear - clear the setting of the user
default Kanban so that there is no user
Kanban defined
Open Project Kanban - if a Kanban
diagram has been set up with the work
assignments and tasks for the overall
project, open that diagram
Manage - (for model settings) provides
these options:
- Set Current as Default - set the
currently-open Kanban diagram as the
Model
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or Project Kanban diagram
- Choose Default - display a
browser through which you locate and
select a
Kanban diagram to be your
Model or Project Kanban diagram (you
can also
select <none> to clear the setting)
- Clear - clear the setting of the
model default Kanban so that there is
no model
Kanban defined
New Standard Kanban - create a new
standard Kanban diagram to contain
active work assignments and tasks,
which you can customize as required
New Backlog Kanban - create a new
Kanban diagram to contain work
assignments and tasks that have not yet
been allocated to a resource
New Iteration Kanban - create a new
Kanban diagram to contain active work
assignments and tasks associated with
the current iteration or sprint
New Complete Kanban - create a new
Kanban diagram to contain work
assignments and tasks that have been
completed and are processing through
to deployment and maintenance
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One Stage Workflow - create a
single-stage Kanban workflow diagram
from a Pattern
Two Stage Workflow - create a
two-stage Kanban workflow diagram
from a Pattern, including a Backlog
Kanban and an Iteration Kanban
Three Stage Workflow - create a
three-stage Kanban workflow diagram
from a Pattern, including a Backlog
Kanban, an Iteration Kanban and a
Complete Kanban

Resources

Click on this icon to display the Resource
Allocation window to assign resources to
Task, Issue, Change and other
project-level elements.

Gantt

Click on this icon to list options to
display:
· Your personal Gantt view, showing the
breakdown of work specifically
assigned to you
· The Project Gantt View, to review the
breakdown of work for the project and
for specific sections of the project; the
display defaults to the 'Resource View'
tab, but you can also select the
'Element View' and 'Report View' tabs
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Active

Click on this icon to display a short menu
of options for searching for and charting
tasks within the model.
· Active Tasks - open the Find in Project
view and execute a pre-loaded search
for Active tasks; click on an item to
display the resource allocation details
in the 'Assigned Resources' dialog
· Chart of Active Tasks - create a Chart
within the selected open diagram
showing the currently active tasks
· Tasks Ending Today - open the Find in
Project view and execute a pre-loaded
search for tasks scheduled to complete
today
· Tasks Starting Today - open the Find in
Project view and execute a pre-loaded
search for tasks scheduled to begin
today
· Overdue Tasks - open the Find in
Project view and execute a pre-loaded
search for tasks that are now overdue
· Chart of Overdue Tasks - create a
Chart within the selected open diagram
showing the currently overdue tasks

Completed

Click on this icon to display a short menu
of options for searching for and charting
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completed tasks within the model.
· Recently Completed - open the Find in
Project view and execute a pre-loaded
search for recently-completed tasks;
click on an item to display the resource
allocation details in the 'Assigned
Resources' dialog
· Chart of Completed Tasks - create a
Chart within the currently-active
diagram showing the
recently-completed tasks
· Chart for Time Period - create a Chart
within the currently-active diagram
showing the tasks completed during a
defined period
· All Completed - open the Find in
Project view and execute a pre-loaded
search for all tasks completed within
the lifetime of the project
Summary
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Click on this icon to display a menu of
options for searching for and charting the
deployment of resources over various
periods of time.
· 30 Day Task Summary (Brief) provide a brief summary of the tasks
performed by resources over the
previous month
· 30 Day Task Summary (Full) - provide
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a full summary of the tasks performed
by resources over the previous month
30 Day Resources - search the project
for tasks that have started in the last 30
days where the resource name matches
(fully or partially) the text in the
<Search Term>
30 Day Roles - search the project for
tasks that have started in the last 30
days where the role name matches
(fully or partially) the text in the
<Search Term>
30 days grouped by resource (Chart) create a chart within the
currently-active diagram showing the
tasks started during the last month,
grouped by resource
30 Day Task Summary (Chart) - create
a chart within the currently-active
diagram showing the tasks started
during the last month
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Test Management Panel
The 'Test Management' panel is used for creating and
managing all aspects of testing. The Test Cases window
conveniently collects all the tests for an element, and allows
new tests to be created and existing ones to be managed.
The tests can be fully described and Inputs, Acceptance
Criteria, Results, Status and more can be defined for each
test. There are several predefined searches that can be run to
find recent test results, such as the recent tests that have
passed. A configurable Test Report can also be generated,
creating a single document that describes all tests or any
combination of tests.

Available Facilities
Facility

Description

Tests

Click on this icon to display a menu of
types of Test that you can define for the
current element, using the Test Cases
window.
· All - display the Test Cases window
listing tests of any class; you might
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Outcomes
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select this option if you are developing
a test but not yet certain of what type it
should be, or if you are creating a suite
of tests of different types
Inspection - display the Test Cases
window set to work on Inspection tests
Unit - display the Test Cases window
set to work on Unit tests
Integration - display the Test Cases
window set to work on Integration tests
System - display the Test Cases
window set to work on System tests
Acceptance - display the Test Cases
window set to work on Acceptance
tests
Scenario - display the Test Cases
window set to work on Scenario tests

Click on this icon to display a list of
options for generating reports on
recently-performed tests, and to represent
the results of those tests in various forms
of chart.
· Recent Test Results - open the Find in
Project view and execute a pre-loaded
search for tests that have been run
within the last 7 days
· Tests on Recently Modified Elements Page 343 of 1150
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open the Find in Project view and
execute a pre-loaded search for tests
that have defined for recently-modified
elements (defaulting to modification
within the last 7 days)
Add Pie Chart - generate, in the
currently-open diagram, a Pie Chart of
the test status statistics from the last
seven days, per status type
Add Bar Chart - generate, in the
currently-open diagram, a vertical Bar
Chart of the test status statistics from
the last seven days, per status type
Test Results from last week - generate,
in the current diagram, a horizontal,
stacked Bar Chart showing the test
status statistics for each day of the last
week
Test Results from last 30 days generate, in the currently-open
diagram, a horizontal, stacked Bar
Chart showing the test status statistics
for each day of the last 30 days, the
most recent date being at the bottom of
the chart
Test Results weekly summary generate, in the currently-open
diagram, a horizontal, stacked Bar
Chart showing the test status statistics
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for each week of the current year
Recent Test Passes - open the Find in
Project view and execute a pre-loaded
search for tests that have been given a
Pass status within the last 7 days
Recent Test Failures - open the Find in
Project view and execute a pre-loaded
search for tests that have been given a
Fail status within the last 7 days
Recently Deferred Tests - open the
Find in Project view and execute a
pre-loaded search for tests that have
been given a Deferred status within the
last 7 days
Report - Click on this icon to display
the 'Generate Test Documentation'
dialog, which you use to generate a
report on the test records of one or
more test types lodged against the
elements of the current Package.

Not Run

Click on this icon to open the Find in
Project view and execute a pre-loaded
search for tests that are currently open but
have not been run within the last 7 days.

Not Checked

Click on this icon to open the Find in
Project view and execute a pre-loaded
search for tests that are currently open but
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have not been checked within the last 7
days.
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Change Management Panel
The 'Change Management' panel is used for describing
important model management items that apply to an
element. Enterprise Architect is a platform for managing
any initiative and can keep track of variations in the life
time of any element. Regardless of the methods or processes
that are being used, elements such as Requirements, User
Stories, Business Rules and Components will change, have
issues, require tasks and have defects. All of these variations
can be recorded and managed, and a series of useful
searches are conveniently made available to find items such
as recently requested changes and incomplete tasks.

Available Facilities
Facility

Description

Maintenance

Click on this icon to display the
Maintenance Overview tab of the
Maintenance window, listing all the
current Maintenance items on the
selected element.
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Click on the drop-down arrow to display
a menu of options for performing
searches manage and visualize records of
features against elements in the model.
· Show Features Window - display the
Features window, which you use to
record and manage specific features of
the selected element
· New Features - open the Find in
Project view and execute a pre-loaded
search for elements that have new
Feature items
· Last Week - open the Find in Project
view and execute a pre-loaded search
for elements having Feature items that
have been recorded within the last 7
days
· Last Month - open the Find in Project
view and execute a pre-loaded search
for elements having Feature items that
have been recorded within the last 30
days
· Last 90 days - open the Find in Project
view and execute a pre-loaded search
for elements having Feature items that
have been recorded within the last 90
days
· Recently Completed Features - open
the Find in Project view and execute a
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Changes
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pre-loaded search for elements having
Change items that have been completed
within the last 7 days
Incomplete Features - open the Find in
Project view and execute a pre-loaded
search for Feature items that have not
been completed

Click on the drop-down arrow to display
a menu of options for performing
searches and generating charts to manage
and visualize changes to elements in the
model.
· Show Changes Window - display the
Changes window, which you use to
record and manage specific requests for
changes to the selected element
· New Changes - open the Find in
Project view and execute a pre-loaded
search for elements that have new
Change items
· Last Week - open the Find in Project
view and execute a pre-loaded search
for elements having Change items that
have been recorded within the last 7
days
· Last Month - open the Find in Project
view and execute a pre-loaded search
for elements having Change items that
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Documents
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have been recorded within the last 30
days
Last 90 days - open the Find in Project
view and execute a pre-loaded search
for elements having Change items that
have been recorded within the last 90
days
Chart Requested Changes - create a
chart in the currently-open diagram,
showing recently-requested changes
Recently Completed Changes - open
the Find in Project view and execute a
pre-loaded search for elements having
Change items that have been completed
within the last 7 days
Chart Completed Changes - create a
chart in the currently-open diagram,
showing recently-completed changes
Incomplete Changes - open the Find in
Project view and execute a pre-loaded
search for Change items that have not
been completed

Click on the drop-down arrow to display
a menu of options for performing
searches to manage and visualize records
of documents opened against elements in
the model.
· Show Documents Window - display
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the Documents window, which you use
to record and manage specific
documents of the selected element
New Documents - open the Find in
Project view and execute a pre-loaded
search for elements that have new
document items
Last Week - open the Find in Project
view and execute a pre-loaded search
for elements having document items
that have been recorded within the last
7 days
Last Month - open the Find in Project
view and execute a pre-loaded search
for elements having document items
that have been recorded within the last
30 days
Last 90 days - open the Find in Project
view and execute a pre-loaded search
for elements having document items
that have been recorded within the last
90 days
Recently Requested Documents - open
the Find in Project view and execute a
pre-loaded search for elements having
document items that have been
requested within the last 7 days
Recently Completed Documents - open
the Find in Project view and execute a
Page 351 of 1150

The Application Desktop

3 October, 2022

·

Issues

(c) Sparx Systems 2022

pre-loaded search for elements having
document items that have been
completed within the last 7 days
Incomplete Documents - open the Find
in Project view and execute a
pre-loaded search for Document items
that have not been completed

Click on the drop-down arrow to display
a menu of options for performing
searches and generating charts to manage
and visualize records of issues raised
against elements in the model.
· Show Issues Window - display the
Issues window, which you use to
record and manage specific reports of
issues with the selected element
· New Issues - open the Find in Project
view and execute a pre-loaded search
for elements that have new Issue items
· Last Week - open the Find in Project
view and execute a pre-loaded search
for elements having Issue items that
have been recorded within the last 7
days
· Last Month - open the Find in Project
view and execute a pre-loaded search
for elements having Issue items that
have been recorded within the last 30
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Defects
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days
Last 90 days - open the Find in Project
view and execute a pre-loaded search
for elements having Issue items that
have been recorded within the last 90
days
Recently Reported Issues - open the
Find in Project view and execute a
pre-loaded search for elements having
Issue items that have been recorded
within the last 7 days
Chart Reported Issues - create a chart
in the currently-open diagram, showing
recently-reported Issue items
Recently Resolved Issues - open the
Find in Project view and execute a
pre-loaded search for elements having
Issue items that have been resolved
within the last 7 days
Chart Resolved Issues - create a chart
in the currently-open diagram, showing
recently-resolved Issue items
Unresolved Issues - open the Find in
Project view and execute a pre-loaded
search for Issue items that have not
been resolved

Click on the drop-down arrow to display
a menu of options for performing
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searches and generating charts to manage
and visualize records of defects raised
against elements in the model.
· Show Defects Window - display the
Defects window, which you use to
record and manage specific reports of
defects in the selected element
· New Defects - open the Find in Project
view and execute a pre-loaded search
for elements that have new Defect
items
· Last Week - open the Find in Project
view and execute a pre-loaded search
for elements having defect items that
have been recorded within the last 7
days
· Last Month - open the Find in Project
view and execute a pre-loaded search
for elements having defect items that
have been recorded within the last 30
days
· Last 90 days - open the Find in Project
view and execute a pre-loaded search
for elements having defect items that
have been recorded within the last 90
days
· Recently Reported Defects - open the
Find in Project view and execute a
pre-loaded search for elements having
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Defect items that have been recorded
within the last 7 days
Chart Reported Defects - create a chart
in the currently-open diagram, showing
recently-reported Defect items
Recently Resolved Defects - open the
Find in Project view and execute a
pre-loaded search for elements having
Defect items that have been resolved
within the last 7 days
Chart Resolved Defects - create a chart
in the currently-open diagram, showing
recently-resolved Defect items
Unresolved Defects - open the Find in
Project view and execute a pre-loaded
search for Defect items that have not
been resolved

Click on the drop-down arrow to display
a menu of options for performing
searches and generating charts to manage
and visualize records of tasks opened
against elements in the model.
· Show Tasks Window - display the
Tasks window, which you use to record
and manage specific reports of tasks
opened against the selected element
· New Tasks - open the Find in Project
view and execute a pre-loaded search
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for elements that have new tasks
Last Week - open the Find in Project
view and execute a pre-loaded search
for elements having task items that
have been recorded within the last 7
days
Last Month - open the Find in Project
view and execute a pre-loaded search
for elements having task items that
have been recorded within the last 30
days
Last 90 days - open the Find in Project
view and execute a pre-loaded search
for elements having task items that
have been recorded within the last 90
days
Recently Requested Tasks - open the
Find in Project view and execute a
pre-loaded search for elements having
tasks that have been recorded within
the last 7 days
Chart Requested Tasks - create a chart
in the currently-open diagram, showing
recently-requested tasks
Recently Completed Tasks - open the
Find in Project view and execute a
pre-loaded search for elements having
tasks that have been completed within
the last 7 days
Page 356 of 1150

The Application Desktop

3 October, 2022
·

·

(c) Sparx Systems 2022

Chart Completed Tasks - create a chart
in the currently-open diagram, showing
recently-completed tasks
Incomplete Tasks - open the Find in
Project view and execute a pre-loaded
search for tasks that have not been
completed

Page 357 of 1150

The Application Desktop

3 October, 2022

Project Management Panel
The 'Project Management' panel provides facilities for
managing project-level items such as issues, events, tasks
and decision, for defining project risks, effort and metrics,
and for obtaining an overview of the project status,
including Quality Assurance reports and project statistics.

Available Facilities
Facility

Description

Decisions

Click on the drop-down arrow to display
a menu of options for performing
searches and generating charts to manage
and visualize records of decisions
associated with elements in the model.
· Show Decisions Window - display the
Decisions window, which you use to
record and manage specific records of
decisions associated with the selected
element
· Verified Decisions - open the Find in
Project view and execute a pre-loaded
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search for elements having decisions
with the status 'Verified'
New Decisions - open the Find in
Project view and execute a pre-loaded
search for elements that have new
decisions
Recently Created Decisions - open the
Find in Project view and execute a
pre-loaded search for elements having
decisions that have been recorded
within the last 7 days
Chart Created Decisions - create a chart
in the currently-open diagram, showing
recently-created decisions
Recently Effective Decisions - open the
Find in Project view and execute a
pre-loaded search for elements having
decisions for which the Effective date
has passed within the last 7 days (that
is, the decision has become effective)
Chart Effective Decisions - create a
chart in the currently-open diagram,
showing recently-effective decisions
Decisions with no Effective date - open
the Find in Project view and execute a
pre-loaded search for elements that
have no Effective date recorded

Click on the drop-down arrow to display
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a menu of options for performing
searches and generating charts to manage
and visualize records of events reported
against elements in the model.
· Show Events Window - display the
Events window, which you use to
record and manage specific reports of
events lodged against the selected
element
· High Priority Events - open the Find in
Project view and execute a pre-loaded
search for elements that have events
with the status High Priority
· Recently Reported Events - open the
Find in Project view and execute a
pre-loaded search for elements having
events that have been reported within
the last 7 days
· Chart Reported Events - create a chart
in the currently-open diagram, showing
recently-reported events
· Recently Completed Events - open the
Find in Project view and execute a
pre-loaded search for elements having
events that have been marked as
complete within the last 7 days
· Chart Completed Events - create a
chart in the currently-open diagram,
showing events that were recently
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marked as complete
Open Events - open the Find in Project
view and execute a pre-loaded search
for events that are currently open

Issues-Tasks

Click on the drop-down arrow to display
two menu options:
· Project Tasks - select this option to
display the Project Tasks window,
which provides a convenient 'To Do'
list of major project work items that are
not recorded elsewhere; it can be used
to track events such as requests or
corrections
· Project Issues - select this option to
display the Project Issues window, on
which you can record any identified
issues against the current project

QA Report

Click on this icon to display two options;
the first is to display the QA Reports
view, which has separate tabs that enable
you to run and display these
system-provided status reports:
· Testing Details
· Maintenance Details
· Dependency Details
· Implementation Details
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Use Case Metrics
The second option is to display the
'Project Statistics' sheet, which lists the
numbers of Packages, diagrams,
elements, connectors, elements of each
type and element features of each type in
the project. For certain items, such as
element risks, metrics and effort, if there
are no instances of that particular object
type it is still listed but with a count of 0.
·

Risks

Click on this icon to display the Risks
window, on which you create and
maintain records of Risks to the work on
the selected element.

Metrics

Click on this icon to display the Metrics
window, on which you create and
maintain records of metrics that have an
influence on the work on an element.

Effort

Click on this icon to open the Effort
window, on which you can create and
maintain Effort records for the
currently-selected element.
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Publish Ribbon
The 'Publish' ribbon brings together all the tools for
publishing, documenting and importing and exporting
valuable model assets in a wide range of formats and styles,
ranging from publications for corporate audiences to
spreadsheets, XML schemas, Patterns, Reusable Assets and
much more. The model is the repository of valuable
organizational information and knowledge, and people who
don't access the model directly can still get access to this
knowledge through this panel of tools.
The publishing system provides a great deal of flexibility,
and outputs and inputs can be tailored to exactly what an
audience requires. This includes the flexible Documentation
engine, with its in-built and user defined templates and
styles that can produce high quality corporate publications
directly from the model. Elements and diagrams can be
imported and exported, including exchanging information
with spreadsheet tools and saving to reusable Patterns and
assets.

Panels
Panel
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Model
Reports

The 'Model Reports' panel groups
together a set of tools used to extract
information from the model in a variety
of useful formats, including customized
documents and templates, docx, pdf and
HTML.

Diagram
Image

The 'Diagram Image' panel provides
facilities to generate both hard and
electronic copies of diagrams from the
model, and to scale images of the
diagrams when they are generated.

Model
Exchange

The 'Model Exchange' panel contains
tools for controlling Packages and
importing and exporting parts of the
model in the XML based model exchange
format XMI, and to formats that can be
opened in a spreadsheet. The Reusable
Asset Server (RAS) is a valuable resource
for either sourcing existing model
fragments or saving parts of the current
model for reuse on future initiatives.

Technologies

The two facilities available through the
'Technologies' panel enable you to
generate files from the Enterprise
Architect model in a format that can be
used specifically in one of a range of
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supported technologies, and to import
files from the same range of technologies
and convert them for use in Enterprise
Architect.
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Model Reports Panel
The 'Model Reports' panel provides a set of tools for
extracting information from the model for output in a variety
of useful formats, including DOCX, PDF and HTML.

Available Facilities
Facility

Description

Report
Builder

Click on this icon to access a short menu
of documentation options:
· Generate Documentation - generate a
document from the content of the
model; generate rtf, pdf or docx format,
from built-in or customized templates
· Generate Documentation from Selected
Objects - generate a document from a
selection of objects (Ctrl+click on
each) in the Browser window or in a
diagram
· Simple Diagram Report - generate a
'Diagram Only' report to capture
images of all diagrams in the current
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·

·

Package - the 'Generate
Documentation' dialog displays,
defaulted to a Diagram Report
template; specify the 'Output to File'
path, including the file extension to set
the file format
Open a Document File - open an
existing document file in RTF or
DOCX format, for manual editing
Create a New Document File - create a
new document for manual editing and
export it in RTF or DOCX format

Custom
Document

Click on this icon to start to generate a
custom linked document, which can
contain any of a range of document
objects from the model, each formatted
with their own document templates.

Templates

Click on this icon to manage, create and
modify the templates used in generating
documents in RTF, PDF or DOCX
format.

Preview
Mode

Click on this icon to display the Dynamic
Documents window, which displays a
document instantly generated from the
current element.
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Click on this icon to select from two
options for publishing documents on the
web:
· Standard HTML Report - publish a
document to an internal or internet
website as static web pages, in standard
HTML
· Publish to Joomla! - generate an
HTML document to a Joomla!
database, for internet distribution
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Diagram Image Panel
The 'Diagram Image' panel provides facilities to generate
both hard and electronic copies of the currently-open and
selected diagram from the model.

Available Facilities
Facility

Description

Print

Click on this icon to display a short menu
of options for printing the diagram:
· Print - print the diagram directly on the
default printer
· Preview - display an image of how the
diagram will appear if it is printed
· Setup - display the 'Print Setup' dialog
to configure the default printer on
which the diagram will be printed,
which you would have selected on the
Windows 'Control' panel
· Print to PDF - print the diagram to a
PDF file instead of to a printer - a
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browser displays to select the PDF file
name and directory path; by
de-selecting the 'Printable' option on an
element on a diagram, you can omit
that element and its connectors from
the diagram in the PDF output
Save
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Click on this icon to save an image of the
current diagram. A small menu displays
from which you can select to:
· Save to File - a browser displays in
which you select where to save the file,
and the format in which to save the file
· Save to Clipboard - the image is
immediately saved to the Enterprise
Architect clipboard
· Scale Image - a list displays of
percentage scale options from 100% to
400%, to apply to the diagram images
saved to file in bitmap format, with a
tick beside the current setting (likely to
be the default of 137%); this list and
the 'Scale Saved Bitmaps to' field on
the 'Diagram' page of the 'Preferences'
dialog are parallel and changes to one
are automatically reflected in the other
Images saved in any format other than
bitmap are not scaled
On the 'Diagram' page of the
Page 370 of 1150

The Application Desktop

3 October, 2022

'Preferences' dialog, selecting the
'Apply scale to clipboard' checkbox
also applies the selected scale to bitmap
images saved to the clipboard

(c) Sparx Systems 2022

Page 371 of 1150

The Application Desktop

3 October, 2022

Model Exchange Panel
The 'Model Exchange' Panel contains tools for controlling
Packages and for importing and exporting parts of the model
both in the XML-based model exchange format, and in other
formats that can be opened in a spreadsheet. The Reusable
Asset Server (RAS) is a valuable resource for either
sourcing existing model fragments or saving parts of the
current model for reuse on future initiatives.

Available Facilities
Facility

Description

Reusable
Assets

Click on this icon to open the Reusable
Asset Service (RAS) view in the central
work area. The RAS provides a simple
and convenient mechanism for modelers
to distribute or download reusable model
structures, information, corporate
directives and standards. The shared
repository is accessible via a Pro Cloud
Server connection, making it accessible
for distributed teams.
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Publish As...

Click on this icon to publish a Package at
any level in the model as an external file
in one of several XML formats, including
XMI 1.1, XMI 2.1, Enterprise Architect's
Native XML, ArcGIS and BPMN 2.0
XML. The 'Publish Model Package'
dialog displays.

CSV

Click on this icon to access the CSV
Import and Export facilities, and to create
and maintain the CSV specifications that
define how the imports and exports
proceed. You can also display the
summary Help topic for CSV transfers.

Package
Control

Click on this icon to display a menu of
options for storing and managing
Packages by creating XMI files from
them (Package Control), supporting
lightweight version management and
model exchange.
· Package Control - configure Package
Control using the 'Package Control
Options' dialog
· Save to File - save the Package to its
configured XMI file (from the 'Package
Control' option), using the 'Export to
Native/XMI File' dialog
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Export
Package
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Load from File - replace the Package
from its saved XMI file, using the
'Import Package from Native/XM File'
dialog
View XMI File for Controlled Package
- review the content of the (exported)
XMI file for the Package, in the Code
Editor
Compare Package to XMI - compare
the current version of the Package with
the exported XMI file for the Package
(the 'Compare Model to File' option in
Managing Baselines)

Click on this icon to display options for
exporting the current Package to a
Native/XMI file for use in other models
and/or different modeling tools.
· Export Current Package to Native/XMI
File - export the Package to a file in
one of several Native/XMI formats,
using the 'Export to Native/XMI File'
dialog
· Batch Export Controlled Packages export a number of controlled Packages
to Native/XMI format in a batch
process, using the 'Batch Export
Controlled Packages' dialog
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Click on this icon to display options for
importing a Native/XMI file to update
one or more Packages in the model.
· Import Package from Native/XMI File
- import a Package from a file in one of
several Native/XMI formats, using the
'Import Package from Native/XMI File'
dialog
· Merge Model XML into Current
Package - import an XML file for the
Package and merge the content of the
file with the Package; you might do
this with a sequence of XML files for
the Package, such as when a number of
people are working on the same
Package offline and storing their work
in separate XML files
· Batch Import Controlled Packages import model Packages from an import
set for controlled Packages, using the
'Batch Import Controlled Packages'
dialog
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Technologies Panel
The two facilities available through the 'Technologies' panel
enable you to generate files from the Enterprise Architect
model in a format that can be used specifically in one of a
range of supported technologies, and to import files from the
same range of technologies and convert them for use in
Enterprise Architect.

Available Facilities
Facility

Description

Publish

Display a menu of options for Publishing
(exporting) Enterprise Architect model
information in a specific format for
consumption by other tools or processes.
A wide range of output formats is
supported, and you can further tailor the
output by including or excluding diagram
information, Enterprise Architect specific
extensions and so on. You would tailor
your published file for the capabilities of
the tool or process expected to consume
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it.
The 'Normative XMI 2.4.2' option
provides a quick means of exporting
model information in the latest
UML/XMI combination with no
Enterprise Architect extension
information or diagram information. This
format is most useful for standards
development and for base interoperability
with other UML based tools.
Note that you should not use this menu to
publish model information for
consumption by other users of Enterprise
Architect. For that purpose, use the
options in the 'Model Exchange' panel.
Import
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Display a menu of options for importing
XMI/XML from a variety of formats.
ArcGIS, EMX/UML2, Rhapsody,
OWL/RDF, BPMN 2.0, DMN 1.1 and
MDZIP are specifically supported, but a
wide range of other tools' XML output
can be imported into Enterprise Architect
using the 'Other Tools/Formats' menu
option.
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Layout Ribbon
The 'Layout' ribbon can be used to create sophisticated
views of a model alignment of elements and sections to
create high-quality diagrams. Diagrams are one of the most
compelling ways of visualizing information. The appearance
of elements in diagrams can be completely changed by
adding border, fill and text colors, creating meaning and
appeal. Diagram 'Filters and Layers' and Layout tools can be
used to automatically change the appearance of diagrams,
and Swimlanes and Roadmaps can be configured, adding
rich presentations. A filter can be applied to hide elements
that don't meet a specific condition, and a range of helpers
can assist with element alignment.

Panels
Panel

Description

Diagram

The 'Diagram' Panel provides a collection
of tools for managing the use of diagrams
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and for manipulating the appearance and
presentation of elements in a diagram.
Style

The 'Style' panel contains a range of tools
for applying different styles to the
elements in a diagram, to emphasize their
importance or relevance in the context of
the diagram. An element's fonts, fill and
borders can be colored and styled, and the
settings can be individually copied to
other elements or saved as a style that can
be applied to other elements as a group.

Alignment

The 'Alignment' panel provides a series
of tools that can be used to refine the
positions of the diagram's elements
relative to each other. Groups of elements
can be selected and their edges or centers
aligned vertically or horizontally. An
element's position in the visual stack can
be altered by moving them forward or
backwards, and you can display a
convenient grid that can be configured so
that elements and connectors 'snap' into
position on the grid.

Tools

The 'Tools' panel provides a series of
facilities for laying out, viewing or
filtering the elements in a diagram. These
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are tools that assist in working with large
or detailed diagrams. Diagram Filters can
be used to hide elements that aren't
relevant in a certain context. The Pan and
Zoom window helps you change a
diagram's magnification, and to quickly
traverse a large diagram. The Diagram
Layout facility can automatically change
and organize the layout of elements in a
diagram.
Filter

The 'Filter' panel helps in emphasizing
aspects of a diagram, filtering out
elements so that only the relevant or
important elements are clearly visible
whilst the other elements are muted. The
filtering can be based on a variety of
element properties that can be set for
exact matches, presence of text strings or
ranges of dates. The tool is invaluable for
quickly locating and visualizing
particular elements in a diagram.

Helpers

The 'Helpers' panel contains a series of
specialized tools for working with the
elements in a diagram, to save time,
preserve layouts and enhance
visualization.
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The 'Auto Refresh' panel provides access
to the diagram Auto Refresh facilities,
which assist in collaborative diagram
design by providing improved support for
multiple people giving input on the same
diagram.

Notes
·

·

·

You can also temporarily display an abbreviated toolbar
of formatting options beside an element or connector; for:
- Elements, select one or more elements on the
diagram and click on the 'paintbrush' icon beside
the element (and, for multiple selected elements, the
icon)
- Connectors, right-click on the connector; the toolbar
appears above the context menu
To set the global appearance of all elements throughout a
model, use the 'Preferences' dialog; select the 'Start >
Appearance > Preferences > Preferences' ribbon option,
then select 'Diagram | Standard Colors' and 'Diagram |
Appearance' from the options tree
To override the global appearance and define a default
appearance for a selected element (or several selected
elements) on all diagrams on which it occurs, right-click
on the element and choose the 'Appearance | Default

(c) Sparx Systems 2022

Page 381 of 1150

The Application Desktop

3 October, 2022

Appearance' option
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Diagram Panel
The 'Diagram' panel provides a collection of tools for
managing the use of diagrams and for manipulating the
appearance and presentation of elements in a diagram.

Available Facilities
To activate these facilities, open a diagram in the Diagram
View. Some facilities are available even when a diagram is
not open.
Facility

Description

Save

Click on the icon to save changes to the
current diagram.

Undo

Click on this icon to reverse the last
unsaved and un-reversed change made to
the diagram. When working with
diagrams, it is quite common for a
modeler to make a series of changes and
then decide to revert to a previous state of
the diagram, using the Undo icon to step
back through all the unsaved changes that
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have been made. For practical purposes,
there is no limit to how many consecutive
unsaved changes can be undone or
redone.
Redo

Click on this icon to re-establish the last
undone and unsaved change made to the
diagram.

Appearance

Click on the drop-down arrow to display
a list of options for configuring the
appearance of the current diagram.
· Standard mode - defaults to selected to
apply the normal rendition of the
diagram; if the current diagram is in
'hand-drawn' or 'white board' mode,
select this option to revert to normal
display
· Hand Drawn Mode - display the
current diagram in 'hand drawn' mode
· White Board Mode - display the
current diagram in 'white board' mode
· Theme & Appearance Options - set the
theme and appearance options for all
diagrams that you review, using the
'Diagram > Themes' page of the
'Preferences' dialog
· Hide Page Borders (All Diagrams) hide the printable-page border lines on
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·

·
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all diagrams that you review; deselect
the option to redisplay the borders
(overridden by the 'Hide page borders
(current diagram)' setting on the
'Diagram' page of the 'Properties'
dialog for the diagram)
Show Diagram Property Note - display
the diagram property note on the
current diagram
Set Visible Relationships - display the
'Set Visible Relations' dialog through
which you select the relationship
connectors to show or hide on the
current diagram
Show Status Colors (All Diagrams) display status colors on the status
compartment or borders of all
status-applied elements on all diagrams
you review; deselect to display the
elements with the default element fill
and shadow colors
Configure Status Colors - set the status
types and colors, using the 'Status' page
of the 'General Types' dialog
Reset Local Element Appearance - for
selected elements or all elements on the
diagram, reset the fill, line and font
colors and line width from the
locally-set values (via the 'Layout >
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·

·

Select
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Style' ribbon panel, for example) to the
values defined at the next level (that is,
default values set on those elements
(the F4 / 'Default Appearance' dialog)
or on all elements ('Start > Preferences
> Preferences > Diagram > Standard
Colors' page)
Reset Default Element Appearance for selected elements or all elements on
the diagram, reset the fill, font and line
colors and the line width from the F4 /
'Default Appearance' dialog values to
the 'Standard Colors' page default; this
then updates all diagrams in the model
that also display those elements
Set Local Appearance as Default - for
selected elements or all elements on the
diagram, reset the F4 / 'Default
Appearance' dialog values of the fill,
font and line color and line width to the
locally-set values of the selected
elements (those elements will change
to these colors in any diagram they are
on, unless they are not overridden by
values set locally or by stereotype)

Click on the drop-down arrow to display
a list of options for selecting, copying and
pasting elements on the current diagram.
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Select All Elements - select every
element in the diagram
Select Elements by Type - specify an
element type and - if appropriate stereotype, and select all elements of
that type in the diagram
Copy Selected Element(s) - copy all
selected elements to the clipboard
Clear Current Selection - clear all
selected elements in the diagram
Make All Elements Selectable - set all
elements in the current diagram to
Selectable, so that you can move them
around the diagram and perform
operations on them (make elements
unselectable by right-clicking on them
and clicking on the 'Unselectable'
option)
Paste as Reference - paste elements
from the clipboard into the diagram as
links to the original elements (the
elements being copied from a different
diagram)
Paste as New - paste elements from the
clipboard into the diagram as new
elements; the 'Paste Elements as New'
dialog displays, on which you change
the names of the new elements
Paste Image as Element - paste a single
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·

image of the copied element(s) and any
connectors between them from the
clipboard into the current diagram; the
image is enclosed within a System
Boundary, and the element images
cannot be selected or moved within the
boundary
Autosize Selected Elements - returns
the selected element(s) to the default
size for the element type, or to the
minimum size that can show the
element contents; the resizing operates
from the center of the element, so that
you do not have to reorganize the
diagram layout

Swimlanes

Click on this icon to divide the
currently-open diagram into logical areas
or partitions using the 'Swimlanes and
Matrix' dialog on the diagram.

Roadmap

Click on this icon to convert the currently
open diagram to a Roadmap with a
timescale, using the 'Roadmap options'
dialog.

Zoom

This Zoom option provides a number of
zoom settings that you can apply to your
diagram:
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Clear
·
50%
·
60%
·
75%
·
80%
· 100%
· 150%
· 200%
When you select a zoom level here, it
persists when you close and re-open the
diagram.
The 'Clear' option resets the diagram's
Zoom level to the default; that is, the
Zoom level that the diagram was created
at. This option only affects diagrams
when the 'Base Zoom' setting from the
'Start > Appearance > Preferences >
Preferences > Diagram > Appearance'
page is set to a value other than 'None'.
·
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Style Panel
The 'Style' panel provides a range of tools for applying
different styles to the elements and connectors in a diagram,
to emphasize their importance or relevance in the context of
the diagram. An element's fonts, fill and borders, and a
connector's line, can be colored and styled, and the settings
can be individually copied to other elements and connectors,
or grouped and saved as a style that can be applied to other
elements and connectors.

Available Facilities
Facility

Description

Style List

Click on the drop-down arrow on this
field and select an existing style to apply
to the selected object(s) in the diagram.

Save Style

Click on this icon to display a short menu
of options for creating styles.
· Save as New Style - save the style of
the selected object under a new name
(for example, after changing the
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·

·

·

appearance of the object); a dialog
displays in which you type the new
style name, and when you click on the
OK button the style is added to the
'Style List' field
Save Style - save the style of the object
under its existing style name (after
changing the appearance of the object)
Refresh List - change the 'Style List'
field setting back to 'Default Style'
Delete Current Style - delete the style
currently shown in the 'Style List' field;
the field reverts to 'Default Style' but
the objects using that style stay as they
are

Get Style

Click on this icon to copy the style of the
currently selected object, to immediately
apply to other objects.

Apply Style

Click on this icon to apply the style
copied using the 'Get Style' icon to the
currently selected object. You can keep
clicking on new objects and on this icon
to apply the style to several objects. As
long as the style characteristic applies to
the object (such as line width and line
color) you can apply the style to any kind
of object, although you would usually
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apply a style to closely related objects.
Set Font

Click on this icon to set the text font,
style, size and effects for the selected
element(s). (You can also select from a
small range of text colors.)

Text Color

Click on this icon to select from a wide
range of colors in which to display the
text of the selected element(s).

Fill Color

Click on this icon to select from a wide
range of colors to set as the fill color of
the selected element(s).

Line Color

Click on this icon to select from a wide
range of colors to set for the borders of
the selected element(s) or lines of the
selected connector.

Line Width

Click on the 'spinner' arrows to set the
selected element border or connector line
width to a value between 1 (thinnest) and
5 (thickest).
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Alignment Panel
The 'Alignment' panel provides a series of tools that can be
used to refine the positions of the diagram's elements
relative to each other. Groups of elements can be selected
and their edges or centers aligned vertically or horizontally.
An element's position in the visual stack can be altered by
moving them forward or backwards, and you can display a
convenient grid that can be configured so that elements and
connectors 'snap' into position on the grid.

Available Facilities
Most of the options on this panel become available when
you select two or more elements together (press Ctrl or Shift
as you click on the elements). Usually, the last-selected
element is the reference element against which the others
align; this element is indicated by a hatched border.
Facility

Description

Make Same
Height

Click on this icon to make all selected
elements the same height as the reference
element.
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Make Same
Width

Click on this icon to make all selected
elements the same width as the reference
element.

Make Same
Size

Click on this icon to make all selected
elements the same height and width as
the reference element.

Align
Vertically

Click on this icon to align the centers of
all selected elements vertically with the
center of the reference element.

Align
Horizontally

Click on this icon to align the centers of
all selected elements horizontally with
the center of the reference element.

Bring to Top

Move the selected elements to the top of
the diagram relative to other elements
(the top of the Z-Order).

Send to Back

Move the selected elements to the back of
the diagram relative to other elements
(the bottom of the Z-Order).

Align Left

Click on this icon to align the left edges
of all selected elements vertically with
the left edge of the reference element.
Shortcut: Ctrl+Alt+Left Arrow
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Align Right

Click on this icon to align the right edges
of all selected elements vertically with
the right edge of the reference element.
Shortcut: Ctrl+Alt+Right Arrow

Align Tops

Click on this icon to align the top edges
of all selected elements horizontally with
the top edge of the reference element.
Shortcut: Ctrl+Alt+Up Arrow

Align
Bottoms

Click on this icon to align the bottom
edges of all selected elements
horizontally with the bottom edge of the
reference element.
Shortcut: Ctrl+Alt+Down Arrow

Space
Horizontally

Click on this icon to evenly separate the
selected elements by the same amount
horizontally.

Space
Vertically

Click on this icon to evenly separate the
selected elements by the same amount
vertically.

Snap to Grid

Click on this icon to display a short menu
of options for applying a grid to help you
position elements on each diagram you
review. If all of the options are
deselected, you can move and resize
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elements freely.
· Standard Grid - make elements 'snap' to
the nearest grid point when you move
or resizing them
· Smart Placement - place elements even
distances away from other elements
and space elements evenly; for
Sequence diagrams, this helps position
Notes on Messages
· Show Grid - display the grid on the
diagram as pale gray dots against the
diagram background
· Show smart placement guides - display
instant lines on the diagram to indicate
where critical points (top, bottom,
sides, center of sides) on the element
being moved or resized lie in relation
to the original position of the element
or to another element or connector way
point; note that the objects must be
contemporary - not at different
hierarchical levels or in different
partitions of the diagram
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Tools Panel
The 'Tools' panel provides a suite of facilities for aligning,
viewing or filtering the elements in a diagram. These are
tools that assist in working with large or detailed diagrams.
Filters and Layers can be used to separate out elements that
aren't relevant in a certain context. The Pan and Zoom
window helps you change a diagram's magnification, and to
quickly traverse a large diagram. The Diagram Layout
facility can automatically change and organize the layout of
elements in a diagram.

Available Facilities
Facility

Description

Filters and
Layers

Click on this icon to display the 'Filters &
Layers' window, which you use to create
and apply filters for selectively muting
parts of the diagram that are not relevant
to an aspect you are investigating.

Pan and
Zoom

Click on this icon to display the Pan &
Zoom window, which helps you to scan
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across large diagrams and 'dive into' areas
of interest.
Diagram
Layout
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Click on this icon to display a menu of
options that you can use to select,
configure and apply a wide range of
diagram layouts to the current diagram.
These options include:
· Apply Default Layout - automatically
apply the default standard Digraph
layout to the current diagram
· Open Diagram Layout Tools - display
the 'Layout Tools' dialog, through
which you can select, configure and
apply one of the predefined diagram
layouts to the current diagram
· <diagram layouts> - the eleven
predefined diagram layouts, each
option automatically applies the current
settings for that layout from the 'Layout
Tools' dialog to the current diagram;
note that the 'Digraph' option applies
any settings you have adjusted,
whereas the 'Apply Default Layout'
option ignores such adjustments
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Filter Panel
The 'Filter' panel helps in emphasizing aspects of the
currently-open diagram, quickly filtering out elements
outside a context so that only the relevant or important
elements are clearly visible whilst the other elements are
muted. The context can be derived from a variety of element
properties (as defined in the Properties window), some of
which can be set to an exact match, the presence of text
strings or a date range. The tool is invaluable for quickly
locating and visualizing particular elements in a diagram.

Fields
The three fields are unlabelled and are referred to by their
position on the panel.
Field

Description

Top Left

This field identifies the type of filter to
apply. It defaults to the value 'Filtering
Off'. Click on the drop-down arrow and
select the filter type.
To expose the full list of filter types,
either use the vertical scroll bar or drag
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the 'dotted line' bar down as far as is
necessary. The filter types include:
· Relationships - filters for elements that
are the source or target of the same
type of connector as the selected
element
· Hierarchy - filters for elements on the
diagram in the same hierarchy as the
selected element, both above and below
that element in the hierarchy
· Name / Alias - filters for elements
having the specified text string in the
'Name' or 'Alias' fields
· Alias - filters for or against elements
having the specified text string in the
'Alias' field
· Author - filters for or against elements
created by the specified author(s) (as
shown in the 'Author' field)
· DateCreated - filters for or against
elements created before, on or after the
specified 'Created' date
· DateModified - filters for or against
elements modified before, on or after
the specified 'Modified' date
· Difficulty - filters for or against
Requirement-type elements (Change,
Feature, Issue) of the specified
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difficulty (see the element's 'Properties'
dialog 'General > Main' page)
GenType - filters for or against
elements of the specified code
generation language (such as Java)
specified in the 'Language' field
Filename - filters for or against
elements having the specified code
generation file path and name in the
'Filename' field
Keywords - filters for or against
elements having the specified text in
the 'Keywords' field
Name - filters for or against elements
having the specified text string in the
'Name' field
Notes - filters for or against elements
having the specified text string in the
'Notes' field (see the element's
'Properties' dialog, 'General' page)
ObjectType - filters for or against
elements having the specified object
type as defined in the 'Type' field
Phase - filters for or against elements
having the specified phase as defined in
the 'Phase' field
Version - filters for or against elements
having the specified object type as
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defined in the 'Version' field
Priority - filters for or against
Requirement-type elements (Change,
Feature, Issue) of the specified priority
(see the element's 'Properties' dialog
'General > Main' page)
RequirementType - filters for or
against Requirement-type elements
(Change, Feature, Issue) of the
specified type (see the element's
'Properties' dialog 'General > Main'
page)
Scope - filters for or against elements
having the specified scope value, as
defined in the 'Scope' field ('Details'
page of the 'Properties' dialog,
'Advanced' section of the Properties
window)
Status - filters for or against elements
having the specified status, as defined
in the 'Status' field
Stereotype - filters for or against
elements having the specified
stereotype as defined in the 'Stereotype'
field
Selectable - filters for or against
elements that have been flagged as
selectable, using the element context
menu
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Printable - filters for or against
elements that have been flagged as
printable, using the element context
menu
For some filter types, one or both of the
remaining two fields might not be
required and they will be grayed out.
·

Top Right

This field defines the operator to apply to
any property or value you define; that is,
whether the element property or text
contains, is equal to, or is not equal to the
defined value, or is within a specified
range of values.
Click on the drop-down arrow and select
the appropriate operator.

Bottom

Type the value or range of values to be
matched against the element property or
text.
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Helpers Panel
The 'Helpers' panel contains a series of specialized tools for
working with the elements in a diagram. These perform
useful function that will save time, preserve layouts and
enhance visualization. The 'Sweeper' and 'HV Lock' tools
move multiple elements vertically, horizontally or
diagonally in the diagram. The 'Presentation' tool can be
used to show which element is in focus during a workshop
or meeting. The 'Show Direction' tool indicates the direction
of relationships connected to the selected element.

Available Facilities
To apply each of these tools to your diagram, click on the
checkbox against the tool name. The options remain
selected across diagrams and work sessions until explicitly
turned off again.
Facility

Description

Sweeper

When the Sweeper is on, you can move
sections of the diagram in one direction
vertically, horizontally or diagonally.
Click on the diagram and move the
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cursor; the section of diagram ahead of
the cursor in its direction of movement is
moved in the same direction.
HV Lock

When the HV Lock is on, when you click
on an element and start to move it
horizontally or vertically, the movement
becomes restricted to that direction. So if
you start to move the element vertically,
you cannot move it horizontally until you
release the mouse button and start another
movement. The lock prevents any
diagonal movement.

Presentation

When the 'Presentation' option is
selected, the borders of selected elements
are a simple solid colored line. There are
no diagram icons (such as the Quick
Linker arrow), movement handles or
hatching. You cannot select and work on
connectors.
Whilst you can still move and resize the
element(s), you might use this option
when you are examining element content
rather than element placement on the
diagram, or using the diagram for display
rather than change.

Show

When this option is selected, the physical
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direction of connectors on the selected
element are indicated by color: incoming
relationships are red, and outgoing
relationships are green. If the element is
not selected, the connectors are not color
coded.

Perpendicular When this option is selected, connectors
Lines
are forced to adopt a vertical or horizontal
position when they are adjusted.
Connectors that are not adjusted when
this option is selected will remain at
whatever angle they present.
Not all types of connector are affected by
this setting.
Reorder
Messages
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This option enables and disables the
ability to swap the order of messages on a
Sequence diagram. When this option is
enabled, if you drag a message up or
down a lifeline beyond the position of the
next or previous message, the messages
swap positions. If this option is disabled,
then dragging a message will only extend
or reduce the spacing between the
message being dragged and its preceding
message.
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Auto Refresh Panel
The 'Auto Refresh' panel provides access to the diagram
Auto Refresh facilities, which assist in collaborative
diagram design by providing improved support for multiple
people giving input on the same diagram, and allowing
those users to monitor changes on a specific diagram.

Available Facilities
Option

Description

Auto Refresh

Displays a menu of options to:
· Disable Auto Refresh on this diagram
(the default setting)
· Enable Auto Refresh and poll for
changes to the diagram every 7 seconds
· Enable Auto Refresh and poll for
changes to the diagram every 15
seconds
· Enable Auto Refresh and poll for
changes to the diagram every 30
seconds
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Enable Auto Refresh and poll for
changes to the diagram every 60
seconds
Pause Auto Refresh to enable you to
edit the diagram
Resume Auto Refresh under the current
interval after you have paused it to edit
the diagram

Pause & Edit

Pauses Auto Refresh to enable you to edit
the diagram.

Resume

Resumes Auto Refresh under the current
interval after you have paused it to edit
the diagram.
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Design Ribbon
The 'Design' ribbon is used to develop and visualize a model
by creating diagrams, matrices and lists of important aspects
of the system. Requirements and other specifications can be
created and viewed and, regardless of the technology or
language of expression, representations can be created,
viewed and tied together to form either blueprints of a
system to be implemented or documentation of an existing
system.

Panels
Panel

Description

Package

The 'Package' panel provides facilities to
create and manage a model. New models
can be added that typically contain a
number of other Packages. These
Packages form the structure of the model
and can be used to group elements,
diagrams or other Packages. You can
work on the contents of a Package as a
series of textual descriptions in the
Specification Manager. A Package can
also be viewed as a list of elements that
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will include other Packages, or as a Gantt
chart describing the allocation of
resources to the elements in the Package.
Snapshots of Packages - including the
complete model - can be taken and
comparisons made to the current
Package.
Diagram

(c) Sparx Systems 2022

The 'Diagram' panel contains a set of
facilities for creating and managing
diagrams and the elements they contain.
Diagrams are a useful way of presenting
and visualizing a model's elements and
their connections. Different types of
diagram can be easily constructed using
the Diagram Toolbox, each page of
which provides the elements and
connectors for creating a specific type of
diagram. Any diagram can be enhanced
by a range of overlays that transform the
diagram into an expressive view such as a
Kanban board, a Roadmap diagram, or
swimlanes that allow elements to be
allocated to different aspects such as
responsibility or ownership. A diagram
can also be viewed in other formats such
as a list of elements, or a Gantt chart
describing the allocation of resources to
the elements, or as a textual specification.
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Element

The 'Element' panel provides facilities to
create, edit and manage the elements that
are the building blocks of models.
Elements can be created and specified
with attributes, operations, Receptions,
Tagged Values, Scenarios, Requirements
and Constraints.

Dictionary

The 'Dictionary' panel provides options to
check the spelling in the current Package
or the whole model, and to create and edit
entries in the Project Glossary.
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Package Panel
The 'Package' panel provides facilities to create and manage
folders (Packages). New models can be added that typically
contain a number of other Packages. These Packages form
the structure of the model and can be used to group
elements, diagrams or other Packages. A Package can also
be viewed as a list of elements that will include other
Packages, or as a Gantt chart describing the allocation of
resources to the elements in the Package.

Available Facilities

Add Package

Click on the icon to create a new child
Package under the currently selected
Package. The 'New Package' dialog
displays, on which you specify whether
to create the Package from a Pattern (with
child structures), with a child diagram, or
as a Package only.

Model

Click on the icon to display the Model
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Wizard

Wizard (Start Page 'Create from Pattern'
tab), which provides Patterns from a wide
range of technologies that you can use to
quickly generate new models in your
project.

Manage

Click on the drop-down arrow to select
from a number of facilities that you can
use to manage Packages in the model.
· Properties - maintain the properties of
the current Package, using the
'Properties' dialog
· Update Status - provide a bulk update
on the Status, Phase and Version of the
selected Package and its elements
· Lock - display the 'Lock Package'
dialog for the selected Package, on
which you restrict changes to the
Package
· Clone Structure as New Version - copy
the structure of the selected Package
and paste it into the Browser window
as a new Package and contents; a
prompt displays for you to enter a
version number for the new Package,
followed by a browser on which you
select its parent Package
· Validate - display a short menu of
options to create validation rules and
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run and cancel a validation of the
current Package
Manage Baselines - display the
'Baselines' dialog for the selected
Package, to create and compare
Baselines of the Package with the
current version (Ctrl+Alt+B)
Find Baselines - execute a report that
finds and lists all the Baselines in the
model
Level Numbering - toggle the display
of automatically applied level
numbering within the Specification
Manager and the Browser window, for
elements within the currently displayed
Package
Auto Naming - apply configured auto
naming conventions to existing
elements in the selected Package
Report Options - display a dialog on
which you specify whether to include
the selected Package in generated
reports, or specifically exclude it from
the reports
DBMS Options - display the 'Manage
DBMS Options' dialog to change the
DBMS Type and/or Owner of one or
more database objects
Copy to Clipboard - immediately copy
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the selected Package to the clipboard
Paste from Clipboard - paste a Package
held on the clipboard as a child of the
selected Package
Search for Package - display the Find
in Project view, pre-loaded with the
'Find Package' search to locate
Packages of a specific name or type
Browse for Package - display a 'Find
Package' dialog listing only Packages,
through which you can easily locate
and select a specific Package from
within the model hierarchy
(Ctrl+Shift+Alt+P)

Package/Matr Click on this icon to examine how sets of
ix
elements in one Package are linked to
each other, or to elements in another
Package, using the Relationship Matrix.
You can also add and delete relationships
using the Matrix. Select options to set the
current Package as the source, target, or
both.
Gap Analysis
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Click on this icon to explore the
implementation of features in the model,
and to identify potential gaps between
solution architectures, using the Gap
Analysis Matrix.
Page 416 of 1150

The Application Desktop

3 October, 2022

Transform

Click on the drop-down arrow to display
options for applying Transformation
Templates in building physical models
from more abstract content.
· Apply Transformation - display the
'Model Transformation' dialog, from
which you select and apply a model
transformation on the elements of the
current Package
· Transform Selection - display the
'Model Transformation' dialog, from
which you define and perform one or
more transformations on the selected
elements, to generate new model
content
· Transform Templates - edit and
configure the templates used to
perform transformations, in the
Transformation Editor view
· Help - display the Model
Transformation Help topic

Specification
View

Click on this icon to display the
Specification Manager, a document-based
interface to a selected Package in the
model, providing the means of creating
and reviewing elements as text
representations of objects in the Browser
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window. When you select this option, the
'Design' ribbon changes to the
'Specification-Specify' ribbon.
List View

Click on this icon to display the selected
Package in the Package Browser window,
in List View mode.

Gantt View

Click on this icon to display the selected
Package in the Package Browser window,
in Gantt View mode.
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Diagram Panel
The 'Diagram' panel contains a set of facilities for creating
and managing diagrams and the elements they contain.
Diagrams are a way of presenting and visualizing a model's
elements and their connections. They can be enhanced by a
range of overlays that transform the diagram into an
expressive view such as a Kanban board, a Roadmap
diagram, or swimlanes, which allow elements to be
allocated to different aspects such as responsibility or
ownership. A diagram can also be viewed in a number of
other formats, such as a list of elements or a Gantt chart
describing the allocation of resources to the elements.

Available Facilities
Facility

Description
Click on this icon to display the Diagram
Toolbox (if it is not already open); the
Diagram Toolbox is a panel of icons
specific to a diagram type that you can
use to create elements and connectors on
a diagram.
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Click on this icon to create a new
diagram under the selected Package or
element. The 'New Diagram' dialog
displays, through which you can create a
new diagram of any type under any
technology supported by Enterprise
Architect, based on a diagram Pattern.
Click on the drop-down arrow to display
a list of options for actions to apply to the
selected diagram.
· Properties - maintain the properties of
the current diagram, using the diagram
'Properties' dialog
· Lock - display the 'Lock Diagram'
dialog for the currently-open diagram,
on which you restrict changes to the
diagram
· Clone as New Version - copy the
currently-selected diagram in the
Browser window and paste it into the
Browser window as a new diagram; a
prompt displays for you to enter a
version number for the new diagram,
followed by a browser on which you
select its parent Package
· Compare to Baseline - Compare the
current diagram with a
(c) Sparx Systems 2022
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previously-captured Baseline of the
diagram
Add to Working Set - add the diagram
to a working set to open when you
open the model
Save as Profile - Save the current
diagram as a Profile
Swimlanes - divide the currently-open
diagram into logical areas or partitions
using the 'Swimlanes and Matrix'
dialog
Kanban - convert the currently open
diagram to Kanban format, using the
'Kanban' dialog
Roadmap - convert the currently open
diagram to a roadmap with a timescale,
using the 'Roadmap options' dialog
Search for Diagram - display the Find
in Project view, pre-loaded with the
'Diagram Details' search to locate
diagrams of a specific name
Browse for Diagram - display the
'Select Classifier' browser, through
which you can locate and open a
diagram in your model

Click on the drop-down arrow to display
a list of options to display the currently
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open and selected diagram:
· In the standard graphical display
format
· As a tabular, editable list of elements
(Diagram List)
· In a Gantt Chart format, showing the
Project Resources assigned to each
element
· With each element represented by a
text description in the Specification
Manager
· With every relationship shown in a
matrix of the source and target
elements, in the Relationship Matrix
· In the Construct View, representing the
diagram as an element hierarchy
showing element type, order of display
and any parent-child structures
· In the Inline Specification View - for
the graphical display format, select
between displaying and hiding a
Specification view of the diagram
elements in the right half of the
diagram
Click on the drop-down arrow to display
a list of options for managing the
diagram's behavior.
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Configure Z Order - display the
'Modify Z Order' dialog, on which you
set the Z order of each element on the
diagram
Make all Elements Selectable - click on
this option to make all the elements on
the current diagram selectable, so that
they each can be worked on
Change Type - change the diagram
type
Sequence Communication Messages (in a Communication diagram) change
the sequence of messages
Auto Reload Changed Diagrams automatically reloads open diagrams
that have been saved by other users
within the last 60 seconds

Notes
If an element is:
· Selectable, you can move it around the diagram and
perform right-click context-menu operations
· Unselectable, you cannot move it around the diagram and
the only right-click operation available is to make the
element selectable
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The 'Make all Elements Selectable' option has no effect on
double-click operations on the element, such as displaying
child diagrams.
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Element Panel
The 'Element' panel provides facilities to manage elements,
which are the building blocks of models. Elements can be
created and specified with attributes and operations. You
can also define scenarios for the activities that the element
represents.

Available Facilities
Facility

Description
Click on the drop-down arrow to display
a short list of options for adding elements
to the model:
· Element - define and add a new
element to the currently-selected
Package or element and, if required, the
currently open diagram, using the 'New
Element' dialog
· Multiple Elements - add a number of
individual elements to the
currently-open diagram, using the
'Create Multiple Elements' dialog
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Related Element - identify elements
that are related to the currently selected
element and, if they are not on the
currently-open diagram, add them to it
Any Element - add any existing
element to the currently-open diagram;
the option displays the 'Select Element'
browser, which you use to locate the
element to add

Click on the drop-down arrow to display
a list of commands you can use to
identify, research, update and protect the
element you have selected in a diagram
or in the Browser window.
· Clone Element as New Version - copy
the structure of the selected element
and paste it into the Browser window
as a new element and contents; a
prompt displays for you to enter a
version number for the new element,
followed by a browser on which you
select its parent Package or element
· Lock - open the 'Lock Element' dialog
through which you can set or clear
editing locks on the selected element
· Lock Element with Children - open the
'Lock Element' dialog through which
you can set or clear editing locks on the
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selected element and all child elements
of that element
Edit Linked Document - open the
Linked Document editor for the Linked
Document on the currently-selected
element
Find Elements with Linked Documents
- display the Find in Project view,
pre-loaded with an executed search for
elements that have Linked Documents;
right-click on an item and select the
'Edit Linked Document' option to
review the element's document
Find Elements with Linked Documents
modified recently - opens the Find in
Project view preloaded with an
executed search for elements that have
Linked Documents that have updated
within the last seven days (you can
re-execute the search with a different
number of days); right-click on an item
and select the 'Edit Linked Document'
option to review the element's
document
Parents and Interfaces - add or delete
Generalization and Realization
relationships to Parent or Interface
Classes, using the 'Set Parents and
Interfaces' dialog
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Overrides and Implementations - set
the system to automatically override
methods from parent Classes and from
realized Interfaces, using the 'Override
Operations/Interfaces' dialog
Template Parameters - display the
'Templates' dialog on which you can
define Template Parameters and
Binding Expressions for a
Parameterized Class
Change Type - change the type of the
selected element, using the 'Select
Element Type' dialog
Find in Project Browser - highlight in
the Browser window an element
selected from a diagram
Find in Diagrams - find the selected
element in every diagram in which it
has been used; if the element is used in
more than one diagram, the 'Element
Usage' dialog displays
Search - display the Find in Project
view, through which you can search for
the use of any aspect of an element
across the model
Bookmark - add or remove a
Bookmark on the selected element on
the diagram; the element is marked
with a red triangle
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Click on this icon to display the
Properties Window Selector, a page of
options for editing element properties,
including Tagged Values and Linked
Documents.
If you have selected two elements in an
open diagram, the Feature Matrix helps
you to create and manage relationships
between the features (attributes,
operations and receptions) of those
elements.
Click on this icon to follow the
connections in a chain of elements,
starting with a single element to establish
the dependencies radiating from that
element, using the Traceability window.
Click on this icon to display the Source
Code editor, to create or edit Behavior
code for the operations in the selected
element, or in the parent of the selected
operation. You have three options:
· Edit Behavior
· Edit Internal Code
· Edit (or View) Source Code
All three options display the Code Editor
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window, but show the appropriate
features, code and editing options for the
type of code identified by the option.
Displays the Scenarios View, on which
you can:
· Construct the scenario step-by step, or
· Import a text file that describes a
scenario, or
· Generate a scenario from an Activity
diagram that was itself generated from
a scenario (thus regenerating the
scenario or importing it from another
element)
Click on the drop-down arrow to display
a short menu of options for working with
Decision Tables for the selected element.
· Find Decision Models - executes a
report on the Find in Project window,
to locate all DMN models represented
by an Artifact with the stereotype
<<DMNSimConfiguration>>
· Add New Decision Model (Create from
Pattern) - displays the Model Wizard
('Create from Pattern' tab of the start
Page) ready to generate a DMN Model
from a Pattern (if the left hand panel
header is not 'Decision Modeling', click
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on the
icon and select
'Requirements > Decision Modeling')
Find Simple Decision Tables - executes
a report to locate and list all elements
that contain Decision Tables
Create/Edit Simple Decision Table Opens the Decision Tables window,
through which you can create or edit a
Decision Table on the current element
Help - display the top-level Help topic
on Decision Models
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Dictionary Panel
The 'Dictionary' panel provides options to create customized
document templates, to check the spelling in the current
Package or the whole model, and to create and edit entries in
the Project Glossary.

Available Facilities
Facility

Description

Glossary

Click on this icon to display options for
viewing and editing the terms defined in
the Project Glossary:
· Glossary View - display the Glossary
window, listing all terms defined in the
Project Glossary
· Edit - display the 'Glossary' dialog,
which provides options to add, edit,
and delete glossary terms and modify
the display of terms
· Implement a Model Based Glossary display the Create a Glossary as a
Package Structure Help topic
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Click on this icon to access the project
Spell Checking facilities. A short menu
displays from which you can select:
· Spell Check Project - the 'Spell Check'
dialog displays, on which you specify
what model components to check
· Spell Check Current Package - the
'Spell Check' dialog again displays, but
in this context you do not have to set
any parameters
· Spelling Options - configure the spell
checker using the 'Spelling Options'
dialog
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Start Ribbon
The 'Start' ribbon provides a range of facilities for exploring,
navigating and viewing the information in the repository.
These include tools to navigate to items, to view the
important events, messages, discussions and work that is
relevant to a modeler on a given day, and to view and
change your workspace settings, including styles and
preferences. This ribbon also provides access to the Help
facilities, including registering licence keys and checking
for updates.

Panels
Panel

Description

All Windows

You can use the 'All Windows' panel to
access a range of Window Selectors to
select and open a window or a
workspace. You can define any number
of workspace layouts and working sets,
saving combinations and arrangements of
windows that are specific to a role that
ultimately increases your productivity as
a modeler.
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Appearance

You can also define the look and feel of
the application, setting preferences that
change the style of the interface to suit
the work role you are performing. There
is a wide range of preferences you can set
to tailor the way the application behaves
under your login, including setting colors,
fonts and diagram styles.

Collaborate

Enterprise Architect is a collaboration
platform and allows any number of
people to work on models and diagrams
at the same time, in a cooperative and
team effort. The collaboration tools
include Reviews and Discussions of
elements, the Model Library, Model Mail
- which contains messages from other
modelers - the Project Calendar listing
important events, the 'Journal' informal
comment capture facility. The tools
ensure that communication about the
elements, diagrams, lists and matrices are
available in the model and links can be
created back to these items from the
collaboration tools. The 'Collaborate'
panel conveniently brings these tools
together, ensuring that you are informed
about what you need to attend to and
made aware of information that is
important to your role.
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Personal

The 'Personal' panel gives access to a
great facility for maintaining a daily
diary, in which you can note down
reminders of what you have done or
intend to do within the model. It provides
an option for opening the 'Working Sets'
tab of the Focus window, to set up and
maintain groups of windows, diagrams
and views to return to as a set in later
work sessions. On the right hand side it
has a set of options for displaying and
managing your user default diagram and
your default work Package, and for
displaying the Gantt Chart listing your
work allocations and the Kanban diagram
you have set as your personal default.

Help

The 'Help' panel provides access to the
Help system and to a wide range of
on-line facilities to support your use of
the tool, including the management of
License Keys through the 'Register'
option. The Help system contains both
overviews of functional areas of the
application and detailed topics on how to
use specific tools, helping you to be
highly productive. The Help is normally
accessed as an on-line, web-based
system, but you can select to download
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the file-based Help to provide a local
Help system. You can also open the
Learning Center library, which provides
user-focused guidance for common tasks.
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All Windows Panel
You can use the 'All Windows' panel to access a range of
Window Selectors to select and open a window or a
workspace. The panel also helps you to define any number
of workspace layouts and working sets, saving sets and
arrangements of windows that are specific to a role that
ultimately increases your productivity as a modeler. The
'Perspective' drop-down helps you to select and set the
global Perspective for your model.

Available Facilities
Facility

Description

Design

Click on this icon to display the Design
Window Selector, which provides access
to the windows for locating, creating and
working on objects on the model,
including within diagrams. Click on the
name of the required window to
immediately open it.

Properties

Click on this icon to display the
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Properties Window Selector, which lists
the windows for editing the properties,
features, structural elements and internal
structures of an element. Click on the
name of the required window or tab to
immediately open it. This window can be
displayed from both the 'Start > All
Windows' panel and the 'Design >
Element' panel.
Collaborate

Click on this icon to display the
Collaborate Window Selector, which
provides access to the Collaboration
facilities such as Discussions, Reviews,
Journal entries, personal conversations
and information concerning the overall
model.

Execute

Click on this icon to display the Execute
Window Selector, which provides access
to the Simulation, Source Code, Visual
Analysis and Process Execution windows
and tabs.

Construct

Click on this icon to display the
Construct Window Selector, which gives
access to tools for managing resources,
changes, testing and project metrics.
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Publish

Click on this icon to display the Publish
Window Selector, which provides access
to facilities for generating static and
dynamic reports, exchanging models in
part or entire, and keeping the model data
accurate and up to date.

Workspace

Click on this icon to display the
Workspace window, from which you can
select from lists of system-defined and
user-defined ('User Layouts') workspaces.
Each workspace opens a number of
related windows that together support a
particular task or area of work in
Enterprise Architect.

Perspective

Click on this icon to display a list of
options to select and set the global
Perspective for your model.
The list is headed by the option to set 'All'
Perspectives, followed by options for
Perspectives defined for the model,
Perspectives you have defined for your
personal use, and Perspectives (in the
'Specialized' group) provided by MDG
Technologies.
In the next block of options are the names
of the standard, system-defined
Perspective groups, which expand to list
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the Perspective Sets.
The last item in the list is the Settings
option, which you select to display the
'Perspective Sets' dialog. You use this
dialog to define the Personal and
Model-based Perspective Sets, and to set
up the Security Group-linked
Perspectives.
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Appearance Panel
The 'Appearance panel helps you to define the look and feel
of Enterprise Architect, setting preferences that change the
style of the interface to suit the work role you are
performing. There is a wide range of preferences you can set
to tailor the way the application behaves under your login,
including setting colors, fonts and diagram styles. You can
also select options to display the interface in full-screen
mode and in one of several visual styles, and you can
temporarily hide or display selected sections of the
interface.

Available Facilities
Facility

Description

Preferences

Click on the drop-down arrow to display
options for:
· Opening the 'Preferences' dialog on
which you can set the general options
of Enterprise Architect; you can control
how the system behaves when you
open a project, including setting the
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home directories and web pages the
project refers to and how the Browser
window responds when items are
selected in it
Displaying the Diagram Toolbar at the
top of every diagram you open in the
model
Making toolbar icons larger and more
visible both in the Toolbar ribbon and
at the top of each dockable window,
with immediate effect
Opening the 'Toolbars' tab of the
'Customize' dialog to set which
Toolbars to automatically display in the
Toolbar ribbon
Opening the 'Customization' dialog
('Other Options') to tailor other user
controls, such as additional key
combinations for accessing Enterprise
Architect dialogs and facilities, and
external tools to link to from within
Enterprise Architect

Full Screen

Click on this icon to toggle Enterprise
Architect in and out of 'Full Screen'
mode.

Visual Style

Displays the 'Application Look' dialog,
on which you can select from a range of
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visual styles, themes and accent colors.
You can also choose options such as
displaying window tabs at the top or
bottom of the windows and displaying
element properties using tree or list style
displays.
View
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When you click on the drop-down arrow,
this icon displays a menu of four options
for managing what segments of the
screen are displayed and how they are
displayed.
The 'Manage Views' option has these
sub-options:
· Float View - display the current View
as a floating window, allowing it to be
displayed in 'Full Screen' mode or to be
moved to a different display monitor
· Focus View - set the input focus back
to the View that last had focus
(intended to be accessed via the
command shortcut keys Ctrl+Shift+0)
· Reload View - load the latest
information from the model database,
to update the display of the current
View
· Close View - lose the current View;
you will be prompted to save any
unsaved modifications
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Close All Except Current - close all
Views except the current view; you
will be prompted to save any unsaved
modifications
Close All - close all Views; you will be
prompted to save any unsaved
modifications
Save All Modified Views - for every
View that is currently open, save to the
model database any modifications to
the appearance of the View; these
include modifications such as changes
to color, size or position
Auto Hide Active Window - auto hide
the currently active window
Auto Hide All Docked Windows - auto
hide all open and docked windows
Close Active Window - close the
currently active window

The 'Show Start Page' option simply
shows or hides the Start Page; this setting
persists through shut down and restart,
until you specifically change the option.
The 'Show All Ribbons' option refreshes
the display of ribbons to show all of
them, revealing any hidden by using a
Custom Ribbon Set.
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The 'Always on Top' option forces the
main Enterprise Architect window to be
on top of all other windows.
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Collaborate Panel
Enterprise Architect is a convenient collaboration platform
that allows any number of people to work on models and
diagrams at the same time, in a cooperative and team effort.
The collaboration tools include Reviews and Discussions of
elements, the Model Library, Model Mail - which contains
messages from other modelers - the Project Calendar listing
important events, the 'Journal' informal comment capture
facility, Gantt Charts listing work allocations and Kanban
diagrams where tasks are presented. The tools ensure that
communication about the elements, diagrams, lists and
matrices are available in the model and links can be created
back to these items from the collaboration tools. The
'Collaborate' panel conveniently brings these tools together,
ensuring that you are informed about what you need to
attend to and made aware of information that is important to
your role.

Available Facilities
Facility

Description

Journal

Displays either the Discuss & Review
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window at the 'Journal' tab (main icon) or
a short menu (drop-down arrow)
providing these options:
· Journal - opens the Discuss & Review
window at the 'Journal' tab, which
providing a great facility for
maintaining a daily log of reminders of
what the developers concerned with a
selected element or diagram have done
or intend to do for the selected object
· Journal History - opens the Discuss &
Review History window at the Journal
tab, on which you can review the
journal entries for elements, grouped
for Today, Yesterday, This Week, Last
Week, This Month and Last Month
· Help - displays the Journal Help topic
Discuss

(c) Sparx Systems 2022

Displays either the Discuss & Review
window (main icon), on which you can
manage current discussions of elements
and diagrams, or a menu (drop-down
arrow) providing these options:
· Discuss - to display the Discuss &
Review window at the 'Discuss' tab, on
which you can create a new discussion
or add to an existing discussion on a
specific element or diagram
· Discussion History - to display the
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·

·

Review
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Discuss & Review - History window at
the 'Discussions' tab, on which you can
review the separate discussions of
elements recorded in the model,
grouped for Today, Yesterday, This
Week, Last Week, This Month and
Last Month
Recently Discussed - to run a report
that presents elements that have been
the subject of discussion in the last 7
days (you can change the number of
days in the 'Search Term' field)
Help - to display the Discussions Help
topic

Displays either the Discuss & Review
window (main icon), on which you can
set up and manage reviews of elements or
diagrams, or a menu (drop-down arrow)
providing these options:
· Review - to display the Discuss &
Review window at the 'Review' tab, on
which you can join a review and create
new discussion points or responses
within that review, on any element or
diagram
· Review History - to display the
Discuss & Review - History window at
the 'Reviews' tab, showing the elements
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·

·

Chat
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included in a selected review; you can
switch to the 'Review' tab of the
Discuss & Review window to show the
details of a selected element under
review
Manage Reviews - to display the
Reviews view, listing all current and
recent reviews of elements
Help - to display the Reviews Help
topic

Displays either the Chat & Mail window
(main icon), on which you can start or
continue Chats, or a menu (drop-down
arrow) providing these options:
· Chat - to display the Chat & Mail
window at the 'Chat' tab, on which you
can follow and participate in quick
conversations on a point of interest,
with a selected user or members of a
selected user group
· Chat History - to display the Chat &
Mail window at the 'Chat History' tab,
on which you can review the separate
chats recorded in the model, grouped
for Today, Yesterday, This Week, Last
Week, This Month and Last Month
· Recent Chats - to run a report that
presents chats that have been recorded
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·

Mail
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in the last 3 days (you can change the
number of days in the 'Search Term'
field to cover a longer period)
Help - to display the Model Chat Help
topic

Click on this icon to display the 'Mail' tab
of the Chat & Mail window, which
provides access to the Model Mail
facility. This enables you to send, receive
and respond to emails within the project
team, under your User Security ID, either
as an individual user or as a member of a
group that has a shared mail inbox.
If you click on the drop-down arrow, you
can select from options to:
· Open the 'Sent Messages' tab of the
main work area, listing all emails sent
by you or by other members of the
security groups of which you are a
member
· Open the 'Model Message' dialog, in
which you create and send an email
message to one or more team members
· (Having selected a model object first)
Open the 'Model Message' dialog that
already contains a hyperlink to the
selected object
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Model Home

This icon presents two options:
· Open Model Diagram - which opens
the diagram that has been defined as
the default model diagram for all users
of the model
· Manage - provides sub-options to set
the currently-open diagram as the
model default, search for and select
another diagram as the model default,
or clear the current default selection;
you have to have the proper
authorization to set the model default
diagram

Model
Library

Click on this icon to open the Model
Library, which you use to review and add
to a hierarchically-structured repository
of comments, reports, reviews and
documents on any structure, feature or
aspect of the project or of other, related
projects.

Calendar

Displays the Project Calendar, defaulted
to today's date, on which you can check
for scheduled meetings and reminders of
events, and add items for today or any
day in the future.
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Personal Panel
The 'Personal' panel provides options to maintain work area
settings that are specific to your login, such as your daily
diary, your working sets - groups of windows, diagrams and
views to return to as a set in later work sessions - your user
default diagram, your default work Package, your Gantt
Chart listing your work allocations, and the Kanban diagram
you have set as your personal default.

Available Facilities
Facility
My Diary
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Click on this icon to open the 'My Diary'
tab of the Chat & Mail window, through
which you can maintain a daily diary
containing ideas, comments, notes,
suggestions, events, to-do lists and other
reminders of what you have done or
intend to do within the model. The
facility is simple to use, allowing you to
quickly jot down your thoughts as they
occur to you.
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Working Sets

Click on the Working Sets icon to open
the 'Working Sets' tab of the Focus
window, on which you can examine, edit,
select, create and delete collections of
windows and diagrams to open in your
work area.

My Diagram

Click on this icon to display options to
open your user default diagram, or to set
the currently open diagram as your user
default, locate and select another diagram
as the user default, or clear the
currently-specified user default diagram.

My Package

Click on this icon to display options to
locate and open your default Package, or
to locate and select a Package as the
default to open in the Browser window
when you log in to Enterprise Architect.

My Kanban

Displays the Kanban diagram that you
have set as your personal default.

My Gantt

Displays a Gantt chart listing the tasks
that have been allocated to you and that
are not yet complete.

(c) Sparx Systems 2022

Page 455 of 1150

The Application Desktop

3 October, 2022

Notes
·

·

The 'Set Current as Default' and 'Choose Default' options
are available in the Corporate, Unified and Ultimate
Editions of Enterprise Architect; User Security must be
enabled
The User Default diagram overrides the Model Default
diagram; the User Default setting is itself overridden by a
project shortcut, which defines displays to present on
opening the project
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Help Panel
The 'Help' panel provides access to the extensive Help
system and to a wide range of on-line facilities to support
your use of the tool, including the management of License
Keys. The Help system contains both overviews of
functional areas of the application and detailed topics on
how to use specific tools, helping you to be highly
productive. The Help is normally accessed as an on-line,
web-based system, but you can select to download a
file-based version of the Help to provide a local Help
system. You can also open the Learning Center, which
provides user-focused guidance for common tasks,
especially those specific to your own use of the system that
you have documented yourself.

Available Facilities
Facility

Description

Help

The Help icon displays a menu
containing a wealth of options for
opening and exploring the Help,
obtaining information from a number of
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other sources, and requesting support
from Sparx Systems.
· Open Help - opens the Help as a set of
pages in HTML format, either on the
web or local to your system, beginning
with the Introduction to Enterprise
Architect topic
· Search Help - opens the 'Find in Files'
search facility, which you use to
specify and search for a text string in
the Help
· Go toTopic - opens a specific Help
topic that you identify by name, if you
already know the topic you want to
display
· Explore Online Resources - opens a
submenu of options for accessing
resources on the Sparx Systems web
site:
- Install Help Locally - displays a
prompt to download the 'EA
UserGuide' installer file
(EAUserGuide.msi), which you use to
install the Help files locally
- User Forum and News - opens the
Sparx Systems User Forum,
which you can read as a guest or
as a logged-in user
- Request a Feature - opens the
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·

·

·
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standard form for submitting a
request for a feature you would
like to see in Enterprise Architect
- Bug Report Page - opens the
standard form for reporting the
details of a bug you have found in
Enterprise Architect (also
prompts you for your registered
user ID and password)
- Automation Interface - opens the
Sparx Systems web page on the
Automation Interface, providing a
number of examples of its use
- Introducing UML - accesses the
Sparx Systems online UML tutorials
- Pricing and Purchase Options displays details on purchasing or
upgrading Enterprise Architect
over the internet
Open Keyboard Accelerator Map displays the 'Help Keyboard' dialog,
which identifies which keyboard keys
have been mapped to Enterprise
Architect commands; you can
customize these mappings if necessary
Open the Example Model - opens the
EAExample model within the current
instance of Enterprise Architect
Configure On-line Help Translate Page 459 of 1150
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·

·

·

·

·

·
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displays a short dialog in which you
specify the language into which you
want to translate the online Help when
you display a page; the requested page
is passed to the Google Translate site
and displayed in the specified language
(this option does not operate on the
downloaded local Help)
Register and Manage Your License
Key(s) - configure and manage the
license keys used to register Enterprise
Architect and its Add-Ins
Check for Updates - displays the Sparx
Systems web page on the latest build
and its release notes
View the License Agreement - displays
the Enterprise Architect End User
License Agreement
Ordering Information - displays
information on how to purchase
Enterprise Architect
Pro Cloud Server Connection - where
the current repository is a Pro Cloud
server repository, this displays in the
System Output window: the version
details, the response of a ping to that
Pro Cloud Server and the timing of a
simple query
Read Me - displays the Readme.txt file,
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·

which details the changes and
enhancements in Enterprise Architect,
build by build
About EA - displays a window
showing your installation details,
including the program version, your
registration key, your repository
connection, the Enterprise Architect
edition and your user id

Home Page

Click on this option to open the Home
page of the Sparx Systems web site.

Libraries

Click on the drop-down arrow to display
these commands;
· Learning Center - displays information
from the Learning Center as a view in
the central workspace area
· Download Library - Opens the web
page for the Learning Center library,
from which you can download the
Learning Center into your file system:
https://sparxsystems.com/resources/libr
aries/index.html
· Manage Library - install, enable and
disable Library files

Register

Click on this option to open the 'License
Management' dialog and register a new
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Enterprise Architect license key.
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File Management
When managing the project as a unit, you can create, open,
close or save projects, provide desktop shortcuts to a
project, or perform print tasks.

Access
Other

Click on

File Management Options
Option

Action

New Project

Create a new Enterprise Architect project,
using the Model Wizard (Start Page
'Create from Pattern' tab) to help you
define the base technology, model types
and Patterns to use as a framework.
Shortcut: Ctrl+N

Open Project

Open an existing project, or create a new
project from scratch or from a base
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template project, using the 'Manage
Projects' dialog
Shortcut: Ctrl+O
Reload
Project

Reload the current project. (Use this in a
multi-user environment to refresh the
Browser window).
Shortcut: Ctrl+Shift+F11

Close Project

Close the current project.

Save as
Shortcut

Create a desktop shortcut to the current
project.
(This option is also active in the 'Lite',
read-only edition of Enterprise Architect.)

Print Setup

Configure your printer's settings.

Page Setup

Configure the page settings to print the
current diagram.

Print Preview

Preview how the currently displayed
diagram will print.

Print

Print the currently displayed diagram.
You can also make use of other facilities
to change the scale of the printed diagram
(the number of pages it takes up) and to
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print or omit page headers and footers on
the diagram. By de-selecting the
'Printable' option on an element on a
diagram, you can omit that element and
its connectors from the printed diagram.
Shortcut: Ctrl+P
Print to PDF

Save the currently displayed diagram as a
PDF file. A browser displays to select the
PDF file name and directory path.
By de-selecting the 'Printable' option on
an element on a diagram, you can omit
that element and its connectors from the
diagram in the PDF output.

Recent
Models

Select from a list of up to ten of the most
recently opened projects, to re-open the
selected project.

Pinned
Models

Select from a list of up to ten of your
pinned projects, to re-open the selected
project.

Search

Type the name of an operation or
command that you want to locate; a list of
options relating to the search text is
immediately displayed down the left hand
side of the dialog and, when you click on
an option, the appropriate dialog opens.
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Exit from Enterprise Architect.
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The Notes Window
Notes are textual descriptions that can be added to an
element, diagram, connector, feature or assigned item (such
as Tests, Maintenance items, or allocated resources) in
Enterprise Architect. They provide valuable information that
describes the entity being modeled. Many newcomers to
modeling are not aware that these textual descriptions are
core to many of the modeling languages, including UML,
BPMN and SysML; without them the model would be hard
to understand and remain opaque. A well-formed note is
unambiguous and doesn’t contain redundant information
that has been entered in other properties of the entity.

Using the Notes window
You can create and view notes in the Notes Window, which
can be docked anywhere in the application, or through the
'Properties' dialog or editing dialog for a modeling object or
feature. The notes can be formatted using the Notes Toolbar,
conveniently located above the notes text field. This
formatting is carried through to documentation generated
from the model, and includes markup such as italics,
bolding, bullets and hyperlinks. You can also reference
Glossary Terms and model elements from the notes text.
There are convenient keyboard shortcuts available for
quickly editing the text.
Many experienced modelers have the Notes window docked
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in the workspace, and when they select an entity in a
diagram, the Browser window or another window, that
object immediately becomes the focus of the window and
they can view, create or edit the notes. Conversely, if you
have limited screen space and do not want to keep the Notes
window open all the time, you can display the Quicknotes
window, which is a simpler version of the Notes window
without the toolbar. You can still format the text using
context menu options. The Quicknotes window closes when
you click outside it.
There are two variants of the Notes window or field:
· For standard modeling objects such as elements,
connectors, diagrams, attributes and operations, where the
text field contains only the text you type into it and the
number of characters of text currently contained in the
field is displayed in the left-hand end of the Status bar

·

For assigned items such as Tests, Maintenance Items,
Project items and allocated resources, where the text field
contains automatic headings - 'Description' and 'History' that cannot be deleted, and that reflect the text typed into
the corresponding tabs in the item's editing dialog; for
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Test items, the headings are 'Description', 'Input',
'Acceptance Criteria' and 'Results'
This variant does not show a character count in the Status
bar

This difference is reflected in the Quicknotes window as
well, where Ctrl+Spacebar displays the general Notes text
or, for an assigned item, the 'Description' text.

For an assigned item, Shift+Space displays the 'Results' or
'History' text.
When text translation is enabled and configured on the
'Translations' page of the 'Manage Model Options' dialog,
the Notes window has a 'Local' tab (to display Notes text in
the original language) and a 'Translation' tab in which you
select to translate and display the same Notes text in the
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selected language. See the Text Translation Help topic.
If you are working in a Cloud-connected model and have
also connected to an external data source, when you select
an external data item a separate version of the Notes
window displays to show the external item Notes text. See
the External Item Details Help topic.
If the text in the Notes window or 'Notes' fields does not
render as well as you would like, you can change the font
using the 'Note Editor Font' option on the 'Application Look'
dialog. You can also change the zoom level applied to all
notes text, using the 'Default Note Zoom' field; this field is
initially set to 110%. See the Visual Styles Help topic.

Access
Ribbon

Start > All Windows > Design > Create >
Notes
Design > Element > Properties > General
> Notes
Start > All Windows > Properties >
General > Notes

Context
Menu

Right-click on model element | Properties
| Notes

Keyboard

Ctrl+3
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Ctrl+Space (Quicknotes)
Shift+Space (Quicknotes History)
Alt+1 | Create | Notes
Alt+2 | General | Notes

Notes Context Menu options
Option

Action

Create |
Glossary
Definition

Click on this option to create a Project
Glossary definition, with the Glossary
term taken from the selected 'Notes' text.
To create the Glossary entry:
1. If suitable Notes text is available,
highlight the text to use as the Glossary
definition and press Ctrl+C to copy it.
2. Highlight the text to use as the
Glossary term, right-click on it and
select the menu option; the 'Glossary
Detail' dialog displays, with the
selected text in the 'Term' field.
3. If you have copied some definition
text, paste it into the 'Meaning' field;
otherwise type a suitable definition of
the term in this field.
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4. In the 'Type' field, select the
appropriate term type.
5. Click on the Apply button to save the
new Glossary definition.
The term displays in the 'Notes' text as a
Ctrl+click hyperlink, which displays the
Glossary definition of the term in the
'Glossary Detail' dialog.
Once you have created a Glossary
definition, here or elsewhere in the
model, you can add the Glossary term
anywhere in the text of the Notes window
(or 'Notes' field of a dialog) where, again,
it becomes a Ctrl+click hyperlink to the
definition. Either:
· Simply type the term in the text, or
· If you are not certain of the term or
have multiple definitions:
1. Move the cursor to the point in the text
at which to insert the term.
2. Press Ctrl+Space; the Glossary Term
Selection window displays.
3. Double-click on the term to insert it in
the text.
Create | New Click on this option to create a new
Element from element in the model, the name of which
Selection
is taken from the selected Notes text.
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6. Click on the option.
7. The 'New Element' dialog displays,
with the 'Name' field pre-filled with the
selected text.
8. Set the element type and other options
as necessary, then click on the Create
button. (You can also select an option
on the dialog to add the element to the
diagram.)
9. The system creates the element, adds it
to the model (and diagram) and creates
a hyperlink to it from the selected
Notes text.
Create |
Element on
Diagram

(c) Sparx Systems 2022

Click on this option to create a new
element in the model, and explicitly in
the diagram also, with its name taken
from the selected Notes text. This option
does not make the selected text a
hyperlink to the element.
10. Click on the option.
11. The 'Toolbox Shortcut' menu displays
for the diagram type. If necessary, click
on the 'Other' option and select from a
different set of element types.
12. Click on the required element type
and then click on the diagram. A new
element is created at the cursor
position, with the selected text as the
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element name.
Create | Link
to Existing
Element

Click on this option to create a hyperlink
from the selected Notes text to an
existing element in the model.
13. Click on the option.
14. The 'Select Classifier' dialog displays.
Locate and select the required element,
and click on the OK button.
15. The selected Notes text becomes a
hyperlink to the element. The target
element name and Notes text remain
unchanged and do not necessarily
mirror each other.

Translate |
Mark for
Translation

If Automatic Translation is enabled,
highlight a term or word then click on
this option to identify a specific
translation for this instance of the
selected text. A prompt displays in which
you specify which Glossary Category the
translation for that term is defined in,
within the Translation section of the
Glossary Model.
This is of particular value where the
sequence of a string of words is
important, such as a breadcrumb trail,
menu path or ribbon path, especially
where the same or related terms are used
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in different sequences of words. A free
translation might re-organize the
sequence of words, or combine words,
making it hard to follow instructions or
recognize the context. You would
therefore make sure that the translation of
this specific combination of words
exactly matched what the reader is
intended to see.
Translate |
Do not
Translate

If Automatic Translation is enabled,
highlight a term or word then click on
this option to protect the selected instance
of the text from the translation process.
You might use this if a term has different
meanings, some of which are appropriate
for translation and some of which have a
special application that should not be
translated. For example, you might freely
translate the words 'the wood' in the
context of a material, but want to protect
'The Wood' as a reference to a location.

Search for
<'selected'>

Click on this option to display a subset of
the functions of the common Code Editor
menu 'Search' option, to locate a text
string outside the element.
In a 'Notes' field (not in the Notes
window) you can perform a search of the
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text for a text string:
· Press Ctrl+F and specify the text string
and the direction of search
· Press F3 to locate more instances of the
word in a forward search, or Ctrl+F3 in
a backwards search
Undo
Cut
Copy
Paste
Delete
Select All

These six options provide simple
functions for editing the Notes text.

Print

Click on this option to send the Notes text
directly to the configured printer.

Thesaurus

Highlight a word in the Notes text and
click on this option to display the
'Thesaurus' dialog, which shows the
meaning of the selected word, its
synonyms and - if you select the
'Antonyms' checkbox - its antonyms. The
antonyms are listed at the bottom of the
Categories panel.
If you want to replace the selected word
with one of its synonyms, click on the
synonym and on the OK button.
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Select this option to reveal underlines and
other markers on text strings that have a
glossary definition assigned to them.
Select again to clear the 'selected' arrow,
to hide the glossary markers in the text.
This option is available in the 'Notes' and
'Description' fields, Discuss & Review
window tabs, Chat & Mail window tabs,
Scenario Editor, Specification Manager
and 'Mail Message' dialog. This is a
global option - selecting it or clearing it
for one screen will affect all the other
screens.

Keyboard Options For Notes
Option

Description

Switch text
orientation

Hold Ctrl, press Shift
Description: On a line of text,
right-justifies or left-justifies the
paragraph in which that line occurs.
Use the keys on the left of the
alphanumeric keyboard to left-justify the
text; use the keys on the right of the
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keyboard to right-justify the text.
Insert Date
and Time

F5
Description: Inserts the current date and
time at the cursor position, in the format:
DD/MM/YYYY HH:MM:SS AM (or
PM)
For example:
22/12/2016 3:39:50 PM

Spell check
Notes text

F7
Description: Performs a simple spell
check on the Notes text.

Undo
changes

Ctrl+Z
Description: Reverses the last change
made to the Notes text.

Redo
changes

Ctrl+Y or
Ctrl+Shift+Z
Description: Re-applies the last reversed
change to the Notes text.

Copy

Ctrl+C
Description: Copies a highlighted Notes
text string to the Enterprise Architect
buffer.
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Paste

Ctrl+V
Description: Pastes a copied or cut text
string from the Enterprise Architect
buffer into the Notes text.

Cut

Ctrl+X
Description: Removes a highlighted
Notes text string and places it in the
Enterprise Architect buffer.
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Notes Toolbar
Although it is not an independent toolbar that you can pin to
the screen top or sides, or float in your work area, the Notes
toolbar appears in many places across Enterprise Architect
in the 'Notes', 'Description' and 'History' fields in, for
example, the:
· Element and connector 'Properties' dialogs
· Feature 'Properties' dialog
· Diagram 'Properties' dialog
· 'Hyperlink Details' dialog
· Test Cases window descriptions
· Notes window
· 'Glossary Detail' dialog
· Responsibility window

Options
The options of this toolbar operate on selected text and any
new text continuing from the formatting. The options (with
some keyboard shortcuts) are, from left to right:
· Make text bold (Ctrl+B)
· Make text italic (Ctrl+I)
· Underline text (Ctrl+U)
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Change the font color of the text
Insert list bullet points (Ctrl+.) (full stop)
Insert list numbering (Ctrl+0)
Make text superscript
Make text subscript
Insert a hyperlink - this displays the 'Hyperlink Details'
dialog, on which you specify the type of hyperlink and
type in or browse for the location of the target of the
hyperlink
Create a new Linked Document for the element, or edit an
existing one

Notes
·

·

If the toolbar is displayed but grayed out, the text field is
read-only and cannot be edited; other long text fields in
Enterprise Architect might not have the toolbar, in which
case the Notes facility is not available for those fields
You can create a Project Glossary term and definition
from text in any field that has the Notes toolbar
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Text Translation
The translation facilities operate primarily on the text
entered into the Notes window, so this is the principal
interface between users and the translations. When the
model administrator enables and configures translations on
the 'Translations' page of the 'Manage Model Options'
dialog, the Notes window has a 'Local' tab that displays note
text in the natural language for the model, and the
'Translation' tab in which you select to translate and display
the same note text in one of the selected languages.
Through the Notes window you can use the Enterprise
Architect text translation feature to:
· Perform a manual translation of the notes text displayed in
the 'Local' tab, by typing or pasting the translation into the
'Translation' tab; available in all editions of Enterprise
Architect
· Automatically translate the Notes text into one of the
selected languages (if using an internet translator
application); available in any Cloud-connected repository
· Block automatic translation of a specific instance of text,
or select an instance of text to be translated according to a
category in the Glossary Model (on the 'Local' tab)
· Force a translation if the translator is not set to operate
automatically
· Toggle automatic translation if you are editing either the
original text or a Translated text and do not want the
original text to be translated
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Reset the 'difference' flag on the 'Translation' tab, when
the flag indicates that either the translation or the original
text has been changed since the note text was translated

Manual Translation
In preparation for performing a manual translation, you first
enable the Translation facilities and - if you have the
Corporate or higher edition - specifically select the option of
performing manual translations, on the 'Translations' page of
the 'Manage Model Options' dialog. You also select the
source and target languages; you can select more than one
target language.
To enter a manual translation of the notes for a selected
object, display the 'Translation' tab of the Notes window
(Ctrl+3 > Translation), click on the drop-down arrow in the
'Language' field and select the language in which to translate
the notes shown in the 'Local' tab.

Now you either manually type or paste a translation of that
text into the text field of the Notes window, in the selected
language.
If you want to create translations of the Notes text in more
than one language, simply select each language in the
'Language' field in turn and enter the translation in that
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language. The translations are held in the model as different
pages, each displayed when the appropriate language is
selected.

You can edit the translated text at any time. Note that if you
do edit the translation, or the text in the 'Local' tab - in the
source language - is changed (that is, the modified date/time
on the original text is later than on the translation text) an
asterisk displays on the 'Translation' tab name to indicate
that the translation(s) might not match the original text. The
asterisk is removed when you select the 'Verify Translation'
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Hamburger option on the 'Translation' tab.
Note that you can also manually translate the object name
and alias into any or all of the enabled languages, using the
Properties window for the object.

Automatic Translation
In preparation for performing automatic translations, you
first:
· Install and set up the Integration Plug-in for Google or
Microsoft, or a customized Plug-in you have created for
any other translator facility you want to use
· Enable the Translation facilities on the 'Translations' page
of the 'Manage Model Options' dialog, register the
translator and select the source and target languages; you
can select more than one target language
· Prepare the Translation section of the Glossary Model to
block the translation of specific terms (such as product
names) or to provide your preferred translations of certain
words either wherever they are used or when they are
used in particular contexts, such as in menu paths
You can select the 'Auto translate notes' option on the
'Translations' page to perform translations automatically as
soon as you open the 'Translation' tab of the Notes window,
or as soon as you change the language into which to
translate the text, in the 'Language' drop-down list on that
tab.
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If you do not have the 'Auto translate notes' option selected,
the Notes text is not automatically translated until you select
the 'Force Translate' option from the Hamburger menu icon
on the 'Translation' tab. This translates the text just for the
current object in the currently selected language.
When an automatic translation is initiated, the system first
checks the Translation elements in the Glossary Model and,
where appropriate, applies the defined translation to the
flagged words in the text. You flag these words and any that
should not be translated at all using the context menu
options in the 'Local' tab of the Notes window; see the Notes
Help topic. The system then protects these words from
translation, and allows free translation of the rest of the text.

Modify Automatic Translation
Text in the 'Translation' tab is laid out in the same format as
the original text. Different languages have different
structures, and the format or emphasis of text in one
language might not suit another language. The translation
itself might also not quite convey the context of the original
language. In these situations, you can manually edit the
translation to better represent your purpose.
As you do this, the 'Translation' tab name displays an
asterisk to indicate that the content of the tab has been
changed after the text was translated. The asterisk also
displays if you edit the original text without retranslating the
text. You can clear the asterisk by clicking on the
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'Hamburger' icon on the 'Translation' tab and selecting the
'Verify Translation' option to indicate that the translation is
acceptable.
To protect the changes you make in the translated text in a
language, further automatic translation of that text in that
language is blocked. To revert to the literal translation of the
local text, click on the 'Hamburger' icon and select the
'Force Translation' or 'Auto Translate' option.
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The Properties Window
The docked Properties window provides a convenient and
immediate way to view and edit the properties of a wide
range of modeling objects and features such as diagrams,
elements, connectors, attributes, operations, receptions,
responsibilities, maintenance items, project items and tests.
The tabs and fields displayed depend on the selected object;
this illustration shows the 'Element' tab of the window,
which displays when you click on a Class element.
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When you click on an object in the Browser window or a
diagram, the Properties window immediately shows that
object's properties, so you can swiftly display the properties
of a sequence of objects of different types - element, then
attribute, connector and diagram - on the same window
without having to open and close separate dialogs.
Each iteration of the window shows the general properties,
such as name, object type and status, and properties
appropriate to the stereotype, technology, object type and
project management. In many cases there is a series of
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additional tabs appropriate to the specific type of object
displayed. These are illustrated in the Help topic describing
the window for each selected object type.
To complete fields you can select values from drop-down
lists and work through short chains of property or parameter
dialogs directly from the Properties window. Your work
with modeling objects becomes quick, precise,
comprehensive and convenient, through the use of a single
area of your work space.
If you are working with an external data source in a
Cloud-connected model, you can also view the details of an
external data item on a variant of the Properties window,
with an 'External' tab. See the External Item Details Help
topic.

Access
Ribbon

Start > All Windows > Properties >
General > Properties
Design > Element > Properties > General
> Properties

Keyboard
Shortcuts

Ctrl+2
Ctrl+Enter
Alt+1 | Properties
Alt+5 | Properties
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Properties Window Options
The Properties window has a toolbar providing a number of
options for operating on the object you have displayed in the
window, as described in this table.

Option

Description

Save

Click on this icon to save any changes
you have made to the fields on any tab of
the Properties window.

Hamburger

Lists several options for acting on the
selected object; several of these options
apply only when you are looking at
element properties.
· Find in Project Browser - Locates and
highlights the current object in the
Browser window
· Element Properties - If you are
displaying the properties of an element,
displays the 'Properties' dialog for the
element
· Diagram Properties - If you are
displaying the properties of a diagram,
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·

·

·

·

·

·
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displays the 'Properties' dialog for the
diagram
Operations - If the current element is
capable of having operations, opens the
Features window at the 'Operations'
tab, to show the operations of the
element.
Attributes - If the current element is
capable of having attributes, opens the
Features window at the 'Attributes' tab,
to show the attributes of the element.
Receptions - If the current element is
capable of having Receptions, opens
the Features window at the 'Receptions'
tab, to show the Receptions of the
element
Set Parents - If the current element can
have interfaces and parent elements,
opens the 'Set Parents and Interfaces'
dialog
Show Groups - Select or deselect this
option to partition the element
Properties into groups (such as 'General
Settings', 'Project' and 'Advanced'), or
present them all in one continuous list.
Help - Select this option to display the
Help topic appropriate to the tab of the
Properties window that you have
selected
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Switch
Display

Click on this option to open the
'Properties' dialog for the selected object.

Special
Action

Click on this icon to display the
appropriate special action or special
properties dialog for the selected object;
if there is no special action display, the
standard 'Properties' dialog displays.

Notes
·

·

When you click on a field name, a brief summary of that
field displays at the bottom of the Properties window,
unless you have selected the 'Hide Properties Info Section'
checkbox on the 'Window Behavior' page of the
'Preferences' dialog
If you click on the field value for an editable field, either a
drop-down arrow or a button displays that enables you
to select or browse for a different value; one of the values
offered might display a more advanced list or a dialog for
adding new objects or selecting multiple objects, as the
'Stereotype' field does
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Properties Window for Diagrams
The docked Properties window provides a convenient and
immediate way to view and edit properties of modeling
objects, including diagrams. When the Properties window is
open and you click on an open diagram, the window defines
the diagram, displaying the common properties and
providing an associated 'Compartments' tab.

(c) Sparx Systems 2022

Page 494 of 1150

The Application Desktop

3 October, 2022

As you review the properties for the diagram, you can edit
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the values by overtyping them, or by clicking on the
drop-down arrow or browse button to select alternative
values.
If you click on a diagram name in the Browser window, you
can edit some of the common properties in the Properties
window; however, most of the fields are available for
editing only when the diagram is open and selected.

Access
Ribbon

After selecting the Properties window
using one of these methods, click on the
first required diagram.
Start > Application > Design > Properties
or
Explore > Portals > Windows >
Properties > Properties

Keyboard
Shortcuts

Ctrl+2 or Ctrl+Enter
Alt+1 > Properties

Properties Window Tabs
Tab
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Diagram Tab

The 'Diagram' tab provides a number of
checkbox fields that make it simple to
define what the diagram shows and how
the objects are presented. You can also
tailor certain fields that were assigned
default values when the diagram was
created. For further details, see the
Diagram Tab Help topic.
You can also define properties on the
diagram's 'Properties' dialog.

Compartment
s Tab

This tab provides a list of the simple
compartments that you can display in
elements included in the current diagram.
Some types of element are automatically
displayed in rectangular notation, whilst
others might have to be set manually in
rectangular notation to show the
compartments.
Click the check box against each
compartment to show in the elements on
the diagram:
· Attributes
· Operations
· Tags
· Requirements
· Constraints
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Testing
· Maintenance
· Discussions
· Reviews
· Resources
· Package Contents
· Project
· Notes
· Receptions
For further information on these
compartments and others you might set
on the diagram, see the Compartments
and Define Element Characteristics Help
topics.
·
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Properties Window - Diagram
The 'Diagram' tab of the Properties window provides a
number of fields and options you can set to define what the
diagram shows and how the objects are presented.

Access
Ribbon

Click on the required diagram and then
display the Properties window using one
of these methods:
Start > Application > Design > Properties
> Diagram
Design > Element > Editors > Properties
> Diagram

Keyboard
Shortcuts

Ctrl+2 > Diagram
Alt+1 > Properties > Diagram
Alt+5 > Properties > Diagram

Diagram Properties
Field
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Name

Defaults to the name of the parent
Package as the name of the diagram. If
necessary, you can edit the name or
overtype it with a new name.

Type

Displays the diagram type. You cannot
edit this field.

Stereotype

(Optional) Type in the name of a diagram
stereotype to apply, or click on the
drop-down arrow and select a stereotype
from the list.
You can define stereotypes to select here
using the 'Settings > Reference Data >
UML Types' ribbon option, selecting the
'Stereotypes' page and creating
stereotypes with a 'Base Class' of
'Diagram'.

Author

Defaults to the name of the person who
created the diagram. If necessary, you can
overtype this or click on the drop-down
arrow and select an alternative name from
the list.

Applied
Metamodel

Displays the name of the diagram View
or specialization. If necessary, click on
the drop-down arrow at the right of the
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field and select a different View.
Filter to
Metamodel

Select this checkbox to filter the diagram
to 'fade' all elements that are not derived
from the same View as the selected
element.

Filter to
Context

Select this checkbox to filter the diagram
to 'fade' all elements that have no
relationships with the selected element
(the context element), so that only those
in the relationship group are apparent.

Context
Navigation

This option operates on the 'Context' tab
of the Browser window, and Package
elements in the diagram. When you select
the checkbox and click on a Package
element, the Package becomes the focus
of the 'Context' tab and you can click on
and expand the Package contents in the
tab.
If you clear the checkbox, clicking on the
diagram content has no effect on the
'Context' tab.

Version

Displays the version number of the
diagram. This defaults to 1.0 when the
diagram is created, and you update the
version manually according to the

(c) Sparx Systems 2022

Page 501 of 1150

The Application Desktop

3 October, 2022

conventions applied in your workplace.
Filter to
Version

Select this checkbox to filter the elements
on the diagram and mute those that do not
have the same version number as the
diagram. This is of particular value when
you are working on the elements of a
cloned diagram and want to distinguish
between elements that have been cloned
to match the diagram and Package
structure, and elements that are still the
same version as the source.
You can use the facility to check more
generally which elements are not of the
same version as the diagram, such as
when you drag elements from the
Browser window as links to local or,
more especially, external elements.

New to
Version

Select this checkbox to set the version of
every new element added to the diagram
to the same version as the diagram.
Elements dragged and dropped from the
Diagram Toolbox or added using the
'New Element' dialog will have the same
version as the diagram. The version value
of elements dragged and dropped from
the Browser window will not be updated.
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Display as

Use this field to display an alternative
view of the diagram. Click on the
drop-down arrow and select:
· Diagram - to show the default graphical
view of the diagram
· Specification - to show the elements on
the current diagram in the Specification
Manager
· List - to show the diagram as a list of
elements (Diagram List)
· Gantt - to show the elements on the
diagram and resource allocations
against them in a Gantt chart
· Relation Matrix - to show a graphical
relationship matrix for the elements on
the diagram
· Construct View - to show the elements
on the diagram and project
management information attached to
them in a grid view

Hand Drawn

Select this checkbox to display the
diagram contents as if they had been
roughly drawn by hand.

Whiteboard

Select this checkbox to display the
diagram as if it had been drawn on a
whiteboard, with white fill and
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background.
Custom Style

Select this checkbox to turn on diagram
custom style. Clear the checkbox to
revert to normal notation. Changes to this
checkbox are reflected in the 'Custom
Draw' checkbox in the diagram
'Properties' dialog, and vice versa.

Disable fully
scoped object
names

Select this checkbox to disable the use of
fully scoped object names for elements in
this diagram.

Display
Element
Lock Status

Select this checkbox to add a locking
indicator ( or ) outside the top left
corner of each locked element on the
diagram.
If the element is:
· Fully locked or locked by another user,
the indicator is red
· Locked by you or by another user in
the same user group as you, the
indicator is blue
· Not locked, no indicator displays

Display
Linked
Document

Select this checkbox to allow elements on
the diagram that have Linked Documents
to display the Linked Document icon (A).
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Icon

Clear the checkbox to hide the icon.

Collapse
Embedded
Elements

Reduces edge-mounted structural
elements to black dots on the parent
element border, on the current diagram.
Each black dot represents one structural
element or one hierarchy of elements; for
example, a Port with an Interface
collapses to one dot.

This simplifies the information presented
by the diagram, when the structural
elements are currently not the focus of
interest.
You can move the dot representing a
structural element, but you cannot create
new structural elements or connectors
involving structural elements on the
diagram whilst this option is in use.
Show
Collapsed
Embedded
Labels
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If embedded elements have been
collapsed, you can select this option to
display labels identifying the collapsed
elements on the diagram by name.
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Use Info Tip
(global)

For all diagrams in the model, display a
tooltip containing element property
information when you move the cursor
over an element in the diagram. Setting or
clearing this checkbox for one diagram
sets or clears the checkbox in every other
diagram in the model.
If this checkbox is not selected, diagram
tooltips are not displayed.
The type of property information to
display is defined in the 'Tooltips' panel
at the bottom of the 'Diagram' tab of the
'Preferences' dialog.

Dashboard
Style

Designed to operate on Dashboard
(Chart) diagrams, to lay out Chart
elements in a logical sequence. Click on
the drop-down arrow and select the style
to apply.
This option will operate on diagrams of
types other than Dashboard, but the effect
might not be as useful.

Grid Style

Click on the drop-down arrow and select
'Enable' to apply the Grid style, 'Disable'
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to cancel the Grid style, and 'Edit' to
define or update the style.
Support
Collaboration
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Select a value to flag elements on this
diagram where monitoring for new
messages has been turned on for:
· Elements that are the subject of
Discussions
· Chat messages to specific user groups
(Chat messages to individual users are
automatically monitored)
If an element is the subject of a
monitored Discussion, and an unread
message is in the 'Discuss' tab of the
Discuss & Review window, the icon
displays against the element on the
diagram.
Each monitored Chat group or user
should be represented by an Actor
element on the diagram. If a user or a
member of a group sends a Chat message,
the icon displays against the
appropriate Actor element on the
diagram.
There are four options:
· None - to turn Collaboration support
off so that no notification icons display
(any other option turns Collaboration
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·

·

·

support on for Discussions)
With Alias - for Chat messages, to
check the Actor elements to locate the
one that has the poster's user ID or
group ID in the 'Alias' field
With Locking User - for Chat
messages, to check the Actor elements
for the one that has been locked under
the poster's user ID or group ID
With Both - for Chat messages, to
check firstly for the user ID that locked
the element and, if that is not found, for
the 'Alias' field containing the poster's
user ID

Theme

Click on the drop-down arrow and select
the theme to apply to the current diagram.
The field defaults to the value 'Use global
theme', which applies the theme selected
on the 'Diagram > Theme' page of the
model 'Preferences' dialog.

MDG
Technology

If the diagram is part of a model created
for an MDG Technology, this field
displays the name of that technology

GUID

Read-only field, displaying the GUID of
the selected diagram.
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WebEA

If your organization uses WebEA on the
Pro Cloud Server, it is likely that the
'Advanced' section of the 'Diagram' tab
will have this field automatically filled
with the https address of the diagram for
access by WebEA; this field is enabled
by the Project Administrator, setting the
model's web address in the 'URL' field of
the 'Cloud' page of the 'Manage Model
Options' dialog.
The WebEA diagram address is a
composite of the model URL, the model
number in WebEA, and the diagram's
GUID.

Show
Relationships

Defaults to selected to show relationships
on the diagram. To hide all relationships
on the diagram, click on the checkbox to
clear it.

Freeze
Visible

Click on the checkbox to select it, to
freeze the diagram to show only the
connectors that are visible on this
diagram at this point. Connectors that are
subsequently created on other diagrams
between the same elements are not added
to this diagram until the option is
deselected and the diagram is refreshed.
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Show
Non-Navigab
le Ends

Click on the checkbox to select it, to
indicate when Association Ends are not
navigable; a cross is shown on each
non-navigable end of an Association
connector.

Show
Property
String

Click on this checkbox to select it, to
show the property strings (constraint text)
for connectors.

Suppress All
Labels

Click on the checkbox to select it, to hide
all connector labels on the diagram.

Show
Stereotype
Labels

Click on the checkbox to select it, to
show a label on each connector indicating
the connector's stereotype.
Click on the checkbox again to clear it, to
hide these stereotype labels.

Connector
Notation

Click on the drop-down arrow and select
the required connector notation:
· UML 2.1 - use the standard UML 2.1
notation for connectors (the default)
· Information Engineering - use the
Information Engineering (IE)
connection style
· IDEFX1 - use the Integrated Definition
Methods IDEFX1 connection style
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Notes
·

In the Corporate, Unified and Ultimate Editions of
Enterprise Architect, if security is enabled you must have
'Update Diagrams' permission to update diagram
properties
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Properties Window for Elements
The docked Properties window provides a convenient and
immediate way to view and edit properties of modeling
objects such as elements. When the Properties window is
open and you click on an element in a diagram or in the
Browser window, the Properties window displays the
general properties and usually provides specialized tabs
appropriate to the particular type of element. For example:
· Port and Part elements have a 'Property' tab and a
'Redefined/Subsetted' tab
· Class and Signal elements simply have an 'Element' tab, a
'Translation' tab and a 'Tags' tab
· Objects have a 'Run States' tab
· Activity elements have 'Behavior', 'Parameters', and
'Partitions' tabs
· Action and Invocation elements (depending on their type)
have 'Action', 'Trigger', 'Behavior', 'Arguments' and 'Call'
tabs
· Action Pins have a 'Pin' tab
· Checklists have a 'Checklist' tab
· System Boundaries have a 'Boundary' tab on which you
define the element appearance
The specialized tabs are described in the Help where each
specific type of element is discussed. Not all tabs and fields
on the Properties window are currently documented for all
element types. The principal tab for elements is the
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'Element' tab.

For information on this tab, please refer to the Element Tab
Help topic. The 'Translation' tab is described in the
Translation Facilities Help topic, and the 'Tags' tab is
described in the Tagged Values Help topic.
As you review the properties for an element, you can edit
the values by overtyping them, or by clicking on the
drop-down arrow or browse button to select alternative
values.
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Access
Ribbon

After selecting the Properties window
using one of these methods, click on the
first required element.
Start > Application > Design > Properties
or
Design > Element > Editors > Properties
or
Explore > Portals > Windows >
Properties > Properties

Keyboard
Shortcuts

Ctrl+2
Ctrl+Enter
Alt+1 | Properties
Alt+5 | Properties

Notes
·

If your organization uses WebEA on the Pro Cloud
Server, it is likely that the 'Project' section of the 'Element'
page will have a 'WebEA' field showing the https address
of the element for access by WebEA; this field is enabled
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by the Project Administrator, setting the model's web
address in the 'URL' field of the 'Cloud' page of the
'Manage Model Options' dialog, and is automatically
filled with a composite of the model URL, the model
number in WebEA, and the diagram's GUID
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Properties Window - Element
The 'Element' tab of the Properties window displays the
properties fields for the currently selected element of any
type, with the properties grouped as General, Technology,
Base Element Type and Project. For some element types it
is the only page shown. If the fields are not displayed, click
on the white arrow head next to each group name to expand
the group.
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To add or change the value of a field, you can either:
· Overtype the field with the required value
· Click on the drop-down arrow to select from a list of
appropriate values or
· Click on the
button at the end of the field to search the
model for an appropriate classifier

Access
Ribbon

Start > Application > Design > Properties
Design > Element > Editors > Properties

Keyboard
Shortcuts

Ctrl+2 > Element

Element Properties
Option

Description

Name

This field displays the element's name
that, for a new element, defaults to either:
· <element type><number of elements of
this type already in the Package> (for
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example, Class3) or
· A name conforming to the
auto-naming/numbering convention
you have defined
If necessary, overtype the default name
with a different name.
Type

Displays the element type, such as Class
or Use Case.

Stereotype

(Optional) Displays the stereotype (if
any) assigned to the element. The
stereotype name is prefixed by its parent
profile name.
If the element has multiple stereotypes,
they are listed on separate lines of the
field.

Role

(Optional, for an Object element)
Displays the role played by the object
represented by the element.

Alias

(Optional, for elements other than an
Object element) Displays the alias or
alternative display name for the element,
if any.

Keywords

(Optional) Displays any significant terms
that the element might be associated with
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and that might be filtered on to identify
the element in Use Case Metrics and
Searches.
Status

Displays the current management status
of the element (such as Approved or
Proposed).

Version

Displays the current version of the
element (defaults to the value specified
on the 'Objects' page of the Preferences
window, such as 1.0 or 2.3, but you can
type in any alphanumeric string that
meets your requirements).

Priority

Displays the relative importance of
meeting this Requirement, Change, Issue
or Feature compared to other elements of
the same type:
· Low
· Medium
· High

Difficulty

Displays an estimate of the difficulty in
meeting the Requirement, Feature,
Change or Issue defined by the element:
· Low
· Medium
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·

High

Multiplicity

Identifies the number of instances of the
element that can exist in a set; the value
displays on the element in a diagram, in
the 'Name' compartment.

Visibility

Displays the element's exposure for
access ('Public', 'Private', 'Protected' or
'Package').

Leaf

Identifies whether or not the element is
final, so it cannot be a parent for other
elements.

Abstract

Identifies whether or not the element is
abstract.

Classifier

Displays the name of the element that
acts as a classifier for the selected
element.

Author

This field defaults to the user ID of the
person who created the element. If
necessary, you can type in a different user
ID, or click on the drop-down arrow and
select one.

Package

Identifies the parent Package of the
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selected element.
Phase

Displays the current phase of the element
(defaults to the value specified on the
'Objects' page of the Preferences window,
such as 1.0 or 2.3, but you can type in
any alphanumeric string that meets your
requirements).

Complexity

Displays the element's development
complexity (used for project estimation).
There are normally three levels:
· Easy
· Medium
· Difficult
However, you can change your user
defaults to add 'Extreme' and 'Unknown'
to this list of options.

Created

Displays the date and time the element
was created.

Modified

Displays the date and time the element
was most recently modified.

Language

Defaults to the programming language
defined for the model (in the 'Default
Language for Code Generation' field on
the 'Source Code Engineering' page of the

(c) Sparx Systems 2022

Page 521 of 1150

The Application Desktop

3 October, 2022

'Preferences' dialog).
If this element is required to have a
different language, click on the
drop-down arrow and select it. If the
element is not language-specific, select
'<none>'.
Filename

(Optional) If you intend to generate code
from the element, click on the button
to the right of the field and create or
select the name and location of the file
into which the code will be generated.

GUID

Displays the automatically-assigned
Globally Unique Identifier of the
element. You can check this GUID and
copy it for reference in many of your
modeling tasks.

WebEA

If your organization uses WebEA on the
Pro Cloud Server, it is likely that the
'Element' tab will have this field
automatically filled with the https address
of the element for access by WebEA; it
can be copied and used as a hyperlink to
access the element. This field is enabled
by the Project Administrator, setting the
model's web address in the 'URL' field of
the 'Cloud' page of the 'Manage Model
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Options' dialog.
The WebEA element address is a
composite of the model URL, the model
number in WebEA, and the element's
GUID.
Is Root

Identifies whether or not the element is a
root element that cannot be descended
from another element.

Is
Specification

Identifies whether or not the element is a
specification.

Persistence

Identifies whether the element is
persistent or transient, or neither (blank).

Base Type

Displays the base type of element of
which the selected element is an
extension.

Exclude from
Generated
Reports

For a Package element, indicates whether
or not the Package and its contents will
be excluded from any reports generated
on this Package's parent Package.
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Properties Window and Dialog for
Connectors
A connector can have a wide range of properties, with some
connector types having fewer, simpler properties and others
having more and more-complex properties. You edit these
properties on either the:
· Properties window for the connector or the
· '<connector type> Properties' dialog

(c) Sparx Systems 2022

Page 524 of 1150

The Application Desktop

3 October, 2022

Some properties are visible on a diagram as text labels on or
around the connector, and you can change these labels using
the 'Label' context menu.
The connector properties are presented on these tabs:
· Connector - defining General and (in the Properties
window) type-specific properties
· Advanced properties - type-specific properties on the
'Properties' dialog
· Source and Target Roles
· Constraints
· Template Bindings (where appropriate)
· Tags (Tagged Values) - On the Properties window,
type-specific and metatype Tagged Values are shown on
the 'Connector' tab; on the dialog all tags are shown on the
'Tags' tab
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Access
Ribbon

Start > Application > Design > Common
> Properties > click on connector in a
diagram > Connector (Properties
window)
Design > Element > Editors > Element >
Properties > click on connector in a
diagram > Connector (Properties
window)

Context
Menu

Right-click on Connector | Properties
('Properties' dialog)

Keyboard
Shortcuts

Ctrl+2 > Connector (Properties window)

Other

Double-click on Connector
('Properties' dialog)

General Options
These options are available on the 'Connector' tab and
'General' grouping of the Properties window, or the 'General
> Main' tab of the 'Properties' dialog.
(c) Sparx Systems 2022
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Option

Action

Name

(Optional) Type a representative name for
the connector; this name displays on the
diagram.

Notes

('Properties' dialog, Optional) Type any
comments you want to record on the
connector. You can format the text using
the Notes toolbar at the top of the field.
These notes can be included in searches,
reports and documentation, if required.

Type

(Properties window) Displays the
connector type selected when creating the
connector.

Stereotype

(Optional) Type the name of a stereotype
for the connector, or click on the
button and select the stereotype from the
'Stereotypes for <object name>' dialog.
If specified, the stereotype is displayed
on the diagram and it over-rides the
connector type in the report
documentation.
If necessary, you can add multiple
stereotypes, each in a separate line of the
field.
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Source

Displays the name of the source element
for the connector.

Target

Displays the name of the target element
for the connector.

Alias

(Optional) Type an alternative name or
alias for the connector.

Direction

Displays the direction of the connector.
For some connectors (such as an
Association), you can change the
direction: click on the drop-down arrow
and select the appropriate direction
details - from source to destination,
destination to source, bi-directional, or
unspecified.
Some connectors have arrow heads that
depend on this setting, and some
connectors are logically dependent on it
(such as Inheritance).

Style

Click on the drop-down arrow and select
the appropriate connection style; choose
from:
· Direct
· Auto-Routing
· Custom
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Tree (Vertical, Horizontal, Lateral
Vertical or Lateral Horizontal), or
· Orthogonal (Square Corners or
Rounded Corners)
Some connectors can also have the Bezier
style, under which the connector follows
a smooth curve.
·

Virtual
Inheritance

(For Generalization connectors) Click on
the drop-down arrow and select True or
False to indicate if inheritance is virtual
or not.

Scope

(For Generalization connectors where the
child Class is C++.) Click on the
drop-down arrow and select the
appropriate value for the scope (used for
inheritance).

Notes
·

Instead of displaying properties on tabs in the 'Properties'
dialog, you can display the properties on screen pages
selected through a hierarchical list; select the 'Property
Sheets use Tree style' checkbox using the 'Start >
Appearance > Visual Style' ribbon option
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The 'Binding' tab is displayed for Generalize, Realize,
Associate and Template Binding connectors; use this tab
to define binding expressions and parameter substitutions
for the connector
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Connector Advanced (Dialog)
The connector 'Properties' dialog has an 'Advanced' tab on
the 'General' page, which you use to reset the values of any
system-defined advanced properties that the connector has.

Access
Context
Menu

Right-click on Connector | Properties >
General > Advanced

Other

Double-click on Connector > General >
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Advanced

Set a value for a connector's advanced
property
Ste Action
p
1

Click on the data field to the right of the property
name.

2

Depending on the property, either:
· Type the value in free text
· Click on the drop-down arrow and select the value
from the list
· Click on the
button and search for the required
value

3

Click on the OK button.
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Connector Tagged Values
You can define Tagged Values for a connector and, for
Association and Aggregation connectors, set additional
Tagged Values for the source role and/or target role.
You can set these Tagged Values separately on the 'Tags'
tab of the Properties window or 'Properties' dialog.

Access
Ribbon

Start > All Windows > Properties >
General > Tagged Values > click on the
connector on the diagram (Properties
window)

Context
Menu

Right-click on Connector | Properties >
General > Tags ('Properties' dialog)

Other

Double-click on Connector > General >
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Tags

('Properties' dialog)

Set Tagged Values for the connector
Ste Action
p
1

Click on the connector type name, Connector Source
or Connector Target as required.

2

Either click on the icon in the toolbar, or press
Ctrl+N.
The 'Tagged Value' dialog displays.

3

In the 'Tag' field type the tag name, or click on the
drop-down arrow and select a predefined Tagged
Value type.

4

In the 'Value' field, type the value for the tag.

5

Click on the OK button to save the changes and
close the dialog.
The Tagged Value is displayed under the object type
you selected in step 1.
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Source and Target Role
For certain types of connector, such as Association or
Aggregation, the elements at either end of the connector can
have defined roles. You define the roles in the:
· Connector 'Properties' dialog, on the 'Role(s)' tab, which
has separate panels for the Source and Target role
definitions, or
· The Properties window for the connector, on the 'Source'
and 'Target' tabs
The field descriptions here are the same for both source and
target roles. This illustration shows the panels from the
'Properties' dialog; the Properties window tabs are almost
identical.
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Access
Ribbon

Start > Application > Design > Properties
> click on connector in a diagram >
Source or Target (Properties
window)
Design > Element > Editors > Properties
> click on connector in a diagram >
Source or Target (Properties
window)

Context
Menu

Right-click on Connector | Properties >
Role(s) (connector 'Properties' dialog)

Keyboard
shortcuts

Ctrl+2 > click on connector in a diagram
> Source or Target (Properties
window)

Other

Double-click on Connector > Role(s)
(connector 'Properties' dialog)

Enter Role Definitions
Option
(c) Sparx Systems 2022

Action
Page 537 of 1150

The Application Desktop

3 October, 2022

<top field>

Type the name of the role assigned to the
element.
Alternatively, click on the drop-down
arrow and select an attribute name from
the opposite element (that is, select the
source role name from the names of
attributes on the target element, and vice
versa).

<second
field>

Type any notes required to describe the
role.

MULTIPLIC
ITY
Multiplicity
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Click on the drop-down arrow and select
the required multiplicity for the role (you
can edit the possible values of this field
on the 'Cardinality' tab of the 'UML
Types' dialog).
Multiplicity is the range of instances of
the role that can be active in the
relationship - for example, one employee
can be assigned to one or more tasks; for
the target role you define the range of
instances (such as tasks) that the
employee could be assigned to.
The values have these formats:
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*, or 0..* - zero, one or many instances
· 0..n - zero or up to n instances, but no
more than n
· n - exactly n instances
· n..* - n, or more than n instances
You can also define source and target
role multiplicity in the corresponding
element's attribute properties.
·

Ordered

Click on the drop-down list and select
True or False to indicate whether or not
the role is an ordered list.

Allow
Duplicates

Click on the drop-down list and select
True or False to indicate that the role can
contain duplicate elements (relevant only
if multiplicity is > 1).
This field maps to the UML property
'isUnique' (selecting the checkbox maps
to the 'isUnique' value of False).

DETAIL
Stereotype
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(Optional) Type the name of a stereotype
that applies to this end of the connector,
or click on the button at the end of the
field and select a stereotype from the
'Stereotypes for <object name>' dialog.
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Alias

(Optional) Type in an alias for the role.

(Level of)
Access

Click on the drop-down arrow and select
the appropriate access level for the role.

Navigability

Click on the drop-down arrow and select
a value to indicate whether or not this
role is navigable (whether non-navigable
ends are shown on the diagram depends
on the diagram properties).

Aggregation

Click on the drop-down arrow and select
a value to indicate the type of aggregation
that this role uses.

Scope

Click on the drop-down arrow and select
a value to indicate the level (instance or
classifier) at which this role applies.

Constraints

Type the names of any constraints on the
role.

Qualifier(s)

Type the names of any qualifiers or
restrictions on the role; separate multiple
qualifiers with a semi-colon.
Alternatively, click on the button at the
end of the field, and define a new
qualifier on the 'Qualifiers' dialog
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(qualifiers typed into the 'Qualifiers' field
are also automatically added to this
dialog).
ADVANCE
D
Member
Type

Type the name of a role-type that can be
used when generating Collection Classes
for multiplicity > 1.

Changeable

Click on the drop-down arrow and select
a value to indicate whether this role is
subject to change.

Containment

Click on the drop-down arrow and select
a value to indicate the nature of the
containment at the Destination
(Reference or Value).

Derived

Click on the drop-down arrow and select
True or False to indicate whether the role
value or values can be computed from
other information.

Derived
Union

Click on the drop-down arrow and
indicate whether the role is derived from
the properties that subset it (that is,
derived from a strict union of all

(c) Sparx Systems 2022

Page 541 of 1150

The Application Desktop

3 October, 2022

properties that are constrained to subset
it). To change this flag, type 'F' or 'T' in
the field, as appropriate.
As an example, you might set this field to
True for a Class 'Schoolbus' with an
attribute 'Passengers [0..48]' that is a
derived union with these attributes
subsetting it:
· SeatedPassengers [0..36]
· StandingPassengers [0..10]
· WheelchairPassengers [0..2]
Owned

Click on the drop-down arrow and select
True or False to indicate whether the role
is owned by the opposite Class rather
than the Association.
Selecting True adds a 'dot' to the
appropriate end of the connector ( ).

Notes
·

·

Source role details are displayed at the start end of a
connector on the diagram; if you have drawn the
connector the wrong way, correct it by right-clicking on
the connector and selecting the 'Reverse Direction' option
Target role details are displayed at the terminating end of
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a connector on the diagram
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Connector Constraints
A UML connector can have associated constraints placed on
it. Constraints provide information on the rules and
conditions under which a relationship operates. For
example, it might be a pre-condition that a customer is of a
certain type before an Association connector to an Account
is allowed.
You can add the constraints using the 'Constraints' tab in
either the connector 'Properties' dialog or the Properties
window; the fields are the same.

Access
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Ribbon

Start > Application > Design > Properties
> click on connector in a diagram >
Constraints (Properties window)
Click on connector in a diagram
Design > Element > Editors > Element >
Properties Dialog (connector 'Properties'
dialog)

Keyboard
Shortcuts

Ctrl+2 > click on connector in a diagram
> Constraints (Properties window)

Context
Menu

Right-click on Connector | Properties >
Constraints (connector 'Properties'
dialog)

Other

Double-click on Connector > Constraints
(connector 'Properties' dialog)

Set constraints on a connector
Option

Action

Constraint

Type the name of the constraint.
Click on the drop-down arrow and select
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Type

the appropriate type of the constraint
(such as Pre-condition).

<notes>

Type any explanatory notes you might
require on the constraint. You can insert
line breaks in the text by pressing
Ctrl+Enter.

Save

Click on this button to save the constraint
definition.
The constraint is added to the 'Defined
Constraints' list.

New

Click on this button to clear the dialog
fields so that you can enter details of a
new constraint.

Defined
Constraints

Displays a list of the constraints defined
for this connector.

Delete

Click on this button to delete a constraint
you have selected in the 'Defined
Constraints' list.
The constraint is immediately removed
from the list.
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Notes
·

Constraints on an Association connector can be added to
further refine the model; constraints detail the business
and operational rules for the model
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Binding
Template Binding connectors, and also Generalize, Realize
and Associate connectors, have a 'Binding' tab on their
'Properties' dialog and in the Properties window. You use
this tab to define binding expressions and parameter
substitutions for the connector.
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Properties Window for Attributes
The docked Properties window provides a convenient and
immediate way to view and edit common properties of
modeling objects, including attributes. When you click on
an attribute in the Browser window or a diagram, the
Properties window immediately shows the attribute's
properties on the 'Attribute' tab.
You can also swiftly display the properties of other types of
object, such as elements, connectors and diagrams on the
same window without having to open and close separate
dialogs.
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Access
Ribbon
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After selecting the Properties window
using one of these methods, click on the
first required attribute.
Start > Application > Design > Properties
or
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Design > Element > Editors > Attributes:
right-click on an attribute | Properties
window or
Explore > Portals > Windows >
Properties > Properties
Keyboard
Shortcuts

Ctrl+2 or Ctrl+Enter, then click on the
required attribute

General Settings
Field

Description

Name

Displays the name of the selected
attribute. If necessary (for example, if it is
a place-holder name) overtype this name
with a new name.

Type

Displays the assigned type of the
attribute. If necessary, click on the
drop-down arrow and select either a
different type, or the 'Select Type' option
to display the 'Select Type' browser to
locate a classifier element as the type.

Stereotype

If the attribute has a stereotype, this field
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displays the stereotype name. To add or
change the stereotype, click on the
browse icon and use the 'Stereotype for
<attributename>' dialog to select the
stereotype from the appropriate profile.
You can select multiple stereotypes; on
the dialog, they are listed on separate
lines of the 'Stereotype' field
Scope

Displays the scope of the attribute. If you
need to change the scope, click on the
drop-down arrow at the right of the field
and select the appropriate value.

Alias

Displays any alternative name or
reference for the attribute. If you need to
add or change the alias, overtype the
field.

Initial Value

Displays the initial value of the attribute.
If you need to add or change the value,
overtype the field.

Advanced Settings
Field
(c) Sparx Systems 2022
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Containment

Displays the type of containment
specified for the attribute. If you need to
change this setting, click on the
drop-down arrow at the right of the field
and select the appropriate value.

Static

The flag indicating if the attribute is a
static member; to change this flag, type
'F' or 'T' in the field, as appropriate.

Property

If the attribute has automatic property
creation, click on the button to define
how it should be implemented for the
programming language you are modeling
for.
The 'Create Property Implementation'
dialog displays.

Const

The flag indicating if this attribute is
constant (read-only, blocked from
change). To change this flag, type 'F' or
'T' in the field, as appropriate.

Is Literal

(For Enumeration elements.) The flag
indicating if the attribute is an
enumeration literal. To change this flag,
type 'F' or 'T' in the field, as appropriate.
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Transient

(For Java code.) The flag indicating
whether or not the attribute can change
regardless of what the code is
performing. To change this flag, type 'F'
or 'T' in the field, as appropriate.

Derived

The flag indicating whether the attribute
is derived from one or more other
attributes; for example, full name can be
derived from the last name and first name
attributes. To change this flag, type 'F' or
'T' in the field, as appropriate.

Derived
Union

The flag indicating if the attribute is a
derived union (that is, derived from a
strict union of all properties that are
constrained to subset it). To change this
flag, type 'F' or 'T' in the field, as
appropriate.
As an example, you might set this field to
True for a Class 'Schoolbus' with an
attribute 'Passengers [0..48]' that is a
derived union with these attributes
subsetting it:
· SeatedPassengers [0..36]
· StandingPassengers [0..10]
· WheelchairPassengers [0..2]

Is ID

The flag indicating whether the attribute
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can be used to uniquely identify an
instance of the containing Class. To
change this flag, type 'F' or 'T' in the field,
as appropriate.
Multiplicity

Click on the button to display the
'Multiplicity' dialog, and define the
multiplicity of the attribute.
· Lower Bound - Type the lower limit to
the number of attributes that must be in
the collection
· Upper bound - Type the upper limit to
the number of attributes allowed in the
collection
· Allow Duplicates - Select the checkbox
to indicate that duplicate values are
allowed; this field maps to the UML
property isUnique, with a value False
· Multiplicity is Ordered - Select the
checkbox to indicate that the collection
is ordered
· OK - Click on this button to save the
information and close the dialog

Is Collection

The flag indicating whether the attribute
is a collection (array), so that it can
contain multiple concurrent values, or a
single value. To change this flag, type 'F'
or 'T' in the field, as appropriate.
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If the attribute is a collection, type the
name of the container type for the
collection.

Notes
·

·

The 'Properties dialog' for attributes also has a 'Redefines'
tab, which lists any Redefined Property or Subsetted
Property added to the selected attribute; click on the
appropriate Add button to add or change the properties in
the lists, selecting each property from the 'Select Property'
dialog
The dialog also has a 'Constraints' tab on which you
define the constraints on the attribute
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Create Properties
You can configure Enterprise Architect to automatically
create properties in the modeled code in any of the
programming languages that the system supports. You
control property creation from the Properties window for
Attributes. Each language has slightly different syntax and
generates slightly different results:
· Java and C++ generate get and set functions
· C# and VB.Net create property functions
· Delphi creates get and set functions as well as a
specialized Delphi property Tagged Value
Note that the attribute must have a defined Type in order to
create properties.

Access
Ribbon

Design > Element > Editors > Properties

Context
Menu

Right-click element in Browser window
or diagram | Properties | Properties

Keyboard
Shortcuts

Ctrl+2
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Configure Properties for an Attribute
Ste Action
p
1

In the Browser window or a diagram, click on the
attribute for which to configure property creation.
The attribute becomes the focus of the Properties
window.

2

Expand the 'Details' section of the 'Attribute' tab, and
click on the 'Property' field and on the button.
The 'Create Property Implementation' dialog
displays.

3

The 'Language' panel defaults to the radio button for
the language defined in the Class properties;
however, you can click on any other radio button to
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select another language for which to configure
property creation.
Each language enables its own combination of fields
in the 'Property Details' panel.
4

The 'Name' field defaults to the name of the attribute.
If necessary, you can overtype this with a different
name.
Select the checkboxes or values from drop-down
lists for these fields as required (and if available) to
define the property for the selected programming
language:
· By Ref
· Stereotype
· Get Scope
· Set Scope
· Published
· Read
· Write
· Abstract

5

Click on the OK button
The system generates the required operations and
properties to comply with the selected language.
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Notes
·

·

Get and Set functions have the stereotypes «property get»
and «property set», making it easy to recognize property
functions in the operations compartment of the element on
a diagram; you can also hide these specialized functions
on a specific diagram, by deselecting the 'Property
Methods' checkbox on the 'Features' page of the
'Properties' dialog for the diagram, which then makes it
easier to view the Classes uncluttered by many get and set
methods
For the Delphi programming language, enable the Tagged
Values compartment to see the generated property Tagged
Value
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Attribute Constraints
Attributes can have constraints associated with them, which
typically indicate such things as maximum value, minimum
value and length of field. You define these constraints on
the Properties window for attributes.

Access
Click on the required attribute in a diagram or the Browser
window, and use one of these methods to display the
attribute 'Constraints' tab.
Ribbon

Design > Element > Properties > General
> Properties Dialog > Constraints
Start > All Windows > Properties >
General > Properties Dialog >
Constraints

Context
Menu

Right-click attribute in diagram or
Browser window | Properties | Properties
> Constraints

Define Constraints
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Option

Action

Constraint

Type in the name or action of the
constraint.

Type

Click on the drop-down arrow and select
the appropriate constraint type.

(Notes)

Type in any comments or notes
concerning the constraint.

New

Click on this button to clear any
displayed data from the constraint fields,
so that you can define a new constraint.

Save

Click on this button to save any new data
in the fields, and to clear the fields in
preparation for defining another
constraint. The saved constraint is added
to the top of list in the second 'Constraint'
field.

Constraint

Lists the existing constraints on the
attribute. If you click on an entry in the
list, the constraint details display in the
tab fields.

Delete

Click on a constraint in the list and click
on this button to immediately remove the
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constraint from the attribute.
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Properties Window for Operations
The docked Properties window provides a convenient and
immediate way to view and edit common properties of
modeling objects, including operations. When you click on
an operation in the Browser window or a diagram, the
Properties window immediately shows the operation's
properties on the 'Operation' tab. You can also swiftly
display the properties of other types of object such as
elements, connectors and diagrams on the same window
without having to open and close separate dialogs.
The Properties window for operations also has a 'Tags' tab
to create and display Tagged Values.
On the Properties window and the Properties dialog for an
operation, the 'Operation' tabs have the same fields.
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Access
After selecting the Properties window using one of these
methods, click on the first required operation.
Ribbon
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Start > Application > Design > Common
> Properties
Design > Element > Editors > Element >
Properties
Explore > Portals > Windows >
Properties > Properties
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Select operation in the Browser Window
or a diagram.
Ctrl+2 or Ctrl+Enter

Properties
Property

Description

Name

Displays the name that has been allocated
to the operation. If you want to change
this, overtype the text in the field.

Parameters

Lists the parameters that have been
defined for this operation on the
'Parameters' tab of the operation
'Properties' dialog.
You can also type in simple parameter
definitions in UML Test input; for
example: age:int, max:int

Return

Displays the return type of the operation
(defaulting to 'void'). To change this,
overtype the field or click on the
drop-down arrow and click on:
· The required data type returned by the
operation, as defined by the code

(c) Sparx Systems 2022

Page 566 of 1150

The Application Desktop

3 October, 2022

language (data type) or
· '<none>' for no type (or you can type in
a value manually if you prefer), or
· 'Select Type' and browse for the
appropriate operation classifier (you
can add a new one if there are no
classifiers that suit)
To add new code language data types that
can be displayed in this list, see the Data
Types topic.
Scope

Displays the scope currently set for the
operation. If it is necessary to change
this, click on the drop-down arrow and
select one of:
· Public
· Protected
· Private
· Package

Stereotype

(Optional) Displays any stereotypes that
have been defined for the operation; if
you want to add others, either:
· Type a stereotype name, or
· Click on the
button and select the
stereotype from the 'Stereotypes for
<object name>' dialog
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Alias

(Optional) Displays any alias that has
been defined as an alternative name or
reference for the operation. If necessary,
overtype this with a different alias.

Concurrency

Displays the concurrency of the operation
- Sequential, Guarded or Synchronous. If
necessary, click on the drop-down arrow
and select a different setting.

Abstract

The flag indicating if this operation is an
abstract function. If it is necessary to
change this, type T or F in the field to
change it to True or False, as appropriate.

Static

The flag indicating if this operation is a
static member. If it is necessary to change
this, type T or F in the field to change it
to True or False, as appropriate.

Modifiers

Click on the button to display the
'Select Modifiers' dialog, and select the
appropriate checkboxes:
· 'Pure' - indicates that the method
statement is pure virtual syntax. For
example:
virtual void myFunction() = 0;
· 'Const' - indicates that the return type
of the method is constant
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'Is Query' - indicates that the method
does not modify the object
'Return Array' - indicates that the
method's returned value is in the form
of an array
'Synchronized' - for Java, sets a code
engineering flag that relates to multi
threading

Concurrency

Reflects the setting of the earlier field.

Leaf

Indicates whether the operation is a Leaf
and cannot be overwritten.

Raised
Exceptions

You can create code in your application
to check for an exception and, if one
occurs, to switch to the code defined by a
Classifier element that you identify in this
field, or through the operation 'Properties'
dialog.

Redefined
Operation

If the parent element of the selected
operation is the source element for a
Generalize connector, you can configure
the operation to redefine an operation in
the target element. You can identify the
target operation (and its parent element)
in this field or in the operation 'Properties'
dialog.
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The flag indicating if this operation is a
native operation. If it is necessary to
change this, type T or F in the field to
change it to True or False, as appropriate.
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User Button
For models with user security enabled, the name of the
currently logged in user will display in the ribbon header in
the top right of the screen. If you click on the user's name, a
drop down menu displays providing a set of user options.

User Button Menu
Me Description
nu
Ite
m
R
e
m
e
m
be
r
M

Select this option to securely store the current user's
login credentials for the current model. The next
time the user attempts to open the model, the stored
credentials will be used instead of prompting the
user for their credentials.
Note:
· This requires the option 'Allow 'Remember Me'' to
be enabled on the 'Security Users' dialog
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The credentials are stored on the current computer
and can not be transferred between computers,
users or models

Change the password for the logged in user.

Se Set an image to be used as an avatar for the logged in
t
user.
A
va
tar
Hi
de
O
pe
nI
D
lo
gi
n

Displays (unselected) or hides (selected) the 'OpenID
login' dialog when you open the project. The option
also resets the 'Don't show this window again'
checkbox on the 'OpenID login' dialog.
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wi
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o
w
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o
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Di
ag
ra
m
s

Automatically reloads open diagrams that have been
saved by other users within the last 60 seconds.

L
og
In
as
A
no
th
er

Display the Login panel, on which you log into the
model as another user.
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Tracing Relationships

A repository contains a graph of elements connected by
relationships; traceability is the ability to explore this graph
from a particular starting point in any direction. Modelers
commonly think of traceability as just applying to
requirements, and the ability to find which elements in the
model realize (implement) the requirements; the term is,
however, much broader than this and can be applied to any
model element. The requirements, for example, could be
traced to stakeholders, which in turn could be traced to a set
of drivers and goals, and these could be traced to a set of
regulatory constraints. Enterprise Architect provides flexible
and expressive features that help you to explore and traverse
this graph of connections, including the Traceability
window and the Relationship Matrix. Enterprise Architect
extends the UML by allowing users to trace between model
features such as attributes and operations, which is a handy
mechanism for the analyst.

Traceability Tools
Enterprise Architect provides a number of tools for tracing
the definition and implementation of a process, from initial
requirement to generated code or technical deployment, or
(c) Sparx Systems 2022
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vice versa. Such tools include the:
· Traceability window, also displayed as the 'Trace' tab of
the Inspector window
· Relationship Matrix
· Gap Analysis Matrix
· Relationships window
· Browser window, and
· Traceability diagrams
The Traceability window, in particular, is designed to
provide very detailed information on an element's
relationships and dependencies, both immediate and distant.

Tracing Transformations
If you have performed any transformations in developing
your model and code, Enterprise Architect automatically
creates Transformation Dependency connectors that you can
trace - using the Traceability window - to establish what
objects and code have been generated from each PSM
element, or what the initial PSM element was for a
generated object.
Whether you use transformations or develop the stages of
the model in other ways, you can build up a range of
Traceability diagrams (Custom diagrams) to identify the
development pathway and the dependencies between entities
such as Requirements, Use Cases, Classes, Packages, Test
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Cases and other model Artifacts, or even between these
entities and the overall business process model.
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Traceability Tools
The structure of your model and a Traceability diagram act
as the starting points for tracing the definition, design and
implementation of a specific feature of a system or process.
By applying tools such as the Relationship Matrix and
Traceability window, you can follow threads through the
model to determine how the feature is implemented and
tested. You can also obtain information on what elements
realize and are realized by the elements in a given Package,
using the Dependency report and Implementation report,
respectively.

Principal Tools
Tool

Detail

Traceability
window

The Traceability window is a very useful
and versatile traceability tool; starting
with a Traceability diagram or a Package
structure in the Browser window, you can
use the Traceability window to quickly
explore the relationship chain of which
any element is a component.
· When you click on an element, it
immediately becomes the top point in
the Traceability window
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When you click on the background of a
diagram, all elements in the diagram
are listed in the Traceability window,
and you can follow the threads starting
at each element through the diagram
If you require a rapid, broad-brush view
of relationship flows in the project
structure, starting with a general list of say - all functional Requirements, you
can use a combination of Model Search,
Browser window and Traceability
window for scanning your project,
identifying how elements have been
organized, and seeing how they interact.
For example, the Model Search would list
all the Requirements. You could rapidly
click on each element and immediately
see in the Browser window where it has
been grouped, and at the same time - in
the Traceability window - how that
element interacts with other elements in
the model.
By moving the cursor around a diagram
or the Browser window, and/or changing
the relationship type combinations in the
Traceability window, you can quickly see
how elements are connected and how
they influence each other. For example,
you could see that - say - REQ017 is
·
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realized by two Use Cases, so you might
then explore what else influences and is
influenced by these two Use Cases. The
Traceability window takes you well
beyond what is likely to be depicted on
any single diagram.
If you have used transformations to
develop your model, you can also follow
the Transformation Dependencies that
exist between an element in a PIM and
elements in the PSMs.
Relationship
Matrix
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Using the Relationship Matrix, you can
both create and study the relationships
between, for example, the Requirements
and Use Cases of a module.
You might identify the 'theme' Package
(such as Manage Users) as the source
Package in the Requirements model and
the target Package in the Use Case model,
and explore the likely element and
connector types in the Packages; this,
similar to the Traceability diagram,
identifies which Requirements are (or
should be) realized by which Use Cases.
You can then perform similar checks with
the Manage Users Packages in, say, the
Use Case and Implementation models.
Using the 'Source' and 'Target' field
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browsers ( ) you can examine child
Packages within the 'theme' Package, and
obtain further detail on how the feature at
this stage is defined.
Relationships
window

The Relationships window shows a single
level of relationships from the currently
selected element.
Each line corresponds to a single
relationship, providing information about
that relationship and the element at the
other end of the relationship.

Dependency
report

The Dependency report provides a list of
dependencies for all elements in the
model.

Implementati
on report

The Implementation report provides a list
of all elements in the model that have to
be implemented, and the elements that
implement them.
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The Traceability Window
Using the Traceability window - or, equally, the 'Trace' tab
of the Inspector window - you can quickly see how elements
are connected and how they influence each other. You can:
· Locate related elements in the Browser window
· View the properties of related elements
· Open the diagrams in which related elements are used
· Add related elements to the current diagram
· View the source code for related elements
· Change the display using the window toolbar options
When an element is selected, it immediately becomes the
top point in the Traceability window. When a diagram is
selected, all elements in the diagram are listed in the
Traceability window, so you can use any of them as a
starting point.

Access
Ribbon
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Design > Element > Trace
Start > All Windows > Design > Explore
> Trace
Start > All Windows > Design > Explore
> Inspect > Trace (This shows the
Traceability window as the 'Trace' tab of
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the Inspector window)
Keyboard
Shortcuts

Ctrl+7
Alt+1 | Traceability
Alt+1 | Inspector | Trace

Traceability window toolbar options
Option/Icon

Action

Locate
Element

Click on this icon to make the selected
element the focus of the Traceability
window and to show all relationships and
elements with which the selected element
forms a relationship chain.
Click on the diagram to list all elements
in the diagram.

Related
Element
Properties

Click on this icon to display the element
'Properties' dialog for the
currently-selected element in the
Traceability window.

Find Element
Usage

Click on this icon to display the 'Element
Usage' dialog, listing all diagrams in
which the currently-selected element is
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used.
(Shortcut keys: Ctrl+U)
(Relationship
selector)
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Click on the drop-down arrow and select
the checkbox against each relationship
type to include in the trace shown in the
window:
· Generalizations
· Aggregations
· Nesting
· Realizations
· Dependencies
· Transitions
Other (unspecified) links such as:
· Associations
· Use Cases
· Delegates
· Assemblies
· Deployments
· Information Flows
· Manifests
· Classifiers - where an element is used
as the classifier of another element
· Embedded Element Re-uses - where a
Port or Part is also represented in
another part of the model
· Transformations - where an element is
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·

·

·

Help

created by running a Transformation
from another element
Custom References that have been
added between elements
Tagged Value References - showing
elements that are the targets of Tagged
Value references
Qualified Names - element names
including the names of owning objects

Click on this icon to display this Help
topic.

Traceability Window Context Menu Options
Right-click on an element or connector in the main panel.
All options listed here act on elements only, except for the
'Properties' option which acts on connectors.
Option

Description

Switch to
Related
Element

Make the selected element the focus of
the Traceability window. The element
displays at the top of the window.

View Related
Element

Display the 'Properties' dialog for the
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Properties

selected element.
You can also display the element's
'Properties' dialog by double-clicking on
it.

Find in all
Diagrams

Display the 'Element Usage' dialog,
listing all diagrams in which the
currently-selected element is used.

Place
element(s) in
diagram

This option is available if the selected
element is not used in the diagram that is
the current focus. Select the option to add
the element and its child structure to the
diagram.

View Source
Code

Display the generated source code for the
selected element, in the Source Code
Editor.

Properties

(For a connector) Display the 'Properties'
dialog for the connector.
(Double-clicking on a connector expands
and collapses any structure beneath it,
rather than displaying the 'Properties'
dialog.)
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Notes
·

·

·

To make it easier and faster to find the elements you are
interested in, restrict the relationship types shown to the
smallest set of relevant types
As an alternative view, or to include the traceability
information in documentation, you can develop a
Traceability diagram using the Traceability window
The Traceability window does not currently recognize
extended relationship types defined by Technologies such
as BPMN or ArchiMate; relationships defined by a Profile
or Technology are identified using their base UML type,
so, for example, ArchiMate 'Realization' and 'UsedBy'
relationships are each reported as UML 'Dependency'
relationships
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Relationship Matrix
When you need to visualize or manage relationships quickly
and definitively, you can use the Relationship Matrix - a
convenient and simple tool for reporting and working on all
the relationships in a selected structure. The Relationship
Matrix is a spreadsheet display of relationships between
model elements within a Package, or between elements in
two different Packages. You can filter the selection of
relationships shown, according to:
· The currently-selected Perspective
· The element type of the source and target elements in
each relationship
· The relationship type and direction
· The Package(s) in which the source elements and target
elements are held
The matrix shows all the relationships of a specified type
between source and target elements by:
· Listing the source Package elements down the side of the
matrix
· Listing the target Package elements across the top of the
matrix, and
· If a relationship exists between a source and target
element, displaying an arrow indicating the direction of
the relationship
The direction is a reflection of which element is the source
element and which the target (it does not indicate the
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Page 588 of 1150

The Application Desktop

3 October, 2022

'Direction' property of the connector, as defined in the
connector 'Properties' dialog). The display might also show
a 'bent arrow' icon, indicating that the same kind of
connectors exist in both directions between the source and
target elements.
The squares or cells of the matrix can have different fill
colors, depending on the existence of relationships and the
lock status of the Package containing the source element. If
the cell is:
· White - there is no relationship between the source
element in this row and the target element in this column
· Pale Blue - the source element on this row has no
relationships at all (if the Matrix Option 'Highlight source
elements without relationships' is selected)
· Pale Pink - the target element in this column has no
relationships at all (if the Matrix Option 'Highlight target
elements without relationships' is selected); if there is an
intersection of blue rows and pink columns, the blue takes
precedence
· Green - with a direction arrow, the elements in the source
row and target column have a relationship and the source
element is not locked (the parent Package has not been
checked in under Version Control)
· Dark Pink - with a direction arrow, the source element is
locked (the parent Package has been checked in)
· Dark Blue - the selected cell, the source element or the
target element have been selected as the object of an
action within the Relationship Matrix; if just the cell is
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Page 589 of 1150

The Application Desktop

3 October, 2022

selected, the source and target element names are also
highlighted
Right-clicking on a square gives you the options of creating,
modifying and deleting relationships between elements with
a single mouse click - a quick way to set up complex sets of
element relationships with a minimum of effort.
You can also create additional elements in the source and
target Packages, and quickly add relationships to and/or
from them.

Access
Ribbon

Design > Package > Package/Matrix |
Open as (Source, Target, Both)

Keyboard
Shortcuts

Alt+9
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Alt+1 | Matrix

Operations
Operation

Detail

Specify the
The Relationship Matrix defaults to show
element types all element types available under the
current Perspective. If you want to
examine relationships between specific
types of element, you can filter for those
types.
You define the element types - if
necessary - as the first step in configuring
the Relationship Matrix.
Click on the drop-down arrow in the
'Type' field in the 'Source' row, and/or in
the 'Target' row, and in each case click on
the required element type in the list.
The Relationship Matrix display
immediately refreshes.
Specify the
connector
type and
direction
(c) Sparx Systems 2022

The Relationship Matrix requires a
relationship type and direction to operate
on.
In the 'Link Type' field, click on the drop
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down arrow and on the type of
relationship to show. The relationship
types listed are filtered by the
currently-selected Perspective.
In the 'Direction' field, click on the
drop-down arrow and on one of the
connector directions to show, or on 'Both'
to show relationships in any direction.
In each case, if any relationships of that
type exist they are immediately shown on
the Relationship Matrix.
Select the
Source and
Target
Packages

You need to set the source and target
Packages in order to display
relationships, but you do this after setting
the connector and element types; as the
Matrix automatically refreshes after each
change, this is usually faster.

Update,
delete and
create
relationships

Having seen what relationships currently
exist between the selected elements, you
can review the relationship and element
properties, modify them, add more
relationships or delete relationships that
are no longer applicable.

Create new
elements

If the source or target element 'Type' field
is set to a specific element type, you can
add elements of that type to the matrix
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and the model.
In the top left corner of the matrix itself,
the 'Target' and 'Source' labels have a +
button. When you click on this button,
the element 'Properties' dialog displays,
through which you can define a new
element of the corresponding (target or
source) type.
If there are stereotyped elements of the
type (such as Actors as defined in UML,
TOGAF and ArchiMate) you are
prompted to select the variant that you
need.
This option is not available for the target
or source axis if the corresponding 'Type'
field is set to '<All>'.
Modify the
display of
information

It is possible to tailor the display of
information to, for example, list the
Package elements in alphabetical order,
show elements from the Package
hierarchy, highlight elements with no
relationships, and hide or show additional
element name components such as level
numbering, aliases and parent Package
names.

Toggle
Between

You can switch the display between the
connector direction format and a CRUD
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relationship
direction and
CRUD
formats

matrix format. The CRUD (or other,
customized) indicators are defined in an
overlay that you create.

Export the
contents of
the
Relationship
Matrix

After reviewing the Relationship Matrix,
you can export the contents to a CSV file,
or capture the image of the contents as a
.png file or a .emf graphics file.

Print the
contents of
the
Relationship
Matrix

You can also send the contents of the
Relationship Matrix to a printer, after
previewing the print format if necessary.
The printout can be on as many pages as
it takes, or you can scale the print format
so that the file occupies a specific number
of pages.

Capture the
Matrix
settings

If you want to use the same Relationship
Matrix settings repeatedly to, for
example, monitor development of the
same source and target Packages, it is
possible to save the settings as a profile
that can be called to reapply those
settings.

Investigate
Source and

Having identified relationships that might
be of significance to you, you can check
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(c) Sparx Systems 2022

3 October, 2022

details of the elements in those
relationships. For example, you can look
at:
· The diagrams that the elements are
used in
· The properties of the elements, or
· What other elements might have
relationships with the selected element
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Set Element Type
The Relationship Matrix defaults to show all element types
available under the currently-selected Perspective, in both
Source and Target Packages. You can also select to list
elements of one specific type in the Source Package or the
Target Package or both. For example:
· Any (<All>) types of element in the Source Package
linked to Use Cases in the Target Package
· Use Cases in the Source Package linked to any (<All>)
types of element in the Target Package
· Requirements in the Source Package linked to Use Cases
in the Target Package
· Classes in the Source Package linked to Classes in the
Target Package
Having set the element type for an axis, you can create
further elements of that type within the Relationship Matrix,

Set the source and/or target element type
Ste Action
p
1

Click on the drop-down arrow in the 'Type' field for
the Source Package, or for the Target Package.
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2

Find the required element type in the list and click
on it.
The Relationship Matrix content automatically
refreshes.

3

If necessary, repeat the process to select a specific
element type in the other Package.
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Set Connector Type and Direction
The Relationship Matrix shows relationships of a specific
type and direction, which you define after selecting the
element type(s) to show, and before you specify the Source
and Target Packages to search in.

Set the connector type and direction
Ste Action
p
1

Click on the drop-down arrow in the 'Link Type'
field.

2

Locate and click on the required connector type in
the list.

3

Click on the drop-down arrow in the 'Direction' field.

4

Click on the required direction in the list.
The Relationship Matrix content automatically
refreshes.
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Notes
·

·

If you set the 'Direction' field to 'Both', each relationship
is indicated by two arrows - a From-To arrow and a
To-From arrow
The direction is a reflection of which elements are the
source elements and which are the target; it does not
indicate the 'Direction' property of the connector, as
defined in the connector 'Properties' dialog
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Set Source and Target Package
Before you display relationships on the Relationship Matrix,
you set both the source and target Packages containing the
elements between which the relationships might exist.
However, you set the source and target Packages after
setting the element and connector types/details; as the
Relationship Matrix refreshes after each change, this is
usually faster. You can set the same Package as the source
and target, to investigate relationships within a Package, or
different source and target Packages to investigate
relationships between Packages.
When deciding on which Packages to investigate and how to
filter the matrix contents, consider that:
· The Relationship Matrix includes all child elements in
each Package, within the criteria you specify; in a large
model, with less-specific filters, this can expand the
matrix with a large number of elements
· On the other hand, if you want to examine relationships
within the Package structure, you can select options to
include elements in child Packages under either the source
Package or the target Package, or both

Access
Ribbon
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Design > Package > Package/Matrix |
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Open as (Source, Target or Both)
Context
Menu

Browser window |Right-click on Package
| Relationship Matrix | (As Source, As
Target or As Both)

Keyboard
Shortcuts

Alt+9
Alt+1 | Matrix

Set source and target Packages (method 1)
In all cases, the Relationship Matrix immediately:
· Populates the axes with the elements identified in the
'Source Package' and 'Target Package' or searches that
meet the selection criteria, and
· Shows any relationships between the sets of elements that
also meet the selection criteria
If you select the first access option:
Step

Action

1

In the Browser window, click on the
required source Package, then press and
hold Ctrl and click on the required target
Package, to select the two Packages
together.
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Drag the selected Packages over the
'Source' and 'Target' fields.
The first-selected Package name displays
in the 'Source' field, and the
second-selected Package name displays
in the 'Target' field.

Set source and target Packages (method 2)
Or, if you use the second access option:
Step

Action

1

Select and drag a single Package name
over the remaining 'Source' OR 'Target'
field, to change just the source or the
target Package.
If you drop the Package name anywhere
else on the Relationship Matrix, the
system prompts you to specify whether to
add it to the 'Source' or 'Target' field, or
both.
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Set source and target Packages using Model
Search
Step

Action

1

Click on the button at the end of the
'Source' or 'Target' field.
A short menu displays, with options to:
· Locate a Package using the 'Browse
Project' dialog or
· Select a Model Search from a
drop-down list and run the search on a
search term; the name of the search is
displayed in the 'Source' or 'Target'
field
The target of the search depends on
whether the 'Return matching items for
the selected Package' option is selected
in the 'Search' definition; if it is
selected, the search operates on the
current Package, otherwise the search
operates on the whole model
It is possible to browse for a Package in
one field and run a search in the other.
Note: this only supports standard Model
Searches. It does not support searches
that include a '<Search Term>'.
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Select the required Package, or the
required Model Search and search term,
and click on the OK button.

Notes
·

·

Custom SQL searches are supported if they are returning
elements; the SQL must include ea_guid AS
CLASSGUID (case sensitive)
Using ORDER BY in a SQL search will not affect the
order of the Relationship Matrix
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Matrix Overlays
The Relationship Matrix indicates the existence of
connectors between elements by displaying an arrow in the
cell at the intersection of the source element row and target
element column.
If you prefer, you can toggle the display to a CRUD matrix
overlay, where the presence of a connector is indicated by
the appropriate value or combination of CRUD values in the
intersection cell. You define the actual values that are
entered and displayed, so the characters can refer to
whatever interpretation of CRUD your organization uses, or
they can be another standard set of indicators such as
BREAD, or your own custom set of indicators. The values
can, therefore, be a selection of these, or anything else you
might use:
· C reate
· A dd
· B rowse
· L ist
· R ead, R etrieve
· U pdate
· E dit
· M odify
· D elete, D estroy
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Toggle between the two display formats
Click on the 'Overlays' field drop-down arrow and select
either:
· '<None>' to use the direction arrow Relationship Matrix
format
· The name of your overlay, to use the Matrix overlay
format, or
· '<New Overlay>' to create and use a new Matrix overlay
The overlay values display if they have been specifically
applied to the relationship via the intersection cell on the
Relationship Matrix.
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Create a Matrix Overlay
When you create a Matrix Overlay to apply to the cells of
the Relationship Matrix, you define the values that can be
assigned under that overlay, and whether the values must be
single or can be set in a combination. The overlay definition
is actually created as a Tagged Value on the connector, of
the predefined Tagged Value Type MatrixOverlay.

Access
Ribbon

Design > Package > Package/Matrix |
Open as (Source/target/Both) : Overlays
drop-down arrow | <New Overlay>

Context
Menu

Browser window |Right-click on Package
| Relationship Matrix | (As Source, As
Target or As Both) : Overlays drop-down
arrow | <New Overlay>

Keyboard
Shortcuts

Alt+9 : Overlays drop-down arrow |
<New Overlay>
Alt+1 | Matrix : Overlays drop-down
arrow | <New Overlay>
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Create an Overlay
Field/Button

Action

Overlay
Name

Type an appropriate name for the overlay.
This also becomes the tag name.

Allowable
Values

Type in the allowable values for the
overlay/tag, not separated by any
punctuation or spaces (for example,
CRUD); the matrix cell is case sensitive,
so type the values exactly as they are to
be entered.

Mutually
Exclusive

If you want only one allowable value to
be set in a matrix cell at a time, select this
checkbox. (This makes the Tagged Value
an Enum type.)
If you want to allow any combination of
values to be set in a matrix cell at a time,
clear the checkbox. (This makes the
Tagged Value a Custom type.)

OK

Click on this button to save the new
overlay/Tagged Value.
You can now view the overlay on the
'Tagged Value Types' tab of the 'UML
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Types' dialog, in the format:
Type=Enum;Values=C,R,U,D;MatrixOve
rlay=true;

Notes
·

You cannot change an existing overlay on the
Relationship Matrix; because the overlay is defined by a
Tagged Value of type MatrixOverlay, you can delete the
overlay or edit the values and/or the 'Mutually Exclusive'
setting by deleting or editing the Tagged Value on the
'Tagged Value Types' tab of the 'UML Types' dialog
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Apply an Overlay to a Cell
You can apply overlays (one overlay at a time) to the cells
of the Relationship Matrix. After you select the required
overlay in the 'Overlays' field, you can:
· Apply an overlay value or values to a cell that identifies
an existing relationship
· Create a new relationship in a cell, and immediately apply
overlay values to that relationship
· Change the overlay values currently applied, or
· Remove the overlay from the cell

Access
Ribbon

Design > Package > Package/Matrix :
right-click on cell

Context Menu - Overlay Options
Option

Action

Apply

(On a cell that has an arrow icon, or the
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overlay

value of a different type of overlay.)
Displays the 'Allowable values <values>'
dialog. Type in the required value or
values and click on the OK button.
· If you have entered more than one
value and the overlay is set to mutually
exclusive, only a single value is
permitted and an error message
displays; click on the OK button and
type in a single character
· If the overlay is not set to mutually
exclusive, you can type in any
individual value, or any combination of
values in any sequence

Create new
relationship
with overlay

(On a cell that has no relationship
indicated in it.)
If necessary, change the 'Link Type' field
to show the type of connector to create.
When you click on the menu option, a
submenu of variations of the selected
relationship type might display. Click on
the variation to create.
The 'Allowable values <values>' dialog
displays; type in the required value or
values and click on the OK button.
A relationship of the selected type is
created between the source and target
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elements, and the selected overlay values
are displayed in the cell.
Edit overlay

(On a cell showing a value of the current
overlay.)
Displays the 'Allowable values <values>'
dialog, showing the current value.
Overtype this with the new value or
values and click on the OK button.
The new value(s) display in the selected
cell.

Remove
overlay

(On a cell showing a value of the current
overlay.)
Clears the overlay value and restores the
appropriate connector direction arrow
symbol to the cell.

Notes
·

You cannot apply different overlays to the matrix at the
same time; if you select a different overlay in the
'Overlays' field, any values in the cells revert to either the
value set under that overlay, or the direction arrow if no
value is set under that overlay
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Matrix Profiles
You can use the Relationship Matrix as a monitoring tool, to
help in tracking the development of elements and
relationships in particular Packages or pairs of Packages
over time. In this case you would re-use the same
combinations of field settings many times. It is very easy to
store a combination of settings as a matrix profile, so that
later you can recall it for use whenever you need it.

Access
Ribbon

Design > Package > Package/Matrix

Context
Menu

Browser window |Right-click on Package
| Relationship Matrix | (As Source, As
Target or As Both)

Keyboard
Shortcuts

Alt+9
Alt+1 | Matrix

Save a Relationship Matrix configuration as
a named profile
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Ste Action
p
1

Set up the Relationship Matrix with the required:
· Source and target element types
· Connector type and direction
· Source and target Packages or Model Searches,
and
· Overlay name or <None> selected

2

Click on the Options button on the Relationship
Matrix and select 'Profiles | Save as New Profile'.
The 'Enter name for new profile' dialog displays.

3

In the 'Enter Value' field, type a profile name of up
to 12 characters.
Click on the OK button.

4

Once you have created a profile, you can select it by
clicking on the Profile drop-down arrow at the top of
the Relationship Matrix screen and selecting the
profile name from the list.
Profiles are also listed in the Matrix Profiles folder
of the 'Resources' tab of the Browser window;
double-click on a profile in the folder to display the
Relationship Matrix with that profile active.
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Notes
·

·

·

·

You can modify an existing profile by:
- Selecting the profile name from the 'Profile'
drop-down list
- Changing the field values, then
- Selecting 'Options: Profiles | Update Current Profile'
To delete an existing profile, select it in the 'Profile'
drop-down list and select 'Options: Profiles | Delete
Current'
You can capture Relationship Matrix profiles in document
reports
In the Corporate, Unified and Ultimate Editions of
Enterprise Architect, if security is enabled you must have
'Configure Resources' permission to Save, Update, or
Delete matrix profiles
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Creating and Deleting Relationships
Having reviewed existing relationships on the Relationship
Matrix, you can use the Matrix to quickly modify or delete
those relationships and create others between the elements.
This is a very useful facility for maintaining a large number
of relationships in a short space of time. As you can filter
for specific types of connector and source and target
element, you can create a logical set of relationships without
having to specify the type of each object every time.

Access
Ribbon

Design > Package > Package/Matrix
Start > All Windows > Design > Tools >
Package Matrix

Keyboard
Shortcuts

Alt+9
Alt+1 | Matrix

Create a new relationship
Note that if the source element (that is, the owner) is locked
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and the 'Settings > Security > Administer > Apply Locks to
Connectors' option is enabled, you cannot create new
relationships on that element.
Ste Action
p
1

In the 'Link Type' field, select the type of
relationship you want to create, and in the 'Type'
fields select the types of source and target element
between which to create the relationships.

2

Right-click on the empty square at the intersection of
the appropriate source row and target column.
You can select and operate on several squares
(creating several relationships) at once. Either:
· Press Ctrl as you click on each intersecting square,
then right-click on one of the selected squares, or
· Click on the first square in the required row,
column or block, then press Shift as you click on
the final square in the required row, column or
block; right-click on one of the selected squares

3

Select either the:
· 'Create new relationship' option, if no overlay is to
be applied
· 'Create new relationship with overlay' option, to
apply an overlay as you create the relationship
If the 'Direction' field is set to 'Both', you are offered
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the choice of creating the relationship to the Source
element or to the Target element.
A further submenu might display, listing any
variations on the type of relationship you can create;
in this case, click on the required type of
relationship.
4

A connector of the selected type is created between
the two elements, and the appropriate indicator
displays in the matrix cell.

Modify or delete a relationship on the
Relationship Matrix
Ste Action
p
1

Right-click on the required highlighted relationship
cell on the matrix, and select the appropriate context
menu option:
· Apply overlay - apply the CRUD overlay, if one is
selected
· Edit overlay - change the overlay values assigned
to the cell
· Remove overlay - take the overlay off this cell
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only, and revert to the connector direction arrow
icon
View relationship - open the 'Properties' dialog for
the selected relationship
Source element properties - open the 'Properties'
dialog for the source element
Target element properties - open the 'Properties'
dialog for the target element
Delete relationship - remove the relationship from
between the elements

2

If you have selected 'Delete relationship', Enterprise
Architect prompts you to confirm this action.
Click on the Yes button.
The 'Delete relationship' option is not available if:
· The source element (that is, the owner) is locked
and the 'Settings > Security > Administer > Apply
Locks to Connectors' option is enabled
· You have selected 'Both' in the 'Direction' field you are effectively trying to delete half a
relationship

3

If you have selected one of the other options, modify
the properties in the dialog fields as required.
Click on the OK button to save the changes.
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Relationship Matrix Options
When you have displayed information on the Relationship
Matrix, you might want to capture the display in some way,
or modify the output. There are a number of options that you
can select to, for example:
· Output the information on the Relationship Matrix to the
printer or to a metafile, .png file or .csv file
· Create and update profiles of the configurations of the
matrix that you have designed
· Define local settings to control what the Relationship
Matrix displays

Access
Ribbon

Design > Package > Package/Matrix :
Options
Start > All Windows > Design > Tools >
Package Matrix : Options

Keyboard
Shortcuts

Alt+9
Alt+1 | Matrix : Options
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Options

Option

Action

Print
Relationship
Matrix

Click on the 'Matrix | Print' menu option.
The 'Print' dialog displays, on which you
select the output printer and specify the
printer properties, the range of pages to
print, and the number of copies.
The output is a WYSIWYG
representation of the Relationship Matrix
contents.

Display a
preview of
the printout

Click on the 'Matrix | Print Preview'
menu option.
The 'Print Preview' screen displays,
showing the Relationship Matrix printout.

Scale the
printout

When you print the Relationship Matrix,
by default it prints on as many pages
wide and long as the Matrix requires.
You can scale the printout into a fixed
number of pages wide; the row height is

(c) Sparx Systems 2022

Page 622 of 1150

The Application Desktop

3 October, 2022

automatically adjusted to maintain the
proportions of the Matrix. This reduces
the overall size of the printout and
improves appearance, especially when
used in conjunction with the 'Landscape'
option in the printer properties.
For example, a 16-page printout without
scaling can, with a scaling of 2 pages
wide, be reduced to 6 pages.
To set the page scaling:
1. Click on the 'Matrix | Scale Setting'
menu option. The 'Scale Matrix' dialog
displays.
2. Select the 'Scale Matrix Width Into
Pages' checkbox, and type or select the
number of pages in width to scale to.
3. Click on the OK button to apply the
setting.
Save
Relationship
Matrix as
graphic file
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Click on the 'Matrix | Save as Metafile' or
'Matrix | Save as PNG' menu options.
A browser dialog displays on which you
select the target file location and specify
the filename of the .emf or .png file in
which to save the output.
You can incorporate these files in a
document or web report, as either a
hyperlinked file or an included file.
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Export output The contents of the Relationship Matrix
to CSV file
can be exported to a CSV file, which
provides a convenient mechanism for
moving the matrix data to a spreadsheet
environment such as Microsoft Excel.
This option is also active in the 'Lite',
read-only version of Enterprise Architect.
To export the Matrix to CSV:
4. Select the 'Matrix | Export to CSV'
menu option. The Windows 'Browser'
dialog displays.
5. Browse to the required file location
and type in a .csv filename to export to.
6. Click on the Save button to export the
data.
Create and
manage
matrix
profiles

If you use a particular combination of
field values often, you can save that
combination as a profile to make it easier
to recall them for use.
You can also include a Relationship
Matrix Profile in a document report, to
pull in specific relationship details using
the Matrix.

Change
Perspective

The types of element and relationship
available to be added to the Matrix are
filtered by the Perspective that is
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currently active. To set the appropriate
Perspective for the relationships you are
modeling, click on this option and select
the required Perspective group and
Perspective. The field drop-downs will
list values specific to the Perspective.
Manage
display
content
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You can extend the information shown by
the Relationship Matrix to include related
elements and/or additional properties of
each element. You can also re-organize
the display to list the element names in
alphabetical order.
Select the 'Options' menu option. The
'Matrix Options' dialog displays. Select
one or more of these checkboxes to
define the information you want to
display:
· 'Include Source Children' - to
recursively include child Packages and
contents under the Source
· 'Include Target Children' - to
recursively include child Packages and
contents under the Target
· 'Include All Extended Meta Types' - to
include elements that are extensions of
a specified meta-type; for example, if
there are Block elements (extending
Class) in the Package, selecting this
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·

·

·

·
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option and specifying the type Class
includes Class and Block elements, and
any further derivatives of Class in the
matrix
'Sort Axes' - to display the element
names in alphabetical order
'Show Package Names' - to hide or
show the elements' parent Package
names in the Relationship Matrix; this
is useful for shortening the displayed
texts, especially in circumstances
where Packages have long names
'Use Element Alias If Available' - to
display an element's alias instead of the
element name, if an alias has been
defined
'Show Level Numbering If Available' to reproduce level numbering in the
Relationship Matrix, if it is turned on in
the Browser window
'Highlight source elements without
relationships' - to display, in pale blue,
all cells in a row belonging to a source
element that has no relationships
'Highlight target elements without
relationships' - to display, in pale pink,
all cells in a column belonging to a
target element that has no relationships
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Review Source and Target Elements
As you review the information on relationships in the
Relationship Matrix, you can also obtain information on the
source and target elements in any of the relationships.

Access
Ribbon

Design > Package > Package/Matrix |
Open as (Source, Target or Both)

Context
Menu

Browser window |Right-click on Package
| Relationship Matrix | (As Source, As
Target or As Both)

Review the elements
Action

Detail

Identify other
elements in
relationships
with a source

Click on the source or target element
name in the row or column titles.
The entire row or column is highlighted.
Scroll across or down the highlighted row
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or target
element

or column and quickly identify where the
relationships are; this is very useful if the
row or column is long.

Display the
'Properties'
dialog for the
selected
element

Right-click on the element name and
select the 'Properties' option.

Identify
diagrams in
which the
element is
used

Right-click on the element name and
select the 'Find in Diagrams' option.
Either:
· The only diagram in which the element
is used displays, with the element
highlighted, or
· A list of the diagrams in which the
element is used displays; you then
double-click on the required diagram to
open it

Highlight the
element
name in the
Browser
window

Right-click on the element name and
select the 'Locate in Project Browser'
option.
The Browser window expands to the
location of the element, and the element
name is highlighted.

Make the

Right-click on the element name and
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select the 'Set Context Item' option; the
selected element becomes the subject of
any other windows or screens that are
open.
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The Relationships Window
If you want a quick overview of all the relationships of one
element or of several elements in the model, you can obtain
this from the Relationships window. This window lists all
the relationships of the elements currently selected in a
diagram or the Browser window, showing:
· The relationship type
· The direction, or navigability, of the relationship
· Any stereotype on the relationship
· The names of the source and target elements in the
relationship (names in parentheses indicate that the
element is not shown on the currently-open diagram); the
selected elements can be either source or target in the
relationship
· Characteristics of the source and target elements, such as
type, stereotype, role, cardinality
· The relationships of structured elements (Ports and Parts)
on the selected element (the child relationships)
This information is presented in a series of columns that you
can display or hide to show only the characteristics you
require, and organize in whatever sequence suits your
requirements. You can also group the information (for
example, by source or target element) and filter the
information to show only items having particular values.
The Relationships window has a 'View' column which, if the
row contains the value 'Visible' or 'Hidden', indicates that
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the related element is present in the currently open diagram
and the relationship to it is visible or hidden. If the related
element is not in the current diagram (the row has no value),
you can add it.
You can perform operations on each relationship using the
options from a context menu.

Access
Ribbon

Start > All Windows > Properties >
Responsibilities > Relations
Explore > Portals > Windows > Trace >
Relationships

Keyboard
Shortcuts

Ctrl+Shift+2

Facilities
Facility

Detail

Reorganize
display

You can click on and drag column
headings across the display to arrange
them in a different sequence.
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You can also right-click on the column
headings and set up the types and values
of information to display, using the Field
Chooser, Group Box and Filter Bar.
Display
connector
properties

Either:
· Double-click on a relationship in the
list
· Click on the relationship and press the
G key, or
· Right-click and select 'General
Properties'
The '<connector type> Properties' dialog
displays showing the 'General' tab, on
which you can view and edit the
connector properties.

Display
properties of
Target Role

Either:
· Double-click on a relationship in the
list and select the 'Role(s)' tab
· Click on the relationship and press the
T key, or
· Right-click and select 'Target Role'
The '<connector type> Properties' dialog
displays showing the 'Roles' tab, on
which you can view and edit the
properties of the Target Role defined in
the relationship.
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Display
properties of
Source Role

Either:
· Double-click on a relationship in the
list and select the 'Role(s)' tab
· Click on the relationship and press the
S key, or
· Right-click and select 'Source Role'
The '<connector type> Properties' dialog
displays showing the 'Roles' tab, on
which you can view and edit the
properties of the Source Role defined in
the relationship.

Show child
relationships

If the element you want to examine has
Ports and Parts, you can select the
element together with those structured
elements and see relationships involving
the element itself and each Port and Part.
Alternatively, on the Relationships
Window press the C key or right-click
and select the 'Expand to Children'
option. The list then expands to include
relationships on the element's Ports and
Parts.
This option is particularly useful for
SysML diagrams containing Information
Flows, where the relationships can be
combined into one line.
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Hide / Show
connector on
diagram

If the related element exists on the
current diagram, and the connector is
shown (the 'View' column has the value
'Visible'), you can hide it. Right-click on
the item line and select 'Hide Relation'.
If the related element exists on the
diagram and the connector is hidden (the
'View' column has the value 'Hidden'),
you can re-display it. Right-click on the
item line and select 'Show Relation'.

Apply
Appearance
to one or
more
connectors
on the current
element on
the current
diagram

Select one or more relationships, then
right-click and select 'Appearance'.
On the 'Connector Appearance' dialog,
click on the drop-down arrow in the:
· 'Line Color' field, and select the color
to apply to the connector lines
· 'Line Thickness' field, and select the
line thickness of the connector lines
Click on the OK button to apply the
settings to all the selected connectors on
the element.
For the selected connectors, you can also
right-click and select 'Line Style', and one
of the listed styles. The style is
immediately applied to the connectors on
the diagram.

Display the
(c) Sparx Systems 2022
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properties of
the Source
element

Either:
· Right-click on the relationship item and
select 'Source Properties', or
· Click on the item line and press the
Enter key
The element 'Properties' dialog displays
for the source element in the relationship.

Display the
attributes or
operations of
the Source
element

Right-click on the relationship item and
select 'Source Features | Attributes' or
'Source Features | Operations'.
(Alternatively, click on the item and press
F9 or F10, respectively).
The Features window displays for the
source element, showing the 'Attributes'
or 'Operations' tab as appropriate.

Display the
properties of
the Target
element

Either:
· Right-click on the relationship item and
select 'Target Properties', or
· Click on the item line and press
Shift+Enter
The element 'Properties' dialog displays
for the target element in the relationship.

Display the
attributes or
operations of

Right-click on the relationship item and
select 'Target Features | Attributes' or
'Target Features | Operations'.
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the Target
element

(Alternatively, click on the item and press
Shift+F9 or Shift+F10, respectively).
The Features window displays for the
target element, showing the 'Attributes' or
'Operations' tab as appropriate.

Find a related
element in
the Browser
window

Right-click on the item line and select
'Locate Source' or 'Locate Target' as
appropriate.
The related element is highlighted in the
Browser window.

Add related
elements to
the current
diagram

If any related elements are not shown on
the current diagram, then:
· The 'View' column has no value and
· The related element name is in
parentheses ()
You can select the relevant relationships
and add the elements to the diagram.
Select the item line(s), then right-click
and select 'Place Element(s) in Diagram'.
The cursor changes to the 'drop element'
symbols (small rectangle and arrow with
a boxed plus sign); move the cursor to the
point in the diagram at which to drop the
related elements, and click the mouse
button.
This facility is useful in building up a
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picture of how an element interacts with
the rest of the model, especially when
reverse engineering an existing code
base.
Locate
related
elements in
diagrams

Right-click on the item line and select the
'Find in all Diagrams' option.
If the related element exists only in one
diagram, that diagram is displayed with
the related element highlighted. The
focus of the Relationships window
switches to the related element.
If the related element exists in more than
one diagram, the 'Element Usage' dialog
displays, listing the diagrams. Click on
one of the diagrams and on the Open
button to display the selected diagram
with the related element highlighted.

Delete the
relationship

Right-click on the item line and select the
'Delete Connection' option.
A prompt displays to warn you that the
selected items will be deleted from all
diagrams and from the model, and that
the action cannot be reversed. This
message refers to the relationship only the source and target elements remain in
the diagram and in the model.
Click on the Yes button to proceed with
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the deletion.

Notes
·

·

In the Corporate, Unified and Ultimate Editions, with
security enabled, the diagram and the source and target
elements must be free for editing before these options are
available for use
Adding a related element from the Relationships window
to the diagram does not change the focus of the window to
that related element; the originally-selected element (and
the original subject of the Relationships window) remains
in context, and you continue working with that element
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Example Traceability Diagram
You can create Traceability diagrams to show a wide variety
of relationships, and you are not restricted to having either a
single element type or elements from a single phase on a
diagram. Therefore, you can create appropriate relationships
(such as Realize or Trace) to elements where no relationship
was previously defined.
Consider this diagram, which shows how a series of
Requirements are traced to Use Cases and then Classes:

The diagram instantly shows:
· That two levels of Requirements are realized by Use
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Cases
· Which Requirement is realized by which Use Case(s)
· How some of the Use Cases are implemented by Class
elements
You can drill down on each Use Case (or, in other
Traceability diagrams, any other composite element) to
display more detailed diagrams showing how the Use Case
meets the Requirement; the Close Account Use Case, for
example, is a composite element containing a
Communication diagram and a Sequence diagram.
You can tailor your Traceability diagrams to depict any
level of granularity and any stages of development that are
appropriate; for example, you might:
· Narrow the example diagram to show development from
just the Remove User Requirement, or
· Extend it to include Interfaces, Components, Test Case
elements or any other facet of the system or process

Building a diagram
A number of tools are available for updating diagrams to
show traceability:
· On the diagram, right-click on an element and select the
context menu option 'Insert Related Elements' to
automatically add elements linked to the selected element
· On the Relationships window, use the context menu
option 'Place Related Element in Diagram' to add
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elements to the diagram that are directly linked to the
selected element
On the Traceability window, add elements that are
indirectly linked

Notes
·

Whilst the Traceability diagram itself provides
information on the definition, design and implementation
of a business process feature, much more information can
be obtained using the Traceability tools
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Gap Analysis Matrix
The Gap Analysis Matrix is a convenient tool for analyzing
model artifacts to identify potential gaps between solutions.
The idea is to highlight a shortfall between the original or
current solution and proposed improvement; that is, items
that have been deliberately omitted, accidentally left out, or
not yet defined. You can then model the gaps in the
repository, which can later be addressed and assigned as
tasks; the identified gaps can also be used to prioritize
activities.
On the Gap Analysis Matrix, you select the:
· Target 'Architecture' Package
· Baseline 'Architecture' Package
· Type of Target 'Architecture' artifact
· Type of Baseline 'Architecture' artifact
· Type of element to model the gap
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Access
Ribbon

Design > Package > Gap Analysis
Start > All Windows > Design | Tools |
Gap Analysis

Keyboard
Shortcuts

Alt+1 | Gap Analysis Matrix

Operations
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Once you open the Gap Analysis Matrix, you can:
· Create, update and delete Gap Matrix Profiles to monitor
development of the Baseline and Target Packages
· Edit Gap notes during a discussion session for Gap
Analysis
· Create elements to address gaps
· Add links to existing elements to address gaps
· Remove links to existing elements modeled as gaps
· Hide and expand individual rows or columns
Operation

Description

Select
Package

Click on the button at the end of the
'Target Architecture' and 'Baseline
Architecture' fields.
The 'Find Package' dialog displays.
Select the required Package and click on
the OK button; by default all the elements
under the Package are displayed.

Set Element
Type

Click on the drop-down arrow in the
'Filter' field for the Target Architecture
Package, and/or for the Baseline
Architecture Package.
Find the required element type in the list
and click on it; Enterprise Architect
refreshes the matrix content.
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Set Gap Type

Click on the drop-down arrow in the
'Record Gap As' field.
Find the required element type in the list
and click on it.
When you create a Gap element, it is
created as the specified type; for
example, if you want to address the Gap
with an issue element then select 'Issue'
for this field.

Baseline
Architecture

The Baseline Architecture artifacts are
listed as the rows of the matrix.
The last row is for capturing the new
elements in the Target Architecture along
the columns that are not in the Baseline
Architecture, hence the name 'New'.

Target
Architecture

The Target Architecture artifacts are
listed along the columns of the matrix.
The last column is for capturing the
missing or intentionally eliminated
elements in the Baseline Architecture
along the rows that are not in the Target
Architecture; hence the name 'Missing /
Eliminated'.

Modeling
Gap

Right-click on a cell in the 'New' row or
'Missing / Eliminated' column.
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The context menu displays the options:
· 'Create Gap Element'
· 'Link to Existing Gap Element'
If a link to a Gap element already exists
in the cell, these options are displayed:
· 'Edit Gap element'
· 'Find in Project Browser...'
· 'Remove Gap Element Link'
Create Gap

Right-click on the cell and select the
'Create Gap Element' option.
The 'Find Package' dialog displays.
Select the Package in which to create the
Gap element and click on the OK button;
a Gap element is created in the selected
Package and its 'Properties' dialog
displays to enable you to enter the
element name and other required
properties.

Link to
Existing Gap

If you intend to use a Gap element that is
already available in the model, right-click
on the appropriate cell in the 'Missing /
Eliminated' column or 'New' row and
select the 'Link to Existing Gap Element'
option.
The 'Select <element type>' dialog
displays, enabling you to select the
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existing Gap element.
Remove Link
to Gap

If you intend to remove a link to the Gap
element in a cell, right-click on the
appropriate cell in the 'Missing /
Eliminated' column or 'New' row and
select the 'Remove Link to Gap Element'
option.
The link is removed from the cell but the
element still exists in the Browser
window.

Review Gap
Element

Right-click on the appropriate cell in the
'Missing / Eliminated' column or 'New'
row and select the 'Edit Gap Element'
option.
The 'Properties' dialog displays, enabling
you to edit the selected Gap element.
To locate and highlight the element in the
Browser window, select the 'Find in
Project Browser...' context menu option.

Hide Row or
Column

If you want to hide a column or row
while you focus on a specific aspect of
the matrix, you can simply drag the right
or lower border of the header cell to hide
to the left or upwards to cover the column
or row. You can pick up the border and
pull it back to expose the row or column
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again, but it is simpler to just click on the
Refresh button to restore the full display.
Gap Analysis
Matrix
Profiles

On the Gap Analysis Matrix, you can
create and manage profiles to save
commonly-used combinations of Target
Architectures, Baseline Architectures and
stereotypes.
To work on Gap Analysis Matrix
profiles, click on the Options button in
the top right corner of the matrix; a
submenu displays, listing options to:
· Save the current matrix settings and
content as a new Profile
· Update the currently selected profile in
the 'Profile' field
· Delete the currently selected profile in
the 'Profile' field

Open a saved
Profile

The 'Profile' field drop-down list shows
all the saved Gap Analysis Matrix
profiles.
Click on the drop-down arrow in the
'Profile' field, find the required profile in
the list and click on it to load the content
of the selected profile in the matrix.
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Notes
·

·

The Gap Analysis Matrix is available in the Corporate,
Unified and Ultimate Editions of Enterprise Architect
You can transport your Gap Analysis Matrix profiles
between projects, using the 'Settings > Model > Transfer
> Export Reference Data' and 'Import Reference Data'
ribbon options
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Edit Gap Notes
The Gap Analysis Matrix provides a way to record notes
during the initial phase or during a discussion session for
Gap Analysis. These notes are saved in the profiles, which
can later be reviewed and the appropriate model elements
created to address the gaps.

Edit Gap Notes
Ste Action
p
1

Right-click on the cell at the intersection of a Target
column and Baseline row and select the 'Edit Gap
Note' option.
Alternatively, double-click on the cell.
The 'Gap Note' dialog displays.

2

Type in or edit the notes as required and click on the
OK button.

3

The edited notes display in the selected cell in the
matrix.

4

Update or save the matrix to retrieve the notes when
the Gap Matrix profile is loaded at a later stage.
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The Search Window

Enterprise Architect has an effective and easy to use search
facility that helps you to find elements in a model, based on
criteria such as name, the date of creation or modification,
type, textual notes and more. There are a number of built-in
searches, but even a novice user can easily extend the
functionality by defining useful and parameterized searches
that can be stored and re-run. When run, the searches return
a set of elements that can be located within the hierarchy of
the repository or in any diagrams in which they appear; they
can even be included in reports. This convenient feature
ensures that, regardless of the structure of the model or how
large the repository is, you will always be able to locate the
information you are looking for.

Facilities
Facility
Model Search - how to use the searching capability within
Enterprise Architect to find and display various kinds of
information
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Create and Modify Searches - how to modify and work
with search definitions
Adding Filters - further modifications to searches
Diagram Filters - how to suppress or highlight
information in a diagram using customizable filtering
mechanisms based on element properties such as status
and complexity
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Model Search
The Model Search facility helps you to quickly navigate to
or find modeling elements within your model. It lists each
object that meets the search criteria you specify within the
search terms and search type. Many different kinds of
searches are already built into the system, and it is possible
to create detailed and specific searches of your own. It is
also possible to export and share your favorite searches.
Having obtained the results of a Model Search, you can
perform a range of operations on them to either modify their
presentation or to extract and/or report on further levels of
detail.
You specify, run and manage the Model Searches through
the toolbar at the top of the view.

Access
Ribbon

Explore > Search > Model (or select one
of the other specialized categories of
search)
Start > All Windows > Design > Explore
> Search
Design > Element > Manage > Search

Keyboard

Alt+1 | Search
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Ctrl+F or
Ctrl+Alt+A

Specify a Search
Option
Search Term
Search
Category

Search
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Action
Type in the word, phrase or characters to
search on.
Use the default Common Searches group
to filter the types of search you might
select from, to the commonest searches
used.
If you want to use a search from a
different functional set, including
searches you have created or imported
yourself, click on the drop-down arrow
and select the appropriate group.
Individual searches you have created are
contained in the My Searches group.
Searches imported as part of a
Technology are grouped under the
Technology name.
Simple is the first, and most general, of
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the system-supplied searches in the
Common Searches group. If you want to
execute a different search in this group,
click on the drop-down arrow and select
the search from the list.
The drop-down list is populated from the
search group selected in the first field in
the toolbar. To list and execute different
searches, change the group in the first
field.
Search in
Model
New Search

Copy Search
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Click on this icon to run the selected
search using the search term you have
provided.
Click on this icon to display the 'New
Search' dialog, through which you can
create your own search in the My
Searches group.
If you want to copy an existing search to
edit into a new search, select the existing
search and click on this icon.
The Enter Search Name prompt displays,
in which you type a new name for the
copied search. The search is
automatically copied into the My
Searches group.
You can now edit this copy to suit your
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requirements.
Edit Search

Delete
Search

Documentati
on and QA
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After creating a new or copied search,
you can edit the search definition.
Click on this icon to open the Query
Editor underneath the toolbar. You can
use search filters to modify the searches
on a search term in order to locate model
elements having specific characteristics.
Click on this icon to delete the search
definition from the My Search group and
its associated Search drop-down list.
The icon is not available for system
defined searches or technology-defined
searches.
Click on this icon to display a submenu
of these options for acting on the results
of a Model Search:
· Edit Notes - select this option to open
the Notes window to edit the text of
any notes a selected element might
have
· Generate Documentation - select this
option to display the 'Generate
Documentation' dialog, through which
you can generate a report on one or
more selected items from the search
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·

·

·

·

·
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results
CSV Import/Export - select this option
to specify the CSV export file location
into which to export the search results
View Notes - select this option to
specify whether to:
- Hide the text of any Notes each
item might have
- Display a summary (the first line)
of any Notes each item might have
- Display the full text of any Notes
each item might have
Import Search - select this option to
display the 'Windows Directory
Explorer Open' dialog, to import
searches as XML Search files from an
external directory; these searches
would have been exported from
another user's model or project
Export Search - select this option to
display the 'Export Searches' dialog, on
which you select the checkbox against
each search in your model that you
want to export to an external directory
as an XML Search file; other users can
then import this file into their models,
to make the same searches available to
them
Dock in Output Bar - select this option
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·

Result List

to move the 'Find in Project' tab to the
System Output window
Dock in Main View - select this option
to return the 'Find in Project' tab to the
main view in the center of the screen

The results of the search display in the
view area, under a set of column headings
that you can reduce, add to and re-arrange
to better display the information you
need.
You can also operate on the items in the
search results using the Model Search
context menu.

Keyboard Options
When the search has produced results, you can perform a
number of simple operations on them using the keyboard
keys:
· Display the 'Properties' dialog for the element
(double-click or press the Enter key)
· Drag item(s) onto a diagram (Ctrl+drag selected items) - a
prompt displays for you to specify how to render the
element on the diagram
· Open the Linked Document window for the selected
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element (press Ctrl+Alt+D)

Notes
You can access the Model Search facilities and perform
specific searches indirectly, from Add-Ins, from MDG
Technologies, from a hyperlink and from a shortcut to
access your model; this entails setting up a search profile,
either in the appropriate tool or as an XML file accessed by
the tool.
Searching from
An MDG Technology
A Login Shortcut
An Add-In
A Hyperlink
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Pre-defined Searches
Enterprise Architect provides a range of pre-defined
searches, grouped according to type. Each search is briefly
explained here.

Access
Ribbon

Explore > Search > Model
Start > All Windows > Design > Explore
> Search
Design > Element > Manage > Search

Keyboard
Shortcuts

Alt+1 | Search
Ctrl+F or
Ctrl+Alt+A

Other

There are many points throughout
Enterprise Architect where you can
invoke a specific pre-defined search,
either to execute immediately without
input from you, or to display the Find in
Project view where you enter a search
term before executing the search. For
example, the 'Explore > Search >
Diagram', or 'Package' ribbon options.
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Common Searches
Search

Description

Simple

Searches the 'Name', 'Alias' and 'Notes'
fields of all elements for the given search
term.

Extended

Searches many additional fields relating
to the element, including attributes,
operations, tags and Test Cases.

Element
Name

Searches for an exact match against the
element name, alias, method or operation;
the default search in the 'Search in Model'
menu option in the Code Editor.

Attribute
Details

Searches for elements with attributes
relating to the search term, including
Tagged Values, constraints, and common
attribute data fields.

Method
Details

Searches for elements with operations
and methods relating to the search term,
including Tagged Values, constraints and

(c) Sparx Systems 2022

Page 663 of 1150

The Application Desktop

3 October, 2022

common operation and method data
fields.
Recently
Modified
Elements

Searches for elements that have been
recently modified, anywhere in the
project.
The search term relates to any common
element field.
The default is to show elements modified
in the last three days, but you can set an
alternative interval by typing the
appropriate number of days in the 'Search
Term' field.

Find
Operations
by Name

Searches for the use of a named operation
anywhere in the model.

Find
Attributes by
Name

Searches for the use of a named attribute
anywhere in the model.

Find Package

Searches for a named Package in the
model.

Find
Scenarios

Lists all elements in the project
containing defined scenarios.

Schema

Lists all elements containing Schema
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Profiles

Profiles held in the project. You can filter
the list by element name, in the 'Search
String' field.

Recently
Modified
Schema
Profiles

Locates all elements in the project
containing Schema Profiles modified
within the previous n days; you specify n
in the 'Search String' field.

Recently
Modified
Linked
Documents

Locates all elements in the project
containing Linked Documents modified
within the previous n days; you specify n
in the search string field.

Recently
Modified
Decision
Tables

Locates all elements in the project
containing Decision Tables modified
within the previous n days; you specify n
in the search string field.

Linked
Documents

Lists all elements in the project having
Linked Documents and having the search
term in the element name.

Decision
Tables

Locates all elements containing Decision
Tables in the project.

Find
Baselines

Lists all Packages having Baselines in the
project.
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Test and Verification Searches
Search

Description

Failed
Internal Tests

Searches the project for elements
containing one or more internal test cases
where the 'Status' value is 'Fail' and the
search term is in any common Test Case
field.
The output lists the elements and shows
their properties; use the 'Construct > Test
Management > Tests > All' ribbon option
to examine the test records for a selected
element.

Tests on
Recently
Modified
Elements

Searches the project for recently modified
elements that have test records. In the
'Search Term' field you can specify the
number of days over which to check
back. If you do not specify a number of
days, the search uses a value of 1 day.
The output lists the elements that have
test records and that have been modified
during the specified period, and shows
the details of each test record on each
element. Double-click on an item to
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display the 'Test Details' dialog for that
test.
Tests Not
Run

Searches the project for elements having
test records where the 'Status value' is any
of: 'Not Run', 'Cancelled' or 'Deferred'. In
the 'Search Term' field you can specify
the number of days over which to check
back. If you do not specify a number of
days, the search uses a value of 1 day.
The output lists the elements that have
test records that have:
· Been updated during the specified
period and
· Have a status other than 'Pass' or 'Fail'
The output shows the details of each test
record on each element. Double-click on
the item to display the 'Test Details'
dialog for the test.

Tests Not
Checked

Searches the project for elements having
test records that have no 'Checked By'
value. In the 'Search Term' field you can
specify the number of days over which to
check back. If you do not specify a
number of days, the search uses a value
of 1 day.
The output lists the elements that have
test records that have:
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Been updated during the specified
period and
· Have an empty 'Checked By' field
The output shows the details of each test
record on each element. Double-click on
the item to display the 'Test Details'
dialog for the test.
·

Passed Tests

Searches the project for elements having
test records where the 'Status' value is
'Pass'. In the 'Search Term' field you can
specify the number of days over which to
check back. If you do not specify a
number of days, the search uses a value
of 1 day.
The output lists the elements that have
test records that have:
· Been updated during the specified
period and
· Have the status 'Pass'
The output shows the details of each test
record on each element. Double-click on
the item to display the 'Test Details'
dialog for the test.

Failed Tests

Searches the project for elements having
test records where the 'Status' value is
'Fail'. In the 'Search Term' field you can
specify the number of days over which to
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check back. If you do not specify a
number of days, the search uses a value
of 1 day.
The output lists the elements that have
test records that have:
· Been updated during the specified
period and
· Have the status 'Fail'
The output shows the details of each test
record on each element. Double-click on
the item to display the 'Test Details'
dialog for the test.
Deferred
Tests
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Searches the project for elements having
test records where the 'Status' value is
'Deferred'. In the 'Search Term' field you
can specify the number of days over
which to check back. If you do not
specify a number of days, the search uses
a value of 1 day.
The output lists the elements that have
test records that have:
· Been updated during the specified
period and
· Have the status 'Deferred'
The output shows the details of each test
record on each element. Double-click on
the item to display the 'Test Details'
Page 669 of 1150

The Application Desktop

3 October, 2022

dialog for the test.
Recently Run
Tests

Searches the project for elements having
test records where the 'Run Date' field has
a value. In the 'Search Term' field you
can specify the number of days over
which to check back. If you do not
specify a number of days, the search uses
a value of 1 day.
The output lists the elements that have
test records that have a 'Run Date' value
within the specified period, and shows
the details of each test record on each
element. Double-click on the item to
display the 'Test Details' dialog for the
test.

Requirements
Search

Description

Internal
Searches the project for elements with
Requirements internal requirements where the search
term relates to any common requirement
field.
The output lists the elements that have
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requirements containing the search term
value, and shows the element properties.
To review the requirements, double-click
on an item to display the element
'Properties' dialog and select the
'Requirements' page.
Requirements Searches the project for Requirement
element types where the search term
occurs in any common element field.
The output lists the Requirement
elements containing the search term.
Double-click on an item to display the
'Properties' dialog for that element.
Recently
Discussed
Elements
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Searches the project for any element that
has a recent entry in the Discuss &
Review window. In the 'Search Term'
field you can specify the number of days
over which to check back. If you do not
specify a number of days, the search uses
a value of 3 days.
The output lists the elements that have
recent discussions, and their properties.
You can display the discussions
themselves by pressing Ctrl+9 or
selecting the 'Start > Collaborate >
Discuss > Discuss' ribbon option, and
clicking on the individual entries in the
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search output.
Recent
Element
Posts

Searches the project for any element that
has a recent entry in the Discuss &
Review window. In the 'Search Term'
field you can specify the number of days
over which to check back. If you do not
specify a number of days, the search uses
a value of 3 days.
The output lists the elements that have
recent discussions, and the date of the
most recent post on each element. You
can display the discussions themselves by
pressing Ctrl+9 or by selecting the 'Start
> Collaborate > Discuss > Discuss'
ribbon option, and then clicking on the
individual entries in the search output.

Resource Tracking
Search

Description

Resources

Searches the project for elements with
assigned resources, where the search term
is the value of any common Resource
field.
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The output lists all elements with
assigned resources containing the text
string specified as the search term, and
shows the properties of each element. To
see the assigned resources for an element,
click on the item and select the 'Construct
> Resource Management > Resources'
ribbon option.
Tasks
Overdue

Searches the project for elements with
assigned resources, where the end date is
in the past and the percentage completion
is less than 100.
The output lists all elements with overdue
tasks, and shows the details of the
resource allocation to each task.

Active Tasks

Searches the project for elements with
assigned resources, where the end date is
in the future and the percentage
completion is less than 100.
The output lists all elements with
currently active tasks, and shows the
details of the resource allocation to each
task.

Tasks
Completed

Searches the project for elements with
assigned resources, where the percentage
completion is 100.

(c) Sparx Systems 2022

Page 673 of 1150

The Application Desktop

3 October, 2022

The output lists all elements with
completed tasks, and shows the details of
the resource allocation to each task.
Recently
Finished
Tasks

Searches the project for elements with
assigned resources, where the end date is
in the recent past and the percentage
completion is 100. In the 'Search Term'
field, specify the number of days over
which to check back.
The output lists all elements with tasks
completed within the specified period,
and shows the details of the resource
allocation to that task. The output does
not include tasks that have already been
finished in advance of a future
completion date.

Tasks Ending
Today

Searches the project for elements with
assigned resources, where the task end
date is today.
The output lists all elements with tasks
ending today, whether the task is
complete or not, and shows the details of
the resource allocation to each task.

Tasks
Starting
Today

Searches the project for elements with
assigned resources, where the task start
date is today.
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The output lists all elements with tasks
starting today, and shows the details of
the resource allocation to each task.
Authors with
no Active
Tasks

Searches the project for authors who have
not been assigned as a resource to any
task that is currently active.
The output lists all defined authors who
have not been assigned to any task that:
· Is currently less than 100 percent
complete or
· Has a start date that is not in the future

30-Day Task
Summary
(Simplified)

Provides a brief summary of the work
allocated to each resource over the last 30
days - how many tasks, how much time
they took and how much time they were
expected to take. Tasks can be grouped
into Series, so a resource might have
more than one entry in the report,
summarizing the work for each series.

30-Day Task
Summary
(Full)

Provides a brief summary of the work
allocated to the resources over the last 30
days, in order of task Group Name. There
can be many entries for each resource,
depending on the tasks and task groups
they have been allocated to.
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30 Day
Resources

Provides a breakdown of each resource
allocation record created or updated
during the last 30 days. If you specify
search text, the report shows records
where the text is included in the resource
name.

30 Day Roles

Provides a breakdown of each resource
allocation record created or updated
during the last 30 days. If you specify
search text, the report shows records
where the text is included in the role
name.

Diagram Searches
Search

Description

Diagram
Name

Lists the diagrams that have a name
containing the term specified in the
'Search Term' field.

Diagram
Details

Lists the diagrams that have the value
specified in the 'Search Term' field in one
or more of the diagram details fields.
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Recently
Modified
Diagrams

Searches for diagrams that have been
recently modified, anywhere in the
project.
The search term relates to any common
diagram properties field.
The default is to show diagrams modified
in the last three days, but you can set an
alternative interval by typing the
appropriate number of days in the 'Search
Term' field.

Find
Bookmarked
Elements

Searches for elements that have been
bookmarked, anywhere in the project.

Find Kanban
Diagrams

Lists all Kanban diagrams in the model
and identifies who created them, when
they were created and when they were
last modified.

Find Orphans

Searches for orphaned elements
throughout the model, with the ability to
filter on common element fields using a
search term.
An 'orphaned' element is an element that
does not appear on any diagram in the
model.
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Project Status
Search

Description

My Checked
Out Packages

Searches the project for Packages under
Version Control that are marked as
checked out under your user ID.

Simulation
Search

Description

StateMachine
Diagrams

Lists all StateMachine diagrams that exist
in the current model, and their properties.

Activity
Diagrams

Lists all Activity diagrams that exist in
the current model, and their properties.

Recent
StateMachine
Diagrams

Lists all StateMachine diagrams that you
have opened recently.
The default is to show diagrams opened
in the last seven days, but you can set an
alternative interval by typing the
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appropriate number of days in the 'Search
Term' field.
Recent
Activity
Diagrams

Lists all Activity diagrams that you have
opened recently.
The default is to show diagrams modified
in the last seven days, but you can set an
alternative interval by typing the
appropriate number of days in the 'Search
Term' field.

Executable
StateMachine
s

Lists all Executable StateMachine
elements (Artifacts with the <<executable
statemachine>> stereotype) in the project,
with their element properties.

SysMLSim
Configuratio
n

Lists all SysMLSim Configuration
elements (Artifacts with the
<<SysMLSimConfiguration>>
stereotype) in the project, with their
element properties.

BPSim
Report

Lists all the simulation report results (as
BPSim Result Artifacts) in the project,
with their element properties.

BPSim Chart

Lists all BPSim Chart elements (both
standard and customized) in the project,
with their element properties.
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Lists all BPSim elements (Artifacts with
the <<BPSim>> stereotype) in the
project, with their element properties.

Changes
Search

Description

Verified
Changes

Lists the elements in the project having
internal change records that have the
status 'Verified' and that are not
completed.

Recently
Requested
Changes

Lists the elements having change records
for recent requests that might or might
not have been acted on. In the 'Search
term' field type the number of days
previous to check (the report defaults to
7).

Recently
Completed
Changes

Lists the elements having change records
that were given the status 'Complete'
recently. In the 'Search term' field type
the number of days previous to check (the
report defaults to 7).
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New
Changes

Lists the elements having change records
that have the status 'New' (that is, no
action has been taken on them yet).

Incomplete
Changes

Lists the elements having change records
that do not have the status 'Complete'.

Defects
Search

Description

Verified
Defects

Lists the elements in the project having
internal defect records that have the status
'Verified' and that are not completed.

Recently
Reported
Defects

Lists the elements having recently
reported defect records that might or
might not have been acted on. In the
'Search term' field type the number of
days previous to check (the report
defaults to 7).

Recently
Resolved
Defects

Lists the elements having recently
resolved defect records that were given
the status 'Complete'. In the 'Search term'
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field type the number of days previous to
check (the report defaults to 7).
New Defects

Lists the elements having defect records
that have the status 'New' (that is, no
action has been taken on them yet).

Unresolved
Defects

Lists the elements having defect records
that do not have the status 'Complete'.

Issues
Search

Description

Verified
Issues

Lists the elements in the project having
internal issue records that have the status
'Verified' and that are not completed.

Recently
Reported
Issues

Lists the elements having recently
reported issue records that might or might
not have been acted on. In the 'Search
term' field type the number of days
previous to check (the report defaults to
7).

Recently

Lists the elements having recently
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Resolved
Issues

completed issue records that were given
the status 'Complete'. In the 'Search term'
field type the number of days previous to
check (the report defaults to 7).

New Issues

Lists the elements having issue records
that have the status 'New' (that is, no
action has been taken on them yet).

Unresolved
Issues

Lists the elements having issue records
that do not have the status 'Complete'.

Tasks
Search

Description

Verified
Tasks

Lists the elements in the project having
internal task records that have the status
'Verified' and that are not completed.

Recently
Requested
Tasks

Lists the elements having recently
requested task records that might or
might not have been acted on. In the
'Search term' field type the number of
days previous to check (the report
defaults to 7).
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Recently
Completed
Tasks

Lists the elements having recently
completed task records that were given
the status 'Complete'. In the 'Search term'
field type the number of days previous to
check (the report defaults to 7).

New Tasks

Lists the elements having task records
with the status 'New' (that is, no action
has been taken on them yet).

Incomplete
Tasks

Lists the elements having task records
that do not have the status 'Complete'.

Events
Search

Description

Recently
Reported
Events

Lists the elements having recently created
event records that might or might not
have been acted on. In the 'Search term'
field type the number of days previous to
check (the report defaults to 7).

Recently
Completed

Lists the elements having recently
resolved event records (the 'Resolved'
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Events

checkbox is selected). In the 'Search term'
field type the number of days previous to
check (the report defaults to 7).

High Priority
Events

Lists the elements having event records
with a 'Priority' setting of 'High', that
have not been resolved.

Open Events

Lists the elements having event records
that have not been resolved or completed.

Decisions
Search

Description

Verified
Decisions

Lists the elements in the project having
internal decision records that have the
status 'Verified' and that are not
completed.

Recently
Created
Decisions

Lists the elements having
recently-created records for decisions that
might or might not have been acted on. In
the 'Search term' field type the number of
days previous to check (the report
defaults to 7).
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Recently
Effective
Decisions

Lists the elements having records for
decisions that have recently become
effective. In the 'Search term' field type
the number of days previous to check (the
report defaults to 7).

New
Decisions

Lists the elements having decision
records that have the status 'New' (that is,
no action has been taken on them yet).

Unresolved
Decisions

Lists the elements having decision
records that do not have the status
'Complete'.

Test Points
Search

Description

Test Suites

Lists the Test Suite elements that exist in
the model. Type a text string in the
Search Term field to filter for Test Suite
elements with that string in the element
name.

Test Sets

Lists the Test Set elements that exist in
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the model. Type a text string in the
Search Term field to filter for Test Set
elements with that string in the element
name.
Test Cuts

Lists the Test Cut elements that exist in
the model. Type a text string in the
Search Term field to filter for Test Cut
elements with that string in the element
name.

Database Engineering
Search

Description

Data Models

Searches the project for data model
Packages (Packages with the string
'DataModel' in the 'Stereotype' field).
The output lists the DataModel Packages
with their basic properties.

Database
Objects

Searches the project for database objects;
that is, Class elements with any of the
database object stereotypes. You can
filter the list by specifying one of the
stereotypes in the 'Search Term' field, or a
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text string to match text in the 'Alias',
'Name' or 'Notes' fields.
The output lists the database object
elements with their element properties.
Functions

Searches the project for database
Functions; that is, Class elements with
the string 'function' in the 'Stereotype'
field. You can filter the list by specifying
a text string in the 'Search Term' field, to
match text in the 'Alias', 'Name' or 'Notes'
fields.
The output lists the database Function
elements with their element properties.

Procedures

Searches the project for database
Procedures; that is, Class elements with
the string 'procedure' in the 'Stereotype'
field. You can filter the list by specifying
a text string in the 'Search Term' field, to
match text in the 'Alias', 'Name' or 'Notes'
fields.
The output lists the database Procedure
elements with their element properties.

Sequences

Searches the project for database
Sequences; that is, Class elements with
the string 'sequence' in the 'Stereotype'
field. You can filter the list by specifying
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a text string in the 'Search Term' field, to
match text in the 'Alias', 'Name' or 'Notes'
fields.
The output lists the database Sequence
elements with their element properties.
Table
Column
Datatypes

Searches the project for database Tables
that have data types containing the string
you specify in the 'Search Term' field.
This field must contain a value.
The output lists Table elements that have
data types containing the specified string,
and shows the element properties of each
Table.
To see the data types, double-click on the
item to display its 'Properties' dialog,
click on the 'Table Detail' tab and on the
Columns button, and review the data
types of the columns on the 'Columns and
Constraints' dialog.

Table
Columns

Searches the project for database Table
columns that contain the string you
specify in the 'Search Term' field. This
field must contain a value.
The output lists Table elements that have
columns containing the specified string,
and shows the element properties of each
Table.
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To see the columns, double-click on the
item to display its 'Properties' dialog,
click on the 'Table Detail' tab and on the
Columns button, and review the columns
on the 'Columns and Constraints' dialog.
Table
Foreign Keys

Searches the project for database Tables
that have Foreign Keys (constraints). You
can filter the search by specifying a text
string in the 'Search Term' field.
The output lists Table elements that have
Foreign Keys, and shows the element
properties of each Table.
To see the Foreign Keys, double-click on
the item to display its 'Properties' dialog,
click on the 'Table Detail' tab and on the
Constraints button, and review the
constraints of type FK on the 'Columns
and Constraints' dialog.

Table
Indexes

Searches the project for database Tables
that have Indexes (constraints). You can
filter the search by specifying a text
string in the 'Search Term' field.
The output lists Table elements that have
Indexes, and shows the element
properties of each Table.
To see the Indexes, double-click on the
item to display its 'Properties' dialog,
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click on the 'Table Detail' tab and on the
Constraints button, and review the
constraints of type Index on the 'Columns
and Constraints' dialog.
Table
Searches the project for database Tables
Primary Keys that have Primary Keys (constraints).
You can filter the search by specifying a
text string in the 'Search Term' field.
The output lists Table elements that have
Primary Keys, and shows the element
properties of each Table.
To see the Primary Keys, double-click on
the item to display its 'Properties' dialog,
click on the 'Table Detail' tab and on the
Constraints button, and review the
constraints of type PK on the 'Columns
and Constraints' dialog.
Tables

Searches the project for database Tables;
that is, Class elements with the string
'table' in the 'Stereotype' field. You can
filter the list by specifying a text string in
the 'Search Term' field, to match text in
the 'Alias', 'Name' or 'Notes' fields.
The output lists the database Table
elements with their element properties.

Triggers

Searches the project for Table Trigger
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elements. You can filter the list by
specifying a text string in the 'Search
Term' field, to match text in the 'Alias',
'Name' or 'Notes' fields.
The output lists the Table Trigger
elements with their element properties.
Views
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Searches the project for database Views;
that is, Class elements with the string
'view' in the 'Stereotype' field. You can
filter the list by specifying a text string in
the 'Search Term' field, to match text in
the 'Alias', 'Name' or 'Notes' fields.
The output lists the database View
elements with their element properties.
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Create Search Definitions
If you want to define your own searches, you can do so
using the SQL Editor, Query Builder or an Add-In, through
the 'New Search' dialog. User-defined searches are stored in
the user application data for the machine being used, and not
in the project repository.

Access
Ribbon

Explore > Search > Model :
or
Design > Element > Manage > Search
Model :

Keyboard
Shortcuts

Crtl+F :
or
Ctrl+Alt+A :

Create a new search definition
Field/Button

Action

Name

Type a name for the search.
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Query
Builder

Click on this radio button to create your
search through the internal search editor.

SQL Editor

Click on this radio button to create your
search by directly writing SQL
statements.
(For advanced users.)

Add-In
Search

Click on this radio button to define the
search as a function of an Add-In.

Add-In Name (Available if you have selected the
and Method
'Add-In Search' radio button)
Type in:
· The name of your Add-In
· A period (full stop) and
· The name of the method to be called
whenever the search is run (for
example, MyAddin.RunThisMethod);
this search can be exported and
distributed as a part of your Add-In
OK
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the search builder panel
· A Query Builder search, the panel
defaults to the 'Query Builder' tab and
you can start adding filters and
constructing the search; see the Define
and Modify Searches topic
· An SQL search, the panel defaults to
the 'Query Builder' tab and you can
start to create the SQL statement for
the search, as in Create SQL Search
The Search Builder also provides an 'SQL
Scratch Pad' tab, which you can use to
create and test SQL statements before
copying them across to the 'Query
Builder' tab.
SQL statements on the 'SQL Scratch Pad'
are not attached to any search and are not
the focus of any operations initiated from
the 'Find in Project' toolbar.
Cancel

Click on this button to abort the search
creation and close the dialog.

Create SQL Search
You can create SQL statements using the SQL Editor
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through the 'Query Builder' tab. The SQL editor is based on
the common Code Editor, and provides an Intelli-sense
autocompletion list populated from the Enterprise Architect
repository structure.
To display the autocompletion list, position the cursor after
a command and press Ctrl+Space.
A simple search might be to locate an object from a table,
given a search term that the user enters in the 'Search Term'
field; for example:
SELECT * FROM t_object WHERE Name='<Search
Term>' (also see the <Search Term> row in the table))
In the WHERE statements you can use #xxx# macros as
string replacers, so that the same search can be used by
different people in different environments. These macros are
all case-sensitive. They include:
Macro

Description

#Author#

Takes the user name from the 'Author'
field in the 'Preferences' dialog 'General'
page, so the defined search can be
performed on objects created by that user
(this value can be manually re-set in the
'Preferences' dialog). This must be used
within a string.

#Branch#

Gets the ID of each child Package under
one or more parent Packages, working
recursively down to the lowest level of
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sub-Package. For example:
t_object.Package_ID in (#Branch#)
There are three permutations of this
macro:
· in #Branch# - gets the ID of each child
Package of the parent Package selected
by the user
· in #Branch=<GUID># or
#Branch=<ID># - gets the ID of each
child Package of the parent Package
specified by the GUID or ID
· in #Branch=<ID>,<ID>,<ID># - gets
the ID of each child Package under
each parent Package specified by its ID
#Concat
Provides a method of concatenating two
<value1>,
or more SQL terms into one string,
<value2>, ...# independent of the database type.
#Datepart
<field>,
<column>#
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#CurrentEle
mentGUID#

week
dayname

Gets the ea_guid for the
currently-selected element. For example:
t_object.ea_guid=#CurrentElementGUID
#

#CurrentEle
mentID#

Gets the Object_ID for the currently
selected element. For example:
t_object.Object_ID=#CurrentElementID#

#DB=<DBN
AME>#
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· SL3
· FIREBIRD
· JET
· ACCESS2007
· MYSQL
· ORACLE
· SQLSVR
· ASA
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This only uses the section of code
between two matching
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current database type matches the
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specified DBNAME; it can be used
where a section of the SQL might require
special handling depending upon the
current database type. For example:
select *
from t_object
where
#DB=Other#t_object.modifieddate >=
now() - 'Search Term'#DB=Other#
#DB=SQLSVR#t_object.modifieddate
>= getdate() - 'Search
Term'#DB=SQLSVR#
#DB=ORACLE#t_object.ModifiedDate
>= (SYSDATE - INTERVAL 'Search
Term' DAY) #DB=ORACLE#
#DB=POSTGRES#t_object.modifieddate
>= CURRENT_DATE - 'Search
Term'#DB=POSTGRES#
#Left
<field>,
<count>#

Returns the 'count' number of characters
from the field, starting at the beginning of
the string.

#Now#

Inserts the current date plus or minus a
specified number of hours or days; the
default is days (the date format is
adjusted to suit the database in use) as in:
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t_object.ModifiedDate >=#Now
<Search Term>#
For example:
· t_object.ModifiedDate >= #Now -4d#
d is days
· t_object.ModifiedDate >= #Now -5h#
h is hours
· t_object.ModifiedDate >= #Now +3#
defaults to days
· t_object.ModifiedDate >= #Now#
·

#Package#

Gets the Package_ID for the
currently-selected Package. For example:
t_object.Package_ID=#Package#

#Right
<field>,
<count>#

Returns the last 'count' number of
characters from the field.

<Search
Term>

Gets the value on which to search, from
the text entered in the 'Search Term' field
in the Find in Project view (the third field
from the left). It therefore functions when
an active search is being run and values
are being placed in that field. It must
appear inside a string, and s required to
be in quotes if the table.Field it is being
compared with is of type string.
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#Substring
<field>,
<start>#

Returns the remainder of the field
beginning at the 'start' character (1-based)

#Substring
<field>,
<start>,
<count>#

Returns the 'count' number of characters
of the field starting at character 'start'
(1-based).

#UserName#

Gets the name of the person logged into
Version Control.; it must be used inside a
string. This example is from the built in
search 'My Checked Out Packages'.
t_package.PackageFlags LIKE
'#WC#VCCFG=#WC#CheckedOutTo=#
UserName##WC#'

#WC#

Gets the appropriate wild card for the
current database, so the search can be
performed on models on different
databases. It must be used inside a string.
For example:
t_object.Name LIKE
'#WC#Test#WC#'
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The GUID and Type
For all functions in which you use a custom SQL statement
(including Document Reporting and Model Views) the
statement must return the GUID and type of the object
found so that the system can search for the selected item in
the Browser window. The SELECT statement is
case-sensitive and should be typed as shown:
· SELECT ea_guid AS CLASSGUID, Object_Type AS
CLASSTYPE, Name FROM t_object
You can extend the usability of your SQL searches using the
aliases CLASSGUID and CLASSTYPE, so that you can
display the 'Properties' dialog, Tagged Values and icon for
elements, connectors, attributes or operations, as well as
selecting them in the Browser window. Some simple
examples for using these aliased fields are:
· SELECT ea_guid AS CLASSGUID, Object_Type AS
CLASSTYPE, Name FROM t_object
· SELECT ea_guid AS CLASSGUID, 'Operation' AS
CLASSTYPE, Name FROM t_operation
· SELECT ea_guid AS CLASSGUID, 'Attribute' AS
CLASSTYPE, Name FROM t_attribute
Queries for connectors and diagrams can both return types
that match the default association to object types. For these
tables, you should also return a CLASSTABLE field to
allow them to be distinguished from the similar object type.
· SELECT ea_guid AS CLASSGUID, Connector_Type AS
CLASSTYPE, 't_connector' as CLASSTABLE, Name
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FROM t_connector
· SELECT ea_guid AS CLASSGUID, Diagram_Type AS
CLASSTYPE, 't_diagram' as CLASSTABLE, Name
FROM t_diagram
You can enable your search users to drag and drop elements
from the search results onto a diagram, by including one of
these in your search SELECT statement:
· (t_object.Object_ID and t_object.Object_Type) or
· t_object. ea_guid AS CLASSGUID
When you have defined the SELECT statement, click on the
Save button in the 'Query Builder' toolbar to save this
search; the search is then available from the 'Search'
drop-down list.

SQL Scratch Pad Toolbar buttons
The 'SQL Scratch Pad' tab provides a small number of
facilities through its toolbar.
Icon

Description
Click on this icon to test the search you
have defined. The results display in the
main panel of the 'Find in Project' view.
Click on this icon to save the current SQL
search as a new search. A prompt
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displays for the new search name.
When you click on the OK button, the
system switches to the 'Query Builder'
tab, copies the SQL Statement to the tab,
and puts the search name into the 'Search'
field.
Click on this icon to clear the 'SQL
Scratch Pad' of the current search
definition.

Notes
·

When you create a custom SQL search on the 'Query
Builder' tab, the only two icons that are available in the
Toolbar are the Save icon and the Remove Filter icon ;
the Remove Filter icon is effectively a Delete icon that
removes the search content (the SQL statement)
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Define & Modify Searches
Having created a new Query Builder search, you can define
the actions of the search using a series of filters on the
'Query Builder' tab of the search editor. A filter is a
statement instructing the search to extract objects of a
certain type with a specific property having a specific value
or a value within a defined range. You can have a number of
filters within one search. If you have copied an existing
search as a base for the new search, the tab will contain
filters already. If the search is completely new, the tab will
be empty.
You build up the search definition in two areas:
· The 'Add Filters' dialog, where you can configure the
filters to whatever level of precision you require
· The 'Query Builder' tab, where you can modify the filter
settings, define how specific a part of the model to search,
and test the search

Access
Ribbon
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search> :
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Crtl+F | <select search> :
> Query
Builder or
Ctrl+Alt+A | <select search> :
>
Query Builder

Build a Search
Ste Action
p
1

Click on the ('Add Filter') icon to display the 'Add
Filters' dialog, and select and define a set of filters.
If you already have filters in the search, you can add
others of the same filter set by selecting the filter set
label (such as 'Attribute') before you click on the
icon. The filter items are then refined to that filter set
on the 'Add Filters' dialog.

2

If necessary (for example, if you are modifying a
copy of an existing search) remove selected filter
items. Click on either the filter itself or the filter set
heading and click on the
(Remove Filter) icon.
· If you selected a filter item, it is immediately
removed
· If you selected the filter set heading, a prompt
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displays to confirm the deletion; when you click
on the Yes button, all filters in the set are removed
3

If you have edited a system-provided search prior to
saving it as your own search, and you have decided
that the changes are not appropriate, you can 'roll
back' to the original settings. Click on the
(Restore Default) icon in the toolbar.

4

Click on the
('Search Options') icon to set the
level of the model to search, and the interaction of
the filters.

Edit Search on Query Builder tab
On the 'Query Builder' tab, you can activate, deactivate and
modify the individual filters within the search. This is
especially useful for 'tweaking' the search as you test it.
Column

Action

Search In

If the Search contains many filters in a
number of filter sets, you can collapse the
filter sets you don't want to review, and
expand those you do. Click on the
expansion box ( ) next to the filter set
name, as necessary.
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Click on the checkbox next to an object
property to select it for inclusion in the
search, or clear it and omit it from the
search.
Condition

If you want to change the condition that
the property value must satisfy, click
twice on the field to display the
drop-down list and select the new
Condition.
The available options are 'Contains',
'Equal To', 'Not Equals' and 'One Of'.

Look for

In most cases, this field is initially set to
<Search Term> to accept a value that the
search user types into the 'Search Term'
field.
If necessary, overtype the current value
with one or more specific values to
perform the conditional search on.
This value should match the selected
filter type; for example, the value would
be a date for 'DateCreated' or a text value
for 'Name'.
The search term can consist of multiple
values, separated by commas.

Required

Select the checkbox to indicate whether
the field is mandatory - that is, whether
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the search results must only include
elements with your search term in that
field.
These examples show uses of the
'Required' checkbox in the default Simple
search, which checks the 'Name', 'Alias'
and 'Notes' fields of all elements:
· If the 'Required' checkbox is not
selected for any field, then if the search
term is found in the 'Name', 'Alias' OR
'Notes' field for an element, that
element is listed in the results
· If the 'Required' checkbox is ticked for
all fields in the search, then the search
term must be found in all of those
fields before the element is listed in the
results; that is: 'Name' AND 'Alias'
AND 'Notes'
· If the 'Required' checkbox is ticked for
some fields but not others, the search
term must be found in all fields for
which the checkbox is ticked, and at
least one of the fields in which the
checkbox is not ticked; that is: Name
AND (Alias OR Notes)
These checkboxes help you to define the
filters on a specific feature (such as an
element, diagram or attribute). You can
also set up a filter to check for a defined
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value in every feature included in a
search (an AND filter) or in any feature
included in the search (an OR filter).

Notes
·

When you have set up your search, click on the Save
Search icon in the Query Builder toolbar and then the
(Search in Model) icon to run the search and test it
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Add Filters
A filter is a statement instructing a search to extract objects
of a certain type with a specific property having a specific
value or a value within a defined set. You can add a number
of filters to a Model Search or Document Generation, to
more precisely define the objects or information to extract
from the model.

Access
Filters can be applied to a model search, and also to
document generation to filter the elements that are reported
on.
Model
Search

In search window | <select search> :
Query Builder :

Document
Generation

In 'Generate Documentation' dialog |
Element Filters : Add Filter

|

Add filter criteria to a model search or a
document report template
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Option

Action

Active Filter
Set

Click on the drop-down arrow and select
the type of object to search for. Initially,
when there are no other filters selected,
the drop-down list provides the full range
of top-level objects.

The object type defines the filter set and
once you have selected the object type
the drop-down list subsequently only
includes objects subordinate to that set.
For example:
· If the initial selection is set to search on
'Element', the drop-down list for
subsequent filters on the search will
show a list of element properties that
you can filter more specifically on
· If the initial filter is set to search on
'Diagram', the list for any subsequent
(c) Sparx Systems 2022

Page 712 of 1150

The Application Desktop

3 October, 2022

filters for the search only contains the
'Diagram' option, as there are no other
filters that can be applied to a search on
diagrams
Add Filter

Select the checkbox corresponding to
each field that the search is to evaluate.

Required

Select the checkbox if the object must
have this property to be included in the
search results.

Field

Provides the name of the field to be
checked in the search.

Condition

Click on the drop-down arrow and select
the condition that the field value has to
satisfy. That is, the field value:
· Contains
· Is exactly Equal to
· Is anything other than (Not Equals) or
· Is one of a subset of values from
the text string in the '<Search Term>'
field for the search, or a more specific
value defined in the 'Value' field.

Value

If the search is to look for a value
provided by the person running the
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search, leave this field at the default value
of '<Search Term>'.
Otherwise over-type the field with a
specific value or, if the 'Condition' is 'One
Of...', type a selection of values separated
by commas.
For some filters and conditions, the
'Value' field contains the button. Click
on this to display a selection dialog. This
dialog varies dependant on the
information required.
Check All

Click on this button to select all of the
'Add Filter' checkboxes to include all
filters in the search definition.
You might then deselect specific
checkboxes to remove a small number of
filters from the search.

Uncheck All

Click on this button to clear all selected
'Add Filter' checkboxes to omit all filters
from the search definition.
You might then select specific
checkboxes to include only a small
number of filters in the search.

OK

Click on this button to apply the filters to
the search definition.
The selected filters are displayed in the
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'Query Builder' tab for the search
definition.
Cancel

Click on this button to close the dialog
and cancel the changes you have made.

Notes
·

·

You can add multiple search definitions as necessary;
however, if you select the 'Required' field in multiple
definitions the search rapidly becomes impractical
Multiple search definitions are better for 'and/or' searches

(c) Sparx Systems 2022

Page 715 of 1150

The Application Desktop

3 October, 2022

Advanced Search Options
The advanced search options help you to apply greater
control over how your customized search operates on your
model.
You can set values and checkboxes in your search definition
to find specific criteria within a feature, for example,
element properties. However, you can also set filters to run
the search across the whole model or a specific Package,
and to locate objects that have a specified value in:
· All features (for example, the value exists in an element's
properties and one of its attributes' properties) or
· Any one of its features (for example, the value exists in an
element's properties or any of its attributes' properties)
The filters for each feature operate on a database table. In
the system-supplied searches, for example, filters on
element properties operate on the t_element table, filters on
attribute properties operate on t_attribute, and filters on
method parameters operate on t_operationparams.

Access
From the 'Find in Project' Search window, select a search,
then click on the
icon in the Search window toolbar,
select the 'Query Builder' tab, then click on the
icon in
the Query Builder toolbar.
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<select search> :

| Query Builder :

Options
Option

Action

Return
matching
items for the
entire model

Defaults to selected, to run the search
across the entire model.
The search checks every Package in the
model, and returns items that match the
search criteria from wherever they are
located.

Return
matching
items for the
selected
Package

Click on this radio button to run the
search on a specific Package that the user
selects in the Browser window.
If the user runs a search and then selects a
different Package in the Browser
window, the search results do not change
until they click on the Search in Model
icon again; that is, to search different
areas of the project:
· Click on the first required Package in
the Browser window
· Click on the Search in Model icon
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·

·

Check the result
Click on another Package in the
Browser window
Click on the Search in Model icon

All Tables

Click on this radio button to list objects
that have a match in every feature table
checked in the search.
For example, only list elements where
both the element and one or more of its
attributes have the same stereotype name.

At Least One
Table

Defaults to selected to list objects that
have a match in at least one of the feature
tables checked in the search.
For example, list elements that either
have the specified stereotype name, or
have attributes that have the specified
stereotype name.

OK

Click on this button to apply the settings
and close the dialog.

Cancel

Click on this button to cancel any
changes you have made and close the
dialog.
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Customizing the Search View
After you have executed a search and displayed a list of
results, you can reorganize the display to show items in a
different sequence, add or remove columns for particular
characteristics, group the items according to one or more
characteristics, and/or select various items from the results.

Access
Ribbon

Explore > Search > Model > Results pane
or
Design > Element > Manage > Search
Model > Results pane

Keyboard
Shortcuts

Crtl+F > Results pane or
Ctrl+Alt+A > Results pane

Reorganization Options
Option

Detail

Sort and

In the Model Search you can:
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·

·

Change and
Resequence
Columns
using the
View Header
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Sort the items by any column value in
ascending or descending order, by
clicking on the column header and on
the blue arrowhead at the right of that
header
For a system-supplied search, display
the properties of a selected item of any
type, by double-clicking on the item
Select:
- An item by clicking on it
- Several individual items by
holding Ctrl as you click on them
- A range of items by holding Shift
as you click on the first and last
in the range
- All items in the list by pressing
Ctrl+Shift+Alt+A

The View Header defines the columns of
information that are presented by the
Model Search, and the order in which
data items are presented.
To review the column headings:
· Right-click on the header and select the
'Field Chooser' option; the 'Field
Chooser' dialog displays
From this dialog, you can add columns to
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or remove columns from the output;
between them, the View Header and
'Field Chooser' dialog show the full range
of column headers available.
To add a column heading to the View
Header:
· Drag it from the 'Field Chooser' dialog
onto the header to the position you
want the column of data to display in
· When you have selected the column
headings you require, click on the red
cross in the top right corner of the
'Field Chooser' dialog to close it
To remove a column from the output:
· Drag the column heading downwards
out of the View Header
To change the sequence of columns:
· Drag the required column header left or
right, as appropriate
Value
Grouping
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You can organize the reported data
hierarchically according to the value of
one or more of the column categories.
You might organize the data by 'Type',
and within each 'Type' by 'Name'; if you
then click on any of the other column
headings, the data within this grouping is
further sorted with the values of the
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selected column (for example, 'Created')
in ascending or descending order.
To set up the value grouping, drag the
column heading representing the primary
grouping (such as 'Author') onto the 'Drag
a column header here to group by that
column' field.
Now drag the column heading for the
next level of grouping (such as 'Status') to
the right of the first heading; the two
heading titles display as connected
blocks, as shown:
You can, if required, add further levels of
grouping by dragging other column
headings onto the hierarchy (such as
'Created'), and restructure the order by
dragging existing or additional headings
into the level you want them to hold.
For example, you could make 'Type' the
secondary grouping by dragging it to the
right of 'Author', or drop 'Status' between
'Author' and 'Type'.
To remove a grouping level, drag the
appropriate column heading out of the
sequence and below the View header; any
subordinate groupings move up a level.
When you have a report with grouped
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results, you can toggle between the
expanded hierarchy and the collapsed
(top-level item only) grouping by
right-clicking on the View Header and
clicking on the 'Collapse All' option.
Filter Bar
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The Filter Bar displays underneath the
column headings; you can hide or show it
by right-clicking on the column headings
and clicking on the 'Toggle Filter Bar'
option.
The Filter Bar consists of a row of fields,
one field per column; as you type a value
into one of these fields, the Model Search
results are automatically filtered to show
entries in the corresponding column that
contain the value in the field.
For example:
· If you type the letter 'F' in the Filter Bar
field under the 'Author' column, the
results immediately reduce to entries
for which the letter 'F' occurs anywhere
in the name (Fred, Fitzgibbon, Rufus,
Wolf)
· If you then go on to type 'Fi', the results
immediately reduce again to entries for
which the combination 'fi' appears in
the name (Fitzgibbon, Amalfi)
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Model Search Context Menu
You can select elements or diagrams in the results of a
Model Search and perform various operations on them, as
well as simply dragging the item into a Library document or
Linked Document. You can:
· Generate reports from search results
· Print search results
· Copy and work with search results
· Manage elements returned by a search
For Packages that are presented in the search results, you
can also select an option to open the Package in the
Specification Manager.

Access
Context
Menu

When you have executed a search,
right-click on an item in the search results

Menu Options
Option
(c) Sparx Systems 2022

Action
Page 726 of 1150

The Application Desktop

3 October, 2022

Scripts

Click on this option to display a list of
any Model Search scripts you have
created, which can be executed on the
selected item.
This option displays only if:
· You have created Model Search scripts
in a Model Search Script Group folder,
and
· The item results from a successful
Query search, or
· The item results from a successful SQL
search that includes CLASSGUID and
CLASSTYPE

Properties

Click on this option to display the
'Properties' dialog for the element.

Copy
Selected to
Clipboard

Click on this option to copy the selected
item to the MS Windows clipboard so
that it can be pasted as a link into a
diagram, document, spreadsheet or email.
Shortcut: Ctrl+C

Documentati
on

Click on this option to generate a
document report on the selected item(s);
you have two options:
· 'Generate a separate report on each
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selected object in the Model Search'
· 'Generate one report on all selected
objects'
In either case, the 'Generate
Documentation' dialog displays.
If you generate the report using a custom
SQL search, the SQL must include
'ea_guid AS CLASSGUID' and the object
type.
Create
Linked
Document
(Edit Linked
Document)

Click on this option to create (or edit) a
Linked Document on the selected
element.
(Available in the Corporate, Unified and
Ultimate Editions).
Shortcut: Ctrl+Alt+D

Delete
Linked
Document

Click on this option to delete an existing
Linked Document.
(This option only displays if the element
has a Linked Document.)
A prompt displays to confirm the
deletion. Click on the Yes button.

Print

Click on this option to print out the
results as currently displayed.
The 'Print' dialog displays, on which you
select the printer and define the print run.
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Clear Results

Click on this option to clear the search
results from the display.

Find in
Diagrams

Click on this option to display the
diagram that depicts the element or, if the
element is used in multiple diagrams,
display a list of diagrams to choose from.

Find in
Project
Browser

Click on this option to highlight the
element in the Browser window.
(Some reportable objects are not shown
in the Browser window; if you select one
of these, this option is not available.)

Specification
Manager

(For a selected Package in the search
results.) Click on this option to open the
Specification Manager and display the
Package contents in it.
If you generate the report using a custom
SQL search, the SQL must include
'ea_guid AS CLASSGUID and
Object_Type AS CLASSTYPE' in order
for the Specification Manager to display
the Package.

Bookmark
Item

Click on this option to add or clear a
bookmark on the element.
A small dialog displays on which you
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select the appropriate radio button to set
the bookmark on or off. If you set the
bookmark on, a red triangle (or red Delta
symbol) is displayed on the element icon
in the results. If you clear the bookmark,
the red triangle is removed.
Delete
Selected

Click on this option to delete the selected
element from the Model Search results.
A prompt displays to confirm the
deletion; click on the Yes button.

Help

Display the Help topic on the Model
Search.

Add Items To Linked Document
A very useful feature of the Model Search facility is the
ability to drag separate items from the Search results into an
existing Linked Document.
To do this you create your Linked Document, run the Model
Search, and open the document and Model Search view as
docked windows. You then drag the items - individually or
as a multiple selection - from the search results into the
document. You are prompted to select one of two options:
· 'Insert as Hyperlink(s)' and
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'Render as RTF'
If you select 'Insert as Hyperlink(s)', a hyperlink is
embedded in the document for each dragged object, linking
to the object in the Browser window.
If you select 'Render as RTF', a prompt displays for you to
select the RTF template (if any) from which to generate a
small report on the dragged objects. You can select different
templates for different objects. However, there must be
compatibility between the selected object type (such as
Diagram) and the RTF template used (such as Diagram
report), otherwise nothing is shown in the document.
You can have hyperlinked objects and RTF-rendered objects
in the same document.
·

Notes
·

Running a custom or diagram-based search disables some
context menu options
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The Package Browser
If you want to quickly create and operate on elements in a
Package, you can use the Package Browser as a workbench.
The Package Browser is a tabular, editable view of the
elements in a selected Package, which can be displayed
either in the main View or as a floating window, and as
either a List display or a Gantt chart. It can be particularly
useful for setting up a Package for a specific purpose, such
as when an Analyst creates and maintains formal
requirement definitions within the model. When you have
checked the contents of the Package, you can either print the
list of elements or generate a document report on all or a
subset of the elements.
You can open more than one instance of the Package
Browser, to review different Packages at the same time.
Each instance of the Package Browser is a separate window
or View, identified by the Package name.
The Package Browser is related to, and can be used in
conjunction with, the:
· Diagram List, which lists the elements in a selected
diagram, and
· Specification Manager, which is a document-based
interface to the Package, providing the means of creating
and reviewing elements as text representations of model
objects in that Package
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Access
Ribbon

Design > Package > List View
Design > Package > Gantt View

Context
Menu

Right-click on Package | Open Package in
| List View
Right-click on Package | Open Package in
| Gantt View

Keyboard
Shortcuts

Ctrl+Alt+R (view as list)

Features
Feature

Detail

Select List
View or
Gantt View

When you select one of these menu paths,
you select either the List View of the
Package Browser, or the Gantt View.
· List View lists all the elements in the
Package, with their properties; you can
manipulate this display using various
menu options
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Gantt View lists all the elements in the
Package, grouped by model hierarchy,
but showing the work timeline for each
element and for each resource assigned
to work on the element, and the
percent-completion of all tasks
associated with each element
Once you have displayed one of these
views, you can switch to the other by
right-clicking on the display and selecting
the appropriate context menu option:
· Switch to List View or
· Switch to Gantt View
·

Switch List
View
Formats
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The Package Browser has a separate
version of the Navigator toolbar, through
which you can change the Package being
investigated and, in 'List View', the
content shown.
In 'List View', the Package Browser has
two formats that influence the use of
other options on the display:
· User Defined format, initially a flat list,
where you can define how the element
information is grouped on the screen
using the value-grouping band below
the toolbar
· Hierarchy format, where the elements
are already organized into their
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Package and element hierarchies in the
display (the value-grouping band is
disabled)
To set the format, click on the
icon in
the toolbar and select (for Hierarchy
format) or deselect (for User Defined
format) the 'Show Element Hierarchy'
option.
Change
Standard
View display
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It is possible to reorganize the
information in the Package Browser in a
number of ways:
· In User Defined format, sort the items
by any column value in ascending or
descending order, by clicking on the
column header; initially the elements
are listed in numerical order (if level
numbering is turned on in the Browser
window) or alphabetical order within
type
· Change the sequence of columns by
dragging column headers left or right
· In Hierarchy format, the 'Name'
column is always on the left; you
cannot move any other column into that
position, although you can re-arrange
the sequence of the rest of the columns
Because of this, if you group or sort
information in User Defined format
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and switch to Hierarchy format your
information structure is altered, and it
is not restored when you switch back to
User Defined format
Show
Elements in a
Child
Package

Double-click on the child Package in the
list to re-focus the display, showing the
contents of that Package only.

Display
Element
Properties

Double-click on the element line to
display the element 'Properties' dialog, or
press Ctrl+Enter.
If the Properties window is open, click on
any element to make it the focus of the
Properties window.

Select Items

Select:
· An element by clicking on it
· A specific value by clicking twice on it
(not double-clicking); either the value
becomes directly editable (overtype or
select from drop-down) or the
'Properties' dialog displays in which
you can edit the value
· Several individual elements by holding
Ctrl as you click on them
· A range of elements by holding Shift as
you click on the first and last in the
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range
Add new
items to the
Package

Click on a listed element and press
Ctrl+N or the Insert key, or right-click
and select the 'Add New Element' option.
The 'New Element' dialog displays;
complete the fields and click on the
Create button.
· In Model Hierarchy format, the new
element is inserted as a sibling of the
selected element, in its parent Package
· In User Defined format, the new
element is added to the root Package
selected for display in the Package
Browser

Add a child
element to
the selected
element

Click on the selected element and press
Ctrl+Shift+N.
The 'New Element' dialog displays;
complete the fields and click on the
Create button.
· In Model Hierarchy format, the new
element is inserted as a child of the
selected element
· In User Defined format, the new
element is added to the root Package
selected for display in the Package
Browser
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Add elements
to the
Package
Browser

Drag the required elements from
anywhere in the Browser window. The
element is listed in the Package Browser,
and moved into the target Package in the
Browser window.
You can also drag elements from the
Package Browser into a Package in the
Browser window, in either List view or
Gantt view.

Add elements
to a diagram
from the
Package
Browser

In either List view or Gantt view, you can
drag one or more elements from the
Package Browser onto a diagram to
immediately create an instance of each
element on the diagram (and in the
Browser window for the diagram's parent
Package).
Click each element (pressing Ctrl or Shift
for multiple selections) to select it before
dragging it onto the diagram.
One advantage of dragging elements
from the Gantt view is that it provides the
additional filter on task or resource, so
that you can isolate elements to be copied
to a diagram or Package specific to a task
or resource.

Delete
elements

Select the item and press Ctrl+D. This
deletes the element from all diagrams and
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from the list

from the model itself.
In Model Hierarchy format, you cannot
delete a parent element until all its child
elements have been removed or deleted.

Include each
element's
notes
(documentati
on)

Notes are shown underneath the element.
To add or edit notes, click on the item
and press Ctrl+Shift+Space to transfer
control to the Notes window, in which
you create or edit the note text.
Alternatively, right-click on the element
line and select the 'Edit Notes' option.

Further Work

You can do further work on the Package
Browser using the toolbar and context
menu options.
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List Header
In your work on your project you might use any of a number
of 'listing' reports in which information is organized in
several columns. Such reports include the:
· Package Browser
· Specification Manager
· Diagram List
· Model Search
· Model Mail
· Discuss & Review window
· Features window
· 'Find Toolbox Item' dialog in the Diagram Toolbox
· 'Testing Details' and 'Maintenance Details' tabs of the QA
Reports view
· The Project Gantt View
· The Project Tools window
In these reports, you can quickly and easily reorganize the
sequence and combination of columns to present the
information in the most appropriate format to suit your
needs, and filter the data according to the values of the text
strings displayed in the column fields.

Reorganize layout of display
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Tool

Description

Value
Grouping

For most reports, if the Package Browser
or Diagram List does not have the 'Show
Element Hierarchy' option selected, you
can organize the reported data according
to the value of one or more of the column
categories, as identified in the 'Group
Box' above the column headings. If the
'Group Box' is not already displayed,
right-click on the column headings and
select the 'Enable Group Box' option.
You might organize the data by 'Type',
and within each 'Type' by 'Name'; if you
then click on any other column heading,
the data within this grouping is further
sorted with the values of the selected
column (for example, 'Created') in
ascending or descending order.
To set up the value grouping, drag the
column heading representing the primary
grouping (such as 'Author') into the
'Group Box'.
Now drag the column heading for the
next level of grouping (such as 'Status') to
the right of the first heading; the two
heading titles display as connected
blocks, as shown:
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You can, if required, add further levels of
grouping by dragging other column
headings onto the hierarchy (such as
'Created'), and restructure the order by
dragging existing or additional headings
into the level you want them to hold.
For example, you could make 'Type' the
secondary grouping by dragging it to the
right of 'Author', or drop 'Status' between
'Author' and 'Type'.
To remove a grouping level, drag the
appropriate column heading out of the
sequence and below the View header; any
subordinate groupings move up a level.
Filter Bar
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The Filter Bar displays underneath the
column headings; you can hide or show it
using the 'Toggle Filter Bar' context menu
option on the column headings.
The Filter Bar consists of a row of fields,
one field per column; as you type a value
into one of these fields, the item lists are
automatically filtered to show entries
with a value in the corresponding column
that contain the text string in the field.
For example:
· If you type the letter 'F' in the Filter Bar
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field under the 'Author' column, the
results immediately reduce to entries
for which the letter 'F' occurs anywhere
in the name (Fred, Fitzgibbon, Rufus,
Wolf)
· If you then go on to type 'Fi', the results
immediately reduce again to entries for
which the combination 'fi' appears in
the name (Fitzgibbon, Amalfi)
For reports and displays that identify the
percentage completion of a task or piece
of work, you can specify a percentage
value or a range to display items that
match that value. In the Filter Bar, in the
field under the '%Completed or
Complete' field, type:
· <x to display items less than x percent
complete; for example, <30 (all items
less than 30 percent complete, but not
those exactly 30 percent complete)
· >x to display items more than x percent
complete; for example, >30 (all items
more than 30 percent complete, but not
those exactly 30 percent complete)
· x to display items exactly x percent
complete; for example, 30 (all items
exactly 30 percent complete)
· -x to display items exactly x percent
complete and less than that; for
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·

·
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example, -30 (all items less than 30
percent complete and those exactly 30
percent complete)
x- to display items exactly x percent
complete and more than that; for
example, + 30 (all items more than 30
percent complete and those exactly 30
percent complete)
x-y to display items between x-1
percent complete and y+1 percent
complete; for example 30-45 (all items
between 30 and 45 percent complete,
including those exactly 30 percent and
45 percent complete)
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Package Browser Options
In building and managing your model you can use the
Package Browser as a workbench to perform many
operations, such as reorganizing the Package structure,
adding new Packages and elements, and generating reports
on the Package contents. You can also modify the display in
a number of ways.
To perform all of these operations, you select options from
the drop-down menu available through the
icon on the
Package Browser toolbar or through the context menu.

Access
Toolbar

Package Browser List View toolbar :

Context
Menu

Right-click on Package Browser List
View

Menu Options
Option
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Add New

Add a new element to the Package.
The 'New Element' dialog displays.
Shortcut: Ctrl+N

Edit Notes

Display the Notes window, to add or edit
notes for the selected element. The cursor
is positioned at the start of the text entry
area of the window.
Shortcut: Ctrl+Shift+Space

Print

Print the current contents of the Package
Browser.
The 'Print' dialog displays, on which you
specify the print job.

Generate
Report

Display the 'Generate Documentation'
dialog, to create one document report on
the selected element(s). You can apply
the full facilities of this dialog to tailor
the report to your requirements.

Show Nested
Package
Content

Toggle the display between:
· Including child Packages and their
contents in the list, and
· Showing only the first-level contents of
the selected diagram or Package

Show

Toggle the display between:
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·

Hierarchy format and
User-Defined, value-grouping format

Show Filter
Bar

Display or hide the Filter Bar fields
underneath the column headings, in any
of which you can type a text string to
filter the data in the corresponding
column to show only data containing the
typed string.

Show Group
Bar

Display or hide the Group Bar (drag a
column header here to group by that
column).

Note Options

Display a short menu from which you can
select to:
· Hide the contents of the Notes
compartment of each element
· Display the first few words as a
preview, or
· Display the full text of each note

Context Menu Options
Right-click on an item in the list of elements and Packages.
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Option

Description

Specialize

Select this option to access a submenu of
enabled Technologies within the system
(for example, ArcGIS or TOGAF), each
of which provides options for performing
technology-specific operations on the
elements.

Collaborate

Select this option to display a short menu
of sub-options to exchange electronic
notes on the selected element with team
colleagues, in the form of Reviews,
Discussions and, if User Security is
enabled, Chats and Model Mail
messages, as well as the option to
monitor Discussions on the element.

Switch to
Gantt View

If in Standard (or List) View format,
switch the display to Gantt View format.

Properties

Display the 'Properties' dialog for the
selected element.

Edit Notes

Add or edit notes on the element, in the
Notes window.
Shortcut: Ctrl+Shift+Space

Linked

Create (or edit) a Linked Document.
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Document

(Corporate, Unified and Ultimate
Editions.)
Shortcut: Ctrl+Alt+D

Add New
Element

The 'New Element' dialog displays,
through which you create an element of
any type (after setting the appropriate
toolset).

Find in
Diagrams

Display:
· The diagram that uses the element, or
· If the element is used in multiple
diagrams, the 'Element Usage' dialog,
which lists the diagrams that contain
the element

Find In
Project
Browser

Highlight the selected element in the
Browser window.

Bookmark
Item

Bookmark the element. When the
element is displayed on a diagram, it has
an inverted red triangle or Del symbol
above it.

Documentati
on

Generate a document report; you have
two options:
· Generate a separate report on each
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selected object in the report
· Generate one report on all selected
objects
In either case, the 'Generate
Documentation' dialog displays. If you
have selected to generate separate reports,
the 'Generate Documentation' dialog
displays separately for each report in
turn.
You also have the option to print the
Package Browser list itself.
Sort Contents

In Hierarchy format, synchronize the list
with the Browser window hierarchy, to
ensure that all element and Package
hierarchies and sequences are - if
necessary - updated.
Normally changes are updated
automatically, but there can be delays if
changes are made outside the Package
Browser.

Reload

Reload the list of elements to refresh the
order and content with any recent
changes.

Add Tag
Value
Column

Add a column to show the values for a
selected Tagged Value, for each element
in the list (see Add Tagged Value Column
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later in this topic).
Columns
Layout

(c) Sparx Systems 2022

Preserve, apply or delete a profile of the
column layout of the Package Browser
display. A layout consists of the number
of columns and (where the workstation
screen layout permits) the column widths.
When you mouse-over this option, a
submenu displays:
· Load Columns Layout - displays a
dialog in which you select to apply the
default layout (all possible columns) or
one that you have previously saved;
click on the OK button to apply the
layout
· Save Columns Layout - displays a
dialog in which you specify the name
under which to save the layout - you
can replace an existing layout by
clicking on the drop-down list and
selecting the name, or save as a new
layout by typing a new name
· Delete Columns Layout - displays a
dialog in which you specify the layout
profile to delete; when you click on the
OK button, the profile is deleted (and
cannot be retrieved again) but if that
profile was in use when it was deleted,
the layout persists until it is specifically
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changed, even if you close and re-open
the Package Browser
Print

Print the contents of the Package
Browser.
The 'Print' dialog displays, on which you
specify the print job.

Delete
Selected

Delete the selected element from the
Package Browser.
A confirmatory prompt displays; click on
the Yes button.

Add Tagged Value Column
If you want to show the value that any element in the list has
for a particular tag, you can add a read-only column for the
tag. There are two ways in which to do this; the first method
is simple and direct, whilst the second method enables you
to search for and select a specific tag that might be set for a
number of elements.
Method

Action

1

Open the 'Tag' tab of the Properties
window for the element and drag the tag
onto the Package Browser; a new column
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is added for each tag you drag onto the
list.
2

(c) Sparx Systems 2022

Either:
· Right-click on the element in the
Package Browser or Diagram List, or
· Right-click on the column headings
Then select the 'Add Tag Value Column'
option; the 'Add Tag Value Column'
dialog displays.
Either type the tag name into the 'Tagged
Value' field, or select one of the two
options:
· Global Tagged Values - populates the
'Tagged Value' drop-down list with all
global Tagged Values in the project;
this enables you to select a Tagged
Value that is applicable to a large
number of elements
· Tagged Values from the selected
element - populates the 'Tagged Value'
drop-down list with the Tagged Values
defined for the selected element (as
listed on the 'Tags' tab of the Properties
window for that element); this enables
you to filter the initial selection to a
specific set of tags
When you have selected the required tag,
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click on the OK button to insert a column
for that tag into the Package Browser or
Diagram List header.

Notes
·

In the Corporate, Unified and Ultimate Editions of
Enterprise Architect, if Auditing is turned on and the
Package Browser is open, you can view a history of
changes to any selected element or connector, in the
'Audit History' tab of the System Output window (if
Security is enabled, you must have at least 'Audit View'
permissions to display the audit history)
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The Browser Window
The Browser window displays your model objects and
features in a number of arrangements, reflecting the content
and structure of your model. The Browser window is the
primary mechanism for browsing and exploring your model
and is the jumping off point for many of the most important
features in Enterprise Architect. You can use it to navigate
through the Enterprise Architect project space and:
· Review the structure, content and organization of your
model
· Drill down to and into specific elements
· Drag and drop elements and Packages within the model
· Copy (duplicate) whole Packages
· Import/export model information
· Set up Version Control, locking, execution analysis and
many other aspects of the model tied to a particular
Package
· Document models
· Import code, xmi and csv files, database schema and other
external data sources
The Browser window provides a range of context menus
through which you can perform additional actions such as
adding new Packages, creating diagrams, renaming items
and deleting model elements.
The full model structure is represented in the 'Project' tab of
the Browser window, which is the default display.
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You can also select a View, Package, diagram or element at
any level and focus the display on just the portion of the
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structure underneath that object, in these tabs:
· Context (see the Browser - Context Help topic)
· Diagram (see the Browser - Diagram Help topic)
The 'Resources' tab enables you to select and apply
structures from a repository of project-standard and
re-usable document generation templates, MDG
Technologies, Relationship Matrix profiles, commonly-used
model elements, stylesheets, UML Profiles and Patterns. See
the Browser - Resources Help topic.
If it is inconvenient to have all Browser window tabs shown
in the window, you can temporarily hide and re-display one
or more of the tabs. See the Hide and Show Browser Tabs
Help topic.
On the 'Project' and 'Context' tabs, you can also add
'Favorite' folders to present just your selection of Packages
to work on. See the Refine Browser Content Help topic.

Access
Ribbon

Start > All Windows > Design > Explore
> Browse
Explore > Portals > Windows > Explore
> Project Browser

Keyboard
Shortcuts

Ctrl+1
Alt+1 | Browser
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Views
The 'Project' tab of the Browser window can be divided into
Views, each of which contains diagrams, Packages and
other elements. A default View hierarchy is described here,
but you can create different Views to suit your requirements.
View

Description

Use Case
View

The functional and early analysis View,
containing Business Process and Use
Case models.

Dynamic
View

The dynamics of your system, containing
State Charts, Activity and Interaction
diagrams.

Logical View

The Class Model and Domain Model
View.

Component
View

A View for your system components. The
high level view of what software is to be
built (such as executables, DLLs and
components).

Deployment

The physical model; what hardware is to
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be deployed and what software is to run
on it.

Custom View A work area for other Views, such as
formal requirements, recycle bin,
interview notes and non-functional
requirements.

Selective Collapse to the Parent Element or
Package
When you are working on an expanded project in the
'Project' tab (or a large segment in the 'Context' tab) you
might want to locate the parent element or Package of an
item, and/or collapse the structure under that parent element
or Package.
Ste Action
p
1

Position the cursor on an item within the element or
Package.

2

Press the left-arrow key on the keyboard to highlight
the parent.
Press the same key again to collapse the structure
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under that parent element or Package.
If you keep repeating this sequence, you locate and
collapse the parent nodes further and further up the
hierarchy to, ultimately, the root node.

Adding Elements from the Diagram Toolbox
When you have a structure in the Browser window, you can
add elements to it by picking them up from the Diagram
Toolbox and dropping them onto the parent element or
Package. To do this, you:
· Click on the element icon in the Diagram Toolbox, then
click on the parent Package or element in the Browser
window to select it, and click again to drop the element
under the parent
You cannot add objects that must display in a diagram such
as Note elements, Text elements, connectors or Boundaries.
If an element is of a type that cannot be added as a child of
the object in the Browser window, an error message
displays.

Changing Names
If you decide to change the name of a Package, diagram or
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element on the 'Project' tab, you can simply click on it and
press F2. This makes the name editable, and you can quickly
overtype it.

Mouse-click Actions
There are various methods of performing actions on the
contents of the Browser window, through Toolbar options,
context menu options and pressing keyboard keys. These are
discussed in the topics and tables describing those actions.
This table identifies the results of simply clicking the mouse
buttons on an object, and the variation in results caused by
pressing Ctrl, Shift or Alt as you click.
Mouse Action Effect
Single-click,
Left button
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If you:
· Single-click the mouse button on the
expansion arrow to the left of an object,
it expands or collapses the structure of
that object
· Single click the mouse button on the
object name, it highlights that object
and makes it the focus or all relevant
windows that are currently open (such
as the Properties window and the
Specification Manager); for a diagram,
this means the diagram opens
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Note that diagrammatic elements, such as
Notes and Text, become the focus in
several property displays but not in the
Specification Manager
Single-click,
Right button

If you right-click on an object, the
appropriate context menu displays for the
object type.

Double-click,
Left button

If you:
· Double-click on an object, the object
becomes the focus of all relevant
windows that are currently open, and
the appropriate context menu displays
for the object type (the same thing
happens if you double-click the right
mouse button)
· Press Ctrl and double-click on an
object, the object becomes the focus of
all relevant windows that are open, and
the 'Properties' dialog displays for that
object
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Browser - Header Bar
The Browser header bar provides access to several
operations you can perform on your project structure and
content, including opening the project in the first place. You
can use the options in the header bar to create a new model
through the Model Wizard, add Packages and diagrams to
an existing model, and move objects up and down within
their object groups and parent structures. These and
additional options are also available through the menu
displayed by the 'Hamburger' icon.
When you first open Enterprise Architect, all the icons
except for the 'Hamburger' are grayed out. You can either
select a model from the 'Recent' list on the Start page, or you
can click on the 'Hamburger' icon and select the 'Open
Project' option. This option displays the 'Manage Projects'
dialog, through which you can locate and open the required
project.

Access
Ribbon
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Start > All Windows > Design > Explore
> Browse
Explore > Portals > Windows > Explore
> Project Browser
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Ctrl+1
Alt+1 | Browser

Icon Options
These options operate on the 'Project' and 'Context' tabs of
the Browser window. In the 'Hamburger' menu options, the
'New Element' option can also update the 'Diagram' tab.
Option

Action

New Model
from Pattern

Click on this icon to create a new model
base structure in the project, underneath a
selected Root Node.
Shortcut: Ctrl+Shift+M

New Package

Click on this icon to create a new child
Package under the selected Package.

New
Diagram

Click on this icon to create a new child
diagram under the selected Package or
element.

Move Object
Up

Click on this icon to move the selected
object further up the Browser window
list, within its parent Package and object
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group type (that is, within the list of
elements or list of diagrams, for
example).
Move Object
Down

Click on this icon to move the selected
object further down the Browser window,
within its parent Package and object
group type (that is, within the list of
elements or list of diagrams, for
example).

Find in
Browser

For an object selected in a dialog,
diagram or window, locates that object in
the Browser window.

Hamburger

Click on this icon to display a drop-down
menu of options to perform various
operations on the model, as described in
the Menu Options table.

Favorites

This icon shows a menu listing the
Packages that you have flagged as
'Favorites' under your own user security
ID and the ID or each security group you
are a member of. (User security must be
enabled for this option to function.)
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Menu Options
Name

Action

Open Project

Select this option to open an existing
project, or to create a new project from
scratch or from a base template project.
Shortcut: Ctrl+O

Reload
Project

Select this option to close and reload the
current project, refreshing the Browser
window (in a multi-user environment, to
bring in changes made by other users
sharing the project).
Shortcut: Ctrl+Shift+F11

New Model
From Pattern

Select this option to create a new Model
Package in the project, underneath a the
selected Package.
Shortcut: Ctrl+Shift+M
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New Package

Select this option to create a new child
Package under the selected Package.

New
Diagram

Select this option to create a new child
diagram under the selected Package or
element.

New Element

Select this option to create a new child
element under the selected Package or
element and, if required, add it to the
currently-open diagram.

Find in
Browser

Select this option to perform a simple
Element Name search on a text string to
locate the element in the Browser
window.

Documentati
on

Select this option to display a submenu
from which you can select to generate, on
the selected Package in the Browser
window, a:
· Document report
(F8)
· Web report
(Shift+F8)
· Joomla! Article or
· Diagram Only report (Ctrl+Shift+F8)

Code
Generation

Select this option to display a submenu
from which you can select to:
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Generate source code (Ctrl+Alt+K)
· Generate DDL
· Import a source directory
(Ctrl+Shift+U)
· Import a binary module
· Import a Resource Script
· Import a database schema
· Generate Package contents to
synchronize with Package code
(Ctrl+Alt+M)
· Reset the source code language
All these options operate on the selected
Package.
·
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Browser - Context
In the Browser window, the 'Context' tab provides a
simplified, focused view of a section of the model, separated
from the full structure. This helps you to concentrate on the
area of the model you are working on, and is very useful
when you are re-organizing that section as it reduces the risk
of dragging objects into the wrong area of the model.

Access
Ribbon
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Start > Application > Design > Browser >
Context
Explore > Portals > Windows > Explore
> Context Browser
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Ctrl+1 > Context
Alt+1 | Browser > Context

Functionality
The tab shows the View, Package or element currently
selected in the 'Project' tab, and its subordinate objects. It
also displays the child objects of subordinate elements, but
not of subordinate Packages. To display the child objects of
one of these Packages, you double-click on it to make it the
focus of the tab.
If the selected object is a Package or element without child
objects, or a diagram, the tab has that object's parent in
focus at the top, rather than the object itself.
If the currently selected object is not a model Root Node,
then the second item in the 'Context' tab is a
icon.
Double-clicking on this switches focus to the next level up
in the model.
Clicking on an object in the 'Context' tab will cause
Enterprise Architect to navigate to that object, displaying its
properties and features in other windows that are open.
Double-clicking on a child object that itself has subordinate
objects in the 'Context' tab makes that object the focus of the
tab, displaying it at the top of the tab. If it does not contain
other objects, the 'Properties' dialog displays.
(c) Sparx Systems 2022

Page 770 of 1150

The Application Desktop

3 October, 2022

Right-clicking on an object in the 'Context' tab displays the
same context menu as in the 'Project' tab of the Browser
window.
The 'Context' tab works very well in combination with the
Navigator toolbar, which displays the full hierarchy path of
any object you highlight in the 'Context' tab. As you change
the object in focus on one of these tools, the other is
automatically updated as well. The 'Context' tab is another
view of the selected section of the model, and any changes
you make through the tab are reflected in all other views of
the model, such as the 'Project' tab.
If you decide to change the name of a Package, diagram or
element on the 'Context' tab, you can simply click on it and
press F2. This makes the name editable, and you can quickly
overtype it.
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Browser - Diagram
The 'Diagram' tab of the Browser window is a simple list of
all elements used in the currently-open and in-focus
diagram, including elements that are hidden or in Packages
other than the diagram's parent. It also shows the
relationships issuing from or terminating at each element.
The 'Diagram' tab is a useful tool for establishing the
content of a diagram, especially a large diagram, and
selecting an object in the 'Diagram' tab brings that object
into focus in other windows and views, including in the
diagram itself and in the other tabs of the Browser window.
You can therefore instantly expose many details of the
object's properties and location.
In many cases, the 'Diagram' tab shows a flat list of
elements, but when elements (other than Packages) in the
diagram contain other elements the 'Diagram' tab illustrates
that hierarchy as shown here.
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The 'Diagram' tab has context menu options to display,
where appropriate for the selected element or connector:
· The 'Properties' dialog
· The docked Properties window
· The Special Action dialog for the element (or, if one is not
appropriate, the 'Properties' dialog)
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The 'Element Usage' dialog to show in which other
diagrams the element is used
· The Notes window
· The Quick Notes panel
· The Linked Document editor
The 'Diagram' tab also has a Filter Bar that you can use to
refine the display to list specific elements. To switch
between exposing the Filter Bar and hiding it, right-click on
the 'Diagram Items' heading and select the 'Toggle Filter
Bar' option.
·

Access
With an open diagram in view:
Ribbon

Start > Application > Design > Browser >
Diagram
Explore > Portals > Windows > Project
Browser > Diagram

Keyboard
Shortcuts

Ctrl+1 > Diagram
Alt+1 | Browser > Diagram
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Browser - Resources
The 'Resources' tab of the Browser window is a repository
of project-standard and re-usable document publishing
templates, MDG Technologies, Relationship Matrix
profiles, commonly-used model elements, stylesheets, UML
Profiles and Patterns. The tab provides facilities for creating
and modifying these structures and facilities and, in many
cases, for applying the facility to the current model directly
from the window.

Access
Ribbon

Start > All Windows > Design > Explore
> Browse > Resources
Explore > Portals > Windows > Explore
> Resources
Settings > Reference Data > Resources

Keyboard
Shortcuts

Alt+6

Resources available through the Resources
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tab
Notes
· In the Corporate, Unified and Ultimate Editions of
Enterprise Architect, if security is enabled you must have
'Configure Resources' permission to maintain 'Resources'
tab items
· For a number of folders in the 'Resources' tab, the
right-click context menu also offers a 'Help' option that,
when you select it, displays a brief description of the
folder
Resource

Description

Document
Publishing

The Document Publishing folder holds
three sub-folders, each of which provides
the facilities for generating a particular
type of document or report from your
model.
· Report Library - this folder contains
the Resource documents (report
specifications) you have created in the
Document Report Generator, and
where appropriate held under document
group sub-folders; you can right-click
on the document name to generate
documents individually or as a batch,
open the generated document, or delete
the report specification
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System Templates - this subfolder
contains system-defined report
templates, Fragments, Cover Pages,
Style Sheets and Table of Contents
definitions
You can right-click on these template
names and select options to display the
template contents or to copy the
template as the basis of a custom
(user-defined) template that you work
on in the Document Template Editor,
under a different name; you can also
select the 'Override' option to create a
copy of the system template as a user
template with the same name
Custom Templates - this sub-folder also
has sub-folders for report templates,
Fragments, Cover Pages, Style Sheets
and Tables of Contents, but these are
the templates that you have created
yourself using the Document Template
Editor, either as new or by copying and
editing another template
You can right-click on these template
names and select options to create,
delete, rename, modify, move or copy a
user-defined template; you have
additional options to mark a report
template as a Fragment, or a Fragment
as a report template, if they are suitable
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for this reclassification
You can also 'drag and drop'
user-defined templates between
user-defined groups, and between these
groups and the appropriate standard
'type' folders; for example, from
'DavidCover' to 'Cover Pages'
Linked
Documents

This folder holds the Linked Document
templates, either system provided,
user-defined for the Model, or supplied
with each MDG Technology that is
enabled on the system. You can edit or
delete any of the existing Model or MDG
Templates, or create new ones from
scratch or by copying an existing
template - including copying the
system-provided Linked Document
templates.
You can also re-assign the templates to
different template groups, either another
of the existing groups or a new one that
you create as part of the assignment.

Dynamic
Documents

The Dynamic Documents folder contains
the user-defined style templates for
generating dynamic documents on
selected elements. The document is
automatically generated when you select
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the element in the 'Dynamic Document'
view, having specified the template to
apply.
HTML
Publishing

This folder contains the HTML style
templates that you have created as
alternatives to the system-supplied
<default> template.
To create a new template, right-click on
the folder name and select the 'Create
HTML template' option, then provide a
template name; this opens the HTML and
CSS Style Editor, in which you create the
template from HTML fragments.
You can right-click on the template
names and select options to delete the
template or modify the template contents.

MDG
Technologies

The MDG Technologies folder lists the
MDG Technologies that have been
imported directly into the 'Resources' tab.
Each technology extends the modeling
capabilities and facilities of Enterprise
Architect. System Technologies are those
provided with Enterprise Architect, and
Addin Technologies are those deployed
from an installed Add-In.
You can import Technologies into your
project by right-clicking on the MDG
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Technologies folder and selecting the
'Import Technology' menu option. The
'Import MDG Technology' dialog then
gives you the option to import the
Technology to:
· 'User' Technologies, for your individual
use
· 'Model' Technologies, for all project
users to access (this folder originally
contained all Technologies imported
into the model)
The User Technologies folder provides a
facility for locating the technology files
on the system.
If you have any MDG Technologies in a
folder, the Technology can be expanded
to show its contents, which can include:
· UML Profiles:
- Displays the list of non-abstract
stereotypes in each profile from the
technology
- Each stereotype will be displayed
with their icon, if one is specified in the
profile
- Allows you to create stereotyped
elements and connectors on a diagram;
drag
the element stereotype from the
folder onto the diagram to create an
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·

·

·

·

·
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element, and
click on the connector stereotype
and drag between elements to create
the connector
Diagram Types:
- Displays the list of diagram
profiles for the technology
Layouts:
- Displays the list of workspace
layouts defined by the technology
- Allows you to select and apply a
layout
Linked Document Templates:
- Displays the list of linked
document templates defined by the
technology
- Allows you to view each template
and create a copy of it for
customization
Model Templates:
- Displays the list of model
templates defined by the technology
- Allows you to open the Start Page
'Create from Pattern' tab (Model
Wizard) to a template, if available in
the current Perspective
Scripts:
- Displays the list of scripts defined
by the technology
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- Allows you to select and run any
of the scripts in the Scripting window
· Toolboxes:
- Displays the list of toolbox pages
defined by the technology
- Allows you to open any of the
toolbox pages in the Diagram Toolbox,
regardless of the current Perspective
You can right-click on these structures
and select options to delete the
Technology, review the Patterns or
Profiles, or invoke the code modules.
If you remove the Technology, it is
removed from the 'Resources' tab of the
Browser window, the 'MDG
Technologies' dialog, and the model.
Consider the fact that some MDG
Technologies can be large and might
impose some delays on the workstation as
they load each time a user connects to the
model.
Model
Patterns

(c) Sparx Systems 2022

The Model Patterns folder holds Model
Patterns that have been imported into the
model from external sources, including
those developed within your own
organization. Each Pattern XML file will
have a matching .rtf file to explain the
Pattern to users. Model Patterns generate
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modeling structures (Packages, diagrams
and elements) within your model.
Matrix
Profiles

The Matrix Profiles folder contains a list
of Relationship Matrix Profiles that you
or your team members have created using
the Relationship Matrix or Specification
Manager. You simply double-click on a
Matrix Profile name to quickly open the
Relationship Matrix under the settings
defined in the Profile.

Favorites

Deprecated, from Release 15.2.
This feature originally provided a
shortcut to each commonly-used element
that you added to the folder, so that you
could quickly and easily locate those
elements in the Browser window. There
are now other features that enable you to
identify specific elements in a similar or
even better way, such as:
· Focus Window, 'Model Views' tab,
Favorites View folder
· Focus window, 'Working Sets' tab
· The Browser window 'Add as Favorite
to' context menu option
If you have previously stored Favorites in
the Resources window Favorites folder,
you can locate them again by creating
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and running a search using this SQL text:
SELECT t_object.ea_guid AS
CLASSGUID, t_object.Object_Type AS
CLASSTYPE, t_object.Name AS
Element, t_object.Object_Type AS
[Type],t_object.Stereotype,
t_object.Author, t_object.Scope,
t_object.Status, t_object.Phase,
t_object.CreatedDate,
t_object.ModifiedDate
FROM
t_object, t_xref
WHERE t_xref.[Type]= 'favorite' and
t_object.ea_guid = t_xref.Supplier
Order By t_object.Object_Type,
t_object.Name
XSL
Stylesheets
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The XSL Stylesheets folder contains XSL
stylesheets that you or your team
members have imported into the model.
These XSL stylesheets support the
optional step of converting XMI files
exported from the model into alternative
formats such as HTML, XSL or source
code. Stylesheets imported here are then
available in the drop-down lists on the
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'Publish Model Package' dialog and the
'Generate GML Application Schema'
dialog.
Combined with UML Profiles, this is an
effective means of extending Enterprise
Architect to generate almost any content
required.
To import a stylesheet:
4. Right-click on the folder name and
select the 'Import Stylesheet' option.
5. Locate and select the stylesheet file in
the browser, and click on the Open
button.
6. Provide a reference name for the file,
and click on the OK button.
Once the stylesheet is in the folder, you
can select context menu options to reload
it (if it has been changed at the source) or
delete it.
UML
Profiles
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A Profile is a source of modified or
extended element and connector types
that you have developed from the UML
base types. You can import each new
Profile into this folder, and then create
elements and connectors of the new types
by dragging the icons from the Profile
onto a diagram.
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Once you have Profiles in the folder, you
can select options for arranging them in
order of name or type, viewing a Profile
description, or deleting a Profile.
It is possible to synchronize the Tagged
Values and constraints for any elements
created from a Profile element in the
'Resources' tab.
Importing and applying Profiles through
the 'Resources' tab is not recommended;
it is recommended that you load and
apply Profiles as components of MDG
Technologies.
Patterns
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The Patterns folder is a folder of Design
Patterns that you or your team members
have imported into the model. A Pattern
captures complex new elements and
features that you can drag into a diagram
without having to retype or reconfigure
each element.
Within the folder, the Patterns are
grouped by type. Once you have Patterns
within a group, you can select options to
delete a selected Pattern or all Patterns in
the group, view a Pattern's details, or
apply a Pattern to an empty diagram.
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Hide and Show Browser Tabs
The tabs of the Browser window give you access to every
level of your model, from the root nodes and their entire
contents in the 'Project' tab through selected Packages and
their structure in the 'Context' tab and the elements in an
open diagram in the 'Diagram' tab, to the detailed design of
a single element in the 'Details' tab of the Inspector window.
However, in any one work session you are unlikely to sweep
across the full spectrum of your model structure, and it is
probably more convenient to refine your work area and the
objects listed to show the portion of the model and the type
of structure you need to work on.
You can do this by hiding the Browser window tabs that are
of less relevance to your task
For example, you might set up a skeleton project structure
of Root nodes, Views, Model Packages and Packages, for
which you initially would be working on the 'Project' tab
and - for the lower levels of the model - the 'Context' tab.
You would not need to use the 'Diagram' tab and could hide
it.
Conversely, you might have set a large diagram to open
automatically when you log on to Enterprise Architect, and
spend the whole session working on the elements of that
diagram, so you could hide the 'Project' and 'Context' tabs,
and just work on the 'Diagram' tab, and/or on the 'Details'
tab of the Inspector window.
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Hide and Show Tabs
In the tab bar of the Browser window, right-click on the tab
you want to hide, and click on the 'Hide Tab' option.

To restore any hidden tabs to the tab bar, right-click on the
bar and select the 'Show All Tabs' option.
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Refine Browser Content
The 'Project' and 'Context' tabs of the Browser window give
you access to your entire model structure and sections of the
model located in and selected from that entire structure.
However, for more detailed work you would be
concentrating on one or more specific Packages, and for
multiple Packages you might be working in different areas
of the model. Rather than scroll through the whole model to
locate and switch between the Packages you need, you can
identify those Packages as Favorites and either flip directly
to them in the 'Project' tab or - even easier - just call them
into the 'Context' tab. This also makes it a lot easier to return
to the same area of the model to continue working across
several work sessions.
Note that the 'Favorite' Packages are registered against user
IDs, so User Security must be enabled for this feature.
This feature is available in the Corporate, Unified and
Ultimate Editions of Enterprise Architect, from Release
15.0.

Identify Favorite Packages
To add a Package to a 'Favorites' list, right-click on it in the
Browser window and select the 'Add as Favorite to' context
menu option. A short menu displays, listing 'Current User'
and the security groups to which your user ID has been
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assigned.

Click on the 'Current User' or appropriate group to add the
Package as a 'Favorite' for users who login under that ID.
To see the Packages listed as 'Favorites' for a security group,
click on the
icon in the Browser window toolbar, and
expand the appropriate group.

Work on a Favorite Package
You can set focus to a 'Favorite' Package in either the
'Project' tab or the 'Context' tab of the Browser window.
Open the required tab, then click on the
icon in the
window toolbar, expand the appropriate group and click on
the Package name.
· In the 'Project' tab, the Package is located and highlighted
in the model structure
· In the 'Context' tab the Package becomes the focus of the
tab
If you subsequently select another 'Favorite' Package, that
(c) Sparx Systems 2022
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becomes the focus of the open tab, which makes it very easy
to select Packages and switch between structurally separated
Packages.

Manage Favorites
After you have worked with a 'Favorite' Package for a while,
you might not need to focus on it and therefore could
remove it from the 'Favorites' list.
To do this, click on the
icon in the Browser window
toolbar and select the 'Manage Favorites' option. The
'Manage Favorites dialog displays.

Right click on the Package to remove from the dialog, and
click on the 'Remove' option. The Package is immediately
removed from the list and is no longer flagged as a
'Favorite'.

(c) Sparx Systems 2022

Page 792 of 1150

The Application Desktop

3 October, 2022

Browser Window Context Menus
The Browser window provides a wide range of options to
work on the objects it contains. These options are presented
through a number of context-sensitive menus.

(c) Sparx Systems 2022

Page 793 of 1150

The Application Desktop

3 October, 2022

Model (Root Node) Menu - Browser
Window
The Root Node in the Browser window is the Model
element. You can have more than one Root Node and hence
more than one Model element. The first level Packages
beneath the Model node are sometimes referred to as Views,
as they commonly divide a model into categories such as
Use Case Model and Logical Model. You can perform a
wide range of operations on the Model nodes of your
project, by selecting options from the Model context menu
in the Browser window.

Access
Context
Menu

Right-click on the Model Node

Options
Option

Action

Specialize

Select this option to access two sets of
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functions:
· Scripts - scripts created using the
Scripting facility, to be executed on
Model Nodes; click on a script name to
execute it (this option is not shown if
no appropriate scripts have been
created)
· Extensions - a list of the enabled
technologies on the system, each of
which provides options for performing
technology-specific operations on the
Package; these options are available in
the Professional, Corporate, Unified
and Ultimate Editions of Enterprise
Architect
Add a Model
using Wizard

Select this option to add further models
using the Model Wizard (Start Page
'Create from Pattern' tab).
The list of available Model Pattern
Technologies includes the MDG
Technology Builder (expand the
Management group), which creates a
Model Package containing templates that
you can use to generate a new MDG
Technology containing a set of Profiles.
Shortcut: Ctrl+Shift+M

Add Root

Select this option to create a new model
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Node

root, without any subordinate structure or
content.
A prompt for the model name displays.

Add View

Select this option to create a new View
(Package) underneath the model root
node.
The 'Create New View' dialog displays.

Package
Control

Select this option to access the Package
Control submenu, which provides these
options:
· Lock Package (if the project has User
Security enabled); the 'Lock/Unlock
Package(s)' dialog displays
· Import a Model Branch, and
· Version Control Settings

Full Structure
for
Duplication

Copy the element(s) of the selected
Package to the clipboard in XMI format.
(Shortcut: Ctrl+Shift+C)

Paste
Select this option to paste a child Package
Package from from the clipboard into the selected
Clipboard
Package.
Clone
Structure as
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Select this option to build a clone of your
current Root Node hierarchy, including
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New Version

diagrams, and update each object with a
user defined version number. All diagram
elements contained in a clone diagram are
included only as linked elements
(references).

Delete
Project Root

Select this option to delete the Model
Root node, after you have already deleted
all of its subordinate Views and
Packages.
A prompt displays for you to confirm the
deletion.

Help

Select this option to display the Help
topic for the Browser window.
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Package Menu - Browser Window
The 'Package' context menu in the Browser window
provides a wide range of options for displaying, organizing
and operating on the Packages in your model.

Access
Context
Menu

Browser window > Project | Right-click
on Package or View
Browser window > Context | Right-click
on Package or View

Options
Option

Action

Specialize

Select this option to access two sets of
functions:
· Scripts - scripts created using the
Scripting facility, to be executed on
Views and Packages; click on a script
name to execute it (this option is not
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·

shown if no appropriate scripts have
been created)
Extensions - a list of the enabled
technologies on the system, each of
which provides options for performing
technology-specific operations on the
Package; these options are available in
the Professional, Corporate, Unified
and Ultimate Editions of Enterprise
Architect

Collaborate

Displays a short menu of options to
exchange electronic notes with team
colleagues, in the form of Reviews,
Discussions and Comments, as well as
the option to monitor Discussions on the
Package.

Properties

Select this option to display the
'Properties' sub-menu for the Package
element.

Open
Package In

Select this option to display the contents
of the Package as a:
· Text description in the Specification
Manager
· List of objects with their selected
properties
· Gantt chart showing resource
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·

allocations and progress
Construct View, showing task
allocations to resources

Add a Model
using Wizard

Select this option to add another Model
Package to the model or View, using the
Model Wizard (Start Page 'Create from
Pattern' tab).
Shortcut: Ctrl+Shift+M

Add a
Package

Select this option to add another Package
to the selected Package.
Shortcut: Ctrl+W

Add Diagram

Select this option to add a new diagram to
the selected Package.

Add Element

Select this option to add a new element to
the selected Package.
Shortcut: Ctrl+M

Add as
Favorite To

Click on this option to flag the selected
View node, Model Package or Package as
a 'Favorite', to be highlighted in the
Browser window when selected from a
list. A short menu displays, from which
you select your user security ID or the
security group you are a member of, to
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access the 'Favorite' Package under.
Package
Control

Select this option to access the Package
Control submenu, which provides these
options:
· Lock the Package (if the project has
User Security enabled)
· Import a Model Branch, and
· Version Control Settings

Clone
Structure as
New Version

Select this option to build a clone of your
current Package hierarchy, including
diagrams, and update each object with a
user defined version number. All diagram
elements contained in a clone diagram are
included only as linked elements
(references).

Copy/Paste

Select this option to access a menu of
options for copying and moving the
Package contents to other areas of the
model.

Contents

Select this option to reorganize the
Package contents after making changes.

Set View
Icon

Select this option to display the 'Set View
Icon' dialog, on which you select one of
the six standard View-type icons to
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display beside the View name.
Delete
Select this option to delete the selected
<packagenam Package and its contents. A prompt
e>
displays to confirm the deletion.
Help
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Select this option to display the Help
topic for the Browser window.
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Properties Sub-Menu
The Package 'Properties' context menu provides a range of
options for displaying and updating the properties, notes,
Tagged Values and Linked Document of a Package element,
and for locating the Package in any diagrams that contain it.

Access
Context
Menu

Browser Window | Right-click on
Package | Properties

Options
Option

Description

Properties

Displays the Properties window for the
Package element, which you can use to
view and modify the element properties.

Notes

Displays the Notes window, showing any
notes that have been written for the
Package element.
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Tagged
Values

Displays the 'Tags' tab of the Properties
window, showing any Tagged Values
(extended properties) that have been
created for the Package element.

Linked
Document

Displays the 'Linked Document' tab of
the Document window showing the
Linked Document for the Package, if one
exists.
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Package Control Sub-Menu
The Package 'Package Control' context menu has two forms:
· The 'Controlled Package' form when the Package is not
under Version Control, that provides options for locking a
Package, importing a model branch into another model
and setting up Version Control
· The 'Package Version Control' form that provides a wider
range of options for managing the Package when it is
under Version Control

Access
Context
Menu

(c) Sparx Systems 2022

Browser window > Right-click on
Package > Package Control
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Copy/Paste Sub-Menu
The Package 'Copy/Paste' context menu provides a range of
options for copying or moving Packages between parent
Packages or between models, within the Browser window. It
also provides options for pasting copied elements and
diagrams into a Package.

Access
Context
Menu

Browser window | Right-click on
Package | Copy/Paste

Options
Option

Action

Cut

Select this option to remove the selected
Package from its parent Package, to be
pasted under another Package. The
selected Package remains where it is until
the Paste operation is invoked.
Shortcut: Ctrl+X
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Paste

Select this option to paste a cut Package
under the selected Package. If the
selected Package is not a valid target, the
'Paste' option is grayed out.
(This option is not available for copied
Packages - use the 'Paste Package from
Clipboard' context menu option.)
Shortcut: Ctrl+V

Copy to
Clipboard

Select this option to copy the selected
element(s) (including the Package
element) to the clipboard. You select one
of two sub options:
· ID for Pasting as Link - copy the
element IDs to the clipboard to be
pasted into a diagram as links to the
actual elements (Shortcut: Ctrl+C)
· Full Structure for Duplication - copy
the element(s) of the selected Package
to the clipboard, in XMI format for
pasting as new duplicate elements in
another Package (Shortcut:
Ctrl+Shift+C)

Paste
Select this option to paste a Package from
Package from the clipboard into the selected Package.
Clipboard
Shortcut: Ctrl+V
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Paste
Element(s)
from
Clipboard

Select this option to paste elements
copied to the clipboard into the selected
Package.
Shortcut: Ctrl+V

Paste
Diagram

If you have copied a diagram from
another Package, select this option to
paste the diagram into the
currently-selected Package.

Copy
Documentati
on Bookmark

When using the Legacy Report
Generator, if you want to create a
complex document that consists of
sections of one or more document
reports, rather than one complete report,
you can create a master document in
Microsoft WordTM and within it create
links to the report sections using their
bookmarks.
Select this menu option to copy the
bookmark on the selected Package to the
clipboard, to be pasted into a search or
other reference to the bookmark.

Copy Node
Path to
Clipboard

Select this option to copy the Package's
node path (hierarchy structure) to the
Enterprise Architect clipboard, as a
reference.
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GUID to
Clipboard
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Select this option to copy the Package's
node GUID to the Enterprise Architect
clipboard, as a reference.
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Contents Sub-Menu
The 'Contents' sub-menu of the Browser window Package
context menu provides options for collapsing and expanding
the contents of a Package, bookmarking the elements of a
Package, and restoring the default sort order of the Package.

Access
Context
Menu

Browser window | Right-click on
Package | Contents

Options
Option

Action

Bookmarks

Select this option to bookmark all
elements in the selected folder.

Expand
Branch

Select this option to expand the complete
contents of this branch of the model.

Collapse

Select this option to collapse all items in
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Branch

this branch of the model.

Reset Sort
Order

Select this option to return sorting of
Package contents to list the child
elements, child Packages and the contents
of each child Package, in alphabetical
order.

Reload
Current
Package

Select this option to refresh the current
Package in the Browser window.
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Element Menu - Browser Window
The element context menu in the Browser window is
available for all types of element. It provides options for
performing a wide range of operations on both individual
elements and multiple elements, including adding element
properties and features, and moving the elements around the
project or between projects.
There are no context menu options in the 'Diagram' tab.

Access
Context
Menu

Browser Window > Project tab|
Right-click on element
Browser Window > Context tab |
Right-click on element

Options (Single element)
Option

Description

Specialize

Select this option to access two sets of
functions:
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·

Scripts - scripts created using the
Scripting facility, to be executed on
elements; click on a script name to
execute it (this option is not shown if
no appropriate scripts have been
created)
Extensions - a list of the enabled
technologies on the system, each of
which provides options for performing
technology-specific operations on the
element; these options are available in
the Professional, Corporate, Unified
and Ultimate Editions of Enterprise
Architect

Collaborate

Select this option to display a short menu
of options to exchange electronic notes
on the selected element with team
colleagues, in the form of Reviews,
Discussions and, if User Security is
enabled, Chats and Model Mail
messages, as well as the option to
monitor Discussions on the element.

Properties

Select this option to display the element
'Properties' sub-menu, to view and
modify the element properties, notes,
Tagged Values and Linked Document.
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Features

Select this option to display a short
submenu for managing attributes and
operations (either in their specific dialogs
or via the Features window) and - for a
Class element with attributes - to
pre-define initial values for attributes that
can be used to override existing defaults.

Add

Select this option to access a submenu of
options for creating a child element and
diagram (Classifier elements) or a
connector to another element.

Copy/Paste

Select this option to access a menu of
options for copying and moving the
Package contents to other areas of the
model.

Find in all
Diagrams

Locates the element in any diagram that
contains it. If the element is in a single
diagram, the diagram displays. If the
element is not in any diagram, or is in
more than one diagram, the 'Element
Usage' dialog displays. You can select the
diagram containing the instance of the
element you require.
This option also operates on Port and Part
Property Type Classifiers.
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Locate in
Current
Diagram

Select this option to select the element in
the currently-visible diagram.
If the element is not in the diagram, this
option is grayed-out.

Lock

Select this option to apply or release a
lock for editing the selected element.
(The option is displayed only when user
security is enabled in User/Group locking
mode)

View Audit
History

Select this option to open the Audit View
to see a history of changes made to the
selected element.

Delete
<element
Name>

Select this option to delete the element.
A prompt displays for you to confirm the
deletion.

Help

Select this option to display the Help
topic for the Browser window.

Options (Multiple elements)
Option
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Scripts

Lists any scripts created using the
Scripting facility, to be executed on
multiple elements; click on a script name
to execute it (this option is not shown if
no appropriate scripts have been created).

Collaborate

This option displays if User Security is
enabled on the model. It provides two
suboptions:
· 'Send Message', which displays the
'Create Message' dialog to create and
send a message containing a hyperlink
to each of the selected objects
· 'Monitor Discussions', which sets a flag
on the element so that if any replies to
your discussions or new discussions are
posted on the selected elements, a
prompt displays in the bottom right of
the Enterprise Architect work area

Lock
Element(s)

Select this option to apply or release
locks for editing the selected elements.
(The option is displayed only when user
security is enabled in User/Group locking
mode).

Generate
Documentati
on

Select this option to display the 'Generate
Documentation' dialog, through which
you can generate a report on the selected
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elements.
Copy to
Clipboard

Select this option to copy the selected
elements to the clipboard. You select one
of two sub options:
· ID for Pasting as Link - copy the
element IDs to the clipboard to be
pasted into a diagram as links to the
actual elements (Shortcut: Ctrl+C)
· Full Structure for Duplication - copy
the elements to the clipboard in XMI
format, for pasting as new duplicate
elements in another Package (Shortcut:
Ctrl+Shift+C)

Delete
selected
item(s)

Select this option to delete the selected
group of objects from the Browser
window and the model. A prompt
displays for you to select whether to
delete each item in turn (click on the Yes
button) or all items together (click on the
Yes to All button).
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Properties Sub-Menu
The element 'Properties' context menu provides a range of
options for displaying and updating the properties, notes,
Tagged Values and Linked Document of an element, and for
locating the element in any diagrams that contain it.

Access
Context
Menu

Browser window > Project | Right-click
on element | Properties
Browser window > Context | Right-click
on element | Properties

Options
Option

Description

Properties

Displays the Properties window for the
element, which you can use to view and
modify the element properties.

Special

Displays either the 'Properties' dialog for
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Action

the element or, for specialized elements,
the dialog that defines their action. For
example, if this option is selected for a
Checklist Artifact, the 'Checklist Items'
dialog displays for defining the checkbox
items in the list.

Notes

Displays the Notes window, showing any
notes that have been written for the
element.

Responsibiliti Displays the Responsibility window,
es
through which you can add and update
internal Requirements (Responsibilities),
Scenarios and Constraints on the element.
Tagged
Values

Displays the Properties window; click on
the 'Tags' tab, showing any Tagged
Values (extended properties) that have
been created for the element.

Summary

Displays the Summary window of the
selected element, which provides a brief,
read-only summary of the general
properties of the currently selected
element. Once displayed, the Summary
window can also show a:
· Package
· Attribute
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Operation
· Test
· Maintenance item or
· Resource
The display refreshes immediately as you
select different objects and items. You
can highlight a section of text or the
complete content, and copy it to be pasted
into an external document.
The Summary window does not display
details for Views, Model Packages,
diagrams, instances or connectors.
·

Linked
Document
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Displays the 'Linked Document' tab of
the Document window showing the
Linked Document for the element, if one
exists.
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Add Sub Menu
The element 'Add' submenu provides a list of appropriate
elements that can be added as child elements to the selected
element. It also provides options for creating child diagrams,
including Composite diagrams, and for adding connectors.

Access
Context
Menu

Browser window > Project | Right-click
on element | Add
Browser window > Context | Right-click
on element | Add

Options
Option

Description

Port

Select this option to add a Port element to
the border of the selected element.

Composite
Structure

Select this option to set the selected
element as a Composite Element and
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Diagram

create a new Composite Structure
diagram (if none exists). If the selected
element already contains a child diagram,
the existing diagram will instead be
referenced as the element's Composite
diagram.

Select
Composite
Diagram

Select this option to set the selected
element as Composite and link it to a
specified diagram, or to change the
currently-linked diagram for another. The
linked diagram could exist anywhere
within the current repository.

Activity

Select this option to add an Activity
behavior element and one of its
associated diagrams to the selected
classifier element.

Interaction

Select this option to add an Interaction
behavior element and one of its
associated diagrams to the selected
classifier element.

StateMachine

Select this option to add a StateMachine
Behavior element and one of its
associated diagrams to the selected
classifier element.
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RuleFlow
Activity

Select this option to add a Rule Flow
Activity element and associated diagram
to a Class, in Business Rule Modeling.

Construction
Diagram

Select this option to create a Construction
rendition of the element on a
Construction diagram. The Construction
rendition is a rectangular element outline
with a in the bottom right corner, and
compartments automatically enabled; the
compartments show various Project
Management items with Progress Bars
where appropriate, as you define them in
the Construct view.

Add Diagram

Select this option to create a diagram to
explain or expand on the selected
classifier element, using the 'New
Diagram' dialog.

Add Custom
Reference

Select this option to set up cross
references between elements in a diagram
and the selected element in the Browser
window.

Create Link

Select this option to create a connector to
another element.
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Notes
·

·

Elements such as Actors, Classes and Activities can
define a large amount of information that can be
conveniently represented by or expanded in a child
diagram; the 'Add' sub-menu for these elements provides
all of the options listed
Elements such as Timing, Exit and History have much
more specific functions that do not require expansion; the
'Add' sub-menu for these elements only provides the
'Create Link' option
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Element Copy/Paste Submenu
The element 'Copy/Paste' context menu provides a range of
options for copying or moving elements between Packages
or between models, within the Browser window.

Access
Context
Menu

Browser Window > Project | Right-click
on element | Copy/Paste
Browser Window > Context | Right-click
on element | Copy/Paste

Options
Option

Description

Copy to
Clipboard

Select this option to copy the selected
element and any sub-structure to the
clipboard. You select one of two sub
options:
· ID for Pasting as Link - copy the
element ID to the clipboard to be
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·

pasted into a diagram as link to the
actual element (Shortcut: Ctrl+C)
Full Structure for Duplication - copy
the element(s) to the clipboard in XMI
format, for pasting as new duplicate
elements in another Package (Shortcut:
Ctrl+Shift+C)

Cut

Select this option to remove the selected
element from its parent Package, to be
pasted under another element or Package.
The selected element remains where it is
until the Paste operation is invoked.
Shortcut: Ctrl+X

Paste

Select this option to paste a cut element
under the selected element or Package. If
the selected element is not a valid target,
the 'Paste' option is grayed out.
(This option is not available for copied
elements - use the 'Paste Package from
Clipboard' menu option in the Package
context menu.)
Shortcut: Ctrl+V

Copy
Documentati
on Bookmark

When using the Legacy Report
Generator, if you want to create a
complex document that consists of
sections of one or more document
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reports, rather than one complete report,
you can create a master document in
Microsoft WordTM and within it create
links to the report sections using their
bookmarks.
Select this menu option to copy the
bookmark to the clipboard, to be pasted
into a search or other reference to the
bookmark.
Paste
Diagram

Select this option to paste an existing
diagram as a child of the selected
element.
The diagram would have been copied to
the clipboard by right-clicking on the
diagram in the Browser window and
selecting the 'Copy Diagram' menu
option.

Copy Node
Path to
Clipboard

Select this option to copy the element's
node path (hierarchy structure) to the
Enterprise Architect clipboard, as a
reference.

Copy Node
GUID to
Clipboard

Select this option to copy the element's
node GUID to the Enterprise Architect
clipboard, as a reference.
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Diagram Menu - Browser Window
The diagram context menu in the Browser window is
available for all types of diagram listed on the 'Project' or
'Context' tabs. It provides options for performing a wide
range of operations on one diagram or several diagrams, and
for moving a diagram around the project or between
projects.

Access
Context
Menu

Browser Window > Project | Right-click
on Diagram
Browser Window > Context | Right-click
on Diagram

Options
Option

Action

Specialize

Select this option to access two sets of
options:
· Scripts - a list of scripts created using
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·

the Scripting facility, to be executed on
diagrams; click on a script name to
execute it (this option is not shown if
no appropriate scripts have been
created)
Extensions - a list of the enabled
technologies on the system, each of
which provides options for performing
technology-specific operations on the
diagram; these options are available in
the Professional, Corporate, Unified
and Ultimate Editions of Enterprise
Architect

Collaborate

Select this option to display a short menu
of options to exchange electronic notes
on the selected diagram with team
colleagues, in the form of Reviews,
Discussions and, if User Security is
enabled, Chats and Model Mail
messages, as well as the option to
monitor Discussions on the diagram.

Properties

This option provides access to the
Properties window for the diagram.

Open

Select this option to open the diagram in
the Diagram View. (You can also
double-click on the diagram name in the
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Browser window.)
Lock
Diagram

Select this option to display the 'Lock
Diagram' dialog, on which you can set,
change and release the editing lock on the
selected diagram.

Show
Diagram
Versions

When a diagram is cloned, a custom
reference is added to the diagram (in the
t_xref table). This custom reference
provides information on the clone,
through the 'Show Diagram Version'
dialog.
Select this option to display the 'Show
Diagram Versions' dialog.

Copy / Paste

Select this option to access a menu of
options for copying and moving the
diagram to other areas of the model.

Print
Diagram(s)

Select this option to print the
currently-selected diagram or diagrams
(hold Ctrl or Shift while selecting).
The 'Print' dialog displays, on which you
specify the print parameters.
By de-selecting the 'Printable' option on
an element on a diagram, you can omit
that element and its connectors from the
printed diagram.
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Shortcut: Ctrl+P
Delete
'<diagram
name>'

Select this option to delete the selected
diagram.
A prompt displays to confirm the
deletion.

Help

Select this option to display the Help
topic for the Browser Window.
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Diagram Copy/Paste Menu
The diagram 'Copy/Paste' context menu provides a range of
options for copying or moving diagrams between Packages
or between models, within the Browser window.

Access
Context
Menu

Browser Window > Project | Right-click
on diagram | Copy/Paste
Browser Window > Context | Right-click
on diagram | Copy/Paste

Options
Option

Action

Cut

Select this option to remove the selected
diagram from its current location, to be
pasted under another Package or element.
The selected diagram remains where it is
until the 'Paste Diagram' operation is
invoked.
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To paste the diagram, use the:
· 'Copy/Paste | Paste Diagram' option on
the Package context menu, or element
context menu
Shortcut: Ctrl+X
Paste

Not used.

Copy
Diagram

Select this option to copy the diagram for
pasting into another location.

Copy
Documentati
on Bookmark

When using the Legacy Report
Generator, if you want to create a
complex document that consists of
sections of one or more document
reports, rather than one complete report,
you can create a master document in
Microsoft WordTM and within it create
links to the report sections using their
bookmarks.
Select this menu option to copy a
bookmark on the diagram to the
clipboard, to be pasted into a search or
other reference to the bookmark.

Copy Node
Path to
Clipboard

Select this option to copy the diagram's
node path (hierarchy structure) to the
Enterprise Architect clipboard, as a
reference.
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Select this option to copy the diagram's
GUID to the Enterprise Architect
clipboard, as a reference.
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Operation/Attribute Menu - Browser
Window
The separate but almost identical 'Operation' and 'Attribute'
context menus in the Browser window provide options for
performing a number of tasks on the features (operations
and attributes) of an element.

Access
Context
Menu

Browser window > Project | Right-click
on Feature
Browser window > Context | Right-click
on Feature

Options
Option

Action

Specialize

Provides access to two sets of functions:
· Scripts - scripts created using the
Scripting facility, to be executed on
attributes and operations; click on a
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·

script name to execute it (this option is
not shown if no appropriate scripts
have been created)
Extensions - a list of the enabled
technologies on the system, each of
which provides options for performing
technology-specific operations on the
attribute or operation; these options are
available in the Professional,
Corporate, Unified and Ultimate
Editions of Enterprise Architect

Collaborate

Select this option to display a short menu
of sub-options to exchange electronic
notes on the parent element of the feature
with team colleagues, in the form of
Reviews, Discussions and, if User
Security is enabled, Chats and Model
Mail messages, as well as the option to
monitor Discussions on the parent.

Properties

Displays a short sub-menu providing
these options:
· Properties - Displays the Properties
window showing details for the
selected feature
· Notes - Displays the notes recorded on
the feature, in the Notes window
· Tagged Values - Displays the Tagged
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·

Values recorded for the feature, in the
'Tags' tab of the Properties window
All Features - Displays the Features
window to access other types of feature
on the same parent element

Copy
Reference

Select this option to copy a reference to
the feature to the Enterprise Architect
clipboard.
Select the appropriate sub-option to copy
the:
· Selected hierarchy structure (Node
Path)
· Node GUID

View Source
Code

Select this option to open the Source
Code Viewer and display the code for the
feature.
Shortcut: F12

Cut

Select this option to cut the feature from
its current element and paste it into
another element. The feature does not
move from the original element until you
paste it into the target.
Use the element 'Copy/Paste | Paste'
menu option to paste the feature into its
new parent.
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Paste

Not used.

Delete
Attribute /
Operation

Select this option to delete the feature.
The feature is immediately removed from
the element.

Help

Select this option to display the Help
topic for the Browser window.
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Browser Window Icon Overlays
The Browser window displays the status of each Package in
the model by overlaying status icons on the Package icon.
The meaning of each overlaid icon is provided here.

Icon Overlays
Icon Overlay Indicates that...
This Package is controlled and is
represented by an XMI file; Version
Control either is not being used or is not
available.
You can edit the Package.
This Package is Version Controlled and
checked out to you, therefore you can edit
the Package.
This Package is Version Controlled and
not checked out to you, therefore you
cannot edit the Package unless you check
the Package out.
This Package is Version Controlled, but
you checked it out whilst not connected
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to the Version Control server.
You can edit the Package but there could
be version conflicts when you check the
Package in again.
This Package is a namespace root, which
denotes where the namespace structure
starts; Packages below this point are
generated as namespaces to code.
The version-controlled Package has been
flagged as Read Only, using a Package
control method applied through the
Automation Interface - as a script, for
example.
The padlock icon displays with other
Package control icons except for the 'blue
box' (third item in the list), which takes
precedence.
The Read Only flag can be applied to
Packages whether they are checked-in or
checked-out.
MDG Add-Ins can specify their own icon
to denote that this branch of the model
belongs to that Add-In.
All Packages connected to an MDG
Add-In correspond to a namespace root,
so the namespace root icon is not
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displayed.

Feature Scope
Similarly, the Browser window indicates attribute and
operation scope status with icons.
Icon Overlay Indicates that...
The attribute or operation is scoped as
protected.
The attribute or operation is scoped as
private.

Notes
·

In the Corporate, Unified and Ultimate Editions, if project
User Security is on, the Browser window also has element
locking indicators (red and blue exclamation marks) that
indicate the lock status of individual elements and
Packages
The availability of these elements for editing depends on
whether user locks are required or not
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Order Package Contents
Ordering elements is very important when it comes to
structuring your model, especially Packages. Report
documents honor any custom ordering when printing
documentation. You can change the order of elements listed
in the Browser window.
By default, elements are first listed in:
· Order of type, then
· Order of set position, then
· Alphabetically
You can use the Browser window toolbar arrows to move an
element up or down within its type, but not outside its type.
This means you can re-sequence Packages or diagrams or
Use Cases, but you cannot mix up elements.
However, you can change this default behavior to allow
elements to be re-ordered within the Package, regardless of
type.

(c) Sparx Systems 2022

Page 844 of 1150

The Application Desktop

3 October, 2022

Set Default Behavior
The 'General' page of the 'Preferences' dialog provides
options for altering the behavior of the Browser window.

Access
Ribbon

Start > Appearance > Preferences >
Preferences > General

Options
Panel

Option

Browser
Window

Select the appropriate checkboxes to
engage particular facilities in the Browser
window:
· 'Confirm Deletes' - (Operates on the
'Project' and 'Context' tabs) This
checkbox defaults to selected to display
a confirmation prompt whenever you
delete a model component; only clear
the checkbox to bypass the prompt if
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·

·
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you are an experienced user and have
taken other measures to identify and
recover from accidental deletes
'Free Sorting' - (Operates on the
'Project' and 'Context' tabs) Select this
checkbox to be able to re-order
elements listed within a Package
regardless of type, in the Browser
window
'Show Stereotypes' - (Operates on the
'Project' tab) Select this checkbox to
display element stereotype names in
front of the element name, in the
Browser window (you must shut down
and restart Enterprise Architect for this
change in setting to take effect); you
assign a stereotype to an element in its
'Properties' dialog
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Navigating the Model

Enterprise Architect stores valuable organizational
information in a repository, and over time these repositories
will become large and will often contain many thousands of
elements and connectors. It is critical to be able locate
entities in the repository, and Enterprise Architect provides
a rich set of features for this purpose.
The Browser window provides hierarchical views of the
repository elements, features and diagrams; knowledge of
the Package hierarchy at different levels, and more detailed
lists of diagram and element content, will help you to
navigate through the repository and drill into and out of
Packages, locating what you are looking for. There are also
Package and resources browsers that help you to find items
in the repository.
A Navigator Toolbar helps you to navigate the hierarchy of
Packages in the repository using a textual breadcrumb
control, showing you the current Package location.
As models become larger, using the flexible Model Search
function will make it easy to find an entity or a set of
entities that meet defined criteria. There are a large number
of built-in searches, but there is no limit to the searches that
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can be created and even novice users can define useful and
time-saving searches.
Elements in well-formed models are articulated using
relationships that create a graph of elements. The ability to
traverse this graph is often termed traceability, and
Enterprise Architect has a series of features such as the
Traceability window that make it easy to visualize this
graph of interconnected elements, bringing the repository to
life.

Facilities
Facility
The use of the Browser window and Package Browser to
navigate and explore your model
How Model Views provide different perspectives and
'entry points' into a model
Focusing on objects with specific characteristics, in the
Focus window
Examining individual elements in the Inspector window
Finding elements and relationships using the Model
Search tools and custom queries
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Traceability tools to help track completeness,
dependencies and other behavioral and structural
relationships
Use of the Diagram List or Package Browser to view
model elements in a conventional list based manner
Use of the Relationship Matrix to understand and track
relationships between model elements in a spreadsheet
view
Using Diagram Filters to highlight information in
diagrams
Using the Traceability window to explore model
dependencies
Finding and working with element Relationships
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Exploring Your Model

Navigating is the ability to explore the hierarchical content
of a repository, using the tree-view windows such as the
'Details' tab of the Inspector window, the Package Browser
and the Traceability window, and the list-view windows
such as the Package and diagram lists. There is a wide range
of other views that help you to navigate through content
stored in a repository, such as the Gantt Chart for exploring
how elements are affected over time, and the 'Resources' tab
of the Browser window that lists assets such as templates,
patterns and matrices. The Navigator toolbar also shows a
bread crumb view of the Package hierarchy. These features
are particularly useful when you have some familiarity with
the structure of a repository, but you can also use the
convenient search features to find individual objects.

Tools
Tool
The Browser window, the main interface element for
exploring and navigating your model
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The Package Browser - a tabular, editable view of
elements in a selected Package, which can be displayed in
the main workspace.
The Diagram List - a tabular, editable view of elements
in a selected diagram, which can be displayed in the main
workspace
Model Views provide different perspectives and 'entry
points' into your model
A Diagram Slide Show displays a number of related
diagrams in a presentation, for illustration and
comparison of features of your model.
The Pan and Zoom window helps you to navigate around
very large diagrams.
The Summary Window shows a brief, read-only summary
of the general properties of the currently selected:
· Element (including Packages)
· Attribute
· Operation
· Test
· Maintenance item
· Resource
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The Navigator Toolbar
The Navigator toolbar identifies the location of the Package
or diagram you are currently working in, and provides
options to change the focus to another level of the Package's
branch, perform relevant operations on the Package, and
locate other Packages in the model.

Access
Ribbon

Explore > Portals > Windows > Explore
> Navigator
Start > All Windows > Design >
Navigate

Navigator Toolbar Options
Icon/Option

Action
Click on this icon to move one level
further up the location path, to the current
Package's parent Package. The child

(c) Sparx Systems 2022

Page 853 of 1150

The Application Desktop

3 October, 2022

Package is cleared from the path.
Click on this icon to move one level
further down the Package's location path,
to the child Package that was previously
opened in this work session. If a child of
the current Package has not been opened,
the icon is not available.
Displays a 'breadcrumb trail' of branch
nodes under which the current Package is
located. You can continue to expand the
'breadcrumb' path to show a branch of the
child Packages contained within the
current Package.
A double chevron (<<) to the left of the
Package path indicates that you have
explored the Package branch to several
levels below the current Package, and it is
out of view to the left. Click on the
chevron to display the current Package
again.
As you click on the last Package in a
path, a list of its child Packages and
diagrams displays, from which you select
the next object for the path. If you click
on a diagram, the diagram opens in the
Diagram View. The listed diagrams
include child diagrams both of the
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selected Package and of elements in that
Package. The names of the child
diagrams of elements are preceded by the
parent element name.
If you click on an expanded path node,
the child nodes are closed and cleared
from the path.
As you select a Package or diagram, that
branch in the Browser window is
expanded and the Package or diagram
you select is highlighted. This also sets
the context for any tools and utilities you
open to work on a Package.
In this field, type the name of a Package
and click on the icon to locate that
Package anywhere in the model, directly
using the Model Search facility.
Click on this icon to return focus to the
Start Page.
Click on this icon to display a set of
buttons, each of which invokes a task or
process that you can perform with the
current Package as the focus or target.
These tasks include:
· Highlight the Package in the
condensed, Package-only hierarchy of
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·

·

·

·

·

·

·

·

the Find Package window
Display the Package contents in the
Package Browser view
Display the Package contents in the
Specification Manager
Add a Model Package to the current
Package, using the Model Wizard
(Start Page 'Create from Pattern' tab)
Add a new child Package to the current
Package
Add a new diagram to the current
Package
Use the Model Search to locate a text
string in the Package
Use the File Search to locate files
associated with the current Package
Access the Portals View through which
you can perform a wide range of other
operations on the Package

Navigator Toolbar Context Menu
If you right-click on a Package in the 'breadcrumb trail' a
context menu displays, providing a number of options for
reviewing the selected Package.
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Option

Action

Specification
Manager

Open the Specification Manager to show
the element hierarchies contained in the
selected Package.

Show Gantt
Chart

Open the Element View of the Project
Gantt Chart, showing the elements in the
Package that have resources allocated to
them.

Show
Contents

Open the Package Browser and display
the contents of the selected Package

Go to
Package

Open the 'Find Package' dialog and
review the Package hierarchy of which
the selected Package is a part.

Add Model

Open the Model Wizard (Start Page
'Create from Pattern' tab) and use this to
create models underneath the selected
Package.

Add Package

Open the 'New Package' dialog and use
this to add child Packages to the selected
Package.

Add Diagram

Open the 'New Diagram' dialog and
create a new child diagram under the
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selected Package.
Copy Path

Copy the Package path to the clipboard.
You can then paste the path into a Model
Mail, Model Library post or other text in
your model, as a reference to the
Package.
You can also capture a Package path by
right-clicking on the Package in the
Browser window and selecting the
'Copy/Paste | Copy Node to Clipboard'
option.

Go To Path

Open the 'Select Package' dialog. Type or
paste into the 'Path' field a Package path
you want to follow.
· If typing, use a period (.) as the
separator between Package names in
the path; for example:
BusinessProcedures.Accounting.Recov
eries.Bad Debt Process
· If pasting, you might copy the path
from a message posted through any of
the communication facilities in the
model, or directly from the model itself
(see Copy Path)
Click on the OK button. The 'Navigator'
path field is updated, and any Package
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content display you have open is
refreshed with the content of the Package
at the end of the path.
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User Preferences

Enterprise Architect has a wide range of default settings for
controlling how the application acts on and presents model
structures and elements on your workstation. You can
customize these settings to define your preferred behavior of
the system. Most of the settings are stored in your registry
and they are set for your use only, on any model you open.
For a networked workplace, registry settings can be copied
down to any network workstation you log in to. Otherwise,
the settings control operations under your login on the
current machine only.
The settings are grouped according to their actions on
specific functional areas, on a number of pages of the
'Preferences' dialog.

Access
Ribbon

Start > Appearance > Preferences >
Preferences

Keyboard

Ctrl+F9
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Shortcuts

Option Groups
Group/Page

Action

General
Options

Control the behavior of the system as a
whole.
You can also define model-specific
options (such as the default directory
name for the shared files you define for
an element) using the 'Manage Model
Options' dialog.

Window
Behavior

Set local options that determine how
dockable windows display in your
system.

Diagram
(New
Diagram
Defaults)

Set the general properties of all diagrams
you create.

Diagram Themes

Create and apply display themes for all
diagrams that you open.
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Diagram Gradients
and
Backgrounds

Select the type of background to apply to
all diagrams, either a single color or a tile
image, and the fill color to apply to all
elements on the diagrams. You can also
set a color gradient to the diagram
background, the element fill, or both.

Diagram Standard
Colors

Set the display colors and background
colors of objects and properties in
diagrams across the system.

Diagram Appearance

Control how elements are displayed on a
diagram.

Diagram Behavior

Control how a diagram responds to
actions taken on it.

Diagram Sequence
(diagram
display)

Control the appearance and behavior of
Sequence diagrams specifically.

Objects
(display)

Configure the properties and behaviors of
elements created on your diagrams.

Links
(Connector
display)

Define the creation, behavior and
notation of connectors on your diagrams.

(c) Sparx Systems 2022

Page 862 of 1150

The Application Desktop

3 October, 2022

Communicati
on Colors (of
Communicati
on Messages)

Set the colors of Messages you create in
Communication diagrams.

XML
Specification
s

Configure the settings for working with
XML.

Source Code
Engineering

Set general user-specific options that
apply to all languages when you are
generating code from models
You can also define model-specific
options (such as the default language in
which to generate code) using the
'Manage Model Options' dialog.

Code Editors

Configure options for the system internal
editor, and for the default editor for DDL
scripts.

Attribute/Ope Set the system actions on attributes and
rations
operations.
Code
language
specifications
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Define how the system handles a
particular language when generating
code, setting user-specific variables such
as the default source directory.
You can also define model-specific
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options (such as the default file
extensions to apply when generating code
in the selected language) using the
'Manage Model Options' dialog.
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General Options
You can control how the system behaves when you open a
project, including setting the home directories and web
pages the project refers to.
The 'General' page has a child 'Window Behavior' page for
defining how dockable windows display on the system.

Access
Ribbon

Start > Appearance > Preferences >
Preferences > General

Keyboard
Shortcuts

Ctrl+F9 | General

Control system behavior
Field/Button

Action

Author

Defaults to your Windows user name.
This value is applied to the 'Author' field
when you create new elements and
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diagrams. Optionally, type in a new
Author name, or click on the drop-down
arrow and select a name from the list
(which contains names defined on the
'Project Author(s)' page of the 'People'
dialog).
When user security is enabled, this field
will be populated with your Firstname
Lastname as defined in the 'Manage
Users' dialog, and it can only be modified
there, not on the 'General' page of the
'Preferences' dialog.
Clipboard
Format

Click on the drop-down arrow and select
the graphic format in which to save
images to the Microsoft Windows
clipboard; Metafile has the best detail.

Default
Project

Either type in the file path and file name
of the project to open when you start up
Enterprise Architect, or click on the
button and browse for the project.

Project
Directory

Type in the default directory location for
the Enterprise Architect project files you
create.

Portal Guides

When you select a PDF User Guide from
the User Guide Portal, the system
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downloads the file from the Sparx
Systems website. If you have stored the
User Guides in a different location, type
in either the local directory path or the
URL of the website into which you have
moved the files.
Confirm
Deletes

The checkbox defaults to selected to
display a confirmation prompt whenever
you delete a model component.
Only clear this checkbox to bypass the
prompt if you are an experienced user
and have taken other measures to identify
and recover from accidental deletes.

Free Sorting

Select the checkbox to allow you to
manually reorganize elements within a
Package regardless of element type, in
the Browser window.

Show
Stereotypes

The checkbox defaults to selected to
display element and feature stereotype
names as part of the object names in the
Browser window.
Deselect the checkbox to hide the
stereotype names.
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Window Behavior
You use the 'Window Behavior' page of the 'Preferences'
dialog for setting local options that determine how dockable
windows display on your system, and what Toolbars are
immediately available.

Access
Ribbon

Start > Appearance > Preferences >
Preferences > General > Window
Behavior

Keyboard
Shortcuts

Ctrl+F9 | General | Window Behavior

Control Window Display
Select from the options listed here.
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Field

Description

Always open
maximized

The checkbox defaults to selected to set
Enterprise Architect to open in a
full-screen (maximized) window on
start-up.
Deselect the checkbox to set Enterprise
Architect to open in a smaller window.

Hide
Properties
Info Section

The checkbox defaults to selected to hide
the properties information bar at the
bottom of various displays such as the
Properties window and 'Properties'
dialog.
Deselect the checkbox to expose the
information bar.
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Animate
Auto Hide
Windows

If you are using windows that have been
automatically hidden, they simply appear
in the workspace when you move the
cursor over the window tab.
Select this checkbox to slide the windows
out into the workspace when you place
the cursor on the window tab.

Hide
Diagram
Caption Bar

The diagram caption bar normally
displays at the top or bottom of a
diagram. If you prefer, select this
checkbox to hide the caption bar.

Hide Status
Bar

The Status Bar normally displays at the
bottom of the Enterprise Architect work
area. It shows information on the current
operation and certain key settings, and
provides a 'zoom bar' for adjusting the
scale of the diagrams you view. If you
prefer to hide the Status Bar, select the
checkbox.
You can also hide sections of the
information that the Status Bar shows by
right-clicking on it and de-selecting any
or all of the options:
· <selected Perspective name> (to hide
the name of the currently selected
Perspective)
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Show Tab
icons

Zoom Slider
Status Indicators

Select this checkbox to show a
representative icon on the name tab of
each docked window.
Deselect the checkbox to hide these
icons.

Show
'auto-hidden'
windows on
mouse over

The checkbox defaults to selected to
show hidden windows when you drag the
cursor onto the window's tab using the
mouse. When you move the cursor off the
window, it no longer displays.
If you deselect the checkbox, you have to
left-click on the window's tab to display
the window.

Full row
select in tree
controls

In a window that displays a hierarchy of
model elements - such as the Browser
window - clicking on an item highlights
the selection. Selecting the 'Full Row
Select in Tree Controls' checkbox causes
the highlight to extend across the width
of the window. Deselecting the checkbox
restricts the highlight to the object name.
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Track
selection in
tree controls

When this checkbox is selected, moving
the cursor over an item in a hierarchy
window - such as the Browser window causes an underline to display under the
element name, indicating that the item
has focus and can be selected. If you
deselect the checkbox, the listed items are
not underlined and none have focus until
they are explicitly clicked on.

Hide
scrollbars in
tree controls

Select this checkbox to hide both vertical
and horizontal scrollbars in the windows
that list the hierarchical contents of the
model, such as the Browser window.
Clear the checkbox to allow scrollbars to
display.

Application
Tooltips

When you mouse-over ribbon or toolbar
options, or the options in their
subordinate menus, Enterprise Architect
displays a tooltip identifying the function
of that option.
You use this drop-down list to select
whether to display the tooltips in the
left-hand end of the Status Bar at the foot
of the screen, or as a pop-up message
close to the option. You can also select a
third option to disable the display of
tooltips.
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Show
Diagram
Toolbar

Display the Diagram Toolbar at the top of
every open diagram. Deselect this
checkbox to hide the Toolbar on every
diagram.

Use Large
Icons

Select to show all icons on Toolbars at
32x32 pixels. Deselect to show the icons
at 16x16 pixels.

Show
Toolbar
Customize
Button

Each toolbar can have a down-arrow
button on the end, which enables you to
customize the toolbar options. This
checkbox defaults to selected to show the
down-arrow button; deselect the
checkbox to hide the button, if you prefer.

Other
Toolbars

Click on this button to show the 'Toolbar
Customization' dialog, which allows you
to quickly show and hide specific
Toolbars.
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Diagram Options
In order to maintain consistency in the format, layout and
visibility of objects in your diagrams, you can define a
number of default settings to apply to all diagrams that you
display, whether you are creating them or reviewing them.
You can change or reverse many of these default settings for
your view of individual diagrams (whether you created them
or another user created them) on the diagram 'Properties'
dialog.

Access
Ribbon

Start > Appearance > Preferences >
Preferences > Diagram

Keyboard
Shortcuts

Ctrl+F9 | Diagram

Control Diagram Setup
Field/Button
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Default Page
Size

Show (underneath the field name) the
default page size for diagrams.
You set the default page size using the
Page Setup button.

Page Setup

Click on this button to define the page
dimensions for diagrams that you create.
The 'Page Setup' dialog displays, on
which you set the page size, orientation,
printer paper tray, and page margins.

Print with
Border

Select the checkbox to set the default to
printing a border on all diagrams you
have created.

Landscape

This checkbox is controlled from the
'Page Setup' dialog. When selected, any
diagrams that you create default to being
printed in landscape orientation.

Show Public
Features
Show
Protected
Features
Show Private
Features

Select any or all of the checkboxes to
automatically show Class features with
the scope of public, protected and/or
private on the diagrams you create.

Show

Select the checkbox to display, by
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Diagram
Notes

default, the diagram details (name, parent
Package, version and author) in the top
left corner of any new diagram that you
create.
Selecting this checkbox sets the 'Show
Diagram Details' checkbox to selected on
the diagram 'Properties' dialog for the
new diagram.

Use Opaque
Diagram
Labels

Select any or all of the checkboxes to
specify which renditions of your
diagrams should have opaque diagram
labels; 'Screen' and 'Printing' are most
often applicable.
An opaque label is a connector or
element label that, when the label
overlaps the connector line or border,
hides the line rather than allowing it to
show through the label text.

Disable fully
scoped object
names

Select this checkbox to disable the use of
fully scoped object names for elements in
all diagrams.
A scoped object name has the format
MyClasses::foo, where the :: character
indicates that the Class is within another
namespace.
This option automatically deselects the
'Show Namespace' option in all new
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diagrams and hides the
'Namespace::element Name' in each
element, but does not hide the '(from
'Namespace')' label.
Alternatively, fully-scoped object names
can be disabled for a specific diagram via
the diagram's display options.
Allow
change of
Created Date

Select this checkbox to allow you to
change the diagram creation date on any
diagram, through the diagram 'Properties'
dialog.

Zoom to best
scale

Select this checkbox to resize all
diagrams that you open to neatly fit the
monitor screen.

Auto-pan
with middle
mouse button

Select this checkbox to turn on
auto-panning using the middle mouse
button. In this case, when you hold down
the middle mouse button a black compass
icon displays, and as you move the cursor
away from this icon the diagram scrolls
in that direction.
If you deselect the checkbox, when you
hold down the middle mouse button a
white compass icon displays, and as you
move this icon the whole diagram moves
with it across or up and down the screen.
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Enable
Connector
line jumps

Defaults to selected, so that solid-line
connectors show 'hoop' icons or 'jumps'
when they cross, on all diagrams that you
open.
Deselect to disable line jumps so that
connectors simply cross with no 'hoop'
icon at the intersection.

Auto Reload
Changed
Diagrams

Select this checkbox to reload any
diagrams that you have open that have
been updated and saved by another user
within the last 60 seconds. If you have
selected this option and someone changes
a diagram you have open, then:
· Any open diagram that is not currently
visible (in another tab) will refresh
when you return to that tab
· An open diagram with no unsaved
changes, which you are looking at, will
just refresh
· A diagram that you are updating
yourself and have not saved is not
reloaded but will display a message
when you select to save your changes,
to prompt you to select to override the
other user's changes with yours or to
reload the diagram and override your
changes
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This option is also available from the
'Design > Diagram > Options' icon.
Scale Saved
Bitmaps to

You can save images of diagrams to file,
suitable for using in published works,
using the 'Publish > Diagram Image >
Save > Save to File' ribbon option. This
option prompts you to specify the file
location and file format. If you select to
save the files in bitmap format, the
images are scaled to the default of 137%.
If you prefer to use a different scale, click
on the drop-down arrow and select one of
the other set values between 100% and
400%. (You can also change the scale
percentage for saving diagram images to
file using the 'Publish > Diagram Image >
Save > Scale Image' ribbon option).
Images saved in formats other than
bitmap are not scaled.

Apply scale
to clipboard

You can also save images of diagrams to
the clipboard, in either bitmap or metafile
format (set in the 'Clipboard Format' field
on the 'General' page of the 'Options'
dialog), using the 'Publish > Diagram
Image > Save > Save to Clipboard' ribbon
option.
If you have set the format to 'Bitmap',
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you can save the images to the clipboard
scaled to the same percentage as is set for
saving to file, by selecting this checkbox.
When pasted into a document the
diagram preserves its original size, which
improves processing performance when
the document is opened, scrolled, printed,
saved to the database or exported to PDF.
You cannot scale metafile images.
Image
Memory
Limit

When you generate images for document
or web reports or save images to file, the
memory limit for storing this image
defaults to 48 MB. If the image is beyond
this limit, the system starts to scale down
the image.
You can click on the drop-down arrow
and select a lower or higher memory limit
for the image files of your diagrams. A
low memory setting means the system
scales the image sooner.

Diagram
Frames

Click on any or all of the checkboxes to
specify which saved images of your
diagrams will automatically include a
diagram frame around them - those saved
to disk, those printed out, and/or those
saved to the default system clipboard.
A diagram frame is a labeled outline
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around the diagram image, providing
both a border and a reference. A SysML
Internal Block diagram can have its own
diagram frame; if that frame is selected to
be shown, these Diagram Frames options
are ignored for the diagram.
These diagram frames are not the same as
the Diagram Frame element in which you
can enclose a diagram image or reference
when you drag the diagram from the
Browser window onto another diagram.
Tooltips
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This panel defines the content of the
tool-tip that is displayed when the cursor
is rolled over an element on a diagram
you have opened, or over the background
of the diagram itself. For the tooltip to be
displayed, the 'Use Info Tip (global)'
checkbox must be selected in the
Properties window for any diagram in the
model.
For each item of information to display as
part of a tool-tip, select the checkbox
against it.
If you select the 'Notes' checkbox,
consider whether the 'Max Characters'
value is appropriate to represent the text
of your element 'Notes' fields. The 'Max
Characters' field defines the maximum
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number of characters of Notes text
included in the tool-tip; if you want to
show less text or more, reset the character
limit accordingly.
Close
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you have made, and to close the
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Diagram Theme Options
It is possible to apply a theme to all diagrams in the project
that you display on your workstation; that is, how the
diagrams and their contents appear when you display them
in the Diagram View. By using a theme you can apply
specific, consistent colors, fonts, gradients, line thicknesses
and background image (tile). Each design helps bring your
diagrams to life with brighter colors, better contrast and
stylish new designs. As you select a theme, the appearance
settings are immediately applied to any diagram that you
open. Enterprise Architect includes a number of basic
built-in themes, which are useful to a wide range of users
and are good examples of how a theme can enhance the
diagrams that you have open.
You can also create your own themes, capturing the set of
colors, text font, line thickness and/or gradient properties
that you have currently defined in the 'Preferences' dialog,
on the:
· 'Gradients and Background' page
· 'Standard Colors' page
· 'Appearance' page, and
· 'Links' page
You select or deselect a checkbox for each set of properties
you want to include or exclude, from the 'Preferences' dialog
pages.
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Access
On the 'Preferences' dialog, select the 'Diagram > Themes'
page.
Ribbon

Start > Appearance > Preferences >
Preferences > Diagram > Themes

Keyboard
Shortcuts

Ctrl+F9

Configure themes for Diagrams and
Elements
Option

Action

Name

Click on the drop-down arrow and select
the theme you want to either:
· Apply as the default appearance of
your diagrams
· Edit (user-defined theme)
· Use as the base for a new user-defined
theme, or
· Delete (user-defined theme)
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Font

Select the checkbox to include the 'User
Font Face' and 'Font Size' settings from
the 'Appearance' page of the 'Preferences'
dialog (click on the 'Configure Default
Element Fonts' button on the
'Appearance' page to set these fields).
Deselect the checkbox to retain the
previous font applied to the diagram.

Color

Select the checkbox to include the
element, connector and diagram colors
defined on the 'Gradients and
Background' page and the 'Standard
Colors' page.
Deselect the checkbox to retain the
previous set of colors applied to the
diagram.

Line
Thickness

Select the checkbox to include the
'Default Element Border Width' from the
'Appearance' page, and the 'Pen Width'
(for connector line thickness) from the
'Link' page of the 'Preferences' dialog.
Deselect the checkbox to retain the
previous set of line widths applied to the
diagram.

Gradient

Select the checkbox to apply the setting
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of the 'Show Gradient Fill for Paper
Color' checkbox (which applies a color
gradient to the background color of the
diagrams you display) and the 'Gradient
Fill Direction for an Element' field on the
'Gradients and Background' page of the
'Preferences' dialog.
Deselect the checkbox to retain the
previous color gradient settings applied to
the diagram.
Background
Image

Select the checkbox to incorporate the
currently-set diagram background image
in the theme.

Element
Shadows

Select the checkbox to incorporate the
currently-set element shadow setting (on
or off) and color in the theme.

Save

Click on this button to either:
· Create a new user-defined theme, or
· Save changes to an existing theme
The 'Diagram Theme' dialog displays for
the theme name. Either:
· Type in a name for the theme and click
on the OK button to create the new
theme, or
· Simply click on the OK button and
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then click on the Yes button to save the
updates to the theme under the same
theme name
Delete

(Only available if a user-defined theme is
selected.)
Click on this button to delete the selected
theme.
A prompt displays for you to confirm the
deletion. Click on the Yes button to
delete the theme, or on the No button to
cancel the deletion.

Optional
Drawing
Modes

Select one or both of the 'Hand Drawn'
and 'Whiteboard' checkboxes if you want
to apply the corresponding mode to all
diagrams that you open in the model.

Close

Click on this button to close the
'Preferences' dialog.
If you have edited an existing theme, this
applies all changes to the theme to the
diagrams you have open.

Notes
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You cannot edit or delete a built-in theme; you can use a
built-in theme as the base for a user-defined theme
A theme draws its properties from other pages of the
'Preferences' dialog, therefore if you select the 'Gradient'
checkbox the theme will apply the status of the 'Show
Gradient Fill for Paper Color' checkbox on the 'Gradients
and Background' page, when that status might be disabled
because you have applied a background tile image
You can apply a different theme to an individual diagram,
on the 'Theme' tab of the diagram 'Properties' dialog
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Diagram Gradients and Background
When reviewing the diagrams in your model, you have a
range of options for managing the display and appearance of
the diagrams and their contents. These options include
setting the color and shading of the diagram and elements,
and the style of the page border of the diagram. You can
also, instead of using the color wash, select a tiled
background image for the diagrams you display, from a set
of system-supplied images or from images that you have
created or downloaded to a local system folder yourself.

Access
Ribbon

Start > Appearance > Preferences >
Preferences > Diagram > Gradients and
Background

Keyboard
Shortcuts

Ctrl+F9 | Diagram | Gradients and
Background

Diagram Background Options
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Field/Button

Action

Tile

Either:
· Type in the file path for a .jpg, .bmp or
.png graphics file to use as a
background for all your diagrams, or
· Click on the Select Tile button to the
right of the field and select a file (by
default from the Enterprise Architect
supplied tiles folder, but you can
browse to any other file location for the
required file)
The selected background is immediately
applied to any diagrams you have open,
and the field displays the location of the
background graphic file, such as:
C:\Program Files\Sparx
Systems\EA\BackgroundTiles\Aqua_03.j
pg
If you no longer want to apply a
background tile to your diagrams, click
on the Clear Tile button to clear the field.
All diagrams with a background tile will
include that background when saved as a
Diagram Image or a copy. The tile
background does not display in generated
documents.
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Paper

Click on the drop-down arrow to change
the background color of the diagrams you
display.
This field is disabled if you have selected
a background tile. The field is re-enabled
when the file path is deleted from the
'Tile' field.

Page Border
Style

Click on the drop-down arrow and select
the option for the type of page border you
want to use when displaying diagrams on
your monitor. You can choose from:
· Solid (the default) - pages are framed
by a solid dark gray line on the screen
· Dash - pages are framed by a broken
dark gray line
· Dash (with white line) - pages are
framed by a broken dark gray line on a
solid pale background
· Dot - pages are framed by a dotted dark
gray line
· Dot (with white line) - pages are
framed by a dotted dark gray line on a
solid pale background line
· Chiselled - pages are framed by a thin
black line bordered by a thicker dark
gray line to the right or below
If you cannot see the page border on a
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diagram, right-click on the diagram and
select the 'Properties' option, then make
sure that the 'Hide Page Border (All
Diagrams)' or 'Hide Page Border (Current
Diagram)' options are not selected.
Gradient

Click on the drop-down arrow and select
the direction of the color gradient to
apply to the background color of the
diagrams you display - Up or Down. You
set the background color itself in the
'Paper' field.
Select <none> to apply the background
color uniformly to the diagram
background.
This field is disabled if you have selected
a background tile. The field is re-enabled
when the file path is deleted from the
'Tile' field.

Element Fill Options
Option

Action

Gradient Fill
Direction For

Click on the drop-down arrow and select
the direction of the color gradient applied
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an Element

to the element fill color.
Select <none> to apply the element fill
color uniformly to the element, with no
color gradient.

Gradient
Style for
Element

Click on the drop-down arrow and select
the style to apply to the element fill color
gradient. The options apply:
· On the left or upper edge of each
element, a band of the gradient color
that fades in the direction of the fill,
and that has an angled line or curve on
the inner boundary
· On the right or lower side of each
element, a band of the gradient color
that fades at 90 degrees to the
first-defined gradient direction
Select '<none>' to have a single band of
color fading across the element in the fill
direction.

Fill

Click on the drop-down arrow and select
the fill color of all elements (except
Screen elements and Notes) on the
diagrams you display.
You can also change the element fill
color on the 'Standard Colors' page,
where you can define the fill color of
Screen and Notes elements as well.
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You can quickly make fill color changes
using the 'Hue', 'Saturation' and
'Luminosity' fields, in combination. The
'Fill' field reflects the color changes as
you make them, but having a diagram
open with large elements also shows the
changes immediately and very clearly.
Revert

Click on this button to reset the fill color
to the previously saved color. If you have
been testing new colors but have not
closed and re-opened the 'Preferences'
dialog, you can return to the color you
originally changed from.

Hue

Click on the slider icon and drag it along
the line to set the basic primary color or
combination of two primary colors. The
numerical value of the color (the H value
in the HSL code) displays in the field to
the right of the slider.

Saturation

Click on the slider icon and drag it along
the line to set the color saturation (the
degree of grayness in the color). The
numerical value of the saturation (the 'S'
value in the 'HSL' code) displays in the
field to the right of the slider.
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Click on the slider icon and drag it along
the line to set the color luminosity (the
degree of light in the color, from none
(black) to full (white). The numerical
value of the luminosity (the L value in the
HSL code) displays in the field to the
right of the slider.

Gradient Options
These options are ineffective if the 'Gradient Fill Direction
for an Element' field is set to '<none>'.
Field/Button

Action

Tint Amount

Click on the slider icon and drag it along
the line to set the degree of tint in the
color gradient. Moving from the left end
the slider sets completely black at the top
of the gradient, through no tint to
completely white at the top of the
gradient.
The percentage tint displays in the field
to the right of the slider, showing -50%
for the left end of the slider, 0% (the
default) in the center and 50% at the right
end.
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To reset the Tint Amount to the system
default (which is a slight, dusky
gradient), click on the Default button.
Fill Amount

Click on the slider icon and drag it along
the line to set the degree of fill of the
gradient. From the left end the slider sets,
effectively, no gradient (0%) through to
starting the gradient immediately at one
edge of the element and building right
across the element (100%).
The percentage gradient fill displays in
the field to the right of the slider.
To reset the Fill Amount to the system
default (80%), click on the Default
button.

Suppress
Child
Gradients

This checkbox defaults to selected, to
show no gradient on child elements that
are displayed on a diagram within the
borders of their parent element.
Deselect the checkbox if you prefer to
show these child elements with a gradient
as well.
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Standard Colors
On a model diagram, the objects and texts are rendered in
the system default colors. You can change any of these
default colors to either one of a range of standard colors, or
a color that you define yourself. Another user viewing the
same model diagrams will still see the diagrams in either the
standard default colors or colors that user has selected for
their own use.
If you define and select a 'non-standard' color for an object
type, that color is shown in the color pallet whilst it is the
selected color for that object type. If you then select a
different color, the non-standard color is no longer available
in the pallet. You can, however, define up to 16 custom
colors (using the Define Colors button) that are permanently
available to use in changing the appearance of individual
elements through the 'Default Appearance' dialog and
'Diagram' page of the 'Preferences' dialog.

Access
Ribbon

Start > Appearance > Preferences >
Preferences > Diagram > Standard Colors

Keyboard
Shortcuts

Ctrl+F9 | Diagram | Standard Colors
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Customize Diagram Element Colors
The color combo boxes on the 'Standard Colors' page help
you to customize the various colors that will be used to draw
elements (and their features) on all diagrams.
Ste Action
p
1

On the selected color combo box, click on the
drop-down arrow.
A 10x14 color pallet displays showing a range of
standard colors, with the system default color shown
above the pallet and a row of squares for custom
colors underneath. If custom colors have already
been defined (using the Define Colors button) they
are shown in the additional row.

2

If the color you want to use is shown on the pallet,
click on it to select it and to return to the 'Standard
Colors' page.

3

If the color you want to use is not shown, click on
the More Colors button.
The 'Color' dialog displays showing the 'Standard'
tab, offering a larger range of standard colors.
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4

If the color you want to use is shown on the pallet,
click on it to show that color in the 'New' panel and
(optionally) compare it with the currently-set color in
the 'Current' panel.
Click on the OK button to set the selected color and
to return to the 'Standard Colors' page.

5

If a suitable color is not available in the extended
pallet, click on the 'Custom' tab. This contains:
· A spectrum panel, with a 'sampler' icon; move the
icon around the panel to change the color shown in
the 'New' panel
· A 'Luminosity' bar; move the arrow on the right up
and down to change the intensity of the color
shown in the 'New' panel
· 'Hue', 'Sat'(uration) and 'Lum'(inosity) (HSL)
fields, and 'Red', 'Green' and 'Blue' (RGB) fields;
type and increment or decrement the decimal
values to either:
- make slight modifications to a color or
- exactly define a color for which you know
the HSL and/or RGB values
As you define the color it changes in the 'New'
panel; (optionally) compare it with the currently-set
color in the 'Current' panel and adjust it as necessary.
When you have defined your color, click on the OK
button to select it and to return to the 'Standard
Colors' page.
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6

As an alternative to selecting a standard color or
defining a new one, you can capture a color that is
used elsewhere on your current monitor screen.
Click on the Select button to redisplay the cursor as
an 'eye-dropper' icon; move this around the screen to
the color you want to sample.
Position the cursor so that the color is under the tip
of the 'eye-dropper' and shown in the 'New' panel.
Click the left mouse button to capture the color, then
click on the OK button to select it and to return to
the 'Standard Colors' page.

7

Click on the Close button to save your changes and
close the 'Preferences' dialog.

Elements
Element /
Component

Description

Fill

Define the fill color of all elements
(except Screen elements and Notes) on
the diagrams you display.
This color can also be changed on the
'Gradients and Backgrounds' page, and
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overridden by any other fill color
definition in your model, such as the
Layout ribbon fill setting, element default
appearance, Template Element Package
or stereotype definition.
Line

Define the line color of all element
borders on the diagrams you display.

Text

Define the font color of element text and
labels on the diagrams you display
(including Text elements).

Shadows

Define the color of element outline
shadows on the diagrams you display
(including Notes).

Attributes

Define the font color of attribute text in
the attribute compartment of all elements
on the diagrams you display.

Methods

Define the font color of method
(operation) text in the operation
compartment of all elements on the
diagrams you display.

Behaviors

Define the color for behaviors in Activity
diagrams you display.
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Define the color of text in the element
notes compartment of all elements on the
diagrams you display.

Note & Constraint Elements
Element /
Component

Description

Fill

Define the fill color of Note and
Constraint elements on the diagrams you
display.

Text

Define the font color of Note and
Constraint text on the diagrams you
display.

Note Line

Define the line color of the borders on
Note elements on the diagrams you
display.

Constraint
Line

Define the line color of the borders on
Constraint elements on the diagrams you
display.
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Others
Element /
Component

Description

Connector
Lines

Define the line color of all connectors on
the diagrams you display.

Screen Fill

Define the fill color of Screen elements
on User Interface diagrams you display.

Custom
Colors

Click on the Define Colors button to
define a set of custom colors for you to
apply to diagram elements anywhere in
the model.

Hyperlinks

Define the color in which Hyperlink text
will be displayed. When you mouse over
a Hyperlink in the model, it will be
shown in a contrasting color.

Show Project
Custom
Colors in
Color Combo
Boxes

Select this checkbox to add up to 16
defined custom colors to the end of the
color selection pallets on the various
object and text appearance dialogs.
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Select this option to apply a
system-managed color theme to certain
types of element (including Packages,
Navigation Cells, Hyperlinks and
Diagram Notes) on diagrams when a dark
Theme is applied to the diagrams. The
general effect is to make the element
colors brighter and richer. The option also
allows use of a diagram background color
when saving the diagram as an image or
copying it to the clipboard.

Notes
·

·

To override the default appearance of a specific element
on all diagrams on which it is found, right-click on the
element and select the 'Appearance | Default Appearance'
option; the 'Default Appearance' dialog displays
To change the appearance of a specific element on the
current diagram only, use the 'Style' panel of the 'Layout'
ribbon
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Create Custom Colors
If the standard colors available through the color palettes do
not meet your requirements, you can define up to 16 custom
colors that you apply to individual elements and connectors
through the 'Connector Appearance' dialog and element
'Default Appearance' dialog.
By applying such custom colors within a template diagram,
you can render all elements of the same type with the same
custom color, for all users of the project.
If another user has a set of custom colors that you want to
use, or a project manager has defined colors specifically for
the project, they can export these colors to the project file
and you can then import them directly as your custom color
pallet. If you have your own colors in the pallet, they are
overwritten by the imported set.

Access
Ribbon

Start > Appearance > Preferences >
Preferences > Diagram > Standard Colors
: Define Colors

Keyboard
Shortcuts

Ctrl+F9 | Diagram | Standard Colors :
Define Colors
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Define your custom colors
Ste Action
p
1

On the 'Color' dialog, click on the Define Custom
Colors » button.
The 'Color' dialog is extended to provide color
selection fields on the right of the dialog.

2

Click on an empty block in the 'Custom colors' pallet
(or, if you are replacing a color, click on that color
block in the pallet) and on the:
· 'Spectrum' panel, move the 'sampler' icon around
the panel to change the color shown in the
'Color|Solid' box
· 'Luminosity' bar, move the arrow on the right up
and down to change the intensity of the color
shown in the 'Color|Solid' box
· 'Hue', 'Sat'(uration) and 'Lum'(inosity) (HSL)
fields, and 'Red', 'Green' and 'Blue' (RGB) fields;
type decimal values to either:
- make slight modifications to a color or
- exactly define a color for which you know
the HSL and/or
RGB values
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As you define the color it changes in the
'Color|Solid' box.
3

When you have finished creating the color, click on
the Add to Custom Colors button to add the color to
the selected Custom Colors block.

4

Repeat steps 2 and 3 for any other custom colors you
want to define.

5

Click on the OK button to close the 'Color' dialog
and return to the 'Standard Colors' page of the
'Preferences' dialog.

6

To make the custom colors available for your use,
select the 'Show Project Custom Colors in Color
Combo Boxes' checkbox.
Up to 16 custom colors are displayed at the end of
the color selection pallets on the 'Connector
Appearance' dialog and element 'Default
Appearance' dialog.

7

Click on the Close button to close the 'Preferences'
dialog.
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Get/Set Custom Project Colors
If more than one person is working on a project, you might
want to share a set of custom colors with other team
members, or possibly provide special colors for use across
the whole project. You would then:
· Capture the custom or project colors you have defined, in
the project file, or
· Retrieve a set of colors someone else has defined, from
the project file

Access
Ribbon

Settings > Reference Data > Settings >
Colors > Get Project Custom Colors
Settings > Reference Data > Settings >
Colors > Set Project Custom Colors

Set custom project colors in the project file
Ste Action
p
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1

Define the custom colors on the 'Standard Colors'
page of the 'Preferences' dialog.

2

Select the 'Set Project Custom Colors' option.
This message displays:
Project Custom Colors export successful. 16 custom
colors saved to the project file.

3

Click on the OK button.
Notify the appropriate users that the colors are
available for importing.

Get project custom colors from the project
file
Ste Action
p
1

Select the 'Get Project Custom Colors' option.
This message displays:
Project Custom Colors import successful. 16 custom
colors imported from the project file.

2

The custom colors are now available at the end of
the color pallets of the 'Default Appearance' dialog

(c) Sparx Systems 2022

Page 909 of 1150

The Application Desktop

3 October, 2022

and 'Connector Appearance' dialog.
· If the colors do not show, select the 'Start >
Appearance > Preferences > Preferences' ribbon
option and the 'Diagram > Standard Colors' page,
and select the 'Show Project Custom Colors in
Color Combo Boxes' checkbox
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Diagram Appearance Options
It is possible to configure the appearance of diagrams and
elements in your models; that is, how diagrams and their
contents appear when displayed in the Diagram View. There
is a wide range of options you can set to create this display
configuration. As you select an option, it has immediate
effect on any diagram that you have open, so you can see
what the change in appearance is.

Access
Ribbon

Start > Appearance > Preferences >
Preferences > Diagram > Appearance

Keyboard
Shortcuts

Ctrl+F9 | Diagram | Appearance

Configure the Appearance of Diagrams and
Elements
Field/Button
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Default Fonts

Click on this button to set the default text
fonts to use on diagrams that you have
opened yourself.

Renderer

Render smooth curves and diagonal lines
in diagrams, so that staggered vertical or
horizontal pixels are less obvious. Click
on the drop-down arrow and select the
type of renderer you prefer to use:
· Basic is GDI32; it does not provide
anti-aliasing and gradient fills
· Enhanced-1 is parallel to Windows
GDI+ but internal to Enterprise
Architect; it provides anti-aliasing and
gradient fills, and operates well across
different platforms
· Enhanced-2 is Windows GDI+; this
can vary across different platforms,
performing better than Enhanced-1 in
some environments, and less well in
others
Experiment with these options and see
which works best for your system and
requirements.

Image
Quality

Defaults to 'High' to maximize image
drawing quality for scaled and resized
images on a diagram. The option does not
affect the drawing of EMF or WMF
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images.
This setting has an effect on processing
performance of the diagram, so if a
diagram has many images and
performance is more important than high
image quality, you can reset the field to
'Low'.
Base Zoom

Click on the drop-down arrow and select
the amount of magnification (zoom) to
apply to all diagram contents when you
open a diagram. Any subsequent Zoom
options operate on the diagram content
with the Base Zoom size as the starting
point.

Scale view
by

Click on the drop-down arrow and select
the percentage (from 0 to 50, in
increments of 10) by which you can
automatically increase the size of all
objects on a diagram you are viewing,
without affecting other users reading that
diagram.
You can perform the same function with
the Zoom Slider on the Status bar;
changes in the 'zoomed' display scale of a
diagram update this field and affect any
other diagrams that you open.
This has no impact any other diagram
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Zoom facility in the system.
Element
Click on the drop-down arrow and select
Border Width the default element border width (1, 2 or
3 pixels).
Anti-aliased
text

Select the checkbox to force text
anti-aliasing in diagrams.
If you deselect the checkbox, the system
applies the MS Windows default setting.
Therefore, if you do not want to use
anti-aliasing, ensure that the Windows
anti-aliasing default is also set to OFF.

Use extended
« and »
characters

The checkbox defaults to selected to
apply the guillemet characters to
stereotype names; recommended for
double byte character sets.
Deselect the checkbox to hide the
guillemet characters.

Invert rotated
text for
metafiles

Select the checkbox to use a different text
format when external metafile readers are
causing issues.

Print in Color

Select the checkbox to print your
diagrams in color.
Deselect the checkbox to print the
diagrams in black and white.
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Document
with
background
color

Select this checkbox to apply the
background color of the current theme to
all diagram images generated in the RTF
Generator, instead of the standard white.

HTML
Report with
background
color

Select this checkbox to apply the
background color of the current theme to
all diagram images generated in the
HTML Generator, instead of the standard
white.

Use Element
Group Style

Select the checkbox to apply a different
fill color to each object type, with objects
derived from a common element having
the same color (for example, Object,
Boundary, Control and Lifeline elements
are the same color). The Group Style
colors are system defined.
Overrides all other settings for element
fill colors.

as Border

This option is available when the 'Use
Element Group Style' option is selected.
It toggles the group style colors between
the element fill and the element border:
· Selected - the element borders are
shown in the different 'Group Style'
colors, whilst the element fill is the
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·

standard 'Fill' color set on the 'Standard
Colors' page
Unselected - the element borders are
shown in the standard 'Line' color set
on the 'Standard Colors' page, while the
elements have the different 'Group
Style' fill colors

Element
Shadows On

Select the checkbox to display a shadow
around the bottom and right edges of
each element in a diagram, including:
· Checklist elements
· Elements in Info View notation
· Constraints
· Interaction Occurrences on Sequence
diagrams
· State/Continuation elements on
Sequence diagrams
· Instanced Actors on Sequence
diagrams

Connector
Shadows On

Select the checkbox to display a shadow
beneath the connector line and arrow
heads of each connector on this diagram.

Suppress
shadows for
child

This checkbox defaults to selected, to
show no shadows on the edges of child
elements that are displayed on a diagram
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within the borders of their parent element.
Deselect the checkbox if you prefer to
show these child elements with edge
shadows as well.

Bold Element Select the checkbox to display element
Names
names in bold text.
Italic Note
Element Text

Select the checkbox to display the text of
Note elements, Text elements and Note
compartments in italics. This does not
affect the text displayed in Notes fields or
the Notes window.

Fit text to
element

Select this checkbox to compress the text
inside the element in a font size that
allows all text to fit inside the element
field.

Round
corners

Select the checkbox to soften the corners
of all elements that have a rectangular
appearance, so that they have rounded
corners.

Hand Drawn
Mode - Font

Click on the drop-down arrow and select
the font to be used in any diagram you
display that has the 'Hand Drawn' option
selected.
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Default

Click on this button to re-set the font you
see used in hand-drawn diagram mode to
the system default (Segoe Print).

Italic

For diagrams displayed in Hand Draw
mode, select this checkbox to display text
in italics.

Use
Watermark

Select the checkbox to add a watermark
to any diagrams that you print.

Text

Type in the text to use as watermark text.
If the 'Use Watermark' checkbox is
selected, this text is displayed on any
diagrams that you print.

Close

Click on this button to save the changes
you have made, and to close the
'Preferences' dialog.
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Set User Default Fonts
A diagram in your model uses a standard font that is applied
to any diagram displayed in any model. You can override
this by setting a user-specific font that applies to any
diagram that you display in any model.
You can also define Model Fonts that apply to any diagram
that any user displays within the model; the Model font
overrides the User font, to ensure that all members of the
project team have a consistent and coherent view of the
model. This avoids the problem of one user creating a
diagram in a small font, and another user trying to view it in
a larger font, which distorts the diagram.

Access
Ribbon

Start > Appearance > Preferences >
Preferences > Diagram > Appearance :
Default Fonts

Keyboard
Shortcuts

Ctrl+F9 | Diagram | Appearance : Default
Fonts

Control Default Diagram Fonts
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Field/Button

Action

Font Face

Click on the drop-down arrow and select
the font typeface to apply to your
diagrams if no model font is specified.

Font Size

Click on the drop-down arrow and select
the font size to apply to your diagrams if
no model font size is specified.

Restore
Defaults

Click on this button to restore the system
defaults to the user 'Font Face' and 'Font
Size' fields.

OK

Click on this button to close the dialog
and save your changes.

Cancel

Click on this button to close the dialog
and discard your changes.

Notes
·

In the Corporate, Unified and Ultimate Editions of
Enterprise Architect, if security is enabled you must have
'Manage Project Settings' permission to set, change or
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clear the 'Model Font' fields
User fonts are overridden by specifically-defined element
fonts, so that the element is viewed as designed regardless
of the model or user defaults; to define the font for a
specific element, right-click on the element in a diagram
and select the 'Appearance | Set Font' option
If you cannot read the diagrams because the default font
makes the objects and text too small, you can scale up all
objects (that is, all diagram displays) to a more readable
size for you only; the objects are not scaled up for other
users
Everything on the diagram is enlarged to the same extent,
so it remains in proportion and readable; to do this, return
to the 'Diagram Appearance' page of the 'Preferences'
dialog and enter a suitable percentage value in the 'Scale
view by' field
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Diagram Behavior Options
As you create and edit diagrams in your model, the system
can respond in different ways to the types of object you are
adding to a diagram. You can configure a range of options
to control what response the system makes to the object you
are adding or the action you are performing.

Access
Ribbon

Start > Appearance > Preferences >
Preferences > Diagram > Behavior

Keyboard
Shortcuts

Ctrl+F9 | Diagram | Behavior

Control Diagram Behavior
Field/Button

Action

Auto
Instance

Select the checkbox to automatically
create object instances when dragging
certain element types - such as Class and
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Component - from the Browser window
onto the diagram, with the dragged
element as the classifier.
Deselect the checkbox to paste the
element as a link.
This option has no effect on Sequence
diagrams.
Instance has
Classifier
style

Select the checkbox to automatically
apply the classifier style of the element
from which an instance is instantiated,
when the instance is created either
through the 'Paste Element' dialog or
when 'Auto Instance' is selected.
The classifier style is the default
appearance of the classifier, such as fill
color and text font.

Show Life
Lines

Select the checkbox to adjust the
alignment of life lines for Sequence
elements.

Layout uses
all relations

Select the checkbox to automatically take
connectors of all types into account when
you lay out the diagram; deselect the
checkbox to ignore Association
connectors in automatically laying out the
elements.
The elements with Association
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connectors are moved as if they do not
have those relationships, although the
connectors themselves are still depicted
on the diagram.
This option acts through the 'Design >
Diagram > Manage > Properties >
Diagram : Set Layout Style' option, and
through the 'Digraph' option of the
Layout Tools window ('Layout > Tools >
Diagram Layout > Open Diagram Layout
Tools').
Auto Save
Changes

Select the checkbox to automatically save
your changes as you work. No prompts
are displayed asking you to save the
changes.
Deselect the checkbox to display prompts
to save your changes when you attempt to
close the diagram without having saved
it.

Show
'Hidden'
Parents

Select the checkbox to list each element's
parent elements that are not already part
of the diagram, in the top right corner of
the element in the diagram.
Deselect the checkbox to not list the
parent elements.

Show Linked

Select the checkbox to include external

(c) Sparx Systems 2022

Page 924 of 1150

The Application Desktop

3 October, 2022

Items in
Package

elements in the Package contents list in a
Package element on a diagram. For this to
take effect, the 'Package Contents'
checkbox must be selected on the
'Elements' tab of the 'Properties' dialog
for the diagram.
Deselect the checkbox to omit external
elements from the list.

Show
Package Item
Scope

Select the checkbox to display the scope
indicators (such as +, # and -) against the
elements in the contents list within a
Package element. For this to take effect,
the 'Package Contents' checkbox must be
selected on the 'Elements' tab of the
'Properties' dialog for the diagram.
Deselect the checkbox to hide these
indicators in the list.

Shift-Mouse
Autoscroll

Select the checkbox to enable you to
autoscroll around diagrams by pressing
and holding Shift and pressing the middle
mouse button while you move the mouse.

Use
Automatic
SubActivities

Select the checkbox to automatically
create a new Structured Activity element
when you drag one Activity diagram
from the Browser window onto another
Activity diagram, and select the
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'Hyperlink' option.
Auto Group
Elements

Select the checkbox to also move
contained (child) elements when you are
moving their container (parent) elements.
Deselect the checkbox to move the
container elements independently.
You can toggle to the opposite setting of
this option when moving an element on a
diagram, by pressing or tapping the Alt
key.

Always
Highlight
Context
Element

Select the checkbox to show a hatched
border around any element when you
select it, along with the tracking handles
(see Tracking Handle Size).
Deselect the checkbox to show only the
tracking handles when you select an
element.

Objects Snap
to Grid

Select the checkbox to make all elements
on a diagram always align with the
nearest grid point.
Deselect the checkbox to position
elements at a precise point regardless of
the grid.

Show Grid

Select the checkbox to display the grid
points as pale gray dots. If you specify a
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large grid size the grid points can be hard
to see.
Deselect the checkbox to hide the grid
points.
Grid Size

If you have selected the 'Objects Snap to
Grid' checkbox, type in the separation of
the grid points, in pixels.
If you deselect the 'Objects Snap to Grid'
checkbox the value is grayed out, but it
remains in the field and is applied again if
you re-select the checkbox.

Auto Tidy

Select the checkbox to automatically tidy
line angles for custom connectors; this
'nudges' the custom line into horizontal
and vertical increments.

Tidy line gap

Type in the maximum distance, in pixels,
that the 'Auto Tidy' option can adjust the
end point of a non-orthogonal line to
make it orthogonal, for custom
connectors.

Alias only

Select the radio button to display, on
elements with aliases, the alias instead of
the element name.
This option and the next two options take
action on diagrams for which the 'Use
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Alias if Available' checkbox is selected
on the 'Properties' dialog for the diagram.
Alias and
Name

Select the radio button to display, on
elements that have aliases, both the
element name and the Alias in the format
'(Alias) name'.

Use alias
field for role

Select the checkbox to use the Alias
property of instances of elements to show
the Role property.

Enable
Presentation
Mode

Select the checkbox to display your
unlocked diagrams in Presentation Mode.
Locked diagrams are automatically
displayed in this mode.
In Presentation Mode, when you click on
an element on the diagram the element is
highlighted with a solid colored border,
the color being identified in the
'Highlight' field. This provides a more
visually appealing highlight of any
element you might be discussing in a
presentation.
In Presentation Mode, the 'tracking
handles' are hidden.

Show
Presentation

Select this checkbox to display the
Enterprise Architect logo down the
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Logo

right-hand edge of diagrams - this is very
useful to add software identification in
presentations, but also during work
sessions.

Highlight

Click on the drop-down arrow and select
the color in which to highlight the borders
of a selected element both in Presentation
mode and when the 'Rect Style' field is
set to 'Thin'. The color is also applied to
element tracking handles when the
'Handle Color' option is set to 'Use
Highlight'.
You can select either:
· One of the available colors
· The More Colors button, or
· (If you have previously changed the
color) the Default color button (Aqua)
The More Colors button displays the
'Colors' dialog, from which you can select
a preset color from the 'Standard' tab or
define a custom color on the 'Custom' tab.
Click on the OK button to apply the new
color as the highlight for selected element
borders.

Handle Color

Click on the drop-down arrow and select
the fill color of the 'size change handles'
or 'tracking handles' on an element,
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connector or label in a diagram. These
display when you click on the object to
select it.
· White
· Light Gray
· Dark Gray
· Black or
· Use Highlight - applies the color you
selected in the 'Highlight' field, so the
tracking handles and selection border
are the same color
Rect Style

Click on the drop-down arrow and select
the thickness of the hashed selection
outline. You can select from:
· 'Normal' - the hashed outline is thick
and obscures the highlighted border of
the element
· 'Thin' - the hashed outline is thin and
not apparent against the highlighted
element border

Handle
Position

Click on the drop-down arrow and select
the position of the 'tracking handles' on
the object outline - either Outside the
outline or Inside. Alternatively, if you do
not want 'tracking handles' to display at
all, select the 'Hidden' option.
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Handle Size

Click on the drop-down arrow and select
the size of the 'tracking handles' from the
list.
You can select:
· Small (the default, 8 pixels)
· Medium (12 pixels), or
· Large (16 pixels)
If 'Enable Presentation Mode' is selected,
the 'tracking handles' are hidden. You can
still expand or contract the element by
dragging on the corners, ends or
mid-points of the object.

Reset BPMN
Prompts

Working on a BPMN 2.0 diagram can
result in certain prompts being displayed,
which you can hide by selecting the 'Do
not show this message again' checkbox
on each prompt.
Click on this Reset BPMN Prompts
button to clear that checkbox so that the
prompts are again displayed.

Close

Click on this button to save your changes
and close the 'Preferences' dialog.
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Notes
·

If you have a diagram open when you reset any of these
diagram behavior options, you might need to close the
diagram and open it again to see the effect
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Sequence Diagram Options
When you are modeling using Sequence diagrams, there are
a number of rendering features that are specific to that
diagram type, such as the focus of the control indicator. You
can define default settings for these features, in addition to
the more-general diagram settings that you define on the
other diagram pages of the 'Preferences' dialog.

Access
Ribbon

Start > Appearance > Preferences >
Preferences > Diagram > Sequence

Keyboard
Shortcuts

Ctrl+F9 | Diagram | Sequence

Control Sequence diagram behavior
Field/Button

Action

Default page
layout is

Select the checkbox to set the default
orientation of your Sequence diagrams to
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Landscape

landscape.

Show
Sequence
Numbering

Select the checkbox to display sequence
numbers against the Sequence Messages
on the diagrams. (This option has
immediate effect.)

Assume right
to left
messages are
Return

Select the checkbox to automatically
render new Messages passing from right
to left as Return Messages.

Default
concurrency
is
Asynchronou
s

Select the checkbox to set the default
concurrency for Sequence Messages to
Asynchronous.
Deselect the checkbox to set the default
concurrency to Synchronous.

Enable
tooltips when
re-ordering
messages

Select the checkbox to display a tool-tip
when you attempt to move one Message
above or below another. The tool-tip is to
remind you that to swap the Message
positions, and thus re-order the Messages,
you must hold down the Alt key.
If you do not hold down the Alt key the
selected Message will move close to the
next Message but will not go past it.
To avoid displaying the tool-tip, deselect
the checkbox. This is only advisable if
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you are familiar with the requirement to
use the Alt key.
Width

Click on the drop-down arrow and select
the line width (in points, between 0 and
20) of the 'focus of control' rectangle (the
body at the start and end of a Message, on
the Lifeline).
(This option takes effect when a new
element is added, an existing element is
repositioned, or the diagram is closed and
re-opened)

Assume
message
returns

Select the checkbox to set implicit Return
Messages when none are explicitly drawn
(recommended).
Deselect the checkbox to use Return
Messages only when they are explicitly
created.

GarbageColle Select the checkbox to automatically
ct
truncate the Lifelines for elements that
have a defined lifecycle, by drawing an X
after the last Message (that is, assume
garbage collect rather than explicit
delete).
Name
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the caption bar text (at the top of the
Sequence diagram) is rendered. The
caption bar shows each element name
immediately over its element in the
diagram.
This feature is particularly useful for
non-English character sets.
Changes take effect immediately after the
'Preferences' dialog is closed.
Size

Click on the drop-down arrow and select
the font size of the caption bar text.
This overrides the font size set in the MS
Windows 'Font' dialog.

Use System

Select this checkbox to override (but not
overwrite) the 'Name' and 'Size' settings
with the system default heading font
definition.

Close

Click on this button to save the changes
you have made, and to close the
'Preferences' dialog.
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Object Display Options
In modeling with elements, you can configure the standard
contents of the elements you create and view and, in
diagrams, how they are rendered and how the system
responds to actions you take on them.

Access
Ribbon

Start > Appearance > Preferences >
Preferences > Objects

Keyboard
Shortcuts

Ctrl+F9 > Objects

Control element appearance and behavior
Field/Button

Action

Version

Type in the default version number or
code for new elements.

Phase

Type in the default phase number or code
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for new elements.
Highlight
References

Select the checkbox to highlight
parameters in operations that are passed
by reference rather than value.

Reference
Char(s)

Type in a character or character string to
act as the reference.

Prefix/Suffix

Select the appropriate radio button to
display the 'Reference Char(s)' value as
either a prefix or a suffix on the operation
parameter.

Warn about
spaces in
class names

Select the checkbox to display a warning
message when a Class, operation or
attribute name has embedded spaces
(which can cause coding problems).
Deselect the checkbox to hide such
messages.

Classes
honor
analysis
stereotypes

Select the checkbox to show Classes as
their stereotype; for example, if a Class is
stereotyped as a Boundary, it appears as a
Boundary rather than a Class.
Deselect the checkbox to show the
element as its base type; that is, as a
Class.
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Show
stereotype
icon for
requirements

Select the checkbox to show a code letter
in the top right corner of Requirement (E,
for external), Change (C) and Issue (I)
elements.
Deselect the checkbox to hide the
indicator letter.

Support for
Composite
Objects

Select the checkbox to:
· Display a hashed border within a valid
parent element when you drag a
potential child element onto it in a
diagram
· Automatically embed the child element
in their parent element in the model,
when you drag and drop the child
element onto the parent element in a
diagram
· Automatically disengage the child
element from the parent (break the
child-parent relationship) in the model
when you drag the child element out of
its parent element
Deselect the checkbox to not display the
hashed border and to not embed the child
element in the parent in the model.

Auto-resize
marks
diagram

Select the checkbox to set auto-resizing
of elements as an unsaved change to the
diagram (displaying an asterisk on the
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'dirty'

diagram tab), so that you must manually
save the diagram to protect the change.
Deselect the checkbox to automatically
save autosizing changes.

Highlight
{abstract}
elements

Select the checkbox to indicate, on a
diagram, Classes set as abstract by
displaying the tag {abstract} below and to
the right of the Class name.

Allow
elongated
Use Cases

Select the checkbox to allow Use Cases
or Use Case extension points to elongate
to accommodate long names.
If you deselect the checkbox, Use Case
re-sizing is proportional and the 'make
same height/width' menu options are
blocked.

Show status
colors on
diagrams

Select the checkbox to display color
coding in Requirement, Change and Issue
elements on all diagrams.
Deselect the checkbox to display the
status bands and element shadows in the
standard fill and shadow colors. You can,
however, select an option in report
generation to still show the status colors
in diagrams in the report.
You can increase the range of element
types on which to use status color coding,
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through the 'Status' page of the 'General
Types' dialog ('Settings > Reference Data
> Model Types > General Types').
Copy
inheritance
links on
duplicate

Select the checkbox to duplicate
Inheritance and Realization connectors
when you copy their elements.

Show buttons
for selected
Object on
diagram

Select the checkbox to enable the display
of the floating toolbar buttons to the right
of an object when you select it.

Deselect the checkbox to not display
these toolbar buttons or element icons.
Hide diagram
element paste
as new dialog

Select this checkbox to prevent the 'Paste
as New' dialog from displaying when you
copy and paste elements between
diagrams; the copied element is pasted as
a new element with the same name.
Clear the checkbox to allow the dialog to
display, so that you can change the
element name and include existing
connectors in the paste operation.

Show

Select the checkbox to show the
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«column»
stereotype

«column» stereotype as a heading in
Table elements, when data modeling.
Deselect the checkbox to just display the
column names without the «column»
heading.

Extend
Complexity

Select the checkbox to extend levels of
complexity to five levels in the
'Complexity' field in the element
'Properties' dialog:
· 'Easy'
· 'Medium'
· 'Difficult'
· 'Extreme'
· 'Unknown'
Deselect the checkbox to restrict the field
to three options (omitting 'Extreme' and
'Unknown').

UML 1.5
Components

Select the checkbox to perform your
modeling using UML 1.5 components
(Enterprise Architect versions from 4.0
onwards default to using UML 2.x).

Show State
Compartment

Select the checkbox to show, in a State
element, the State compartment divider
under the State name.
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Select the checkbox to enable duplicate
tag names to be shown in the element
Tagged Values compartment and in the
'Tags' tab of the Properties window for
the element.
The system defaults to hiding duplicate
tag names, to avoid displaying inherited
and overridden Tagged Values. It is
useful to display the duplicate tags when
you are revising them; for example, when
you are adding namespaces and labels in
ODM.

Group
Select the checkbox to group an element's
Operations
operations by their stereotype, in the
by Stereotype element's operations compartment on the
diagram.
The order in which the stereotypes are
listed is determined by the order of the
operations in the 'Operations' page of the
Features window for the element - if
operation AA with stereotype Z is the
first in the operation list, stereotype Z is
first in the stereotype list.
Deselect the checkbox to list the
operations ungrouped, in the order in
which they appear in the Features
window for the element.
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Group
Attributes by
Stereotype

Select the checkbox to group an element's
attributes by their stereotype, in the
element's attributes compartment on the
diagram.
The order in which the stereotypes are
listed is determined by the order of the
attributes in the 'Attributes' page of the
Features window for the element - if
attribute AA with stereotype Z is the first
in the attribute list, stereotype Z is first in
the stereotype list.
Deselect the checkbox to list the
attributes ungrouped, in the order in
which they appear in the 'Attributes' page
for the element.

Sort Features
Alphabeticall
y

Select the checkbox to list element
features of each type alphabetically.
Features include attributes, operations,
tags, constraints and Test Cases.
Deselect the checkbox to list the features
in the order in which they are defined (if
not alphabetical) in the corresponding
dialog or window for the feature.
To observe the effects of selecting or
deselecting the checkbox, you must close
the diagram and reload it.

Disable

Select the checkbox to turn off automatic
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spelling

spell checking.
Deselect the checkbox to resume
automatic spell checking.
The spelling checker operates on the
view, dialog or window where you
initially enter the text strings.

Show
invoked
Activity
name
(SysML)

For SysML diagram types. Select the
checkbox to show CallBehaviorAction
names as 'Action:Activity'. Clear the
checkbox to show the names as 'Action'.

Show
invoked
Activity
name (UML)

For UML and other non-SysML diagram
types. Select the checkbox to show
CallBehaviorAction names as
'Action:Activity'. Clear the checkbox to
show the names as 'Action'.

Advanced

Click on this button to specify which
types of element should be listed in
document reports and in diagram
Packages.
Some types of element do not appear in
Packages and in document output by
default. You use this facility to include
such types.

Close

Click on this button to save the changes
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you have made, and to close the
'Preferences' dialog.
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Connector Display Options
It is possible to configure a number of settings that control
the creation, behavior and notation for the connectors that
you define in your diagrams.

Access
Ribbon

Start > Appearance > Preferences >
Preferences > Links

Keyboard
Shortcuts

Ctrl+F9 | Links

Control connector appearance and behavior
Field/Button

Action

Edit
Connector on
New

Select the checkbox to automatically
open the connector 'Properties' dialog
each time you create a new connector on
a diagram.
Deselect the checkbox to simply create
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connectors without displaying the
'Properties' dialog to assign a name or
properties.
Association
default =
source -- >
target

Select the checkbox to automatically set
the direction of new Associations,
flowing from source to target element
(that is, with an arrow head at the target
end).
Deselect the checkbox to create
Associations with no direction (no
arrowhead on the connector line.)

Generalizatio
n link style
Default =
Tree

Select the checkbox to show
Generalizations in vertical tree-style,
forming a hierarchy where multiple links
to elements exist.
Deselect the checkbox to create
Generalizations in Auto Route style.

Shade
Qualifier
boxes

Select the checkbox to lightly shade all
Qualifier boxes on Associations in the
diagrams you open (see Suppress
Qualifier Boxes).
Deselect the checkbox to prevent shading
of the Qualifier boxes.

Draw
Aggregations

Select the checkbox to draw Aggregate
and Composite connectors from target
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Reversed

element to source element (the diamond
on the source end of the line).
Deselect the checkbox (the default), to
draw these connectors from source to
target (the diamond on the target end of
the line).

Prompt on
connector
deletes

Select the checkbox to display a prompt
before deleting connectors, offering the
choice of hiding the connector on the
diagram or deleting it completely.
If you deselect this option, the delete
operation defaults to the last-set option on
the dialog.

Suppress
Link
Constraints

Select the checkbox to hide any
constraints set on connectors in the
diagrams you open.
Deselect the checkbox to allow the
constraints to display on the connector
lines.

Suppress
Qualifier
boxes

Select the checkbox to hide the qualifiers
(in their boxes) on Association
connectors.
Deselect the checkbox to show the
qualifiers on the diagrams you open.

Show Uses

Select the checkbox to show an
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arrowheads

arrowhead on the target end of each Use
connector in a Use Case diagram.
Deselect the checkbox to show the
connector as a simple line.

Show
'Override
Operation'
dialog on
new
connector

Select the checkbox to show the 'Override
Operation' dialog automatically when
adding Generalization and Realization
connectors between Classes and
Interfaces, if the target element has
features that can be overridden.

Suppress ' + '
Role Scope

Select the checkbox to hide the 'Public'
indicator (+, when Access = Public in the
connector role properties) of the source
and/or target role on a connector.
Deselect the connector to allow the +
symbol to display.
When changing this setting, you might
need to reload the diagram to see the
change take effect.

Strict
Connector
Syntax

Select this checkbox to check that each
new connector complies with UML,
BPMN 2.0 and SysML 1.2 & 1.3 syntax
as you add it, and to enforce compliance.

Enable

Select the checkbox to enable the Quick
Linker, showing the Quick Linker arrow
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when you click on an element on the
diagram.
Deselect the checkbox to hide the Quick
Linker arrow and make the Quick Linker
unavailable.
Show Help

Select the checkbox to add a 'Help' option
at the end of the Quick Linker menu, to
display the Quick Linker Help topic.

Pen Width

Click on the drop-down arrow and select
the default connector line width (between
1 and 4 pixels).

Routing

Click on the drop-down arrow and select
the default connector style for new
connectors (Direct, Routed or Custom).

Exact
placement

Select this radio button to set the
orientation of the dashed guide line for
new connectors to the exact point on the
element you drag from and the exact
position of the cursor as you drag to the
target element.
This option enables the 'Force
perpendicular line' checkbox.

Center to
center

Select this radio button to set the
orientation of the dashed guide line for
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new connectors to anchor on the center of
the source element and, as you approach
the target element, the center of that
element.
The guide line displays both when you
are dragging the Quick Linker arrow and
when you have dragged a connector icon
from the Diagram Toolbox.
Force
perpendicular
line

Select this checkbox to set the orientation
of the dashed guide line for new
connectors to a perpendicular line
between the source and target element
edges, wherever this is possible.
You can toggle between this effect and
the Exact Placement effect by holding
[Ctrl] as you move the cursor between the
source and target elements.

Close

Click on this button to save the changes
you have made, and to close the
'Preferences' dialog.

Notes
·

For the 'Draw Aggregations Reversed' option, all tools
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have the parent as the target and the child as the source of
the connector, which is a requirement of UML; only the
direction in which you drag the mouse to draw the
connector is changed
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Communication Message Colors
Communication diagrams illustrate how components
interact and exchange information in a process. They have a
large number of messages that indicate the timing or
sequence of events in the communication process. You can
define the sequence of these messages using sequence
numbers, which also help you to group messages within a
stage in the sequence. To help make the sequence easier to
see at a glance, you can also:
· Select to display the messages in color
· Set a color for each group of messages

Access
Ribbon

Start > Appearance > Preferences >
Preferences > Communication Colors

Keyboard
Shortcuts

Ctrl+F9 | Communication Colors

Notes
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Select the 'Use Communication Message Coloring'
checkbox to turn on message coloring in the
Communication diagrams you open; when you select this
option, Communication messages display in different
colors depending on the sequence group they belong to on
the diagram - for example, messages 1.n are black, 2.n are
red and 3.n are green
Click on the down arrow in the color field for each
numerical message group and click on the color to set for
that group; if you have more than eight groups in the
sequence the color pattern repeats, so group 9 messages
are the same color as group 1 messages, and group 10
messages are the same color as group 2 messages
Click on the Close button to save the changes you have
made, and to close the 'Preferences' dialog
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XML Specifications
Many of the model development and management tasks you
perform operate either directly or indirectly with XML. You
can set defaults on a number of settings to standardize the
way in which you use XML in your own modeling
activities. You can override several of these settings on any
specific XMI import or export, especially when publishing a
model Package in XMI to another modeling language or
tool.

Access
Ribbon

Start > Appearance > Preferences >
Preferences > XML Specifications

Keyboard
Shortcuts

Ctrl+F9 | XML Specifications

Notes
·

If 'Export Alternate Images' is set, and you have Packages
in your model under Version Control, then any alternative
images used in those Packages are also exported to the
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Version Control repository when you check in the
Packages; in this case, you would only select the
checkbox if the alternative images are subject to frequent
change
Otherwise, do not select this option and instead use the
'Settings > Model > Transfer > Export Reference Data'
and 'Import Reference Data' ribbon options to manage
alternative images

Set XML Specification Options
Field/Button

Action

Editor

Specify the default editor for reviewing
any XML documents you open within the
system. Either:
· Type in the location of the editor .exe
file, or
· Click on the
button and browse for
the location

Code Page

Defaults to windows-1252; if you do not
want to use this Code Page, type in your
preferred code page reference.
Setting a null encoding string results in
the encoding tag being entirely omitted
from the XML output.
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Click on the Default button to restore the
setting to the default Code Page.
Format XMI
Output

Select the checkbox to set formatting of
your XMI output into human-readable
form as the default.
Deselect the checkbox to show the XMI
as unformatted code.

Use DTD

Select the checkbox to default to using a
Data Type Definition (DTD) in your XMI
imports and exports. A DTD validates the
correctness of the model and checks that
no syntactical errors have occurred.
Deselect the checkbox to set the default
to not using a DTD.

Export
Diagrams

Select the checkbox to default to
including diagrams when you export
XML to another format or tool.

Export
Alternate
Images

Select the checkbox to export any
alternative images used in the model
when you export to XML.

Validate
XMI against
Schema/DTD

Select the checkbox to validate the XML
format against the schema or Data Type
Definition when loading an imported
XML file.
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Import using
single
transaction

Select the checkbox to make all XMI
import operations and all Paste Package
from Clipboard operations default to
being performed within a single
transaction.
Deselect this checkbox to make all XMI
imports and paste Package operations
default to being performed data item by
data item, so that one failure does not
block the whole operation (recommended
for large imports/copies).
In either case, in any specific XMI import
operation the setting can be overridden.

Write Log

Select the checkbox to write the
execution activity to a log file when you
import or export XMI.
Deselect the checkbox to not record the
activity of the import or export to a log
file.

Export
Diagram
Images

Select the checkbox to export diagrams as
images when you export to XML.

Image Type

If you select the 'Export Diagram Images'
option, click on the drop-down arrow and
select the image format to export to.
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Select from metafile, bitmap, .gif, .png
and .jpeg.
Create
placeholders
for missing
External
References
during XMI
1.1/2.1 and
Native File
Import
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Select the checkbox to show, during the
import of an Enterprise
Architect-exported XMI 1.1/2.1 or Native
XML/XEA file, any missing:
· Diagram elements, using a Boundary
element as a placeholder
· Diagram connectors, using a
Dependency connector as a placeholder
When importing an Enterprise
Architect-exported XMI 1.1/2.1 or Native
XML/XEA file with cross-Package
references, use this option to visually
show the diagram items that are not yet in
the model.
A sample scenario would be, as shown
here, exporting 'Package2' to 'XMI 1.1'
from 'Master.EAP' and importing it into
'New.EAP' - the Classes 'Class1' and
'Class2' and the connector between them
are shown using a placeholder on the
diagram 'Package2'.
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If the file is for a Package under Package
Control or Version Control, and this
checkbox is not selected, it is overridden
if the 'For all packages, create
placeholders for external references'
checkbox is selected on the 'Version
Control Settings' dialog and/or 'Package
Control Options' dialog.
Prefix
Enterprise
Architect
Tagged
Values in
XMI 1.0 with
(c) Sparx Systems 2022

Select the checkbox to prefix any
Enterprise Architect Tagged Values
within any XMI 1.0 you create, with ea$.
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ea$
Update Last
Save Time

Select the checkbox to update the
timestamp of the last time each controlled
Package was saved.

Report Cross
Package
Reference
Deletions
(XMI 1.1)

Select the checkbox to report any
Package cross-references that would be
deleted when a Controlled Package from
an 'incomplete' model is exported to XMI
1.1.

Default XML
Directory

Type in the location of the default XML
directory to use when importing and
exporting XML, or click on the button
and browse for the location.

Close

Click on this button to save the changes
you have made, and to close the
'Preferences' dialog.
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Keyboard Shortcuts
You can display the Enterprise Architect dialogs, windows
and views, or initiate processes, using menu options and
Toolbar icons. In many cases, you can also access these
facilities by pressing individual keyboard keys or
combinations of keys, as shortcuts. The tables in this topic
show the default keyboard shortcut for each of the functions.
You can also display the key combinations on the 'Help
Keyboard' dialog (the Keyboard Accelerator Map).
The shortcuts described here are operations on the model.
When a diagram is open, you can use special quick-keys
that make navigating and editing the diagram simple and
fast. These quick-keys are described in the Diagram
Shortcuts Help topic.

Access
Ribbon

Start > Help > Help > Open Keyboard
Accelerator Map

Notes
·

The 'Help Keyboard' dialog shows the functions that have
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shortcut keys; it does not list functions that have no
shortcuts
There are additional shortcuts using the keyboard and
mouse in combination
If necessary, you can change the keyboard shortcuts using
the 'Keyboard' tab of the 'Customize' dialog

Opening Projects
Shortcut

Operation

Ctrl+N

Create an object of the same type as the
current selection in the window or
diagram. Otherwise, the 'New Project'
dialog displays through which you can
create a new Enterprise Architect (.qea,
.eap or .feap) project.

Ctrl+O

Open an Enterprise Architect project.

Ctrl+Shift+F
11

Reload the current project.

Adding Objects to the Project
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Shortcut

Operation

Ctrl+Shift+M

Add a new model to the project, using the
Model Wizard (Start Page 'Create from
Pattern' tab).

Ctrl+Insert

Add a new diagram to a Package.

Ctrl+M

Add a new element to a Package.

Shift+F3 or
Ctrl+click

Create a new element of the same type as
the last, on the diagram.

Ctrl+Shift+F
9

Add an attribute to an element.

Ctrl+Shift+F
10

Add an operation to an element.

Ctrl+F11

Add other types of feature to an element.

Insert key

Insert a new feature after the current
selection.

Locating Information
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Shortcut

Operation

Ctrl+F,
Ctrl+Alt+A

Search for items in the project (search in
the model).

Ctrl+Shift+F

Opens the Find in Files window at the
'Find File' tab, which you use as a File
System Explorer to quickly locate
specific files.

Ctrl+Shift+A
lt+F

Search files for data names and
structures.

Alt+G

Locate the selected element in the
Browser window.

Shift+Alt+G

Locate a selected object in the Browser
window.

Ctrl+Alt+G

Locates, in the Browser window, the
classifier for an object or instance, or the
call operation for an Action element.

Ctrl+U

Locate diagrams in which the element is
used.
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Copying and Pasting

Ctrl+C

Copy text, or element ID for pasting an
element on a diagram as a link.

Ctrl+Shift+C

Copy an element, multiple elements or a
Package plus any underlying structure to
the clipboard for duplication in a target
Package.

Ctrl+X

Cut the selected text.

Ctrl+V

Paste text.

Viewing Information in Windows
Shortcut

Operation

Alt+1

Displays the Design Window Selector,
which provides access to the windows for
locating, creating and working on objects
on the model, including within diagrams.
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Alt+2

Displays the Properties quick-access
window, which provides access to the
element Properties, Features, and
Responsibility windows and dialogs, and
a number of other tools for working on
objects within an element.

Alt+3

Displays the Collaborate quick-access
window, which provides access to the
Collaboration facilities such as
Discussions, Reviews, Journal entries,
personal conversations and information
concerning the overall model.

Alt+4

Displays the Execute quick access panel,
which provides access to the Simulation,
Source Code, Visual Analysis and
Process Execution windows and tabs.

Alt+5

Displays the Construct quick-access
panel, which gives access to tools for
managing resources, changes, testing and
project metrics.

Alt+6

Displays the Publish quick access panel,
which provides access to facilities for
generating static and dynamic reports,
exchanging models in part or entire, and
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keeping the model data accurate and up
to date.
Alt+7

Displays the Workspace quick access
panel, which provides access to the
defined workspaces for Design and
Construction, Software and Simulation
and User Layouts.

Alt+8

Displays the Debug window.

Alt+9

Opens the Relationship Matrix.

Alt+0

Displays the Feature Matrix for the
currently-selected element.

Alt+Enter

Displays the element 'Properties' dialog at
the 'General' tab.

Alt+\

Moves focus to the Diagram View from a
docked window.

Ctrl+Space

Displays the Quick Notes window for the
selected object.

Ctrl+1

Displays the Browser window.

Ctrl+Enter or
Ctrl+2

Displays the Properties window.
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Ctrl+3

Opens the Notes window.

Ctrl+4

Displays the Responsibility window.

Ctrl+5

Displays the Features window (defaulted
to the 'Attributes' tab).

Ctrl+6

Displays the Summary window for the
selected object (not for Views, Model
Packages, diagrams, instances or
connectors).

Ctrl+7

Opens the Traceability window.

Ctrl+8

Displays the Maintenance window
(defaulted to the 'Changes' tab).

Ctrl+9

Display the Discuss & Review window at
the 'Discussions' tab.

Ctrl+0

Displays the Specification Manager view.

Enter key

In the 'Project' tab of the Browser
window, displays the context menu for
the object.
In the 'Details' tab of the Inspector
window, displays the 'Properties' dialog
for the object, feature or property, or the
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equivalent 'Details' dialog.
Ctrl+F4

Closes the current window.

Ctrl+Shift+1

Displays the Portals window.

Ctrl+Shift+2

Opens the element Relationships
window.

Ctrl+Shift+3

Displays the Diagram Toolbox.

Ctrl+Shift+4

Displays the Pan and Zoom window.

Ctrl+Shift+5

Displays the Database Builder.

Ctrl+Shift+6

Displays the Schema Composer.

Ctrl+Shift+7

Opens the Resource Allocation window.

Ctrl+Shift+8

Opens the System Output window.

Ctrl+Shift+9

Displays the Scripting window.

Ctrl+Shift+0

Displays the work area full screen, and
restore full screen to partitioned,
multi-window.

Ctrl+Shift+F

Auto hides the current window.
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4
Ctrl+Alt+R

Opens the Package Browser (Package
Contents).

Ctrl+Alt+U

In the Browser Window, opens the
Library window.

F9

Displays the Features window at the
'Attributes' tab.

F10

Displays the Features window at the
'Operations' tab.

Shift+Enter

Displays the special properties of certain
types of object or, if there are no special
properties, displays the 'Properties'
dialog. If used in the 'Details' tab of the
Inspector window, the selected item is
displayed in a window.

Generating Documentation
Shortcut

Operation

F8

Opens the 'Generate Documentation'
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dialog for creating documents and
reports.
Shift+F8

Opens the 'Publish as HTML' dialog for
generating a web report in HTML.

Ctrl+Shift+F
8

Generates a 'Diagrams Only' report.

Deleting Objects from the Project
Shortcut

Operation

Ctrl+Delete

Deletes the selected element(s) from the
model (from the Browser window and
any diagram in which the element
occurs).

Ctrl+Shift+D
elete

Deletes the selected feature from the
model.

Checking Spelling
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Shortcut

Operation

Ctrl+Shift+F
7

Spell checks the current Package.

Ctrl+F7

Spell checks the model.

Performing Code Engineering
Shortcut

Operation

Ctrl+Shift+P

Edit code generation templates.

Alt+7

Open the Source Code window.

Ctrl+Alt+Y

Opens a source directory.

Ctrl+Alt+O

Opens a source file.

Ctrl+Shift+U

Imports a source directory.

Ctrl+Alt+K

Generates Package source code.

Ctrl+Alt+M

Synchronizes Package contents.
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F11

Generates code on a selected element.

F7

Synchronizes the current element.

Shift+F11

Batch generates selected elements.

Ctrl+R

Batch synchronizes selected elements.

Ctrl+E or
F12

Displays source code in the code editor.

Ctrl+Alt+H

Edit Transformation templates.

Ctrl+H or
Ctrl+Alt+F

Transforms selected elements.

Ctrl+Shift+H

Transforms the current Package

Ctrl+Shift+I

Indents the cursor/line one tab setting in
the code editor.

Exchanging Data
Shortcut
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Ctrl+Alt+I

Import a Package from XML.

Ctrl+Alt+E

Export a Package to XML.

Ctrl+Alt+C

Import and export to data CSV files.

Performing Visual Execution Analysis
Shortcut

Operation

Ctrl+Shift+J

Create a Workbench Instance of a Class.

Shift+F12

Manage Analyzer Scripts on the
Execution Analyzer window.

Ctrl+Shift+F
12

Create a Build Script.

Ctrl+Alt+N

Create a Run Script.

Ctrl+Alt+T

Create a Test Script.

Ctrl+Shift+A
lt+F12

Create a Deployment script.
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Alt+8

Open the Debug window.

F6

Start a Debug session.

Shift+F6

Step Into a function call.

Alt+F6

Step Over a function call.

Ctrl+F6

Step Out of a function call.

Ctrl+Alt+F6

Stop the debug session.

Other Operations
Shortcut

Operation

Shift+F9

Check project data integrity.

Ctrl+Alt+B

Manage Baselines.

Ctrl+Alt+D

Create a Linked Document on an
element.

Ctrl+Alt+P

Configure Package Control.
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Ctrl+Alt+V

Validate the current Package.

Ctrl+Shift+`

Switches focus to the active view from
any window. For example, if you are
reviewing something in the Specification
Manager and open a dialog on an item,
using this key combination returns focus
to the Specification Manager.

Ctrl+Shift+B

Manage structural (embedded) elements.

Ctrl+Shift+E
or F4

Configure an element's default
appearance.

Ctrl+Shift+L

Open a 'Lock <item>' dialog for the
selected Package, diagram or element.

Ctrl+Shift+O

Override inherited features.

Ctrl+Shift+W Select an alternative image for an
element.
Ctrl+Shift+Y

Specify which element features are
visible on a diagram.

Ctrl+F9

Configure system options.

Ctrl+I

Set an element's parent or implement
interface(s).
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Ctrl+J

Set cross references to other elements and
diagrams.

Ctrl+L

Locate and set the classifier for an object.
Also loads a controlled Package from its
XML file.

Ctrl+S

Saves changes, mainly in diagrams, but
also saves a controlled Package to its
XML file and saves and reverse engineers
a generated code file to the model

Ctrl+Z

Reverses changes to the content of
diagrams, Notes, documents and
templates.

F2

Edit the selected property value.

F5

Refresh the selected Package in the
Browser window.
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Keyboard-Mouse Shortcuts
When you work on an aspect of your model within a
diagram, there are a number of operations you can perform
quickly using a combination of keyboard keys and the
computer mouse.

Keyboard/mouse combinations
Action

Shortcut

Create an
element of
the same type
as was last
created on
the diagram.

Ctrl+click

Make a
duplicate of
an existing
diagram
element.

Ctrl+Shift+hold left mouse button and
drag to a new location on the diagram

Display the
element
'Properties'

Ctrl+click
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dialog for the
element
shown in the
scenario
'Context
References'
tab.
Select a
number of
individual
objects for an
operation.

Ctrl+click each object

Select a
range of
objects for an
operation.

Shift+click on the first and last object in
the range

Move the
selected
elements
along the
horizontal
axis or
vertical axis.

Shift+hold left mouse button and drag

Create a bend Shift+hold left mouse button and drag
in and change
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the direction
of the
connector
line.
Add or
remove a
bend-point
from a
connector.

Ctrl+click or Shift+click on the connector
at the point to add or remove

Move
elements in a
section of the
diagram
('Sweeper') in
any direction,
including
diagonally.

Alt+hold left mouse button and drag

Zoom in to or Ctrl+ mouse scroll wheel
zoom out of
the diagram.
Scroll the
diagram
horizontally.
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Diagram Shortcuts
When you have a diagram open, you can use a set of single
or combination keyboard keys to move between, select and
operate on the elements and connectors within the diagram.

Selecting and Marking Elements
Quick Key

Operation

Enter,
comma (,) or
period (.)

When no element is currently selected,
select the element nearest the top left
corner of the diagram or of the section of
diagram in view.

. (period)

When an element is selected, change
selection to the nearest child element
closest to the top left of the selected
parent element, on the diagram.

, (comma)

When an element is selected, change
selection to the parent element of the
selected child element, on the diagram

Arrow keys

Select the next element on the diagram
above, below, to the left or to the right of
the current element; when moving left or
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right, the selection tends to be upwards
rather than downwards.
S

Keep an element selected as you move to
another element (using the keyboard
arrow keys), so that you can select
multiple elements using the keyboard.

Q, F (element If no element property is selected,
name) or F2
highlight the element name for in-place
(property)
editing.
If you have selected an element property,
enable it for in-place editing.
F

Select the first editable feature of the item
in focus.
This is generally the element name but if
you select a Tagged Value that has
multiple system-defined values (such as
the SearchName tag) you can cycle
through the list of values to obtain the
correct one.

Shift+Space

Bookmark the current element with a red
marker.

/

Toggle selection between the current
(source) element and its connector.
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Inserting Objects, and Cutting and Pasting
Quick Key

Operation

Ctrl+V or
Shift+Insert

Paste element(s) from the clipboard as
links to the original element(s). The
'Paste <element name>' dialog displays;
simply click on the OK button to paste
the element.

Ctrl+Shift+V

Paste a diagram element as a duplicate
copy of the original element. The 'Paste
as New' dialog displays.

Insert or
Spacebar

Displays the 'Toolbox Shortcut' menu,
from which you can select to create and
add an element of one of a wide range of
types.

Ctrl+Shift+In
sert

Paste an element into the diagram as a
metafile image held on the clipboard.

F3

Create a new connector of the same type
as the last.

W

Add a way-point to the current connector.
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(This does not act on every line style.)
Ctrl+Shift+I

Hide or show selected connectors.

Positioning Elements
Quick Key

Operation

Alt

Press or tap this key when moving a child
element in its parent element on the
diagram, to toggle between:
· Confining the child element to the
parent and
· Allowing the child element to be
dragged outside the borders of the
parent element, thus breaking the
child-parent relationship
Under Linux or Windows VM, do not
hold the Alt key down, as this is linked to
other behaviors.

Alt+Z

Automatically size selected elements.

Alt+-

Space elements evenly, horizontally.
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Alt+=

Space elements evenly, vertically.

Shift+arrow
keys

Move elements by small increments.

Ctrl+arrow
keys

Resize a selected element by small
increments.

Ctrl+Alt+Do
wn

Align the bottom edges of selected
elements.

Ctrl+Alt+Up

Align the top edges of selected elements.

Ctrl+Alt+Lef
t

Align the left boundaries of selected
elements.

Ctrl+Alt+Rig
ht

Align the right boundaries of selected
elements.

Saving and Undoing Changes
Quick Key

Operation

Ctrl+Z

Undo a change.
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Ctrl+Y

Redo an undone change.

Ctrl+S

Save changes to a diagram.

Ctrl+T

Save an image to file.

Ctrl+B

Save an image to the clipboard.

Deletions
Quick Key

Operation

Delete key or
Ctrl+D

Delete selected element(s) in a diagram,
but not from the model.

Ctrl+Delete

Delete selected element(s) in the diagram
from the diagram and from the model.

Displaying Details in Other Windows
Quick Key
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N

Open and/or shift focus to the Notes
window.

P

Open and/or shift focus to the Properties
window.

R

Open and/or shift focus to the
Relationships window.

E

Display the Responsibility window

V

Display the Properties window

Z

If the Inline Specification Manager
window is open, set focus to that
window.

O

When you have selected an operation,
open the Features window at the
'Operations' tab.

A

When you have selected an attribute,
open the Features window at the
'Attributes' tab.

G

Display the 'Generate Code' dialog for the
selected element, to generate code from
it.
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Y

Synchronize the code generated from the
selected element with the element
content.

M

Display the 'New Element' dialog to
create a new element.

Ctrl+Shift+N

View the Pan and Zoom window.

Displaying Portals Windows
Quick Key

Operation

3

Display the Workspaces portal

4

Display the Perspectives portal

5

Display the Windows portal

6

Display the Extend portal

7

Display the Execute portal

8

Display the Learning portal
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Display the Working Sets portal

Printing a Diagram
Quick Key

Operation

Ctrl+P

Print the active diagram.
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The System Output Window
The System Output window is used to display information
generated by internal Enterprise Architect processes, or by
Add-Ins and other third-party tools. The output from each
type of operation is generally displayed on its own tab
within the window. The System Output window can provide
useful information during long-running processes and batch
operations; through this window you can, for example:
· Validate information - many validation processes within
Enterprise Architect write out their results to this window
· Review progress information during the launch of
external processes
· Review command line output from Build and Test scripts
· Review the output of jobs executed from the Job Queue
window
· Check parse errors generated during import of various
types of files
· Check Audit information
· Re-dock the Model Search results into a System Output
window tab for more convenient reference during various
operations
For some processes, information can be displayed on the
System Output window in a long line, wider than the
window. You can display the hidden text by dragging the
slider bar in the upper right of the window.
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Access
Ribbon

Start > All Windows > Design > Explore
> System

Keyboard
Shortcuts

Ctrl+Shift+8
Alt+1 | System

Options available on output data
Right-click on an item and select the appropriate context
menu option to:
· Copy the selected item to the clipboard
· Copy all items to the clipboard
· Save the output to an external file
· Clear the output from the window
· Rollback selected 'Get All Latest' updates to a Version
Controlled Package
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You can also:
· Drag the selected items or text out of the System Output
window and onto a diagram to quickly create a named
element
· Double-click on model validation errors or parsing errors
to display the source of the error
· Switch between tabs to view different categories of
information from different tools

Notes
·

(Corporate, Unified and Ultimate Editions of Enterprise
Architect, with Auditing turned on) the 'Audit History' tab
of the System Output window shows a history of changes
to any element or connector selected from the:
- Audit View
- Package Browser
- Diagram List
- Browser window, or
- Current diagram
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Status Bar
The Status bar displays at the bottom of the Enterprise
Architect work area. It shows information on the current
operation and certain key settings, and provides a 'zoom bar'
for adjusting the scale of the diagrams you view.
You can hide the Status bar itself by selecting the 'Hide
Status Bar' option on the 'Window Behavior' page of the
'Preferences' dialog ('Start > Appearance > Preferences >
Preferences > General > Window Behavior').
You can also hide sections of the information that the Status
Bar shows by right-clicking on it and de-selecting any or all
of the options:
· <current perspective> (to hide the name of the currently
selected Perspective)
· Zoom Slider
· Status Indicators

Status Bar Sections
Section

Information

Object
Type/Name

Shows the type and name of the
currently-selected diagram, or of the
currently selected element in the diagram,
or the status of the currently-displayed
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Model Search.
Creation data

Shows the date and time at which the
current diagram was created and last
modified, the percentage zoom of the
current display, and the normal page size
of the diagram.

Element/Feat
ure Name

Shows the name of the currently-selected
element, attribute or operation.

Position and
Size

Shows the coordinates of the top left
corner of the selected element, and the
width and height of the element.

<perspective
name>

Shows the name of the currently-selective
Perspective or Perspective Set.

Zoom
Control

Allows a zoom to be applied to all
diagrams, regardless of existing zoom
levels and without impacting other users.
Values range from 100% to 150%.

Status
Indicators

Indicates the status of the Caps Lock,
Num Lock and Scrl Lock keyboard keys,
and the Connect to Cloud facility (bold
indicates 'in use', pale indicates 'off').

Display

A triangle in the bottom right corner
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indicates that the screen is not
maximized; you can drag the screen
corner to increase the size of the window.

Notes
·

The zoom facility has the same function as the 'Scale view
by' field on the 'Diagram Appearance' page of the
'Preferences' dialog; changes in the 'zoomed' display scale
of a diagram update this field and are applied to any other
diagrams that you open

(c) Sparx Systems 2022

Page 998 of 1150

The Application Desktop

3 October, 2022

Legacy Toolbars
Enterprise Architect provides a set of toolbars containing
convenient shortcuts to a wide range of common functions
that you can perform on your project as a whole or on the
individual modeling units.
The toolbars can be displayed in the toolbar banner at the
top of the work area, or you can float them over a particular
area of the application; this is useful when you are using a
certain set of functions a lot in a particular area.
You can also dock toolbars to the edge of the Enterprise
Architect work area by dragging them by the title bar and
placing them against the appropriate edge.

Available toolbars
·
·
·
·
·
·
·
·
·
·

Default Tools Toolbar
Project Tools Toolbar
Diagram Toolbar
Element Toolbar
Connector Toolbar
Code Engineering Toolbar
Simulate Toolbar
Build Toolbar
Record Toolbar
Debug Toolbar
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Collaborate Toolbar
· Custom Draw Style Toolbar
· Publish Toolbar
Each toolbar has a icon at the right-hand end, which can
be enabled or hidden using the 'Window Behavior' tab of the
Preferences window. If you click on this drop-down arrow,
the 'Add or Remove Buttons' option displays. Select this
option to show a context menu listing the toolbars that are
displayed on the same line as the current toolbar, and an
option to customize toolbars - both your own and the
system-provided toolbars.
If you select one of the toolbars identified on the context
menu, the icons available through that toolbar are listed.
Click on the checkbox against each icon as necessary to hide
or show it in the toolbar.
If you select the 'Customize' option, the 'Customize' dialog
displays at the 'Commands' tab, where you can start
associating icons with commands to be added to Toolbars
on the 'Toolbars' tab.
There are two other bars that provide functions you can
apply in different contexts; these are the:
· Navigator Toolbar to help you locate and move to
sections of the model, and
· Status Bar to provide information on currently-selected
objects and on important system settings
Many of the dockable windows in the system also have their
own embedded Toolbars below the window name; for
example, the Notes Toolbar on the Notes window, and the
·
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Browser window toolbar.
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Quick Access Toolbar
The Quick Access Toolbar (QAT)
is a handy,
customizable toolbar that provides quick access to a set of
frequently used commands. By default, the QAT contains
buttons for Full Screen view and the Workspace Quick
Access panel. Users can also add their own frequently-used
commands to this set.

Access
You can find the Quick Access Toolbar at the top left corner
of the Enterprise Architect application window. You can
also move it to an alternative location below the menu
ribbon, so that it is closer to the main view.

QAT Menu
Clicking on the QAT's drop down button, , displays the
QAT menu.
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The menu commands are described in this table:
Command

Description

Full Screen

Maximize the main window and most
other windows.

Workspace

Show/Hide the Workspace button in the
QAT.
(The Workspace button is used to display
the Workspace Quick Access panel.)

More
Commands

Display the customization dialog, where
you can add more commands to the
toolbar.

Show Below
the Ribbon

Show the Quick Access Toolbar below
the ribbon, placing it closer to the main
view.

Minimize the
Ribbon

Minimize the ribbons and completely
hide them from view.

Minimal Text Hide the text under large icons in the
Mode
ribbon.

Customizing the Quick Access Toolbar
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There are two ways to add commands to the Quick Access
Toolbar.
In the Ribbon, right-click on the command that you want to
add to the QAT. From the pop-up menu, choose 'Add to
Quick Access Toolbar'.

Alternatively, you can add commands using these steps:
· Click on the QAT's drop-down button
, and select 'More
Commands'
· Use the pop-up window to add or remove commands from
the QAT

(c) Sparx Systems 2022

Page 1004 of 1150

The Application Desktop

3 October, 2022

Using the Quick Access Toolbar
Once a command has been added to the QAT, it is readily
accessible regardless of the menu ribbon that is currently
displayed.

(c) Sparx Systems 2022

Page 1005 of 1150

The Application Desktop

3 October, 2022

Default Tools Toolbar
The Default Tools toolbar provides instant access to the
most commonly used tools in Enterprise Architect,
including file management, printing and technology
facilities.

Access
Ribbon

Explore > Portals | Show Toolbar |
Default Tools

Default Tools Options
Icon/Option

Action

New Project

Click on this icon to create a new
Enterprise Architect project (as a .EAP,
.EAPX or .FEAP file).
Shortcut: Ctrl+N
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Open Project

Click on this icon to open an existing
project.
Shortcut: Ctrl+O

Save Current
Diagram

Click on this icon to save changes to the
current diagram.
Shortcut: Ctrl+S

Cut

Click on this icon to cut the selected
element(s) from the diagram and copy
them to the Enterprise Architect
clipboard.
Shortcut: Ctrl+X

Copy

Click on this icon to copy the selected
element(s) from the diagram to the
Enterprise Architect clipboard.
Shortcut: Ctrl+C

Paste

Click on this icon to paste elements from
the Enterprise Architect clipboard as a
reference on the current diagram.
Shortcut: Shift+Insert
Ctrl+V

Undo

Click on this icon to undo the last action.
Shortcut: Ctrl+Z
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Redo

Click on this icon to redo the last undone
action.
Shortcut: Ctrl+Y

Print Preview

Click on this icon to display the current
diagram as it will appear when printed.

Page Setup
for Current
Diagram

Click on this icon to configure print
settings for the current diagram.

Print
Diagram

Click on this icon to print the current
diagram.
Shortcut: Ctrl+P

Package
Browser

Click on this icon to display the content
of the current Package as a list of editable
elements.

Project
Search

Click on this icon to display the Find in
Project window, to define, manage and
run model searches.
Shortcut: Ctrl+Alt+A

Technology
List

Click on the down-arrow and select the
active technology, to provide the
appropriate sets of Toolbox pages and the
diagram Space Bar context element menu
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options.
Help
Contents

Click on this icon to access the Enterprise
Architect Help.
Shortcut: F1

Notes
·

·

·

The Cut button and Copy button are only enabled when an
item is selected on the current diagram
You can move this toolbar to any dockable position; it
retains that position in subsequent sessions
You can hide or show the toolbar by clicking on the
'Explore > Portals > Show Toolbar > Default Tools'
ribbon option
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Project Toolbar
The Project toolbar provides tools for performing routine
tasks such as creating Packages, diagrams and elements,
searching the model and generating documentation.

Access
Ribbon

Explore > Portals | Show Toolbar |
Project Tools

Project Toolbar Options
Icon/Option

Action

Reload
Project

Click on this option to close and reload
the current project, to bring in changes
made by other users sharing the project.
Shortcut: Ctrl+Shift+F11

New

Click on this option to create a new
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Diagram

diagram under the currently selected
Package, in the Browser window.
Shortcut: Ctrl+Insert

New Package

Click on this option to create a new child
Package under the currently selected
Package, in the Browser window.
Shortcut: Ctrl+W -- --

New Element

Click on this option to create a new
model element under the currently
selected Package or element, in the
Browser window.
Shortcut: Ctrl+M

Find in
Project
Browser

Click on this option to run a simple
search within the Browser window.

Find in
Project

Click on this option to search the entire
project or the selected Package using
pre-defined and customized searches.
Shortcut: Ctrl+F

Generate
Documentati
on

Click on this option to define and
generate Document reports on the
currently-selected Package.
Shortcut: F8
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Project Issues Click on this option to display the 'Project
Issues' dialog to review and create project
issues.
Project
Glossary

Click on this option to display the
'Glossary' dialog to review and create
glossary terms.

Set Options

Click on this option to display the
'Preferences' dialog, through which you
can personalize project display and
behavior options for your own login to
the project.
Shortcut: Ctrl+F9

Notes
·

·

You can move this toolbar to any dockable position; it
retains that position in subsequent sessions
You can hide or show the toolbar by selecting the
'Explore > Portals > Show Toolbar > Project Tools' ribbon
option
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Diagram Toolbar
The Diagram toolbar provides tools to lay out and improve
the appearance of diagrams, including zoom controls to
better manage large diagrams and quickly identify key areas
of interest.

Access
Ribbon

Explore > Portals | Show Toolbar |
Diagram

Diagram Toolbar Options
Icon/Option

Action

Align Left

Click on this option to align the left edges
of the selected elements.
Shortcut: Ctrl+Alt+Left Arrow

Align Right

Click on this option to align the right
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edges of the selected elements.
Shortcut: Ctrl+Alt+Right Arrow
Align Tops

Click on this option to align the top edges
of the selected elements.
Shortcut: Ctrl+Alt+Up Arrow

Align
Bottoms

Click on this option to align the bottom
edges of the selected elements.
Shortcut: Ctrl+Alt+Down Arrow

Bring to Top

Click on this option to bring the selected
elements to the top of the Z order, in front
of other elements on the diagram.

Send to Back

Click on this option to move the selected
elements to the bottom of the Z order,
behind other elements on the diagram.

Previous
diagram

Click on this option to display the
previous open diagram.
Shortcut: Alt+Left Arrow

Next
Diagram

Click on this option to display the next
open diagram.
Shortcut: Alt+Right Arrow

Home

Click on this option to display the default
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Diagram

Model Diagram (or default User
Diagram) if one has been defined.

Zoom In

Click on this option to zoom into
(magnify) the diagram by 10 percent.

Zoom Out

Click on this option to zoom out of
(shrink) the diagram by 10 percent.

Fit to View

Click on this option to adjust the diagram
size to fit within the Diagram View
screen.

Size View to
Page

Click on this option to adjust the diagram
size to fit within the page margins shown
on the screen.

Zoom to
100%

Click on this option to display the
diagram content at 100% of default size,
regardless of the Diagram View screen
size.

Layout
Diagram

(Not applicable to Behavioral diagrams)
Click on this option to automatically
layout the diagram in the Digraph layout
format.

Diagram
Properties

Click on this option to display the
'Properties' dialog, on which you can
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adjust the diagram display and behavior
properties.
Paste
Appearance

Click on this option to apply to the
selected element a set of appearance style
settings as defined for an element in the
'Default Appearance' dialog and loaded
into the Painter.

Delete
Selected

Click on this option to delete the selected
element(s) from the diagram.
Shortcut: Ctrl+D

Notes
·

·

·

·

Any actions that result in a change in diagram content and
appearance (including Zoom) are saved as changes to the
diagram
The Diagram toolbar can be docked to any main window
edge or floated freely in a convenient location for quick
access
You can move this toolbar to any dockable position and it
retains that position in subsequent sessions
You can hide or show the toolbar by clicking on the
'Explore > Portals > Show Toolbar > Diagram' ribbon
option
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Element Toolbar
The Element toolbar provides a number of options for
performing common operations on a selected element, such
as viewing the element's properties, operations or attributes.
You can also use it to specify the visibility of the element's
features and compartments, and to lock that element.

Access
Ribbon

Explore > Portals > Show Toolbar >
Element

Element Toolbar Options
Icon/Option

Action

Edit
Properties

Click on this option to display the
element 'Properties' dialog, through
which you can view and edit the
properties of the selected element.
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Shortcut: Alt+Enter
Set Parent

Click on this option to display the 'Set
Parents and Interfaces' dialog, through
which you can set the parent or
implement interfaces for the selected
element.
Shortcut: Ctrl+I

Operations

Click on this option to display the
'Operations' page of the Features window,
through which you can create and edit
operations for the selected element.
Shortcut: F10

Attributes

Click on this option to display the
'Attributes' dialog, through which you can
create and edit attributes for the selected
element.
Shortcut: F9

Show
Features

Click on this option to display the
'Compartment Visibility' dialog, through
which you can specify which
compartments and information to display
for the selected element.
Shortcut: Ctrl+Shift+Y

Set

Click on this option to display the
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Runstate/Initi
alization

'Override Attribute Initializers' dialog,
through which you can set the element
run state, attribute initializers or - for
Parts - property value.
Shortcut: Ctrl+Shift+R

Find Element
Usage

Click on this option to find all other
diagrams in which the selected element is
used:
· If the element is not used in any other
diagram, there is no further action
· If the element is included in other
diagrams, the 'Element Usage' dialog
displays, listing those diagrams, and
you can choose which diagram to
explore
Shortcut: Ctrl+U

Find in
Project
Browser

Click on this option to highlight the
selected element in the Browser window.
Shortcut: Alt+G

Configure
References

Click on this option to display the
'Custom References' dialog, on which
you can view the properties of other
elements and diagrams in the model to
which the selected element has custom
cross-references.
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Shortcut: Ctrl+J
Lock
Element

Click on this option to apply or release a
lock on the selected element. The element
is then blocked against or made available
for editing, respectively, depending on
which locking policy your system is
operating under.

Add Tagged
Value

Click on this option to display the
'Tagged Value' dialog, through which you
can add a Tagged Value to the selected
element(s).
Shortcut: Ctrl+2 > Tags

Notes
·

·

You can move this toolbar to any dockable position and it
retains that position in subsequent sessions
You can hide or show the toolbar by selecting the
'Explore > Portals > Show Toolbar > Element' ribbon
option
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Connector Toolbar
The (Current) Connector toolbar provides a number of
options for quickly modifying the properties, style and
direction of a selected connector, showing and hiding the
connector and/or its labels, and pinning each end of the
connector.

Access
Ribbon

Explore > Portals > Show Toolbar >
Connector

Current Connector Toolbar Options
Icon/Option

Action

Connector
Properties

Click on this option to display the
'<connector type> Properties' dialog, on
which you can view and edit the
properties of the selected connector.
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Shortcut: Enter key
Connector
Style

Click on the drop-down arrow and select
the appropriate connector line style from
the list. The options are:
· Direct Route
· Auto Routing
· Custom Routing
Shortcut: Ctrl+Shift+D
Ctrl+Shift+A
Ctrl+Shift+C

Attach Note
or Constraint

Click on this option to display the 'Link
Relations' dialog, which you use to attach
a note or constraint to the selected
connector and to any other existing
connectors in the current diagram.
Double-click on the Note element to
display the 'Notes' dialog on which to
type in the text.

Show or Hide Click on this option to display the 'Label
Connector
Visibility' dialog, which you use to
Labels
specify which of the eight possible label
positions around the selected connector
are to be displayed.
Show and
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Hide
Relationships

Visible Relations' dialog, through which
you can show or hide each of the
relationships between elements within the
current diagram.
Shortcut: Ctrl+Shift+I

Reverse
Direction

Click on this option to simply reverse the
direction of the selected connector.

Pin
Connector
Ends

Click on the down-arrow to select the end
of the selected connector to pin to the
source and/or target elements. The pinned
end cannot be dragged off the point on
the element border to which it has been
fixed.
Some connector line styles (such as the
Tree styles) are not compatible with
pinning the connector ends; if a pinned
connector is changed to one of these
styles, the connector ends will be
unpinned.

Notes
·

You can move this toolbar to any dockable position and it
retains that position in subsequent sessions
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You can hide or show the toolbar by clicking on the
'Explore > Portals > Show Toolbar > Connector' ribbon
option
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Code Engineering Toolbar
The Code Generation (Engineering) toolbar provides
options to import, generate, synchronize and open source
code. Some of these options display convenient menus to
quickly set, for example, the default language and default
database type for the project.

Access
Ribbon

Explore > Portals > Show Toolbar >
Code Engineering

Code Generation Toolbar Options
Icon/Option

Action

Default Code
Language

Click on the drop-down arrow and click
on a coding language in the list, to set
that language as the default applied to all
newly created Class elements.
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Default
Database
Type

Click on the drop-down arrow and click
on a database type in the list, to set that
database type as the default applied to all
newly created database elements.

Import

Click on the drop-down arrow to locate
and select source files to import for
reverse engineering code into new Class
and Interface elements in the current
diagram.
Firstly, click on a coding language in the
drop-down list to identify the file types to
locate; this selection overrides the
project's default language for this
particular import.
When you have selected a language, a
browser dialog displays through which
you browse for the file location and select
from files with the extensions appropriate
to the coding language you selected.
When you click on a file, the system
immediately imports it and generates
elements from the file, in the current
diagram. The progress of the reverse
engineering is shown on a 'Progress'
dialog; click on the Close button when
the process is complete.

Generate

Click on this option to generate source
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Source Code

code for the currently selected single
Class element, through the 'Generate
Code' dialog.
Shortcut: F11

(Batch)
Generate
Source Code

Click on this option to batch-generate
source code for multiple selected Class
elements.
A 'Progress' dialog displays and, if no
target file is specified in the element, a
prompt for the location of a file to
generate the code into.
Shortcut: Shift+F11

Synchronize
Element with
Source

Click on this option to synchronize the
selected Class element with its associated
source code.
The synchronization completes as a
background task.
Shortcut: F7

Open Source
Code

Click on this option to open the source
code of the selected Class, in the default
code editor.
The source code must have been
generated, and the selected element must
be a Class. Otherwise no action is taken.
Shortcut: F12
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Notes
·

·

You can move this toolbar to any dockable position and it
retains that position in subsequent sessions
You can hide or show the toolbar by selecting the
'Explore > Portals > Show Toolbar > Code Engineering'
ribbon option
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Simulate Toolbar
The Simulate toolbar provides access to control options for
executing a simulation of a behavioral model's processing
through a model diagram. These options enable you to start,
pause, stop and step in, out, and over the simulation, and set
the type and speed of the simulation.

Access
Ribbon

Explore > Portals > Show Toolbar >
Simulate

Simulate Toolbar Options
Icon

Action

Simulate

Start the Simulator for the current
diagram or, if the current diagram cannot
be simulated, run the Simulation using
the activated Simulation script.
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Pause-Resum
e

Pause the simulation.

Step
In/Over/Out

When the Simulation is paused, step over,
step in and step out to control the
Simulator's execution at the required step
in the model Simulation.

Stop
Simulation

Stop the simulation.

Set Type

Click on the drop-down arrow and select
the type of simulation to run:
· 'Interpreted' - Perform dynamic
execution of a simulation (Corporate,
Unified and Ultimate Editions)
· 'Manual' - Step through a simulation
manually (the only option available in
the Professional Edition)
· 'Executable' - Select when running the
simulation on an Executable
StateMachine

Select Tool

Click on the drop-down arrow and select
from a menu of options for performing
specific operations on the simulation
script and output, such as Build, Run,
Generate and View Breakpoints.
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Vary the execution rate of the Simulation,
between 0% and 100%; at:
· 100%, the Simulation executes at the
fastest possible rate
· 0% the Simulator breaks execution at
every statement

Notes
·

The Simulate Toolbar is also found as the embedded
toolbar in the Simulation window
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Build Toolbar
The Build toolbar provides access to tools for building
program source code. From this toolbar you can:
· Build the currently active application
· Run the compiled application
· Run your Test and Deployment scripts

Access
Ribbon

Explore > Portals > Show Toolbar >
Build

Build Toolbar Options
Icon/Option

Action

Active
Analyzer
Script

Display the name of the currently active
analyzer script.
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Click on this icon to display the
Execution Analyzer window, which you
use to manage the Analyzer scripts for
your model.
Shortcut: Shift+F12

Build Current Click on this icon to execute the Build
Package
script for the selected Package.
Shortcut: Ctrl+Shift+F12
Cancel Build

Click on this icon to cancel execution of
the Build script currently in progress.

Run
Executable

Click on this icon to execute the Run
script for the selected Package.
Shortcut: Ctrl+Alt+N

Run Test
Script

Click on this icon to execute the Test
script for the selected Package.
Shortcut: Ctrl+Alt+T

Run
Deployment
Script

Click on this icon to execute the Deploy
script for the selected Package.
Shortcut: Ctrl+Shift+Alt+F12

Run Merge
Script

Click on this icon to execute the Merge
script for the selected Package.
Shortcut: Ctrl+Alt+M
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Notes
·

·

·

The toolbar can be docked to any main window edge or
floated freely in a convenient location for quick access
You can move this toolbar to any dockable position and it
retains that position in subsequent sessions
You can hide or show the toolbar by clicking on the
'Explore > Portals > Show Toolbar > Build' ribbon option
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Record & Analyze Toolbar
The Record & Analyze toolbar provides access to tools for
recording the execution of program source code. From this
toolbar you can:
· Begin manual or automation recording of the currently
active application
· Step through manual execution
· Generate Sequence diagrams from a recording session

Access
Ribbon

Explore > Portals | Show Toolbar |
Record

Record & Analyze Toolbar Options
Icon/Option

Action

Recorder
Command

Click on the drop-down arrow to show a
menu of commands for recording the
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List

execution of Analyzer scripts.

Recording

Click on this icon to begin or resume
recording of the current program.

Manual
Record

Click on this icon to manually step-record
the current thread.

Auto Record
Selected
Thread

Click on this icon to auto-record an
execution trace for the current thread.

Step Through

Click on this icon to step into a function,
record the function call in the History
window, and step back out.
The option is enabled for manual
recording only.
Shortcut: Alt+;

Stop
Recording

Click on this icon to end the recording of
program execution.

Synchronize
Model with
Source Code

Display the 'Synchronize Model' dialog
through which you can synchronize the
model with the code files generated
during a Record Profile operation.
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Notes
·

·

·

The toolbar can be docked to any main window edge or
floated freely in a convenient location for quick access
You can move this toolbar to any dockable position and it
retains that position in subsequent sessions
You can hide or show the toolbar by clicking on the
'Explore > Portals > Show Toolbar > Record' ribbon
option
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Debug Toolbar
The Debug toolbar provides access to tools for debugging
program source code. From this toolbar you can:
· Attach to running processes
· Open a number of debugger windows
· Run, pause or terminate program execution
· Step over, step into or step out of program statements

Access
Ribbon

Explore > Portals | Show Toolbar | Debug

Debug Toolbar Options
Icon/Option

Action

Drop-down
Command

Click on the drop-down arrow and select
options from the menu for attaching to a
running process and accessing a range of

(c) Sparx Systems 2022

Page 1039 of 1150

The Application Desktop

3 October, 2022

List

debugging windows.

Debug

Click on this option to begin or continue
execution of the current program.
Shortcut: F6

Pause-Resum
e

Click on this option to pause or resume
execution of the current program.

Step Over

Click on this option to step over the next
statement in the program.
Shortcut: Alt+F6

Step In

Click on this option to step into the next
function call in the program.
Shortcut: Shift+F6

Step Out

Click on this option to step out of the
current function call.
Shortcut: Ctrl+F6

Debug Stop

Click on this option to stop debugging the
current program.
Shortcut: Ctrl+Alt+F6
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Notes
·

·

·

The toolbar can be docked to any main window edge or
floated freely in a convenient location for quick access
You can move this toolbar to any dockable position and it
retains that position in subsequent sessions
You can hide or show the toolbar by clicking on the
'Explore > Portals > Show Toolbar > Debug' ribbon
option
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Collaborate Toolbar
The Collaborate Toolbar provides options to swiftly access
and switch between the communication and fact recording
facilities of Enterprise Architect, such as Model Mail,
Discussions and the Diary.

Access
Ribbon

Explore > Portals | Show Toolbar |
Collaborate

Collaborate Toolbar Options
Icon

Action

Show
Discussions

Opens the Discuss & Review window at
the 'Discuss' tab, for you to start or
respond to a discussion on the
currently-selected element or diagram.
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Chat

Opens the Chat & Mail window at the
'Chat' tab, for you to participate in an
exchange of brief comments on any
point, with members of one of the defined
user security groups.

Diary

Opens the Chat & Mail window at the
'Diary' tab, to maintain a daily diary in
which you can type all kinds of ideas,
comments, notes, suggestions, events,
to-do lists and other reminders of what
you have done or intend to do within the
model.

Model Mail

Opens the 'Mail' tab of the Chat & Mail
window, which provides you with the
ability to send, receive and respond to
emails within the project team under your
User Security ID, either as an individual
user or as a member of a group that has a
shared mail inbox.

Send
Message

Opens the 'Model Message' dialog
directly; you use this dialog to create,
address and send a Model Mail message.

Calendar

Opens the Project Calendar, defaulted to
today's date, on which you can check for
scheduled meetings and reminders of
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events, and add items for today or any
day in the future.
Model
Library

Opens the Model Library, which you use
to review and add to a
hierarchically-structured repository of
comments, reports, reviews and
documents on any structure, feature or
aspect of the project or of other, related
projects.

Notes
·

·

·

The toolbar can be docked to any main window edge or
floated freely in a convenient location for quick access
You can move this toolbar to any dockable position and it
retains that position in subsequent sessions
You can hide or show the toolbar by clicking on the
'Explore > Portals > Show Toolbar > Collaborate' ribbon
option
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Custom Draw Style Toolbar
The Custom Draw Style Toolbar provides access to a range
of facilities for applying a simple style of drawing to
segments of your model, rather than the formalized styles of
the notations such as UML, ArchiMate and SysML. These
facilities are essentially the shape and position options
provided by the full Custom Style Format toolbar displayed
on a diagram when Custom Styles are enabled.

The icons are highlighted on the Toolbar when at least one
element is selected in a diagram.

Access
Ribbon

Explore > Portals | Show Toolbar |
Custom Draw Style

Custom Draw Style Toolbar Options
Icon
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Hamburger

This icon offers the choice of enabling
Custom Styles for all elements on the
diagram or for just those that are
currently selected.

Shapes

This icon changes the shape of the
selected element. In the drop-down menu,
click on the appropriate shape option to
render the element as a:
· Rectangle (the default)
· Rounded-corner rectangle
· Ellipse (which you can drag into the
shape of a circle)
· Diamond
· Triangle or
· Polygon, with a submenu to define the
shape as having 5, 6, 7, 8, 9 or 10 sides
You can also select the 'Non' option to
restore the element to its native shape and
format.

Transparency

This icon sets the selected element shape
to be fully transparent (so that the
diagram background and any overlapped
elements show through) or at one of
various degrees of opacity that
overshadow the overlapped elements. If
you set 100% opacity, the element fill is
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solid and totally hides the background
and any overlapped elements.
Click on the drop-down arrow and select
from:
· 100% (fully opaque)
· 75%
· 50%
· 25% and
· 0% (fully transparent)
Text Position
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This icon sets the position of the element
name, stereotype and notes within the
element border. You can position the text
at nine points within the element shape,
or place it in a custom position.
From the drop-down list select from these
options:
· Top Left
· Top Center
· Top Right
· Left Center
· Center
· Right Center
· Bottom Left
· Bottom Center
· Bottom Right
· Custom
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If you select the 'Custom' option, the
element text is displayed as a label just
beneath the element, and you can drag it
to whatever position inside or outside the
element you prefer. You can also use any
of the standard label formatting facilities.
Text
Orientation

This icon sets the orientation of the text
within the element border, to either the
default horizontal line ('None') or to
vertical rotated clockwise or
anticlockwise (the base of each letter is
aligned with the left edge or the right
edge, respectively).

Icon Size and
Position

If the element has an icon (assigned by
dragging an Image Asset onto the
element shape), you can change the size
of the icon and/or its position within the
element border. Click on the toolbar icon
and select:
· 'Size', and select from these options:
- 16x16 pixels
- 24x24 pixels
- 32x32 pixels (the default)
- Image Size (the actual size of the
image in the source Image Asset; do
not select this option unless the image
is already small enough to act as an
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·

icon)
'Position', and select from these
options:
- Top Left
- Top Center
- Top Right (the default)
- Bottom Left
- Bottom Center
- Bottom Right

Border Style

This icon enables you to change the line
style of the element border. Click on the
drop-down arrow and select from:
· Solid
· Dashed
· Dotted
· Dashed-and-Dotted
· None

Stack
Element

This icon helps you to make one element
represent an abstract group of objects people, reports, deliveries - by adding
multiple frames behind the element
shape. When you click on this icon,
firstly select 'Stacks' and the number of
edges to add, between 1 (the default) and
4.
Then select 'Direction' and one of these
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options:
· NW (top left corner)
· NE (top right corner; the default)
· SW (bottom left corner)
· SE (bottom right corner)
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Publish Toolbar
The Publish Toolbar provides access to a number of
facilities for capturing details of your model structures in a
document or report for more general and external
distribution.

Access
Ribbon

Explore > Portals | Show Toolbar |
Publish

Publish Toolbar Options
Icon

Action

Generate
Documentati
on

Opens the 'Generate Documentation'
dialog, on which you specify the
parameters for generating a document on
the content of the selected Package in
PDF, RTF or DOCX format.
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Custom
Document

Prompts you to specify a name for a
custom Linked Document, held in a
Document Artifact element, into which
you can type, paste or link any material
you require on the selected Package. The
Document Artifact is created as a child
element of the selected Package.

Preview
Mode

Displays an instant dynamic document on
the selected element.

Publish As

Publish the currently-selected Package to
a file in one of a number of different
XML formats, for use in your preferred
external tool, such as Rational Rose.

Create a New
Document
File

Opens a new, blank, Linked Document in
the Document Editor for the selected
element or Package.

Reusable
Asset Service

Displays the Reusable Asset Service view
through which - if you working via a
connection to the Cloud - helps you to
connect to your Reusable Asset Service
registry and review the registry contents.

Save
Diagram

If you have a diagram open this icon
displays the 'Save as Image' browser,
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Image to File

which you use to create and save a file
containing an image of the diagram.

Print
Diagram

Print the current diagram on the
locally-defined printer.

(c) Sparx Systems 2022

Page 1053 of 1150

The Application Desktop

3 October, 2022

The Code Editors
Enterprise Architect provides a number of editors that you
can use across the development environment to maintain
scripts, code and templates. Each editor has its own features,
but they are all based on a common Code Editor control.
You can have several code editors (or files within a code
editor) open at the same time, as separate tabs in the
Enterprise Architect central work area (the 'Diagram View').
You can also close the editors individually or all together,
leaving views of other types (such as diagrams or Document
reports) still open.

Code Editors
Editor

Detail

Shape Script
Editor

When you create a Shape Script to alter
the appearance of an element or
connector through the use of a stereotype,
you create and edit the script using the
Shape Script Editor, which provides a
number of facilities including
Intelli-sense for Shape Script attributes
and functions.

Code

You use the Code Generation Template
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Generation
Template
Editor

Editor to create and edit templates that
control the generation of code from your
model elements. The facilities include
Intelli-sense for a wide range of macros.

Transformati
on Template
Editor

You use the Transformation Template
Editor to create and edit templates that
control the transformation of model
structures from one domain to another
(typically a generic domain to a code
language specific domain).

Custom SQL
Search Filter
Editor

The Custom SQL Search Filter Editor is
available through the Model Search
facility, to define your own SQL searches
for locating information in your model.

Database
View Editor

The 'Database View editor' is available
within the 'View definition' field of a
database View element 'Properties'
dialog. You create the View definition in
SQL, using Intelli-sense for basic SQL
keywords and functions.

HTML and
CSS Style
Editor

You use the HTML and CSS Style Editor
to create web style templates from which
to generate HTML reports. These
templates incorporate a large number of
HTML Template Fragments, which you
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edit to customize the reports for your
specific purposes.
Source Code
Viewer

You use the Source Code Viewer to both
display and edit the source code files that
you have generated or imported for an
element. The Viewer/Editor is quite
adaptable, and you can access it and use
it in different ways for different types of
source code file.

Script Editor

Enterprise Architect provides a flexible
and easy to use scripting capability to
create scripts in JavaScript, Microsoft
JScript or VBScript for programmatically
inspecting and/or modifying elements
within the currently open model. You use
the Script Editor to create and edit scripts,
and to run, debug and stop an open script.
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Customize the Desktop
As you work on your project, creating and reviewing model
structures, you can make use of a wide range of system
windows that help you locate and focus on particular types
of object or object property. To make your modeling tasks
even easier, you can fix these windows in a convenient
place on your screen, move them around, set them as
callable tabs or auto hide them.
Using Workspace Layouts, accessible from the Ribbon bar
or from the Portals, you can also quickly load different sets
of windows that target particular tasks. You can also save
your favorite layouts and recall them when required.
You can access these windows through ribbon options or
through keyboard key combinations. However, the fastest
way to select and open any window in Enterprise Architect
is to use the Quick Access panels, as described in the
Window Quick Access Help topic.
One of the strengths of Enterprise Architect is that you can
work in a central view and instantly view and edit aspects of
your model in one or more of the windows surrounding the
central view. Having completed your review in a window,
however, you can quickly switch focus back to the object
you were working on in the central (or 'active') view by
pressing Ctrl+Shift+` (effectively Ctrl+~).

Which are the Standard windows?
(c) Sparx Systems 2022
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Window

Description

Browser

The Browser window is the primary
mechanism for navigating through and
exploring your model and is the starting
point for many of the most important
features in Enterprise Architect. It lists
the model Packages, diagrams, elements
and element features in a hierarchical
structure, reflecting the arrangement of
Packages and elements within your
model.

Element
Browser

The Element Browser is the 'Details' tab
of the Inspector window. This is one of
the most useful and important
information displays in Enterprise
Architect. You can use the 'Details' tab to
summarize, review and manage a wide
range of properties and features of the
selected element, such as relationships,
operations, attributes, requirements and
maintenance items.

Properties

The Properties window provides an
immediate method of viewing and editing
the properties of a selected object element, diagram, connector, attribute,
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operation, Maintenance Item, Project
Item, test or associated file.
Notes

Notes are the main documentation feature
you use to describe an element, diagram,
feature or connector; in the
documentation that Enterprise Architect
generates, notes feature prominently. You
can record and view notes on a modeling
object using the Notes window.

Responsibiliti The Responsibility window is a tabbed
es
window through which you can quickly
add, view, edit and delete rules applied to
the selected element. The entities that
impose such rules are requirements,
scenarios, and constraints applied to the
element, and external files containing
information relevant to the element.
Traceability
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Using the Traceability window you can
quickly see what elements are
immediately linked to the selected
element and in what relationships, and
what elements are indirectly linked via a
chain of relationships. You can also
select a diagram and explore the
relationships of all elements in that
diagram.
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Relationships

The Relationships window lists all the
relationships of the currently-selected
element, and shows the properties of each
relationship.

Library
Window

The Library window provides a
structured internal forum that your team
can use to discuss aspects of the model
content and development.

Diagram
Toolbox

The Diagram Toolbox is a panel of icons
that you drag onto a diagram to create
elements and connectors. Related
elements and connectors are organized
into Toolbox pages, each page containing
the elements or connectors used for a
particular type of diagram.

Diagram
Filters

You use the Filters & Layers window to
modify the display of diagram
components so that relevant items are
immediately identified for the reader's
attention, without damaging the structure
and integrity of the model.

Layout
Diagrams

The Layout Diagrams window provides a
set of diagram layout formats that you
can apply to a diagram you have created,
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to automatically reorganize the layout to
make it more readable.
Pan and
Zoom

The Pan and Zoom window enlarges the
current diagram by a percentage you
define, and displays a thumbnail view of
it with a shaded rectangle. As you move
the shaded rectangle with the mouse, the
diagram shows the magnified items of the
structure underneath the rectangle.

Resources

The 'Resources' tab of the Browser
window provides useful shortcuts and
re-use functions for creating and applying
stock components in the current model.
The tab contains a tree structure of
document templates, Relationship Matrix
profiles, stylesheets, patterns and
commonly-used model elements. The tab
can also provide access to UML Profiles
and MDG Technologies, although this is
not the recommended route to these
facilities.

Source Code
Viewer

The Source Code Viewer window
displays the generated source code for a
selected Class element, and provides a
number of facilities for editing that
source code.
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Scripting

The Scripting window hosts a flexible
and easy to use scripting capability to
create scripts in JavaScript, Microsoft
JScript or VBScript. Using a built in
'Repository' object, you can
programmatically inspect and/or modify
elements within the currently open
model. The window provides tools to
edit, run, debug and manage your scripts.

Debug

The Debug window provides a set of
facilities for starting, managing and
halting a debug session on the code
generated from elements of your model.

Maintenance

The Maintenance window, or workspace,
lists the maintenance records (features,
changes, documents, issues, defects and
tasks) for a selected element, ready for
modification or addition. The window
provides several facilities for managing
the maintenance records.

Project

The Project Tools window provides
facilities to record and manage the
events, decisions, effort, risk and metrics
associated with the work in developing
the area of the model represented by the
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selected element.
Testing

The Test Cases window, or workspace,
lists the test records for a selected
element, ready for modification or
addition. The window provides several
facilities for managing the test records.

Learning
Center

The Learning Center provides quick
access to a range of context-specific task
guides in a number of work areas of the
system, such as Getting Started,
Modeling or Testing.

Notes
·

On the Testing, Maintenance and Project Tools windows,
any descriptive text, history, input or results for a selected
item are also displayed in the Notes window
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Visual Styles
It is possible to change the overall style and color of the
Enterprise Architect user interface to match the standard
styles (or themes) of a number of Microsoft Office and
Visual Studio product releases. The styles are applied
uniformly across all displays, dialogs, windows, views and
ribbons.
To test the style that you are selecting, simply click on the
Apply button.
This image illustrates the 'Microsoft Office 2016'® style,
using different themes and accent colors.

Access
Ribbon
(c) Sparx Systems 2022

Start > Appearance > Visual Style
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Reset the style of the user interface
Define the visual style you want to use, on the 'Application
Look' dialog.
Option

Action

(top field)

Click on the drop-down arrow and select
the application style you want to apply.

Theme

For certain application styles, you can
also apply a color theme.
If this field is enabled, click on the
drop-down arrow and select the required
theme color or tone.

Accent Color

For certain application styles, you can
also change the accent color for messages
and highlights.
If this field is enabled, click on the
drop-down arrow and select the required
accent color.

Code Editor

Click on the drop-down arrow and select
an option to apply, within the code editor
views:
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The automatic default background
color of the code panel for the
application style
· A dark background for the code panel,
or
· A light background for the code panel
You can also re-set the dark and light
backgrounds on the 'Editor Language
Properties' dialog.
·

Diagram

Defaults to the diagram theme currently
set in the 'Preferences' dialog.
If you want to apply a different diagram
theme, click on the drop-down arrow and
select the required theme.

Workspace
Orientation

Many of the workspace layouts have a
left orientation or a right orientation, most
easily observable in the side of the screen
that the Browser window displays on.
You can use this 'Workspace Orientation'
field to specify the orientation you prefer
- click on the drop-down arrow and select
either 'Left' or 'Right' to automatically
position the Browser window and related
displays in your preferred workspace on
the corresponding side of the screen.

Default Note

Click on the drop-down arrow and select
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Zoom

the percentage zoom or magnification
(from 90% up to 150%) to apply to the
text in the element Notes window and
any text field that has the Notes toolbar at
the top. The field defaults to 110%.

Note Editor
Font

If the text in the Notes window, 'Notes'
fields and 'Description' fields does not
render as well as you would like, you can
change the font used. Click on the
drop-down arrow and click on an
appropriate font.
To apply the change, restart Enterprise
Architect.
If you decide to revert to the default font,
click on the Clear button and again restart
Enterprise Architect.

Internal Tab
style (restart)

Click on the drop-down arrow and select
the required style to apply to the internal
tabs of docked windows. The option does
not affect the internal tabs of views or
dialogs, nor does it change the tabs of the
Browser window or Database Builder.
The different types of style make the tabs
display with - for example - rounded or
squared-off corners, with a 2D or 3D
effect, overlapping or with a common
border, or with a colored underline.
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Docked windows that contain a shared
horizontal scroll bar (such as the System
Output window or Find in Files window)
will only change to the Pointer style,
where the tabs have no outline but do
have an arrow shape in the line
underneath the tab. Otherwise they keep
the Flat style (flattened pyramid shape).
When you have made your selection, you
must re-start Enterprise Architect to bring
this style into effect.
Show Menu
Icons

Select this checkbox to display icons next
to the menu options (where they have
been assigned).
Deselect the checkbox to hide the icons
and show simple lists of text options.

Main View
Tabs use
Caption style

Select this checkbox to display the icons
and names of the main view tabs in a
larger format.

Main View
Tabs at
bottom
(restart)

When a main view has tabs, by default
the tab names display at the top of the
view.
If you prefer to display the tab names
along the bottom of the view, select this
checkbox.
The change does not take effect until you
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shut down and restart Enterprise
Architect.
Property
Sheets use
Tree style

By default 'Properties' dialogs and
various other screens present sections of
data on tabs.
If you prefer to display the sections of
data on dialog pages, where you choose
the pages from a tree or hierarchy on the
left of the dialog, select this checkbox.

Use Property
List for
Elements

By default element 'Properties' dialogs
show the main properties as a series of
fields on the right of the dialog.
If you prefer to display the properties as a
simple list of names and editable values,
select this checkbox.

Increase Note Increases the paragraph spacing from the
Paragraph
default, in all new text in the element
Spacing
Notes window and all text fields with the
Notes toolbar at the top. The change is
applied to all paragraph styles, including
bullet and number lists.
The paragraph spacing is increased in
existing text when you open and close a
dialog containing that text.
When you deselect the option, all new
Notes text reverts to the default spacing.
(c) Sparx Systems 2022
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Enable
Concise
Diagram
Navigation

Enable diagram navigation elements such
as a Nav Cell, Diagram Hyperlink,
Package with a child diagram and others
to open a diagram (and replace the
current diagram) in the active tab. You
can move back through previously
opened diagrams using the Backspace
key or by clicking the back arrow on the
right of the diagram tab. The same
behavior is available when a diagram is
floated.
When this option is enabled, you can also
click on a Composite element and press
the = key to open the Composite diagram
in the same tab. In this case, if you press
the Backspace key to return to the parent
diagram, the Composite element remains
selected.

OK

Click on this button to save and apply the
changes, and close the dialog.

Cancel

Click on this button to cancel the changes
and close the dialog.

Apply

Click on this button to apply the changes
but keep the dialog open for further
editing.
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If a change takes immediate effect, you
can see it on any open windows and then,
if you prefer something different, change
the setting.
If you click on the Apply button and the
Cancel button, the changes still take
effect.
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Docked Windows
When you are doing work using one or more of the
Enterprise Architect windows, you can re-position and/or
group the windows to make them easier to use. You can
easily move any window around the application workspace
and either dock (anchor) it against the top, bottom, left or
right edge of the workspace for long-term use, or just drop it
where it is most convenient for the moment (that is, leave it
floating).
All the windows are resizable, so you can also drag the
window margins to make the window a convenient size and
shape to display either just a column or row, or a large
section of the information it contains.

Dock a Window Against an Edge
Notice that the window docking is an insert, not an overlay;
in the illustration (step 3), the left border of the Start Page is
moved to sit just under the 'ticked man' icon in the toolbar.
The docking behavior varies depending on whether you
have already docked other windows on the screen, whether
you use the navigation compass or the compass point icons,
and where you drag the docked window before you release
the mouse button. If you drag and release the window over:
· A point of the navigation compass in the center of the
screen, the window sits inside existing docked windows
(c) Sparx Systems 2022
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(for example, in the illustration a window released on the
bottom, top or left icons of the navigation compass would
be docked to the right of the Traceability window)
· A separate compass point icon on the edge of the screen,
the window is docked on the outside edge of the screen
and existing docked windows are pushed inwards
· A point of the navigation compass at the edge of the
screen (only when there is already a docked window
there) the window is docked within the area occupied by
the previously docked window (for example, in the
illustration you could dock your new window as the left,
right, top or bottom segment of the Traceability window
space; the Traceability window itself is reduced in size to
accommodate the new docked window, but you can then
adjust the margins of the two docked windows to improve
readability)
· The center of the navigation compass at the edge of the
screen (only when there is already a docked window
there) the window is docked as a tab of a window frame;
see Dock Windows into a Frame
The highlighted area always indicates exactly where the
moved window will be docked, so you have an indication of
the effect before you release the window.
Ste Action
p
1

Click on the title bar of the window and start to drag
it towards the appropriate edge of the workspace. A
set of positioning icons display, consisting of a
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navigation compass in the body of the application
workspace and a compass pointer in the middle of
each edge.

2

Drag the window onto a compass point.
The screen display shades the area that the window
will fill, once you release the mouse button. Notice
in this screen capture that the left-hand quarter of the
compass has thickened borders, indicating that the
window has been dragged over it.

3

Release the mouse button to dock the window.
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The docked window initially fills the
previously-highlighted space, but you can drag the
margins to resize the window, if required.

Dock Windows into a Frame
A docked window does not overlap any other window, so if
you are docking several windows you progressively fill up
the workspace; however, you can avoid this by combining
the docked windows in a single tabbed frame by either:
· Dragging the title bar of each window up to the title bar of
the first docked window, or
· Dragging each window over the 'tabbed frame' icon in the
(c) Sparx Systems 2022
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middle of the navigation compass, when the compass is
over the previously-docked window that you want to
combine the dragged window with; when you release the
mouse button, the window becomes a tab of the frame
Initially, the window you are moving is visible with the
tabbing compass.

Notice that the center of the compass has a square inside it,
and the tabbed frame shows the names of the windows it
currently contains. As you move the new window over the
square in the center of the compass, it disappears but its
name is added as a tab of the frame.
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When you release the mouse button to finish dragging the
window into place, the compass disappears and the window
displays as a tab of the frame.
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You can move and re-dock the frame of windows as if they
were a single window.
To separate a window from a tabbed frame, click on the
window's tab at the bottom of the frame and drag it away.

Close Docked Windows
If you do not want to have a docked window open any
longer, click on the window header and press Ctrl+F4. This
just closes the selected window; if the window is in a tabbed
frame, the other windows in the frame remain open.
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Floating Windows
To float a window anywhere on the screen, click on its title
bar and drag it to where you want it to sit. The navigation
compass displays, but you ignore it in this situation.
Floating windows can overlay each other, which is
convenient if you want to compare information displayed in
two windows. You can drag one window under or over
another so that the relevant pieces of information are
adjacent, do your check, then move the windows apart
again.
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Auto Hide Windows
If you are using docked windows, you can have them
available for use but kept minimized or hidden until you
actually need to use them. The windows are represented by
tabs in the top, bottom, left or right margins of the work
area. In the illustration, the Browser window is the open
hidden window with the Focus window, Inspector window,
Properties window, Discuss & Review window and
Diagram Toolbox hidden in the margin.
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When you move the cursor over the tab, the window
overlays the screen and you can work within it. As soon as
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you move the cursor out of the window, it automatically
contracts into the margin tab again. This means that you
have the maximum work area for performing your main
task, with the convenience of still being able to immediately
use any of a wide range of other windows.
If you 'hide' a tabbed frame of docked windows, those
windows are hidden together in one click. Each window
behaves in the same way as before, but if you cancel auto
hide on one of them they are all released.
When you cancel the auto hide on a docked window (or a
frame of windows) it will persist on the screen as an insert
(pushing visible window borders across to take up some of
the display) when you select it.

Auto Hide a Window or Set of Windows
·

·

To set the displayed window to 'auto hide', click on the
button in the top right corner of the window; any other
windows in the same frame as the open window are set to
'auto hide' as well
To turn off 'auto hide' for a particular window, or set of
windows within a frame, click on the button

Notes
·

You can only auto hide docked windows; if you want to
auto hide a floating window, dock it against a margin first
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When you select an auto hidden window, it immediately
displays against the nearest work area margin; you can
make the auto hidden window slide out of and into the
margin by selecting the 'Animate Autohide Windows'
checkbox on the 'Window Behavior' page of the
'Preferences' dialog ('Start > Appearance > Preferences >
Preferences > General > Window Behavior')
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Advanced Customization
Enterprise Architect has a standard style and appearance,
which you can customize to suit your own work
environment. Several facilities are available for
customizing:
· The means of issuing commands to the system - such as
ribbons, toolbars and keyboard keys - and the commands
themselves
· The visual style and color of the user interface
· The windows you want to display together on the screen,
and their position on the screen (the 'Workspace Layout')
On occasion, you might want to use Enterprise Architect for
two distinct types of operation at the same time. You can do
this by storing registry settings - such as window layouts - to
a different path in the registry, by adding this command line
argument when you run Enterprise Architect:
/regkey:<regkeyname>
You can also configure a wide range of local options and
specific settings for using Enterprise Architect on your
workstation, through the 'Preferences' dialog. These options
apply to all models that you work in using Enterprise
Architect on your workstation.
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Customize Dialog
It is possible to customize the Enterprise Architect toolbar
and keyboard commands and how they are displayed and
made available to you, tailoring the user interface to suit
your work methods and environment. You can also define a
number of external applications that you can activate from
the 'Tools' menu. You perform these tasks using the
'Customize' dialog.

Access
Ribbon

Start > Application > Preferences > Other
Options

Other

At the far right of any toolbar, click on
the drop-down arrow and on the 'Add or
Remove buttons | Customize' option

Notes
·

If a documented toolbar icon, keyboard combination or
menu facility does not appear to be available, select the
appropriate tab and click on the Reset button or Reset All
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button to restore the toolbar, menu or key settings to the
defaults; however, this also removes any customized
icons, options or combinations you might have set,
because it is possible that the customization itself has
displaced or affected the default setting
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Customize Commands
The Enterprise Architect toolbars provide a wide range of
functions, some of which are useful in several different
contexts. You might find it more convenient to have a
function command available either from a different toolbar
to the one it is currently set in, or from more than one
toolbar. You can customize which toolbar a command is
available from by generating a button or icon for the
command on either another existing toolbar or a new toolbar
that you create for this purpose. Conversely, you might
remove a command from its current toolbar, to simplify the
selection of tools from that toolbar.

Access
Ribbon

Start > Application > Preferences > Other
Options > Commands

Manage Toolbar Commands
Task
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Add
Also display the appropriate toolbar,
Command To using:
Toolbar
· 'Explore > Portals > Show Toolbar >
<toolbar name>
The toolbar icons are then highlighted
with a dark border as you select them.
On the 'Commands' tab:
1. Click on the appropriate command
category in the 'Categories:' panel.
2. Click on the command you need from
the list in the 'Commands:' panel.
3. Drag the command onto the toolbar; it
is immediately placed in the toolbar at
the cursor position.
4. Add any further commands you want.
5. Put the icons in the order you prefer,
by dragging each icon into position.
6. Click on the Close button to close the
'Customize' dialog.
7. If necessary, resize the toolbar or drag
it back into the top of the screen.
If the command has an associated icon,
the icon displays in the toolbar;
otherwise, the command name displays.
Delete
Command
from Toolbar
(c) Sparx Systems 2022

While the 'Customize' dialog is displayed,
right-click on the command icon or text
in the toolbar, and select the 'Delete'
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option. The command icon is
immediately removed from the toolbar.
The context menu does not display if the
'Customize' dialog is closed.
Change or
assign icon
for command
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All commands listed in the 'Customize'
dialog have a text label, and many have
associated icons, either system-defined
(default) or user-defined. If the command
has an icon, you can select to represent
the command in the toolbar by:
· The icon
· The text
· Both together
You have a range of other options for
changing how the command is
represented in the toolbar, such as:
· If the command does not have an
associated icon, assign one from an
image library
· Change the icon currently assigned to
the command to a different icon
· If the command has a system default
icon and you have changed it, restore
that default icon to the command
· Edit the icons in the library, and create
new ones; you can also copy an
existing icon and edit the copy
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These options are available through a
context menu that you display by
right-clicking on the icon in the toolbar
while the 'Customize' dialog is displayed.
The context menu does not display if the
'Customize' dialog is closed.
The changes apply only to the selected
toolbar. Any instances of the command in
other toolbars or menus are not affected.
Toggle
1. Right-click on the command icon or
command
text in the toolbar.
button
2. Select the context menu option you
between icon,
need - 'Image', 'Text' or 'Image and
text and both
Text'.
If the option has an icon, the selected
change is made. If the command has no
icon, the 'Button Appearance' dialog
displays. You can also toggle between the
image/text options on this dialog.
Assign icon
to command

(c) Sparx Systems 2022

3. Right-click on the command icon or
text in the toolbar.
4. Select the 'Button Appearance' option;
the 'Button Appearance' dialog
displays.
5. Select either the 'Image only' radio
button or the 'Image and text' radio
button.
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6. For a command with a default icon, the
'Use Default Image' radio button is
followed by the default icon; if you
have assigned a different image, you
can restore the default by selecting this
radio button.
Otherwise, select the 'Select
User-defined Image' radio button, and
click on an appropriate image from the
selection provided. You can add or edit
images in this selection.
7. Click on the OK button to apply the
changes to the toolbar.
(You can also restore the default icon by
right-clicking on the current icon in the
toolbar and selecting the 'Reset to default'
option.)
Copy a
toolbar icon

8. Right-click on the icon in the toolbar.
9. Select the 'Copy Button Image' option;
the image is copied to the clipboard.

Create and
edit icons

10. Right-click on the command graphic
or text in the toolbar.
11. Select the 'Button Appearance' option;
the 'Button Appearance' dialog
displays.
12. Select either the 'Image only' radio
button or the 'Image and text' radio
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button.
13. Select the 'Select User-defined Image'
radio button.
14. To create a new image, click on the
New button; to edit an existing
user-defined image, click on the image
and then on the Edit button.
The 'Edit Button Image' dialog
displays.
15. If you have copied another icon to edit
as a new icon, click on the Paste button
in the 'Tools' block.
16. Select a color and the appropriate
painting tool - the 'pencil' fills
individual squares, the 'filler' fills the
whole 'Picture' block, and the 'line'
creates lines of two or more squares
thick.
17. Create or edit the icon, working right
up to the border of the 'Picture' block if
necessary.
18. Click on the OK button to apply the
changes to the toolbar.
Change icon
text label
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19. Right-click on the command graphic
or text in the toolbar.
20. Select the 'Button Appearance' option;
the 'Button Appearance' dialog
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displays.
21. Select either the 'Text only' radio
button or the 'Image and text' radio
button.
22. In the 'Button text' field, highlight and
delete the existing text and type in the
new text.
23. Click on the OK button to apply the
changes to the toolbar.
Group Icons
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If necessary, you can indicate that the
command icons are arranged in groups.
To do this:
24. While the 'Customize' dialog is
displayed, right-click on the first
command icon or text in the group in
the toolbar, and select the 'Start Group'
option.
A vertical line displays to the left of the
icon. All icons to the right of the line
form a group, up to any subsequent line.
To remove the line and cancel the
grouping, repeat the step.
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Customize Toolbars
As well as tailoring the commands that are available through
the toolbars, you can modify the toolbars themselves; for
example, you can:
· Hide or show toolbars by selecting the appropriate
checkbox
· Rename toolbars
· Create new toolbars
· Delete toolbars
· Modify toolbar contents by dragging commands onto a
visible toolbar from the 'Commands' tab or from another
toolbar
· Reset a toolbar (or all toolbars) to the default contents and
position, and
· Display text labels under the toolbar icons, to indicate
what the icons do

Access
Ribbon
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Start > Appearance > Preferences > Other
Options > Toolbars : New
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Create a New Toolbar and Populate it with
Commands
Ste Action
p
1

In the 'Toolbar Name' field, type a name for your
new toolbar and click on the OK button.
Your new toolbar is created. The toolbar and
'Customize' dialog are independently positioned, so
you might have to drag the 'Customize' dialog to one
side to expose your new toolbar.

2

If you want to display the name of each command
you put into your toolbar, select the 'Show text
labels' checkbox.
Otherwise leave the checkbox unselected.

3

To add commands to your new toolbar from another
toolbar, see step 6.
To add menu commands to your toolbar, click on the
'Commands' tab.
The 'Categories' list on the left of the tab represents
the Enterprise Architect menu structure. The
'Commands' list contains the commands in the
selected category; the list updates when you click on
a different category.
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4

Find and click on the command to add to your
toolbar in the Commands list.

5

Drag the selected command from the list into the
new toolbar.
If you selected the 'Show text labels' checkbox, your
toolbar should now resemble this:

If you did not select the 'Show text labels' checkbox,
your toolbar should resemble this:

6

If the command you require is on another toolbar,
display that toolbar and drag it to a position near
your new toolbar.
Press Ctrl and drag the required icon for the
command from the existing toolbar onto your new
toolbar.

7

Repeat steps 3 to 6 for each command that you want
to make available in your new toolbar.
When you have finished, click on the Close button
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on the 'Customize' dialog and drag your toolbar into
the toolbar ribbon or to any other convenient
position for you to use.

Notes
·

·

You can add as many commands to your toolbar as you
need; your new toolbar behaves the same way as other
toolbars - you can position it next to the other toolbars at
the top of the application workspace, dock it to the side of
the workspace or close it
You can also modify the display of toolbar options using
the 'Options' page of the 'Customize' dialog
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Add Custom Tools
You can extend the power of the Enterprise Architect
desktop by making external tools accessible from the
ribbons. You can create options that hyperlink to different
applications, compilers, batch scripts, automation scripts,
URLs or documentation. The tools can be either
commercially available or those you have configured
yourself.

Access
Ribbon

Start > Appearance > Preferences > Other
Options > Tools :

Add and configure custom tools
Option

Action

Menu
contents

In the boxed, blank field in the list, type
in the name of the tool as it should appear
in the menu.
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Command

Either:
· Type the name of the tool .exe file to
use, or
· Click on the
button and browse to
the file location
The .exe file must have a valid filename.

Arguments

Type in any arguments required by the
tool

Initial
directory

(Optional) Type in the location of an
initial directory.

Close

Click on this button to close the
'Customize' dialog.
Your tool is added to the 'Tools' menu.
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Open External Tools
When configuring custom tools in Enterprise Architect, by
selecting 'Start > Appearance > Preferences > Other Options
> Tools', you can:
· Specify the custom tool (application) using the
'Command' field
· Define a file to open using the 'Arguments' field

Example 1
This configuration opens the file c:\Temp\Customer
Account.cls using Wordpad. If you save from within
Wordpad the initial directory is c:\Temp.

If there are any spaces in the paths in the 'Command',
'Arguments' or 'Initial directory' fields, you must enclose the
(c) Sparx Systems 2022
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whole path in double quotes. For example:
"c:\Temp\Customer Account.cls" must have quotes, but
c:\Temp\CustomerAccount.cls does not have to have quotes

Example 2
This example opens the file c:\Temp\Customer Account.cls
using Visual Basic (VB). As VB is not installed with the
operating system, the whole file path for VB must be
included in the 'Command' field; you can locate and select
this path using the button. Again, if you save from within
VB the initial directory is c:\Temp.
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Pass Parameters to Applications
When configuring custom tools in Enterprise Architect, by
selecting 'Start > Appearance > Preferences > Other Options
> Tools', you can define parameters to pass to an external
application using the 'Arguments' field.

Available parameters
Parameter

Passes

$f

A project name.
Notes: For example,
C:\projects\EAExample.eap

$F

The calling application.
Notes: That is, Enterprise Architect.

$p

The current Package ID.
Notes: For example, 144.

$P

The Package GUID.
Notes: A GUID for accessing this
Package.

$d

The diagram ID.
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Notes: An ID for accessing the associated
diagram.
$D

The diagram GUID.
Notes: A GUID for accessing the
associated diagram.

$e

A comma separated list of element IDs.
Notes: All elements selected in the
current diagram.

$E

A comma separated list of element
GUIDs.
Notes: All elements selected in the
current diagram.
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Customize Keyboard Shortcuts
Various context menu options can also be invoked using a
single keyboard key, or a combination of keys, referred to as
shortcuts. You can assign your own shortcut keys to either
the standard options or your customized options, to suit your
work practices or other applications.

Access
Ribbon

Start > Appearance > Preferences > Other
Options > Keyboard

Create or modify a keyboard shortcut
Option

Action

Category

Click on the drop-down arrow and select
the name of the context menu containing
the command to assign a shortcut to.

Commands

Scroll through the list of commands and
click on the one to assign the shortcut
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key(s) to.
If the command already has a shortcut
key it is shown in the 'Current Keys' field.
Press New
Shortcut Key

Click on this field and press the shortcut
key(s) to assign to the command.
Press the actual keys to use; for example,
to assign F5 press the F5 key, do not
press F and then 5.

Assign

Click on this button to assign the key to
the command.
The button is disabled if the selected
keyboard shortcut is already used for
another command; if this occurs the
command it is assigned to is shown in the
'Assigned to' field, and you must select a
different shortcut key.

Remove

To remove a shortcut, select it in the
'Current Keys' field and click on this
button. The shortcut is immediately
removed.

Reset All

Click on this button to reset all
commands to the default set of shortcut
keys. All keys that you have assigned are
removed.
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Click on this button to close the dialog,
saving all keys that you have assigned.

Notes
·

·

It is simpler to have one shortcut per command, although
you can assign more than one shortcut if necessary
Modified shortcut keys are stored in the registry, so they
are available only to you and not to other users
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Customize Submenus
It is possible to customize your submenus to add or remove
shadow around the outline of each menu and to apply
animation to the way in which the submenus are opened.

Access
Ribbon

Start > Appearance > Preferences > Other
Options > Menu

Animate Menu Display
Option

Description

Menu
animations

Click on the drop-down arrow and select
one of the options:
· None - the menus are instantaneously
displayed on selection
· Unfold - the menus unfold from the top
left corner diagonally downwards
· Slide - the menus slide out from the top
downwards
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·

Fade - the menus fade in
[Default] - similar to Fade

Menu
Shadows

Select the checkbox to display a shadow
along the right and lower edges of the
menu.
Clear the checkbox to display menus with
no shadow on the borders.

Close

Click on this button to close the
'Customize' dialog.
Your animation options take effect on the
menus.

Notes
·

When you perform a major upgrade of the system (such as
from release 12 to 13) the menus are reset and deleted
options are replaced.
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Customize Options
It is possible to customize the entire set of Toolbars to
display with large icons, and/or show a Screen Tip as you
mouse over each toolbar icon. The options take effect
immediately, so you can see what impact they have before
closing the dialog.

Access
Ribbon

Start > Application > Preferences > Other
Options

Customize Toolbar Display
Option

Description

Show Screen
Tips on
Toolbars

Select this checkbox to display a Screen
Tip as you mouse over each toolbar icon,
if a Screen Tip is defined for the icon.
The screen tip is predefined in Enterprise
Architect and cannot be edited.
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Show
shortcut keys
in Screen
Tips

If you have selected to show Screen Tips,
select this checkbox to include any
shortcut key combinations in the Screen
Tip text.
The shortcut keys are editable, and you
can add, change or remove the keys
assigned to any of the commands
represented by an icon. The current
shortcut key combination is added to the
Screen Tip text.

Large Icons

Select this checkbox to enlarge all the
Toolbox icons. This takes effect
immediately, so that you can see how the
display changes.

Close

Click on this button to save and commit
the settings.
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Workspace Layouts
As you perform work on your model you use various
toolbars and windows; you will quite likely use the same
toolbars and windows regularly, in an arrangement that suits
the way in which you use the system. Rather than having to
re-open and arrange these tools at the start of each work
session, you can use either a predefined or a customized
work environment or workspace.
Workspaces:
· Automatically open and organize all the tools appropriate
to an area of work such as Requirements Management,
Code Engineering and Debugging
· Help a new user by:
- Opening the tools that are appropriate to a task so
that they can immediately get started, and
- Showing the user what tools they should become
familiar with for that area of work
· Help you switch rapidly to work environments for either
successive or completely different areas of work
· Re-establish a work environment that you have
accidentally or deliberately changed
To select, create and maintain workspaces you use the
'Workspaces' page of the 'Workspace Layout' dialog, which
lists the currently-available system and user-defined layouts.
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Access
Ribbon

Start > All Windows > Workspace >
Workspace Tools > Workspaces

Manage Layouts
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Task

Description

Change
workspace
layout

The 'Last Applied Workspace' field at the
bottom of the 'Workspace Layout' dialog
identifies the layout last selected, before
any changes you might have made.
You can change the layout to:
· The original layout (as identified by the
'Last Applied Workspace' field),
discarding any changes you might have
made, by clicking on the Restore
button; alternatively select the 'Load
workspace on startup' checkbox to
restore the original workspace when
Enterprise Architect is next started
· One of the other named layouts, or
· A new named, customized layout,
capturing the current screen layout and
including any changes you have made
to the previously-applied layout
To change the layout in use, either:
· Click on the preferred layout name and
on the Apply button, or
· Double-click on the required layout
name, or
· Right-click on the layout name and
select the 'Apply' option
If you want to experiment with layouts,
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clear the 'Close on Apply' checkbox. This
allows you to see what effect changing
the workspace has, but keep the
'Workspace Layout' dialog open so that
you can try another workspace or restore
the original one. When you have chosen
the required workspace, reselect the
checkbox so that the 'Workspace Layout'
dialog closes when you click on the
Apply button.
Copy
workspace
layout

Right-click on the layout name and select
the 'Copy As New' option
The 'Save Custom Workspace Layout'
dialog displays.
In the 'Custom Workspace Layout' field,
type a name for the layout. By selecting
an existing name you can change an
existing layout to something different.
Click on the Save button.
If you already have tailored windows or
views open that you want to include in
your selected layout, select the 'Include
active custom views' checkbox.

Delete
workspace
layout

Right-click on the (custom) layout name
and select the 'Delete' option. A prompt
displays for you to confirm or cancel the
deletion.
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Notes
·

·

If you apply a working set that invokes floating diagrams
or views, it will override the current workspace layout
with the layout that was in use when the working set was
defined
If you develop a workspace layout that would be useful
for your colleagues, you can share it with them by
incorporating it in an MDG Technology that they can
download
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The Portals Bar
The Portals provide a high level, logical grouping of
Enterprise Architect's tools and facilities, to form an entry
point into specific features that you might need to apply.
They provide access to common tools, custom searches,
window layouts and Perspectives. For example, if you want
to run searches for particular information in the model, or
access the windows that are appropriate to a particular set of
actions, you can select a Portal to identify and provide
access to those facilities. This makes it easier to set up a
work environment within the system, and carry out your
tasks in a smooth sequence.

Access
Ribbon

Explore > Portals > <select Portal>
Start > Application > Design > Portals :
<Portal> button | <Portal>

Keyboard
Shortcuts

Shift+Alt+P

Other
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:
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The Portals window
The Portals window displays on either the left- or right-hand
side of the Enterprise Architect work area. It contains the
currently-selected Portal and, under the title bar, a Portal
selection button for changing the selected Portal.
Once the Portals window is displayed, it remains visible
until you specifically select to hide it, or to auto hide it as a
tab on the side of the display, using the Portals window
context menu options (see the Portals Window Context
Menu table later in this topic).

Portals
The system currently provides eight Portals, each consisting
of a collapsible hierarchy of option groups and options. If a
Portal is too long to display the entire contents at once, a
scroll button displays at the top and/or bottom of the Portal.
Click on these buttons to scroll the Portal contents up or
down (or use the scroll wheel on your mouse, or the
keyboard arrow keys).
Portal

Description

Recent

Provides links to recently viewed
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Places

diagrams, documents and files. Links are
grouped into these categories:
· Current Diagrams
· Recent Diagrams
· Documents
· Recent Files

Workspaces

Provides links to the system-provided
workspaces that you might use to lay out
the Enterprise Architect work area, and to
any workspaces that you have created
yourself. The categories provided are:
· Customized ('My Workspaces')
· Core
· Design
· Software
· Simulation
· Construction
· BABOK

Perspectives

Provides a wide range of model Patterns
from which you can generate model
structures for particular areas of work.
The Patterns are organized into groups
within Perspectives, and presented for
selection through the Start Page 'Create
from Pattern' tab (Model Wizard), and
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through the 'New Diagram' dialog.
Windows

Provides links to the Enterprise Architect
windows that you might use. The
windows are grouped under the areas of:
· Exploring the model
· Properties
· Diagrams
· Specialized Tools
· Trace
· Collaborate
· Test
· Task
· Maintenance
· Templates

Extend

Lists the MDG Technologies currently
active in your model - such as ArcGIS or
NIEM - and for each one provides links
to the facilities for working with those
technologies within Enterprise Architect.

Execute

Provides a wide range of options that
help you to:
· Perform Execution Analysis on your
model - building and running the
Analyzer scripts
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·

·

Record, Profile, Debug and Simulate
the execution of your modeled
application
Access various windows that display
specific aspects of debugging and
simulating an application
Create and edit code for your
application

Guidebook

Provides links to the library of Enterprise
Architect User Guides in PDF format.
The Portal initially displays with ten
categories of document, each of which
can be expanded to a list of the PDF
documents in that category.

Learning

Provides links to either the web version
of the Enterprise Architect User Guide,
or the locally-installed Help if you have
downloaded that. The Portal also
provides links to a number of useful web
pages on the Sparx Systems website, such
as the Resources, Tutorials, Webinars and
Video Demos pages.

Portals Window Context Menu
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Right-click on the Portals window title bar to display the
context menu. You can select the options in this table:
Portal

Description

Dock Left

Docks the Portals window on the left
hand side of the work area.

Dock Right

Docks the Portals window on the right
hand side of the work area.

Auto Hide

Condenses the Portals window to a tab on
the edge of the work area. Mouse-over
the tab to re-open the Portals window,
move the cursor off the window to return
it to a tab.

Hide

Hides - and effectively closes - the
Portals window. To re-open the window,
select the appropriate option under the
'Explore > Portals' ribbon icon or the
appropriate icon on the Start page.

Auto
Collapse
Groups

Automatically collapses the
currently-selected group of options when
you expand another group.

<list of
portals>

If you right-click anywhere in the Portals
window other than the window title, the
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list of Portals displays. Click on a Portal
name to change to that portal in the
window.
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Recent Places Portal
Provides links to recently viewed diagrams, documents and
files. Clicking the link will re-open the selected item in the
appropriate window. Links are grouped into these
categories:
· Current Diagrams
· Recent Diagrams
· Documents
· Recent Files

Access
Ribbon

Explore > Portals | Recent Places

Keyboard
Shortcuts

Shift+Alt+P :
Places

Other
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Workspaces Portal
Provides links to the system-provided workspaces that you
might use to lay out the Enterprise Architect work area, and
to any workspaces that you have created yourself. The
categories provided are:
· Customised ('My Workspaces')
· Core
· Design
· Software
· Simulation
· Construction
· BABOK

Access
Ribbon

Explore > Portals > Workspaces

Keyboard
Shortcuts

Shift+Alt+P :
Workspaces

Other
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Facilities
Category

Options

My
Workspaces

This section provides the Workspaces
that you have customized for your
particular use on the 'My Workspaces' tab
of the 'Workspace Layouts' dialog.

Core

The options in this category apply some
of the basic workspaces to your work
area. These include:
· Basic Diagramming
· Collaborate
· Core Modeling
· Default
· Explore
· Wide View

Design

The options in this category apply some
of the model design workspaces to your
work area. These include:
· Database Modeling
· Gap Analysis
· Requirements
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·
·

Schema Design
Trace by Matrix
Use Case Modeling

Software

The options in this category apply some
of the software development workspaces
to your work area. These include:
· Code Editing
· Debug
· Profile
· Record
· Software Engineering
· Testpoints
· XSLT Debugging

Simulation

The options in this category apply some
of the simulation workspaces to your
work area. These include:
· BPSim
· DMN-Sim
· Simulation
· SysML-Sim

Construction

The options in this category apply some
of the project construction workspaces to
your work area. These include:
· Change
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·
·
·
·
·

BABOK
Guide
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Maintenance
Resource Management
Support
Task Management
Testing
Work Items

The 'BABOK Reader' option applies the
BABOK workspace to your work area.
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Perspectives Portal
The Perspective Portal provides a number of work
Perspectives grouped by general work area. Each
Perspective filters the modeling windows and dialogs to
present only the modeling Patterns you might use in the
work defined by the Perspective. When you select a
Perspective the Model Wizard displays (the Start Page
'Create from Pattern' tab), providing the model templates
that you might use to initially create a model supporting the
type of work.
For example, if you select the 'Construction > Kanban'
Perspective the Model Wizard presents three Kanban
Patterns for one-stage, two-stage and three-stage workflows.
As you open or refresh other windows, such as the 'New
Diagram' dialog, the objects you can initially select are
filtered to provide - in this example - only Patterns for
developing Kanban diagrams.
The Perspectives you can select from the Portal, the Patterns
they provide, and the facilities for managing Perspectives
are described in the Model Perspectives Help topic.

Access
Ribbon
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Explore > Portals | Perspectives
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Shift+Alt+P :
Perspective

|

Navigator Toolbar :
:
:
| Perspective
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Windows Portal
Provides links to the Enterprise Architect windows you use
to navigate through, develop and manage your models.

Access
Ribbon

Explore > Portals > Windows

Keyboard
Shortcuts

Shift+Alt+P :

Other

Navigator Toolbar :
:
| Window

| Window

:

Facilities
Type

Facilities

Explore

Provides links to display the:
· Project
}
tabs of the Browser
· Context
}
window
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Resources }
'Details' tab of the Inspector window
Navigator
Model Search
File Search
System Output window

Properties

Provides access to these facilities:
· Properties window main tab
· Notes dialog
· 'Tags' tab of the Properties window
· Summary screen
· Document window
· Features dialog
· Requirements window

Diagram

Provides access to these facilities:
· Filters and Layers
· Pan and Zoom window
· Diagram Layout tools

Specialized
Tools

Provides access to these facilities:
· Specification Manager
· Scenario Builder
· Constraints, through the Responsibility
window
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Decision Table Editor
Database Builder
Schema Composer

Trace

Provides access to these facilities:
· The Traceability window
· Relationships window
· Relationship Matrix
· Gap Analysis Matrix

Collaborate

Provides access to these team
communication facilities:
· Finding All Reviews
· Finding All Discussions
· Conducting Reviews
· Conducting Discussions
· Model Mail
· Calendar
· Chat
· Model Library

Test

Provides the facilities to create and
review Tests of all types supported by
Enterprise Architect.

Task

Provides access to these facilities:
· Project Gantt Chart
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Personal Gantt Chart
Resource List

Maintenance

Provides access to the facilities for
recording and managing:
· Changes
· Defects
· Issues
· Tasks
· Events
· Decisions
· Effort
· Risks
· Metrics

Templates

Provides access to the facilities for
maintaining:
· Code Engineering Templates
· DDL Templates
· Document Templates
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Extend Portal
The Extend Portal lists the MDG Technologies currently
active in your model, and for each one provides links to the
facilities for working with those technologies within
Enterprise Architect.

Access
Ribbon

Explore > Portals > Extend

Keyboard
Shortcuts

Shift+Alt+P :

Other

Navigator Toolbar :
:
| Extend

| Extend

:

Facilities
The options provided in this Portal depend on what Add-Ins
and MDG Technologies are loaded and active for the model,
and what operations are supported between the technologies
and Enterprise Architect.
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Execute Portal
The Execute Portal provides links to the facilities of the
system that help you to:
· Perform Execution Analysis on your model - building and
running the Analyzer scripts
· Record, Profile, Debug and Simulate the execution of
your modeled application
· Access various windows that display specific aspects of
debugging an application
· Run a number of searches for information on recent
Simulations

Access
Ribbon

Explore > Portals > Execute

Keyboard
Shortcuts

Shift+Alt+P :
Execute

Other
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>

Navigator Toolbar :
:
:
> Execute
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Facilities
Category

Options

Execution
Analyzer

These options provide the facilities to
create and execute scripts for building,
running and testing an application. Select:
· Edit Build Scripts - to display the
Execution Analyzer window, from
which you can select a Build Script to
edit
· Open Source File - to display the 'Open
Source File' browser from which you
select a source file to view, and then
display the file content in the Code
Editor
· Merge - to run the Merge script
associated with the selected Package
· Build - to build the selected Package
according to the active Build Script
· Deploy - to run the deployment script
associated with the selected Package
· Run - to run the executable script
associated with the selected Package
· Test - to run the testing script
associated with the selected Package
The options in this section open a number
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Simulator

of windows that you might use in a
Simulation session. Select:
· Simulator to open the Simulation
window
· Triggers and Events to open the
Simulation Events window
· Breakpoints - to open the Breakpoints
& Markers window
· Local Variables - to open the Locals
window
· Call Stack - to open the Call Stack
window
· BPSim to open the Configure BPSim
window
· SysMLSim to open the Configure
SysML Simulation window

Simulation

The options in this section help you to
quickly control a simulation process.
Select:
· Start Simulation - to start debugging
· Step - to step over the next line of code
after a break
· Step In - to step into a function call in
the code
· Step Out - to step out of a function call
· Pause - to pause simulation
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Stop - to stop the simulation altogether

Debugger

The options in this section open a number
of windows that you might use in a
debugging session. Select:
· Debugger - to open the Debug window
· Breakpoints - to open the Breakpoints
& Markers window
· Call Stack - to open the Call Stack
window
· Local Variables - to open the Locals
window
· Memory - to open the Memory Viewer
window
· Modules - to open the Modules
window
· Watches - to open the Watches window
· Object Workbench - to display the
'Object Workbench' dialog
· Debugging Perspective - to display the
set of debug windows, dialogs, toolbars
and menus that you might use in a
debugging session

Debug

The options in this section help you to
quickly debug a running process or
application (through a debug script).
Select:
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·

Record
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Debug Run - to start debugging
Step - to step over the next line of code
after a break
Step In - to step into a function call in
the code
Step Out - to step out of a function call
Pause - to pause debugging
Stop - to stop the debugging session
altogether

The options in this section help you to set
up, start, record and analyze the
execution of the application code
developed from your model. Select:
· Recorder to open the Record &
Analyze window
· 'Apply Record Layout' - to open the
windows and dialogs that you would
use in performing Execution Analysis
on your model
· 'Start Recording' - to start a manual
recording of the current thread during a
debug session, managing it using the
'Step... ' functions
· 'Stop Recording' - to stop the current
recording session
· 'Auto Record Thread' - to begin
recording and not stop until either the
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·
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program ends, you stop the debugger or
you click on the 'Stop' icon
'Toggle Display of Execution Point' - to
toggle between highlighting the
execution point and not doing so
'Create Sequence Diagram' - to
generate a Sequence diagram from the
recording trace

Profile

The two options in this section are to
quickly set up a Profiling session on your
application. Select:
· Profiler - to open the Profiler window
· Apply Profile Layout - to display all
windows and dialogs that you might
use in profiling the execution of your
application

Code

The options provided in this section help
you to create, edit and debug code.
· Scripting - displays the Scripting
window for creating scripts within
script groups
· Source Code Editor - displays the
Source Code Editor, which helps you
to view, edit and maintain your source
code directly inside Enterprise
Architect
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Test

·

XSLT

·
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Language Grammars - displays the
Grammar Editor for writing and editing
a grammar for code imported in a new
programming language
Search Files - displays the Find in Files
window for searching the content of
selected files, or using the Code Miner
Testpoints to open the Testpoints
window
XSLT Editor/Debugger - displays both
the XSLT Debugger screen and the
System Output window at the XSLT
Transformation tab, for converting an
input document into XML or other
document types using an XSLT
Stylesheet; the transformation is
modeled in an XML Transform
diagram, from which you can debug
and/or execute the stylesheet
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Guidebook Portal
The Guidebook Portal provides access to a library of PDF
documents held on the Sparx Systems website. These
documents discuss specific areas of Enterprise Architect's
functionality and use. The documents are grouped according
to the area of work they support, namely:
· Basics
· Repository
· Modeling
· Domains
· Guides (for Business Analysis, Business Modeling and
Enterprise Architecture)
· Project Management
· Publishing
· Simulation
· Execution
· Automation
To open a document, double-click on the document name.

Access
Ribbon
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Explore > Portals > Guidebook
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Shift+Alt+P :
Guidebook

>

Navigator Toolbar :
:
:
> Guidebook
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Learning Portal
The Learning Portal provides links to a number of useful
Help pages or other web pages on the Sparx Systems
website, to present topical information quickly.
The options are organized in a sequence, giving very
specific information on a narrow subject such as keyboard
shortcuts through increasingly broad discussions of
facilities, features and concepts.

Access
Ribbon

Explore > Portals > Learning

Keyboard
Shortcuts

Shift+Alt+P :
Learning

Other

>

Navigator Toolbar :
:
:
> Learning

Facilities
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Category

Options

Quick
Reference

The 'Quick Reference' option provides a
set of Help topics that give immediate
information on some of the collections of
tools of Enterprise Architect, such as
shortcut keys or the ribbons.

Help

The options in this group access the
top-level topic from each chapter of the
Help. Once you have displayed a
top-level topic, you can select
subordinate topics for more detailed
information on a subject, or return to the
Index to open a different chapter.

Special
Topics

These topics describe specific features
and facilities of Enterprise Architect, to
provide a direct and focused discussion of
a facility such as Kanban diagrams or
Roadmaps.

Guides

These topics discuss broader subject
areas and work concepts, such as
Enterprise Architecture, Business
Analysis and Business Modeling.

Webinars

Select the 'All Webinars' option to open
the 'Webinar Registration' page of the
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Sparx Systems website, which:
· Describes upcoming webinars
(real-time seminars hosted via the
internet) scheduled by Sparx Systems,
and
· Provides links to the registration form,
for you to register your participation in
a webinar
About

(c) Sparx Systems 2022

The options in this section provide access
to a range of useful Sparx Systems web
pages, which contain information on and
demonstrations of Enterprise Architect
and other Sparx Systems facilities.
· 'Tutorials' - to open the 'Tutorials' page
of the Sparx Systems website, which
provides tutorials on general UML
modeling and doing work with
Enterprise Architect
· 'Resources' - to open the 'Help,
Tutorials & White papers' page and the
'Resources' page of the Sparx Systems
website, providing access to a wide
range of Enterprise Architect and UML
tutorials, demonstrations, examples,
base files, Add-Ins and general
information
· 'MDG Technologies' - to open the
'MDG Products' page of the Sparx
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Systems website, which provides a
brief description of, and the download
links for, each supported MDG Add-In
product for a selected edition of
Enterprise Architect - select your
installed edition from the drop-down
list
Enterprise Architect editions such as
Unified and Ultimate will
automatically register certain Add-In
products; however these Add-Ins are
not included in the default Enterprise
Architect installation and must be
downloaded separately
'3rd Party Extensions' - to open the
'Third Party Extensions' page of the
Sparx Systems website, which provides
listings of additional Enterprise
Architect Add-Ins developed by
partners and other members of the
Enterprise Architect community
'Newsletter' - to open the 'Newsletters'
page of the Sparx Systems website,
which provides links to view
newsletters previously released by
Sparx Systems, and to subscribe to
receive future newsletters as they are
released
'Release History' - to open the 'Recent
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Features' page of the Sparx Systems
website, which provides a full history
of changes in the most recent builds of
Enterprise Architect
You can also open the release history
and investigate the features of earlier
releases of the system, going back to
version 1.1.3, the very first commercial
release
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